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Chapter 1. C Language
This chapter describes the target specific features of the C language, including language extensions that
are not standard in ISO-C. For example, pragmas are a way to control the compiler from within the C
source.

The TASKING VX-toolset for LC87 C compiler fully supports the ISO-C standard and adds extra possibilities
to program the special functions of the target.

In addition to the standard C language, the compiler supports the following:

• attribute to specify alignment and absolute addresses

• intrinsic (built-in) functions that result in target specific assembly instructions

• pragmas to control the compiler from within the C source

• predefined macros

• the possibility to use assembly instructions in the C source

• keywords for inlining functions and programming interrupt routines

• libraries

All non-standard keywords have two leading underscores (__).

In this chapter the target specific characteristics of the C language are described, including the above
mentioned extensions.

1.1. Data Types

The TASKING C compiler for the LC87 supports the following data types. The sizes are shown in bits.

LimitsAlignSizeC type

0 or 111__bit

0 or 181_Bool

[-27, 27-1]88signed char

[0, 28-1]88unsigned char

[-215, 215-1]816short

[0, 216-1]816unsigned short

[-215, 215-1]816int

[0, 216-1]816unsigned int

[-27, 27-1] or [0, 28-1]
[-215, 215-1]

88
16

enum *

[-231, 231-1]832long

1



LimitsAlignSizeC type

[0, 232-1]832unsigned long

[-263, 263-1]864long long

[0, 264-1]864unsigned long long

[–3.402E+38, –1.175E-38]
[+1.175E-38, +3.402E+38]

832float (23-bit mantissa)

[-1.797E+308, -2.225E-308]
[+2.225E-308, +1.797E+308]

864double
long double (52-bit mantissa)

[0, 216-1]816__bdata pointer **

[0, 211-1]816__bdata __bit pointer

[0, 29-1]816__sdata pointer

[0, 213-1]816__mdata pointer

[0, 216-1]816__mdata __bit pointer

[0, 216-1]816__data pointer

[0, 224-1]824__xdata pointer ***

[0, 224-1]824__hxdata pointer

[0, 224-1]824__xrom pointer ***

[0, 224-1]824__hxrom pointer

[0, 216-1]816__zero0 pointer

[0, 216-1]816__zero1 pointer

[0, 217-1]824__bank0 pointer

[0, 218-1]824__bank1 pointer

[0, 218-1]824__rom pointer

* When you use the enum type, the compiler will use the smallest suitable integer type (char,
unsigned char, or int), unless you use C compiler option --integer-enumeration (always use
16-bit integers for enumeration).

** __bdata pointers are calculated using 8-bit pointer arithmetic.

*** __xdata pointers and __xrom pointers are calculated using 16-bit pointer arithmetic.

Aggregate and union types

Aggregate types are aligned on 16 bits by default. All members of the aggregate types are aligned as
required by their individual types as listed in the table above. The struct/union data types may contain
bit-fields. The allowed bit-field fundamental data types are _Bool, (un)signed char and (un)signed
int. The maximum bit-field size is equal to that of the type’s size. For the bit-field types the same rules
regarding to alignment and signed-ness apply as specified for the fundamental data types. In addition,
the following rules apply:

2
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• The first bit-field is stored at the least significant bits. Subsequent bit-fields will fill the higher significant
bits.

• A bit-field of a particular type cannot cross a boundary as is specified by its maximum width. For example,
a bit-field of type short cannot cross a 16-bit boundary.

• Bit-fields share a storage unit with other bit-field members if and only if there is sufficient space in the
storage unit.

• An unnamed bit-field creates a gap that has the size of the specified width.

• As a special case, an unnamed bit-field having width 0 (zero) prevents any further bit-field from residing
in the storage unit corresponding to the type of the zero-width bit-field.

Bit structures

The __bit data type is allowed as a struct/union member, with the restriction that no other type than
__bit is member of this structure.This creates a bit-structure that is allocated in bit-addressable memory.
Its alignment is 1 bit.

There are a number of restrictions to bit-structures. They are described below:

• It is not possible to pass a bit-structure argument to a function.

• It is not possible to return a bit-structure.

• It is not possible to make an automatic bit-structure.

The reason for these restrictions is that a bit-structure must be allocated in bit-addressable memory,
which the stack is not.

__bitsizeof() operator

The sizeof operator always returns the size in bytes. Use the __bitsizeof operator in a similar way
to return the size of an object or type in bits.

__bitsizeof( object | type )

1.1.1. Bit Data Type

The TASKING C compiler for the LC87 supports the data type __bit. The LC87 instruction set supports
some operations of the __bit type directly.

The following rules apply to __bit type variables:

• A __bit type variable is always unsigned.

• A __bit type variable can be exchanged with all other type variables. The compiler generates the
correct conversion.

3
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A __bit type variable is like a boolean.Therefore, if you convert an int type variable to a __bit type
variable, it becomes 1 (true) if the integer is not equal to 0, and 0 (false) if the integer is 0. The next
two C source lines have the same effect:

   bit_variable = int_variable;
   bit_variable = int_variable ? 1 : 0;

• You cannot take the address of an automatic __bit variable, because the stack is not bit addressable.

• The __bit data type is allowed as a struct/union member.

• A __bit type variable is allowed as a parameter of a function.

• A __bit type variable is allowed as a return type of a function.

• A __bit typed expression is allowed as switch expression.

• The sizeof of a __bit type is 1.

• Global or static __bit type variables can be initialized.

• A __bit type variable can be declared absolute using the __at() attribute. See Section 1.3.5, Placing
an Object at an Absolute Address: __at().

• A __bit type variable can be declared volatile.

Promotion rules

For the __bit type, the promotion rules are similar to the promotion rules for char, short, int, long
and long long.

1.2. Changing the Alignment: __align()

Normally data, pointers and structure members are aligned according to the table in the previous section.
With the attribute __align(n) you can overrule the default alignment of objects or structure members
to n bytes. The alignment must be a power of two.

Example:

int __align( 2 ) src[4];

The compiler generates the following assembly:

        .section .bss
        .global  _src
        .align   2
        .size    _src,8
_src:   .type    object
        .ds      8

4
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1.3. Accessing Memory

The LC87 series microcontrollers have the following three types of memory space:

• Program memory space: 2 ROM banks of 128 kB.

• Internal data memory space: 64 kB RAM, of which RAM/stack space at 0x0000 to 0xFDFF (9-bit), SFR
space at 0xFE00 to 0x FEFF (8-bit, some 9-bit)

• External data memory space: 16 MB RAM.

The TASKING VX-toolset for LC87 has several keywords you can use in your C source to specify memory
locations. This is explained in the sub-sections that follow.

1.3.1. Memory Type Qualifiers

In the C language you can specify that a variable or function must lie in a specific part of memory.You
can do this with a memory type qualifier. If you do not specify a memory type qualifier, data objects and
functions get a default memory type.

Memory type qualifiers for functions

You can specify the following memory type qualifiers for functions:

Section
name

Maximum
object size

LocationMemory spaceDescriptionQualifier

.text0x1FFFE0x00000 - 0x3FFFF
(2 pages of 128 kB)

Program memory
space

function in ROM__rom *

.text00x1FFFE0x00000 - 0x1FFFFProgram memory
space

function in ROM
bank 0

__bank0

.text10x1FFFE0x20000 - 0x3FFFFProgram memory
space

function in ROM
bank 1

__bank1 **

.ztext00xFFFE0x00000 - 0x0FFFFProgram memory
space

function in lowest 64
kB ROM

__zero0

.ztext10xFFFE0x20000 - 0x2FFFFProgram memory
space

function in lowest 64
kB ROM of bank 1

__zero1 **

* If you do not specify a memory type qualifier for functions, __rom is the default.

** When you use __bank1 or __zero1 in your C source you need to enable the option
--bank-switching of the linker. In Eclipse enable the option Generate bank switching stubs on
the Linker » Miscellaneous page of the Project Properties dialog.

Memory type qualifiers for data

You can specify the following memory type qualifiers for data:

5
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Section nameLocationMemory spaceDescriptionQualifier

.bdata /

.bbss
0x0000 - 0x00FFInternal data memory

space
initialized/cleared data__bdata

.bdata0x0000 - 0x00FFInternal data memory
space

constant data__bdata
const

.bitdata /

.bitbss
0x0000 - 0x07FF (bit
addresses)

Internal data memory
space

bit-addressable
initialized/cleared data

__bdata
__bit

.bitdata0x0000 - 0x07FF (bit
addresses)

Internal data memory
space

bit-addressable constant
data

__bdata
__bit const

.sdata /

.sbss
0x0000 - 0x01FFInternal data memory

space
short addressable
initialized/cleared data

__sdata

.sdata0x0000 - 0x01FFInternal data memory
space

short addressable
constant data

__sdata
const

.mdata /

.mbss
0x0000 - 0x1FFFInternal data memory

space
medium addressable
initialized/cleared data

__mdata

.mdata0x0000 - 0x1FFFInternal data memory
space

medium addressable
constant data

__mdata
const

.mbitdata /

.mbitbss
0x0000 - 0xFFFF (bit
addresses)

Internal data memory
space

medium bit-addressable
initialized/cleared data

__mdata
__bit

.mbitdata0x0000 - 0xFFFF (bit
addresses)

Internal data memory
space

medium bit-addressable
constant data

__mdata
__bit const

.data / .bss0x0000 - 0xFFFF (sfr
and system areas
reserved)

Internal data memory
space

normal initialized/cleared
data

__data

.data0x0000 - 0xFFFF (sfr
and system areas
reserved)

Internal data memory
space

normal constant data__data
const

.xdata /

.xbss
0x000000 - 0xFFFFFF
(pages of 64 kB)

External data memory
space

paged external
initialized/cleared data

__xdata

.xdata0x000000 - 0xFFFFFF
(pages of 64 kB)

External data memory
space

paged external constant
data

__xdata
const

.hxdata /

.hxbss
0x000000 - 0xFFFFFFExternal data memory

space
external
initialized/cleared data

__hxdata

.hxdata0x000000 - 0xFFFFFFExternal data memory
space

external constant data__hxdata
const

.xrodata0x000000 - 0xFFFFFF
(pages of 64 kB)

External data memory
space

paged external constant
data in ROM

__xrom *

.hxrodata0x000000 - 0xFFFFFFExternal data memory
space

external constant data in
ROM

__hxrom *

.rodata0x00000 - 0x3FFFF (2
pages of 128 kB)

Program memory
space

constant data in ROM__rom *

6
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Section nameLocationMemory spaceDescriptionQualifier

.rodata00x00000 - 0x1FFFFProgram memory
space

constant data in ROM
bank 0

__bank0 *

.rodata10x20000 - 0x3FFFFProgram memory
space

constant data in ROM
bank 1

__bank1 *

.zrodata00x00000 - 0x0FFFFProgram memory
space

constant data in lowest
64 kB ROM

__zero0 *

.zrodata10x20000 - 0x2FFFFProgram memory
space

constant data in lowest
64 kB ROM of bank 1

__zero1 *

* The memory type qualifiers __xrom, __hxrom, __rom, __bank0, __bank1, __zero0 and
__zero1 automatically imply the const qualifier. So, for example, if you specify __rom, this is
the same as if you specify const __rom.

If you do not specify a memory type qualifier for data, a default memory type is assigned based on memory
model options as explained in Section 1.3.2, Memory Models and Default Memory Type for Data.

Examples using explicit memory types

__bdata  unsigned char  c;
__sdata  unsigned short s;
__data   char  text[] = "No smoking";
__xram   int   array[10][4];

The memory type qualifiers are treated like any other data type specifier (such as unsigned).This means
the examples above can also be declared as:

unsigned char  __bdata  c;
unsigned short __sdata  s;
char   __data  text[] = "No smoking";
int    __xram  array[10][4];

1.3.2. Memory Models and Default Memory Type for Data

The C compiler supports several RAM and ROM data memory models, listed in the following tables.

ROM data models

All ROM data models allow all memory type qualifiers to be used. Each model has a default memory type
qualifier, which is used for objects defined without a memory type qualifier.You can select a ROM data
model with compiler option --rom-model.

Default data memory typeDescriptionROM data model

__bank0bank 0 in program memoryb0

__bank1bank 1 in program memoryb1

__zero0lowest 64kB in bank 0 of program memory (default)z0
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Default data memory typeDescriptionROM data model

__zero1lowest 64kB in bank 1 of program memoryz1

__romany bank in program memoryrom

When an object is explicitly or automatically qualified with the default memory type qualifier, the compiler
can generate better optimized code to access the object.

RAM data models

All RAM data models allow all memory type qualifiers to be used. Each model has a default memory type
qualifier, which is used for objects defined without a memory type qualifier.You can select a RAM data
model with compiler option --ram-model.

Default data memory typeDescriptionRAM data model

__datafull 64kB internal data memory (RAM) (default)data

__sdatalowest 512 bytes of internal data memory (RAM)sdata

Default memory type for data

The default memory type for data without a memory type qualifier is determined by the memory model
options as follows:

Constant dataCleared dataInitialized dataDescriptionMemory model options

.data.bss.dataSet const default to
__data

none

.zrodata0.bss.dataSet const default to
__zero0

--rom-const

.zrodata0not affectednot affectedSet const default to
__zero0

--rom-const
--rom-model=z0

.zrodata1not affectednot affectedSet const default to
__zero1

--rom-const
--rom-model=z1

.rodata0not affectednot affectedSet const default to
__bank0

--rom-const
--rom-model=b0

.rodata1not affectednot affectedSet const default to
__bank1

--rom-const
--rom-model=b1

.rodatanot affectednot affectedSet const default to __rom--rom-const
--rom-model=r

.data.bss.dataSet default to __data--ram-model=d

.zrodata0.bss.dataSet default to __data--ram-model=d
--rom-const

.sdata.sbss.sdataSet default to __sdata--ram-model=s

.zrodata0.sbss.sdataSet default to __sdata--ram-model=s
--rom-const

8

TASKING VX-toolset for LC87 User Guide



1.3.3. Pointers with Memory Type Qualifiers

Pointers for the LC87 can have two types: a 'logical' type and a storage type. For example:

char __xdata * __sdata p;

This declaration means that pointer p is allocated in the __sdata space, and that it is referring to a
character in the __xdata space.The memory type qualifier used to the left of the '*', specifies the logical
(target memory) type of the pointer, the memory type qualifier used to the right of the '*', specifies the
storage memory of the pointer itself.

Pointer conversions

Conversions of pointers with the same qualifiers are always allowed, with one exception. It is not possible
to convert a pointer to __bit to a pointer with another fundamental type and the other way around. The
following table contains the additionally allowed pointer conversions. Other pointer conversions are not
allowed to avoid possible run-time errors.

RemarksDestination pointerSource pointer

Fundamental type not __bit__sdata__bdata

Fundamental type not __bit__mdata__bdata

__mdata __bit__bdata __bit

Fundamental type not __bit__data__bdata

Fundamental type not __bit__mdata__sdata

__data__sdata

Fundamental type not __bit__sdata__mdata

Fundamental type not __bit__data__mdata

__sdata__data

Fundamental type not __bit__mdata__data

__hxdata__xdata

__xrom__xdata

__hxrom__xrom

Destination must be a pointer to const
to avoid a warning

__hxdata__xrom

__hxrom__hxdata

Destination must be a pointer to const
to avoid a warning

__hxdata__hxrom

__bank0__zero0

__rom__zero0

__bank1__zero1

__rom__zero1
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RemarksDestination pointerSource pointer

__rom__bank0

__rom__bank1

1.3.4. Code Generation for the __xdata Space

The __xdata space is located in external data memory and is divided into pages of 64kB. Objects in the
__xdata space are never located across a page boundary. Therefore, an object in the __xdata space
cannot be larger than a page. Because objects do not cross a page boundary it is possible to do the
pointer arithmetic in the __xdata space in 16 bits, instead of 24 bits as is the case in the __hxdata
space. In addition to the page boundary restriction the first and last byte of each page are not used for
the following reasons:

• It is necessary to exclude the first byte because with 16-bit pointer arithmetic there will be a NULL
pointer in each page.

• The last byte in each page is not used because in C it is allowed that a pointer refers to the first address
after an object.With 16-bit arithmetic this causes a wrap when an object is located at the end of a page.

Pointer comparisons are also done by comparing only the 16-bit offsets within the page. This is possible
because:

• It does not make sense to compare pointers that are not referring to the same object.

• Because the first byte in each page is not used NULL pointer comparisons will still work.

• Because the last byte in each page is not used it is possible to let a pointer refer to the first address
after an object.

1.3.5. Placing an Object at an Absolute Address: __at()

Just like you can declare a variable in a specific part of memory (using memory type qualifiers), you can
also place an object or function at an absolute address in memory.

With the attribute __at() you can specify an absolute address. If you use this keyword on __bit objects
or functions, the address is a bit address.

The compiler checks the address range, the alignment and if an object crosses a page boundary.

Examples

unsigned char Display[80*24] __at( 0x2000 );

The array Display is placed at address 0x2000. In the generated assembly, an absolute section is
created. On this position space is reserved for the variable Display.

int i __at(0x1000) = 1;

The variable i is placed at address 0x1000 and is initialized.

__bit b __at(0x103);
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The variable b is placed at bit address 0x103.

void f(void) __at( 0xf0ff + 1 ) { }

The function f is placed at address 0xf100.

Restrictions

Take note of the following restrictions if you place a variable at an absolute address:

• The argument of the __at() attribute must be a constant address expression.

• You can place only global variables at absolute addresses. Parameters of functions, or automatic
variables within functions cannot be placed at absolute addresses.

• A variable that is declared extern, is not allocated by the compiler in the current module. Hence it is
not possible to use the keyword __at() on an external variable. Use __at() at the definition of the
variable.

• You cannot place structure members at an absolute address.

• Absolute variables cannot overlap each other. If you declare two absolute variables at the same address,
the assembler and/or linker issues an error. The compiler does not check this.

1.3.6. Accessing Bits

There are several methods to access single bits in the bit-addressable area. The compiler generates
efficient bit operations where possible.

Masking and shifting

The classic method to extract a single bit in C is masking and shifting.

__bdata unsigned short bitword;
void foo( void )
{
    if( bitword & 0x0004 )    // bit 2 set?
    {
        bitword &= ~0x0004;   // clear bit 2
    }
    bitword |= 0x0001;        // set bit 0;
}

Built-in macros __getbit() and __putbit()

The compiler has the built-in macros __getbit() and __putbit().These macros expand to shift/and/or
combinations to perform the required result.

__bdata unsigned short bw; 
void foo( void )
{
    if( __getbit( bw, 2 ) )
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    {
        __putbit( 0, bw, 2 );
    }
    __putbit( 1, bw, 0 );
}

Accessing bits using a struct/union combination

typedef __bdata union
{
    unsigned short word;
    struct
    {
        int  b0 : 1;
        int  b1 : 1;
        int  b2 : 1;
        int  b3 : 1;
        int  b4 : 1;
        int  b5 : 1;
        int  b6 : 1;
        int  b7 : 1;
        int  b8 : 1;
        int  b9 : 1;
        int  b10: 1;
        int  b11: 1;
        int  b12: 1;
        int  b13: 1;
        int  b14: 1;
        int  b15: 1;
    } bits;
} bitword_t;

bitword_t bw;

void foo( void )
{
    if( bw.bits.b3 )
    {
        bw.bits.b3 = 0;
    }
    bw.bits.b0 = 1;
}

void reset( void )
{
    bw.word = 0;
}
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1.4. Shift JIS Kanji Support

In order to allow for Japanese character support on non-Japanese systems (like PCs), you can use the
Shift JIS Kanji Code standard. This standard combines two successive ASCII characters to represent
one Kanji character. A valid Kanji combination is only possible within the following ranges:

• First (high) byte is in the range 0x81-0x9f or 0xe0-0xef.

• Second (low) byte is in the range 0x40-0x7e or 0x80-0xfc

Compiler option -Ak enables support for Shift JIS encoded Kanji multi-byte characters in strings and
(wide) character constants. Without this option, encodings with 0x5c as the second byte conflict with the
use of the backslash ('\') as an escape character. Shift JIS in comments is supported regardless of this
option.

Note that Shift JIS also includes Katakana and Hiragana.

Example:

// Example usage of Shift JIS Kanji
// Do not switch off option -Ak
// At the position of the italic text you can
// put your Shift JIS Kanji code
int  i;  // put Shift JIS Kanji here
char c1;
char c2;
unsigned int ui;
const char mes[]="put Shift JIS Kanji here";
const unsigned int ar[5]={'K','a','n',
                   'j','i'};
                   // 5 Japanese array
void main(void)
{
    i=(int)c1;
    i++; /* put Shift JIS Kanji here\
            continuous comment */
    c2=mes[9];
    ui=ar[0];
}

1.5. Using Assembly in the C Source: __asm()

With the keyword __asm you can use assembly instructions in the C source and pass C variables as
operands to the assembly code. Be aware that C modules that contain assembly are not portable and
harder to compile in other environments.

The compiler does not interpret assembly blocks but passes the assembly code to the assembly source
file; they are regarded as a black box. So, it is your responsibility to make sure that the assembly block
is syntactically correct. Possible errors can only be detected by the assembler.
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You need to tell the compiler exactly what happens in the inline assembly code because it uses that for
code generation and optimization. The compiler needs to know exactly which registers are written and
which registers are only read. For example, if the inline assembly writes to a register from which the
compiler assumes that it is only read, the generated code after the inline assembly is based on the fact
that the register still contains the same value as before the inline assembly. If that is not the case the
results may be unexpected. Also, an inline assembly statement using multiple input parameters may be
assigned the same register if the compiler finds that the input parameters contain the same value. As
long as this register is only read this is not a problem.

General syntax of the __asm keyword

__asm( "instruction_template"
       [ : output_param_list
       [ : input_param_list
       [ : register_reserve_list]]] );

Assembly instructions that may contain parameters from the input
list or output list in the form: %parm_nr[.kid]

instruction_template

Parameter number in the range 0 .. 9. With the optional .kid number
you can select a byte kid register from a word register. Kid 0 selects
the least significant byte, and kid 1 the most significant byte. For
example, if r4 is used for %0, %0.1 selects byte register r4h.

%parm_nr[.kid]

[[ "=[&]constraint_char"(C_expression)],...]output_param_list

[[ "constraint_char"(C_expression)],...]input_param_list

Says that an output operand is written to before the inputs are read,
so this output must not be the same register as any input.

&

Constraint character: the type of register to be used for the
C_expression. See the table below.

constraint _char

Any C expression. For output parameters it must be an lvalue, that
is, something that is legal to have on the left side of an assignment.

C_expression

[["register_name"],...]register_reserve_list

Name of the register you want to reserve. For example because this
register gets clobbered by the assembly code. The compiler will not
use this register for inputs or outputs.You can use byte register
r0l,r0h...r36l,r36h, word registers r0 ... r36, bit registers r0l,[0..7] ...
r36h,[0..7], the accumulators a, b, c and the program status register
psw. Note that reserving too many registers can make register
allocation impossible.

register_name

Specifying registers for C variables

With a constraint character you specify the register type for a parameter.

You can reserve the registers that are used in the assembly instructions, either in the parameter lists or
in the reserved register list (register_reserve_list). The compiler takes account of these lists, so no
unnecessary register saves and restores are placed around the inline assembly instructions.
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RemarkOperandTypeConstraint
character

r0l,[0..7] .. r36h,[0..7]bit registerB

r0l .. r36hbyte registerb

r0 .. r36word registerw

Input constraint only. The number
must refer to an output parameter.
Indicates that %number and number
are the same register.

same as %numbertype of operand it is
associated with

number

If an input parameter is modified by the inline assembly then this input parameter must also be
added to the list of output parameters (see Example 6). If this is not the case, the resulting code
may behave differently than expected since the compiler assumes that an input parameter is not
being changed by the inline assembly.

Loops and conditional jumps

The compiler does not detect loops with multiple __asm() statements or (conditional) jumps across
__asm() statements and will generate incorrect code for the registers involved.

If you want to create a loop with __asm(), the whole loop must be contained in a single __asm()
statement. The same counts for (conditional) jumps. As a rule of thumb, all references to a label in an
__asm() statement must be in that same statement.You can use numeric labels for these purposes.

Example 1: no input or output

A simple example without input or output parameters.You can use any instruction or label. When it is
required that a sequence of __asm() statements generates a contiguous sequence of instructions, then
they can be best combined to a single __asm() statement. Compiler optimizations can insert instruction(s)
in between __asm() statements. Use newline characters ‘\n’ to continue on a new line in a __asm()
statement. For multi-line output, use tab characters '\t' to indent instructions.

__asm( "nop\n"
       "\tnop" ); 

Example 2: using output parameters

Assign the result of inline assembly to a variable. With the constraint b a byte register is chosen for the
parameter; the compiler decides which register is best to use.The %0 in the instruction template is replaced
by the name of this register. The compiler generates code to assign the result to the output variable.

char initone( void )
{
    char out;
    __asm( "mov  #1,%0" : "=b"(out) );
    return out;
}
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Generated assembly code:

_initone: .type  func
    mov  #1,r4l
    ld   r4l
    ret

Example 3: using input parameters

Assign a variable to the LDCBNK bit in the PSW register. A bit register is chosen for the parameter
because of the constraint B, the compiler decides which register is best to use. The %0 in the instruction
template is replaced by the name of this register. Because there are no output parameters, the output
parameter list is empty. Only the colon has to be present.

void bnkselect( __bit bnk )
{
    __asm( "chgp3   #0\n\t"
           "bn      %0,bank0\n\t"
           "chgp3   #1\n"
           "bank0:"
           : 
           : "B"(bnk) );
    return;
}

Generated assembly code:

_bnkselect: .type  func
    chgp3   #0
    bn      r1l,0,bank0
    chgp3   #1
bank0:
    ret

Example 4: using input and output parameters

Multiply two C variables and assign the result to a third C variable. Data type registers are necessary for
the input and output parameters (constraint w, %0 for out1, %1 for out2, %2 for in1 and %3 for in2 in
the instruction template). The compiler generates code to assign the result to the output variables. With
the .kid notation you can select the byte kid-registers from a word register. Kid 0 is the least significant
byte and kid 1 is the most significant byte. In the reserved register list the accumulators and the psw are
specified to let the compiler know that these registers are overwritten.

long out;
void multiply32( unsigned int in1, unsigned int in2 )
{
    unsigned int out1;
    unsigned int out2;

    __asm( "pushw %2\n\t"
           "push  #0\n\t"
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           "pushw %3\n\t"
           "mul24\n\t"
           "stw   %0\n\t"
           "ld    c\n\t"
           "st    %1.0\n\t"
           "pop   %1.1\n\t"
           "pop   %1.1"
           : "=w" (out1), "=w" (out2)
           : "w" (in1), "w" (in2)
           : "a", "b", "c", "psw" );
    out = out1 | (signed long)out2 << 16;
    return;
}

Generated assembly code:

 _multiply32: .type  func
    pushw r1
    push  #0
    pushw r2
    mul24
    stw   r3
    ld    c
    st    r4l
    pop   r4h
    pop   r4h

    ldw   r3
    stw   _out
    ldw   r4
    stw   _out+2
    ret

Because out is a global variable it is also possible to omit the output parameters, and use the symbol
_out directly in the inline assembly code.

Example 5: reserving registers

Sometimes an instruction knocks out certain specific registers. The most common example of this is a
function call, where the called function is allowed to do whatever it likes with some registers. If this is the
case, you can list specific registers that get clobbered by an operation after the inputs.

Same as Example 4, but now registers r3 and r4 are reserved registers.You can do this by adding these
registers to the reserved register list (, "r3", "r4"). As you can see in the generated assembly code,
registers r3 and r4 are not used (the first register used is r1).

long out;
void multiply32( unsigned int in1, unsigned int in2 )
{
    unsigned int out1;
    unsigned int out2;
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    __asm( "pushw %2\n\t"
           "push  #0\n\t"
           "pushw %3\n\t"
           "mul24\n\t"
           "stw   %0\n\t"
           "ld    c\n\t"
           "st    %1.0\n\t"
           "pop   %1.1\n\t"
           "pop   %1.1"
           : "=w" (out1), "=w" (out2)
           : "w" (in1), "w" (in2)

: "a", "b", "c", "psw", "r3", "r4" );
    out = out1 | (signed long)out2 << 16;
    return;
}

Generated assembly code:

 _multiply32: .type  func
    pushw r1
    push  #0
    pushw r2
    mul24
    stw   r3
    ld    c
    st    r4l
    pop   r4h
    pop   r4h

    ldw   r3
    stw   _out
    ldw   r4
    stw   _out+2
    ret

Example 6: use the same register for input and output

As input constraint you can use a number to refer to an output parameter. This tells the compiler that the
same register can be used for the input and output parameter. When the input and output parameter are
the same C expression, these will effectively be treated as if the input parameter is also used as output.
In that case it is allowed to write to this register. For example:

long swap( long p )
{
    unsigned int hi;
    unsigned int lo;

    lo = (unsigned int)p;
    hi = (unsigned int)(p >> 16);
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    __asm( "ldw   %3\n\t"
           "xchw  %0\n\t"
           "stw   %1"
           : "=w"(lo), "=w"(hi)
           : "0"(lo), "1"(hi)
           : "a", "b", "psw" );
    return (long)hi << 16 | lo;
}

In this example the "0" constraint for the input parameter lo refers to the output parameter lo, and similar
for the "1" constraint and hi. In the inline assembly %0 (lo) and %1 (hi) are written. This is allowed
because the compiler is aware of this.

This results in the following generated assembly code:

 _swap: .type  func
    ldw   r2
    xchw  r1
    stw   r2
    ret

Example 7: using a constant value from a preprocessor macro

When it is necessary to use an immediate value from a preprocessor macro, you can first convert the
constant to a string. For example:

#define QUOTEME(x)  #x
#define IMM(x)      QUOTEME(x)

#define VALUE       6

char imm( void )
{
    char out;

    __asm( "mov  #" IMM(VALUE) ",%0" : "=b"(out) );
    return out;
}

The IMM macro converts VALUE into a string. Next string concatenation is used to build the instruction
template. The generated code is:

_imm: .type  func
    mov  #6,r4l
    ld   r4l
    ret
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1.6. Attributes

You can use the keyword __attribute__ to specify special attributes on declarations of variables,
functions, types, and fields.

Syntax:

__attribute__((name,...))

or:

__name__

The second syntax allows you to use attributes in header files without being concerned about a possible
macro of the same name.

alias("symbol")

You can use __attribute__((alias("symbol"))) to specify that the function declaration appears
in the object file as an alias for another symbol. For example:

void __f() { /* function body */; }
void f() __attribute__((weak, alias("__f")));

declares 'f' to be a weak alias for '__f'.

align(value)

You can use __attribute__((align(n))) to change the alignment of objects. The alignment must
be a power of two. See also Section 1.2, Changing the Alignment: __align().

const

You can use __attribute__((const)) to specify that a function has no side effects and will not
access global data. This can help the compiler to optimize code. See also attribute pure.

The following kinds of functions should not be declared __const__:

• A function with pointer arguments which examines the data pointed to.

• A function that calls a non-const function.

export

You can use __attribute__((export)) to specify that a variable/function has external linkage and
should not be removed. During MIL linking, the compiler treats external definitions at file scope as if they
were declared static. As a result, unused variables/functions will be eliminated, and the alias checking
algorithm assumes that objects with static storage cannot be referenced from functions outside the current
module. During MIL linking not all uses of a variable/function can be known to the compiler. For example
when a variable is referenced in an assembly file or a (third-party) library. With the export attribute the
compiler will not perform optimizations that affect the unknown code.
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int i __attribute__((export)); /* 'i' has external linkage */

flatten

You can use __attribute__((flatten)) to force inlining of all function calls in a function, including
nested function calls.

Unless inlining is impossible or disabled by __attribute__((noinline)) for one of the calls, the
generated code for the function will not contain any function calls.

format(type,arg_string_index,arg_check_start)

You can use __attribute__((format(type,arg_string_index,arg_check_start))) to
specify that functions take printf, scanf, strftime or strfmon style arguments and that calls to
these functions must be type-checked against the corresponding format string specification.

type determines how the format string is interpreted, and should be printf, scanf, strftime or
strfmon.

arg_string_index is a constant integral expression that specifies which argument in the declaration of the
user function is the format string argument.

arg_check_start is a constant integral expression that specifies the first argument to check against the
format string. If there are no arguments to check against the format string (that is, diagnostics should only
be performed on the format string syntax and semantics), arg_check_start should have a value of 0. For
strftime-style formats, arg_check_start must be 0.

Example:

int foo(int i, const char * my_format, ...) __attribute__((format(printf, 2, 3)));

The format string is the second argument of the function foo and the arguments to check start with the
third argument.

leaf

You can use __attribute__((leaf)) to specify that a function is a leaf function. A leaf function is
an external function that does not call a function in the current compilation unit, directly or indirectly. The
attribute is intended for library functions to improve dataflow analysis. The attribute has no effect on
functions defined within the current compilation unit.

malloc

You can use __attribute__((malloc)) to improve optimization and error checking by telling the
compiler that:

• The return value of a call to such a function points to a memory location or can be a null pointer.

• On return of such a call (before the return value is assigned to another variable in the caller), the memory
location mentioned above can be referenced only through the function return value; e.g., if the pointer
value is saved into another global variable in the call, the function is not qualified for the malloc attribute.
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• The lifetime of the memory location returned by such a function is defined as the period of program
execution between a) the point at which the call returns and b) the point at which the memory pointer
is passed to the corresponding deallocation function. Within the lifetime of the memory object, no other
calls to malloc routines should return the address of the same object or any address pointing into that
object.

noinline

You can use __attribute__((noinline)) to prevent a function from being considered for inlining.
Same as keyword __noinline or #pragma noinline.

always_inline

With __attribute__((always_inline)) you force the compiler to inline the specified function,
regardless of the optimization strategy of the compiler itself. Same as keyword inline or #pragma
inline.

noreturn

Some standard C function, such as abort and exit cannot return.The C compiler knows this automatically.
You can use __attribute__((noreturn)) to tell the compiler that a function never returns. For
example:

void fatal() __attribute__((noreturn));

void fatal( /* ... */ )
{
  /* Print error message */
  exit(1);
}

The function fatal cannot return. The compiler can optimize without regard to what would happen if
fatal ever did return.This can produce slightly better code and it helps to avoid warnings of uninitialized
variables.

protect

You can use __attribute__((protect)) to exclude a variable/function from the duplicate/unreferenced
section removal optimization in the linker. When you use this attribute, the compiler will add the "protect"
section attribute to the symbol's section. Example:

int i __attribute__((protect));

Note that the protect attribute will not prevent the compiler from removing an unused variable/function
(see the used symbol attribute).
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pure

You can use __attribute__((pure)) to specify that a function has no side effects, although it may
read global data. Such pure functions can be subject to common subexpression elimination and loop
optimization. See also attribute const.

section("section_name")

You can use __attribute__((section("name"))) to specify that a function must appear in the
object file in a particular section. For example:

extern void foobar(void) __attribute__((section("bar")));

puts the function foobar in the section named bar.

used

You can use __attribute__((used)) to prevent an unused symbol from being removed, by both the
compiler and the linker. Example:

static const char copyright[] __attribute__((used)) = "Copyright 2013 Altium BV";

When there is no C code referring to the copyright variable, the compiler will normally remove it. The
__attribute__((used)) symbol attribute prevents this. Because the linker should also not remove
this symbol, __attribute__((used)) implies __attribute__((protect)).

unused

You can use __attribute__((unused)) to specify that a variable or function is possibly unused. The
compiler will not issue warning messages about unused variables or functions.

weak

You can use __attribute__((weak)) to specify that the symbol resulting from the function declaration
or variable must appear in the object file as a weak symbol, rather than a global one. This is primarily
useful when you are writing library functions which can be overwritten in user code without causing
duplicate name errors.

See also #pragma weak.

1.7. Pragmas to Control the Compiler

Pragmas are keywords in the C source that control the behavior of the compiler. Pragmas overrule
compiler options. Put pragmas in your C source where you want them to take effect. Unless stated
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otherwise, a pragma is in effect from the point where it is included to the end of the compilation unit or
until another pragma changes its status.

The syntax is:

#pragma [label:]pragma-spec pragma-arguments [on | off | default | restore] 

or:

_Pragma( "[label:]pragma-spec pragma-arguments [on | off | default | restore]" )

Some pragmas can accept the following special arguments:

switch the flag on (same as without argument)on

switch the flag offoff

set the pragma to the initial valuedefault

restore the previous value of the pragmarestore

Label pragmas

Some pragmas support a label prefix of the form "label:" between #pragma and the pragma name. Such
a label prefix limits the effect of the pragma to the statement following a label with the specified name.
The restore argument on a pragma with a label prefix has a special meaning: it removes the most
recent definition of the pragma for that label.

You can see a label pragma as a kind of macro mechanism that inserts a pragma in front of the statement
after the label, and that adds a corresponding #pragma ... restore after the statement.

Compared to regular pragmas, label pragmas offer the following advantages:

• The pragma text does not clutter the code, it can be defined anywhere before a function, or even in a
header file. So, the pragma setting and the source code are uncoupled. When you use different header
files, you can experiment with a different set of pragmas without altering the source code.

• The pragma has an implicit end: the end of the statement (can be a loop) or block. So, no need for
pragma restore / endoptimize etc.

Example:

#pragma lab1:optimize P

volatile int v;

void f( void )
{
      int i, a;

      a = 42;

lab1: for( i=1; i<10; i++ )
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      {
        /* the entire for loop is part of the pragma optimize */
        a += i;
      }
      v = a;
}

Supported pragmas

The compiler recognizes the following pragmas, other pragmas are ignored. Pragmas marked with (*)
support a label prefix.

alias symbol=defined_symbol

Define symbol as an alias for defined_symbol. It corresponds to a .ALIAS directive at assembly level.
The symbol must not be defined elsewhere, and defined_symbol must be defined with static storage
duration (not extern or automatic).

clear / noclear [on | off | default | restore] (*)

By default, uninitialized global or static variables are cleared to zero on startup. With pragma noclear,
this step is skipped. Pragma clear resumes normal behavior. This pragma applies to constant data as
well as non-constant data.

See C compiler option --no-clear.

extension isuffix [on | off | default | restore] (*)

Enables a language extension to specify imaginary floating-point constants. With this extension, you can
use an "i" suffix on a floating-point constant, to make the type _Imaginary.

float 0.5i

extern symbol

Normally, when you use the C keyword extern, the compiler generates an .EXTERN directive in the
generated assembly source. However, if the compiler does not find any references to the extern symbol
in the C module, it optimizes the assembly source by leaving the .EXTERN directive out.

With this pragma you can force an external reference (.EXTERN assembler directive), even when the
symbol is not used in the module.

inline / noinline / smartinline

See Section 1.10.4, Inlining Functions: inline.

inline_max_incr {value | default | restore} (*)
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inline_max_size {value | default | restore} (*)

With these pragmas you can control the automatic function inlining optimization process of the compiler.
It has only effect when you have enabled the inlining optimization (--optimize=+inline (-Oi)).

See C compiler options --inline-max-incr and --inline-max-size.

integer_enumeration [on | off | default | restore] (*)

With this pragma the compiler always treats enum types as integers. Same as C compiler option
--integer-enumeration

macro / nomacro [on | off | default | restore] (*)

Turns macro expansion on or off. By default, macro expansion is enabled.

message "message" ...

Print the message string(s) on standard output.

nomisrac [nr,...] [default | restore] (*)

Without arguments, this pragma disables MISRA-C checking. Alternatively, you can specify a
comma-separated list of MISRA-C rules to disable.

See C compiler option --misrac and Section 3.7.2, C Code Checking: MISRA-C.

optimize [flags] / endoptimize [default | restore] (*)

You can overrule the C compiler option --optimize for the code between the pragmas optimize and
endoptimize. The pragma works the same as C compiler option --optimize.

See Section 3.5, Compiler Optimizations.

section [type=][format_string][,...] / endsection [default | restore] (*)

Rename sections by adding a format_string to all section names specified with .type, or restore default
section naming. If you specify only a format_string (without a type), the suffix is added to all section names.
See Section 1.11, Section Naming, C compiler option --rename-sections and assembler directive
.SECTION for more information.

source / nosource [on | off | default | restore] (*)

With these pragmas you can choose which C source lines must be listed as comments in assembly output.

See C compiler option --source.
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stdinc [on | off | default | restore] (*)

This pragma changes the behavior of the #include directive. When set, the C compiler options
--include-directory and --no-stdinc are ignored.

string_literal_memory {space | default | restore} (*)

Controls the allocation of string literals.The memory space must be one of:__bdata, __sdata, __mdata,
__data, __xdata, __hxdata, __xrom, __hxrom, __rom, __bank0, __bank1, __zero0, __zero1
or model.

See C compiler option --string-literal-memory.

tradeoff {level | default | restore} (*)

Specify tradeoff between speed (0) and size (4). See C compiler option --tradeoff

warning [number,...] [default | restore] (*)

With this pragma you can disable warning messages. If you do not specify a warning number, all warnings
will be suppressed.

weak symbol

Mark a symbol as "weak" (.WEAK assembler directive). The symbol must have external linkage, which
means a global or external object or function. A static symbol cannot be declared weak.

A weak external reference is resolved by the linker when a global (or weak) definition is found in one of
the object files. However, a weak reference will not cause the extraction of a module from a library to
resolve the reference.When a weak external reference cannot be resolved, the null pointer is substituted.

A weak definition can be overruled by a normal global definition. The linker will not complain about the
duplicate definition, and ignore the weak definition.

1.8. Predefined Preprocessor Macros

The TASKING C compiler supports the predefined macros as defined in the table below. The macros are
useful to create conditional C code.

DescriptionMacro

Identifies the build number of the compiler, composed of decimal digits for
the build number, three digits for the major branch number and three digits
for the minor branch number. For example, if you use build 1.22.1 of the
compiler, __BUILD__ expands to 1022001. If there is no branch number,
the branch digits expand to zero. For example, build 127 results in
127000000.

__BUILD__
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DescriptionMacro

Expands to UCHAR_MAX or SCHAR_MAX, depending upon the option
--uchar (char defaults to unsigned).

__CHAR_MAX

Expands to 0 or SCHAR_MIN, depending upon the option --uchar (char
defaults to unsigned).

__CHAR_MIN

Expands to the compilation date: “mmm dd yyyy”.__DATE__

Expands to 1 if you did not use option --no-double (Treat ‘double’ as ‘float’),
otherwise unrecognized as macro.

__DOUBLE_FP__

Expands to the current source file name.__FILE__

Expands to 1 for the LC87 toolset, otherwise unrecognized as macro.__LC87__

Expands to the line number of the line where this macro is called.__LINE__

Expands to 1. The processor accesses data in little-endian.__LITTLE_ENDIAN__

Expands to 1 if profiling is enabled, otherwise expands to 0.__PROF_ENABLE__

Expands to INT16_MAX.__PTRDIFF_MAX

Expands to INT16_MIN.__PTRDIFF_MIN

Expands to 1 if you used option --ram-model=data), otherwise unrecognized
as macro.

__RAM_DATA__

Expands to 1 if you used option --ram-model=sdata), otherwise
unrecognized as macro.

__RAM_SDATA__

Expands to the revision number of the compiler. Digits are represented as
they are; characters (for prototypes, alphas, betas) are represented by -1.
Examples: v1.0r1 -> 1, v1.0rb -> -1

__REVISION__

Expands to 1 if you used option --rom-model=b0), otherwise unrecognized
as macro.

__ROM_BANK0__

Expands to 1 if you used option --rom-model=b1), otherwise unrecognized
as macro.

__ROM_BANK1__

Expands to 1 if you used option --rom-const), otherwise unrecognized as
macro.

__ROM_CONST__

Expands to 1 if you used option --rom-model=rom), otherwise unrecognized
as macro.

__ROM_ROM__

Expands to 1 if you used option --rom-model=z0), otherwise unrecognized
as macro. This is the default.

__ROM_ZERO0__

Expands to 1 if you used option --rom-model=z1), otherwise unrecognized
as macro.

__ROM_ZERO1__

Expands to 1 if you used option --no-double (Treat ‘double’ as ‘float’),
otherwise unrecognized as macro.

__SINGLE_FP__

Expands to UINT16_MAX.__SIZE_MAX

Expands to 0.__SIZE_MIN

Identifies the level of ANSI standard. The macro expands to 1 if you set
option --language (Control language extensions), otherwise expands to 0.

__STDC__

28

TASKING VX-toolset for LC87 User Guide



DescriptionMacro

Always expands to 0, indicating the implementation is not a hosted
implementation.

__STDC_HOSTED__

Identifies the ISO-C version number. Expands to 199901L for ISO C99 or
199409L for ISO C90.

__STDC_VERSION__

Identifies the compiler as a TASKING compiler. Expands to 1 if a TASKING
compiler is used.

__TASKING__

Expands to the compilation time: “hh:mm:ss”__TIME__

Identifies the version number of the compiler. For example, if you use version
3.0r1 of the compiler, __VERSION__ expands to 3000 (dot and revision
number are omitted, minor version number in 3 digits).

__VERSION__

Identifies the VX-toolset C compiler. Expands to 1.__VX__

Expands to UINT16_MAX.__WCHAR_MAX

Expands to 0.__WCHAR_MIN

Example

#ifdef __LC87__
/* this part is only compiled for the LC87 */
...
#endif

1.9. Strings

In this context the word 'strings' means the separate occurrence of a string in a C program. So, array
variables initialized with strings are just initialized character arrays, which can be allocated in any memory
type, and are not considered as 'strings'.

Strings have static storage. The ISO C standard permits string literals to be put in ROM.

Allocation of string literals

By default the C compiler allocates string literals in the memory model's default memory space according
to the settings of the options --ram-model / --rom-model. See Section 1.3.2, Memory Models and Default
Memory Type for Data.You can overrule this with #pragma string_literal_memory:

#pragma string_literal_memory space

The space must be one of: __bdata, __sdata, __mdata, __data, __xdata, __hxdata, __xrom,
__hxrom, __rom, __bank0, __bank1, __zero0, __zero1 or model. . Instead of this pragma you can
also use the equivalent command line option --string_literal_memory.

String literals as use in:

char * s = "string";
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or:

printf("formatter %s\n", "string");

are affected by this pragma/option.

Example:

#pragma string_literal_memory __bank0   /* allocate strings in __bank0 memory */
__bank0 char * txt = "text1";

1.10. Functions

1.10.1. Calling Convention

Parameter passing

A lot of execution time of an application is spent transferring parameters between functions. The fastest
parameter transport is via registers. Therefore, function parameters are first passed via registers. If no
more registers are available for a parameter, the compiler pushes parameters on the stack.

Registers available for parameter passing are given in the following table.

Registers used for parametersArgument size

r1l,0..7 .. r32h,0..71 bit

r1l, r1h .. r32l, r32h8 bit

r1 .. r3216 bit

r2lr1, r3lr2, r4lr3 .. r32lr3124 bit

r2r1 .. r32r3132 bit

r4r3r2r1 ... r32r31r30r2964 bit

The parameters are processed from left to right. The first not used and fitting register is used. Registers
are searched for in the order listed above. When a parameter size does not match one of the sizes listed
in the table, or all registers are used, parameter passing continues on the stack. The stack grows from
lower towards higher addresses. Each parameter on the stack is stored in little endian.

Examples:

void func1( int a, char * b, char c );        /* r1 r2 r3l */
void func2( long long d, char e );            /* r4r3r2r1 r5l */
void func3( double f, long long g, char h );  /* r4r3r2r1 r8r7r6r5 r9l */

Variable argument lists

Functions with a variable argument list must push all parameters after the last fixed parameter on the
stack. The normal parameter passing rules apply for all fixed parameters. When an __bit variable is
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passed in a variable argument list it is promoted to type _Bool. It should therefore be retrieved as an
object of type _Bool in the called function. For example:

#include <stdarg.h>

__bit f( int n, ... )
{
    va_list ap;

    va_start( ap, n );
    return va_arg( ap, _Bool );
}
__bit b;
int main( void )
{
    f( 1, b );
    return 0;
}

Function return values

The C compiler uses registers to store C function return values, depending on the function return types.
The registers a, ba, r1, r2, r3 and r4 are used for return values <= 64 bit.

RegisterReturn value size

a,01 bit

a8 bit

ba16 bit

r2lr124 bit

r2r132 bit

r4r3r2r164 bit

Return values that do not match one of the sizes listed in the table are returned in a buffer, allocated on
the stack. The caller must pass a pointer to the return buffer in the first parameter register (r1). It is the
caller's responsibility to allocate and release the space used for the return buffer. The callee puts the
return value in the allocated buffer.

1.10.2. Register Usage

The C compiler uses the general purpose registers according to the convention given in the following
table.

PurposeClassRegister

Return valuescaller savesa

Return valuescaller savesba

Index registercaller savesc
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PurposeClassRegister

Base pointer for indirect + offset addressing, stack frame pointercallee savesr0

Parameter passing, automatic variables and return valuescaller savesr1

Parameter passing, automatic variables and return valuescaller savesr2

Parameter passing, automatic variables and return valuescaller savesr3

Parameter passing, automatic variables and return valuescaller savesr4

Parameter passing and automatic variablescallee savesr5 .. r32

Automatic variablescallee savesr33 .. r36

Not used by the C compiler-r37 .. r63

The registers are classified: caller saves and callee saves.

These registers are allowed to be changed by a function without saving the contents.
Therefore, the calling function must save these registers when necessary prior to a
function call.

caller saves

These registers must be saved by the called function, i.e. the caller expects them not
to be changed after the function call.

callee saves

1.10.3. Stack Usage

The stack on the LC87 consists of a single system stack.The stack is used for function return addresses,
parameter passing and the allocation of automatic and temporary storage. A frame pointer (r0) is used
to access the data on the stack.The stack grows from lower addresses to higher addresses, and is located
in internal data memory (__data).The data on the stack is aligned at 8 bits, and the stack pointer always
refers to the last occupied slot. A typical stack frame is outlined in the following pictures:
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Stack frame when function does not use variable length arrays (VLAs)

Depending upon the size of the stack frame, the frame pointer equals the stack pointer (sp) or is set to
sp - 63. When the stack frame is small enough to access all data with the negative range of the r0 +
offset addressing mode, the frame pointer will be set to sp. When the stack frame is larger, the frame
pointer will be set to sp - 63, so that the full signed offset range of the r0 + offset addressing mode
can be used.

33

C Language



Stack frame when function uses variable length arrays (VLAs)

Because the size of the VLA area is determined at run-time it is not possible to use the frame pointer to
access the argument passing area. Further more the argument passing area must be on top of the stack
in order to let the callee find its parameters. Therefore, a dynamic argument passing area is used when
VLAs are present. This means the arguments are pushed on the stack using push(w) instructions just
before a function call is made. After the function call the argument passing area is cleaned up. Like in the
situation where there are no VLAs involved, the frame pointer is set to sp, or to sp - 63, depending
upon the frame size.

1.10.4. Inlining Functions: inline

With the C compiler option --optimize=+inline, the C compiler automatically inlines small functions in
order to reduce execution time (smart inlining). The compiler inserts the function body at the place the
function is called. The C compiler decides which functions will be inlined.You can overrule this behavior
with the two keywords inline (ISO-C) and __noinline.

With the inline keyword you force the compiler to inline the specified function, regardless of the
optimization strategy of the compiler itself:
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inline unsigned int abs(int val)
{
    unsigned int abs_val = val;
    if (val < 0) abs_val = -val;
    return abs_val;
}

If a function with the keyword inline is not called at all, the compiler does not generate code for it.

You must define inline functions in the same source module as in which you call the function, because
the compiler only inlines a function in the module that contains the function definition. When you need to
call the inline function from several source modules, you must include the definition of the inline function
in each module (for example using a header file).

With the __noinline keyword, you prevent a function from being inlined:

__noinline unsigned int abs(int val)
{
    unsigned int abs_val = val;
    if (val < 0) abs_val = -val;
    return abs_val;
}

Using pragmas: inline, noinline, smartinline

Instead of the inline qualifier, you can also use #pragma inline and #pragma noinline to inline
a function body:

#pragma inline
unsigned int abs(int val)
{
    unsigned int abs_val = val;
    if (val < 0) abs_val = -val;
    return abs_val;
}
#pragma noinline
void main( void )
{
    int i;
    i = abs(-1);
}

If a function has an inline/__noinline function qualifier, then this qualifier will overrule the current
pragma setting.

With the #pragma noinline / #pragma smartinline you can temporarily disable the default behavior
that the C compiler automatically inlines small functions when you turn on the C compiler option
--optimize=+inline.

With the C compiler options --inline-max-incr and --inline-max-size you have more control over the
automatic function inlining process of the compiler.

35

C Language



1.10.5. Interrupt Functions

The TASKING C compiler supports a number of function qualifiers and keywords to program interrupt
service routines (ISR). An interrupt service routine (or: interrupt function, interrupt handler, exception
handler) is called when an interrupt event (or: service request) occurs.

Defining an interrupt service routine: __interrupt()

With the function type qualifier __interrupt() or __attribute__((interrupt())) you can declare
a function as an interrupt service routine.The function type qualifier __interrupt() takes one interrupt
vector (0..10) as argument.

Interrupt functions cannot return anything and must have a void argument type list. It is also not possible
to call an interrupt function directly from an application.

void __interrupt([vector]) isr( void )
{
...
}

or:

void isr( void ) __attribute__((interrupt([vector])))
{
...
}

The argument vector identifies the entry into the interrupt vector table (0..10). For example,

void __interrupt(2) isr( void )
{
    return;
}

The relationship between a vector number and a vector address is:

vector = (address + 5) / 8

For example, vector address 0x33 (51) is interrupt number 7.

The C compiler will bind the interrupt function to the appropriate vector. For example:

           .global .vector_1
.vector_1  .equ    _isr

The compiler generates code to save and restore the used resources in the interrupt function. An interrupt
function can only be located in ROM bank 0.The __bank0 memory type qualifier is the default for interrupt
functions.
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No vector

When you omit the argument vector, the compiler creates an interrupt function, but does not generate
code to bind the function to a specific interrupt vector. This makes it possible to decide at a later stage
to which vector an interrupt function is assigned.

void isr( void ) __attribute__((interrupt()))
{
...
}

Note that when an interrupt function is not directly assigned to a vector by the compiler, the interrupt
function may be removed from your application because it is not referenced. The interrupt function will
reappear once it is assigned to a vector. Alternatively, you can use the protect attribute:

void isr( void ) __attribute__((interrupt(),protect))
{
...
}

The __isr pointer qualifier

When you need to create a pointer to an interrupt function, it is advised to qualify the pointer with the
__isr pointer qualifier. This prevents that an interrupt function is accidentally called directly from an
application through a function pointer. When you omit the __isr pointer qualifier, the C compiler issues
a warning.You can avoid this warning with an explicit type cast. Examples:

extern void __bank0 isr( void ) __attribute__((interrupt()));
extern void __bank0 f( void );

void __bank0    (*fp_a)( void );
void __bank0    (*fp_b)( void );
void __bank0    (*fp_c)( void );
void __bank0 __isr (*fp_isr_a)( void );
void __bank0 __isr (*fp_isr_b)( void );

int main( void )
{
  fp_a     = f;        /* ok, non-interrupt function, non-interrupt pointer */
  fp_isr_a = isr;      /* ok, interrupt function, interrupt pointer */
  fp_b     = isr;      /* warning, interrupt function, non-interrupt pointer */
  fp_isr_b = f;        /* ok, non-interrupt function, interrupt pointer */
  fp_c     = fp_isr_a; /* warning, interrupt pointer assigned to
                          non-interrupt pointer */
  isr();               /* error, cannot call an interrupt function */
  (*fp_isr_a)();       /* error, cannot call an interrupt function */
  return 0;
}
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1.10.6. Intrinsic Functions

Some specific assembly instructions have no equivalence in C. Intrinsic functions give the possibility to
use these instructions. Intrinsic functions are predefined functions that are recognized by the compiler.
The compiler generates the most efficient assembly code for these functions.

The compiler always inlines the corresponding assembly instructions in the assembly source (rather than
calling it as a function).This avoids parameter passing and register saving instructions which are normally
necessary during function calls.

Intrinsic functions produce very efficient assembly code. Though it is possible to inline assembly code by
hand, intrinsic functions use registers even more efficiently. At the same time your C source remains very
readable.

You can use intrinsic functions in C as if they were ordinary C (library) functions. All intrinsics begin with
a double underscore character (__).

The TASKING LC87 C compiler recognizes the following intrinsic functions:

Intrinsic functions used internally by the C compiler

__alloc

__data void * volatile __alloc( __size_t size );

Allocate memory. Returns a pointer to space of size bytes on the stack of the calling function. Memory
allocated through this function is freed when the calling function returns. This function is used internally
for variable length arrays, it is not to be used by end users.

__dotdotdot__

__data char * __dotdotdot__( void );

Variable argument '...' operator. Used in library function va_start(). Returns the stack offset to the
variable argument list.

__free

void volatile __free( __data void * p );

Deallocate the memory pointed to by p.p must point to memory earlier allocated by a call to __alloc().

User intrinsic functions

__nop

void volatile __nop( void );

Generate a nop instruction.
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__mul16

unsigned long volatile __mul16( unsigned int  x,
                                unsigned char y );

Use the mul16 instruction to perform a 16-bit by 8-bit unsigned multiplication and return the unsigned
long product.

__div16

unsigned int volatile __div16( unsigned int  x,
                               unsigned char y );

Use the div16 instruction to perform a 16-bit by 8-bit unsigned divide and return the unsigned 16-bit
quotient.

__mod16

unsigned char volatile __mod16( unsigned int  x, 
                                unsigned char y );

Use the div16 instruction to perform a 16-bit by 8-bit unsigned divide and return the unsigned 8-bit
remainder.

__mul24

__mul24_t volatile __mul24( unsigned long x,
                            unsigned int  y );

Use the mul16 instruction to perform a 24-bit by 16-bit unsigned multiplication and return the product.
The type of the returned value is __mul24_t. When C compiler option --iso is set to 99 (default), the
__mul24_t type is defined as an unsigned long long.When set to 90, it is defined as an unsigned
long.

__div24

unsigned long volatile __div24( unsigned long x,
                                unsigned int  y );

Use the div24 instruction to perform a 24-bit by 16-bit unsigned divide and return the unsigned 32-bit
quotient.

__mod24

unsigned int volatile __mod24( unsigned long x,
                               unsigned int  y );

Use the div24 instruction to perform a 24-bit by 16-bit unsigned divide and return the unsigned 16-bit
remainder.
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__rol

unsigned char volatile __rol( unsigned char operand,
                              unsigned char count );

Use the rol instruction to rotate operand left count times.

__ror

unsigned char volatile __ror( unsigned char operand,
                              unsigned char count );

Use the ror instruction to rotate operand right count times.

__getbit

__bit __getbit( operand, bitoffset );

Return the bit at bitoffset of the bit-addressable operand for usage in bit expressions. Bit operations
are allowed on __bdata, __mdata and SFR objects, or on a local variable when it is allocated in a
register. This intrinsic is implemented as a built-in macro that performs AND, OR and SHIFT operations
on the arguments.The compiler optimizes the operations to the appropriate instructions.This also means
that you can use any integral type as an argument.

__putbit

void __putbit( __bit value, operand, bitoffset );

Assign value to the bit at bitoffset of the bit-addressable operand. Bit operations are allowed on
__bdata, __mdata and SFR objects, or on a local variable when it is allocated in a register.This intrinsic
is implemented as a built-in macro that performs AND, OR and SHIFT operations on the arguments. The
compiler optimizes the operations to the appropriate instructions. This also means that you can use any
integral type as an argument.

__testclear

__bit __testclear( __bit semaphore );

Read and clear semaphore using the bpc instruction. Returns 0 if semaphore was not cleared by the
bpc instruction, 1 otherwise. This intrinsic is implemented as a built-in macro.

1.11. Section Naming

By default the compiler generates section names that start with a dot ('.') and the section type, extended
with the module name and the name of the symbol that is allocated in the section. Each component is
separated by a dot ('.'):

  .type.module-name.symbol-name

See Section 1.3.1, Memory Type Qualifiers for the relation between qualifiers and section names.

40

TASKING VX-toolset for LC87 User Guide



You can rename sections with a pragma or with a command line option. The syntax is the same:

--rename-sections=[type=][format_string][,[type=][format_string]]...

#pragma section [type=][format_string][,[type=][format_string]]...

With the type argument you select which sections are renamed. When the type of a section matches, the
section name will get the specified format string as suffix.

You can specify the following section types:

Section typesMemory space

ztext0, ztext1, text0, text1, text, zrodata0, zrodata1,
rodata0, rodata1, rodata

Program memory space

bdata, bbss, sdata, sbss, mdata, mbss, data, bss, bitdata,
bitbss, mbitdata, mbitbss

Internal data memory space

xdata, xbss, xrodata, hxdata, hxbss, hxrodataExternal data memory space

allOther

When you omit the type or use type "all", all sections will be renamed.

With the format_string you specify the string that extends the ELF section name. The format string can
contain characters and may contain the following format specifiers:

Expands to the section attributes, separated by underscores. The cluster attribute,
used when debug information is enabled, is not included.

{attrib}

Expands to the basename of the module name.{module}

Expands to the object name, name of variable or function.{name}

In format specifier expansions (for example, a module name with an extra dot), dots ('.') are replaced by
dollars ('$').

When you omit the format string, a section will have a name that consist of a dot ('.') and the section type
only.

Note that #pragma section text=code,,data=special will give all sections a name consisting
of just the section type, except for data sections, which will be named ".data.special". The reason
for this is that the double comma is interpreted as: --rename-sections or #pragma section, without
arguments:

#pragma section text=code,,data=special

is the same as:

#pragma section text=code
#pragma section
#pragma section data=special
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With #pragma endsection the naming convention of the previous level is restored, while with #pragma
section default the default section naming convention is restored. Nesting of pragma
section/endsection pairs will save the status of the previous level.

Example

The following example (file test.c) sets a default naming scheme for all sections, and then specializes
the names for some section types.

#pragma section all=other.{name},bss=region1.{name}
#pragma section text=task1.{name}

__data int var1;       /* .bss.region1.var1 */

#pragma noclear        /* set "noclear" attribute on 
                          sections of uninitialized variables */
#pragma section bss={attrib}
                       /* assign format to .bss sections */

__data int var2;       /* .bss.noclear   */

void f1( void )        /* .text.task1.f1 */
{
    return;
}

void f2( void )        /* .text.task1.f2 */
{
    return;
}

#pragma endsection     /* pop last #pragma section from stack */

__data int var3;       /* .bss.region1.var3 */
__rom const int c = 3; /* .rodata.other.c   */
__sdata int s1 = 5;    /* .sdata.other.s1   */

This example generates the following code:

        .section .text.task1.f1
        .global  _f1
; Function _f1
        .align   1
_f1:    .type    func
        ret
        ; End of function
        .size    _f1,$-_f1
        .endsec

        .section .text.task1.f2
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        .global  _f2
; Function _f2
        .align   1
_f2:    .type    func
        ret
        ; End of function
        .size    _f2,$-_f2
        .endsec

        .section .bss.region1.var1
        .global  _var1
        .align   1
        .size    _var1, 2
_var1:  .type    object
        .ds      2
        .endsec

        .section .bss.noclear, noclear
        .global  _var2
        .align   1
        .size    _var2, 2
_var2:  .type    object
        .ds      2
        .endsec

        .section .bss.region1.var3, noclear
        .global  _var3
        .align   1
        .size    _var3, 2
_var3:  .type    object
        .ds      2
        .endsec

        .section .rodata.other.c
        .global  _c
        .align   1
        .size    _c, 2
_c:     .type    object
        .dw      3
        .endsec

        .section .sdata.other.s1
        .global  _s1
        .align   1
        .size    _s1, 2
_s1:    .type    object
        .dw      5
        .endsec
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Chapter 2. Assembly Language
This chapter describes the most important aspects of the TASKING assembly language for LC87 and
contains a detailed description of all built-in assembly functions and assembler directives. For a complete
overview of the architecture you are using and a description of the assembly instruction set, refer to the
target's core reference manual (for example the LC87 Series User's Manual.

2.1. Assembly Syntax

An assembly program consists of statements. A statement may optionally be followed by a comment.
Any source statement can be extended to more lines by including the line continuation character (\) as
the last character on the line. The length of a source statement (first line and continuation lines) is only
limited by the amount of available memory.

Mnemonics, directives and other keywords are case insensitive. Labels, symbols, directive arguments,
and literal strings are case sensitive.

The syntax of an assembly statement is:

[label[:]] [instruction | directive | macro_call] [;comment]

A label is a special symbol which is assigned the value and type of the current
program location counter. A label can consist of letters, digits, dots (.) and
underscore characters (_). The first character cannot be a digit. The label can
also be a number. A label which is prefixed by whitespace (spaces or tabs) has
to be followed by a colon (:).The size of an identifier is only limited by the amount
of available memory.

number is a number ranging from 1 to 255.This type of label is called a numeric
label or local label. To refer to a numeric label, you must put an n (next) or p
(previous) immediately after the label. This is required because the same label
number may be used repeatedly.

Examples:

   LAB1:    ; This label is followed by a colon and
            ; can be prefixed by whitespace
LAB1        ; This label has to start at the beginning
            ; of a line
1: jmp 1p   ; This is an endless loop
            ; using numeric labels

label
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An instruction consists of a mnemonic and zero, one or more operands. It must
not start in the first column.

Operands are described in Section 2.3, Operands of an Assembly Instruction.
The instructions are described in Chapter 5 Instructions of the LC87 Series
User's Manual .

The instruction can also be a so-called 'generic instruction'. Generic instructions
are pseudo instructions (no instructions from the instruction set). Depending on
the situation in which a generic instruction is used, the assembler replaces the
generic instruction with appropriate real assembly instruction(s). For a complete
list, see Section 2.12, Generic Instructions.

instruction

With directives you can control the assembler from within the assembly source.
Except for preprocessing directives, these must not start in the first column.
Directives are described in Section 2.10, Assembler Directives.

directive

A call to a previously defined macro. It must not start in the first column. See
Section 2.11, Macro Operations.

macro_call

Comment, preceded by a ; (semicolon).comment

You can use empty lines or lines with only comments.

2.2. Assembler Significant Characters

You can use all ASCII characters in the assembly source both in strings and in comments. Also the
extended characters from the ISO 8859-1 (Latin-1) set are allowed.

Some characters have a special meaning to the assembler. Special characters associated with expression
evaluation are described in Section 2.6.3, Expression Operators. Other special assembler characters
are:

DescriptionCharacter

Start of a comment;

Line continuation character or macro operator: argument concatenation\

Macro operator: return decimal value of a symbol?

Macro operator: return hex value of a symbol%

Macro operator: override local label^

Macro string delimiter or quoted string .DEFINE expansion character”

String constants delimiter'

Start of a built-in assembly function@

Location counter substitution$

Immediate addressing#

String concatenation operator++

Indirect addressing mode[ ]
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2.3. Operands of an Assembly Instruction

In an instruction, the mnemonic is followed by zero, one or more operands. An operand has one of the
following types:

DescriptionOperand

A symbolic name as described in Section 2.4, Symbol Names. Symbols can also occur
in expressions.

symbol

Any valid register as listed in Section 2.5, Registers.register

Any valid expression as described in Section 2.6, Assembly Expressions.expression

A combination of expression, register and symbol.address

2.4. Symbol Names

User-defined symbols

A user-defined symbol can consist of letters, digits, dots (.) and underscore characters (_). The first
character cannot be a digit. The size of an identifier is only limited by the amount of available memory.
The case of these characters is significant.You can define a symbol by means of a label declaration or
an equate or set directive.

Predefined preprocessor symbols

These symbols start and end with two underscore characters, __symbol__, and you can use them in your
assembly source to create conditional assembly. See Section 2.4.1, Predefined Preprocessor Symbols.

Labels

Symbols used for memory locations are referred to as labels. It is allowed to use reserved symbols as
labels as long as the label is followed by a colon or starts at the first column.

Reserved symbols

Symbol names and other identifiers beginning with a dot (.) are reserved for the system (for example for
directives or section names). Instructions and registers are also reserved. The case of these built-in
symbols is insignificant.

Examples

Valid symbol names:

loop_1
ENTRY
a_B_c
_aBC
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Invalid symbol names:

1_loop     ; starts with a number
.DEFINE    ; reserved directive name

2.4.1. Predefined Preprocessor Symbols

The TASKING assembler knows the predefined symbols as defined in the table below. The symbols are
useful to create conditional assembly.

DescriptionSymbol

Expands to 1 for the LC87 toolset, otherwise unrecognized as macro.__AS87__

Identifies the build number of the assembler, composed of decimal digits for
the build number, three digits for the major branch number and three digits
for the minor branch number. For example, if you use build 1.22.1 of the
assembler, __BUILD__ expands to 1022001. If there is no branch number,
the branch digits expand to zero. For example, build 127 results in
127000000.

__BUILD__

Expands to the revision number of the assembler. Digits are represented
as they are; characters (for prototypes, alphas, betas) are represented by
-1. Examples: v1.0r1 -> 1, v1.0rb -> -1

__REVISION__

Identifies the assembler as a TASKING assembler. Expands to 1 if a
TASKING assembler is used.

__TASKING__

Identifies the version number of the assembler. For example, if you use
version 2.1r1 of the assembler, __VERSION__ expands to 2001 (dot and
revision number are omitted, minor version number in 3 digits).

__VERSION__

Example

.if @defined('__AS87__')
  ; this part is only for the as87 assembler
...
.endif

2.5. Registers

The following register names, either uppercase or lowercase, should not be used for user-defined symbol
names in an assembly language source file:

A, ACC, B, BA, C, PSW, PCON, IE, IP, SP, SPL, SPH, SBUF
OV, CY, AC
R0  .. R63   (general purpose registers)
R0L .. R63L  (byte registers)
R0H .. R63H  (byte registers)
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2.6. Assembly Expressions

An expression is a combination of symbols, constants, operators, and parentheses which represent a
value that is used as an operand of an assembler instruction (or directive).

Expressions can contain user-defined labels (and their associated integer or floating-point values), and
any combination of integers, floating-point numbers, or ASCII literal strings.

Expressions follow the conventional rules of algebra and boolean arithmetic.

Expressions that can be evaluated at assembly time are called absolute expressions. Expressions where
the result is unknown until all sections have been combined and located, are called relocatable or relative
expressions.

When any operand of an expression is relocatable, the entire expression is relocatable. Relocatable
expressions are emitted in the object file and evaluated by the linker. Relocatable expressions can only
contain integral functions; floating-point functions and numbers are not supported by the ELF/DWARF
object format.

The assembler evaluates expressions with 64-bit precision in two's complement.

The syntax of an expression can be any of the following:

• numeric constant

• string

• symbol

• expression binary_operator expression

• unary_operator expression

• (expression)

• function call

All types of expressions are explained in separate sections.

2.6.1. Numeric Constants

Numeric constants can be used in expressions. If there is no prefix, by default the assembler assumes
the number is a decimal number. Prefixes can be used in either lowercase or uppercase.

ExampleDescriptionBase

0B1101
11001010b

A 0b prefix followed by binary digits (0,1). Or use a b suffix.Binary

0x12FF
0x45
0fa10h

A 0x prefix followed by hexadecimal digits (0-9, A-F, a-f). Or use
a h suffix.

Hexadecimal

49

Assembly Language



ExampleDescriptionBase

12
1245

Decimal digits (0-9).Decimal integer

6E10
.6
3.14
2.7e10

Decimal digits (0-9), includes a decimal point, or an 'E' or 'e'
followed by the exponent.

Decimal
floating-point

2.6.2. Strings

ASCII characters, enclosed in single (') or double (”) quotes constitute an ASCII string. Strings between
double quotes allow symbol substitution by a .DEFINE directive, whereas strings between single quotes
are always literal strings. Both types of strings can contain escape characters.

Strings constants in expressions are evaluated to a number (each character is replaced by its ASCII
value). Strings in expressions can have a size of up to 8 characters or less depending on the operand of
an instruction or directive; any subsequent characters in the string are ignored. In this case the assembler
issues a warning. An exception to this rule is when a string is used in a .DB assembler directive; in that
case all characters result in a constant value of the specified size. Null strings have a value of 0.

Examples

'ABCD'              ; (0x41424344)
'''79'              ; to enclose a quote double it
"A\"BC"             ; or to enclose a quote escape it
'AB'+1              ; (0x4143) string used in expression
''                  ; null string
.DW 'abcdef'        ; (0x64636261) 'ef' are ignored
                    ; warning: string value truncated
'ab'++'cd'          ; you can concatenate 
                    ; two strings with the '++' operator.
                    ; This results in 'abcd'

2.6.3. Expression Operators

The next table shows the assembler operators.They are ordered according to their precedence. Operators
of the same precedence are evaluated left to right. Parenthetical expressions have the highest priority
(innermost first).

Valid operands include numeric constants, literal ASCII strings and symbols.

Most assembler operators can be used with both integer and floating-point values. If one operand has
an integer value and the other operand has a floating-point value, the integer is converted to a floating-point
value before the operator is applied. The result is a floating-point value.
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DescriptionNameOperatorType

Expressions enclosed by parenthesis are evaluated
first.

parenthesis( )

Returns the value of its operand.plus+Unary

Returns the negative of its operand.minus-

Integer only. Returns the one’s complement of its
operand. It cannot be used with a floating-point
operand.

one's complement~

Returns 1 if the operands' value is 0; otherwise 0.
For example, if buf is 0 then !buf is 1. If buf has
a value of 1000 then !buf is 0.

logical negate!

Yields the product of its operands.multiplication*Arithmetic

Yields the quotient of the division of the first operand
by the second. For integer operands, the divide
operation produces a truncated integer result.

division/

Integer only.This operator yields the remainder from
the division of the first operand by the second.

modulo%

Yields the sum of its operands.addition+

Yields the difference of its operands.subtraction-

Integer only. Causes the left operand to be shifted
to the left (and zero-filled) by the number of bits
specified by the right operand.

shift left<<Shift

Integer only. Causes the left operand to be shifted
to the right by the number of bits specified by the
right operand. The sign bit will be extended.

shift right>>

Returns an integer 1 if the indicated condition is
TRUE or an integer 0 if the indicated condition is
FALSE.

For example, if D has a value of 3 and E has a value
of 5, then the result of the expression D<E is 1, and
the result of the expression D>E is 0.

Use tests for equality involving floating-point values
with caution, since rounding errors could cause
unexpected results.

less than<Relational

less than or equal<=

greater than>

greater than or equal>=

equal==

not equal!=

Integer only.Yields the bitwise AND function of its
operand.

AND&Bitwise

Integer only.Yields the bitwise OR function of its
operand.

OR|

Integer only.Yields the bitwise exclusive OR function
of its operands.

exclusive OR^

51

Assembly Language



DescriptionNameOperatorType

Returns an integer 1 if both operands are non-zero;
otherwise, it returns an integer 0.

logical AND&&Logical

Returns an integer 1 if either of the operands is
non-zero; otherwise, it returns an integer 1

logical OR||

The relational operators and logical operators are intended primarily for use with the conditional assembly
.if directive, but can be used in any expression.

2.6.4. Symbol Types

The type of a symbol is determined by the section in which it is defined. The following symbol types are
available: text, rodata, data, mdata, sdata, bdata, bitdata, mbitdata and xdata. The following table shows
the relation between the section name and the resulting symbol type (see also the .SECTION directive).

Section where symbol is definedSymbol type

.text, .text0, .text1, .ztext0, .ztext1text

.rodata, .rodata0, .rodata1, .zrodata0, .zrodata1rodata

.data, .bssdata

.mdata, .mbssmdata

.sdata, .sbsssdata

.bdata, .bbssbdata

.bitdata, .bitbssbitdata

.mbitdata, .mbitbssmbitdata

.hxdata, .hxbss, .xdata, .xbss, .hxrodata, .xrodataxdata

It is also possible to explicitly define the symbol’s type with the .EXTERN directive.

Labels not on the same line as the directive still are assigned the type for that directive if they immediately
precede the directive:

  .section .bdata
mylabel:  ; this label gets the bdata type
 .dw 1

When you make a symbol global with the .GLOBAL directive, the symbol’s type will be stored in the object
file.The .EXTERN directive used for importing the symbol in another module must specify the same type.

Type Checking

When you use a symbol as an operand for an instruction, the assembler will check if the type of this
symbol is valid for the used instruction. If it is not valid, the assembler will issue an error. For generic
instructions the assembler uses the symbol type to select the smallest instruction.

The following symbol types are allowed when the symbol is used as an instruction operand.
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Allowed symbol typeOperand type

textJMP/CALL/BR/RCALL target label

textBranch near PC-relative target label

bdata, sdataDirect short range byte address

bdata, sdata, mdata, dataDirect long range byte address

bdataDirect short range byte address and a bit offset

bdata, sdata, mdataDirect medium range byte address and a bit offset

bitdataDirect short range bit address

bitdata, mbitdataDirect medium range bit address

SFR addresses can be entered symbolically by using the SFR name. Type checking is not needed in
that case because the SFR names are only accepted with the appropriate instructions.

2.7. Working with Sections

Sections are absolute or relocatable blocks of contiguous memory that can contain code or data. Some
sections contain code or data that your program declared and uses directly, while other sections are
created by the compiler or linker and contain debug information or code or data to initialize your application.
These sections can be named in such a way that different modules can implement different parts of these
sections. These sections are located in memory by the linker (using the linker script language, LSL) so
that concerns about memory placement are postponed until after the assembly process.

All instructions and directives which generate data or code must be within an active section.The assembler
emits a warning if code or data starts without a section definition. The compiler automatically generates
sections. If you program in assembly you have to define sections yourself.

For more information about locating sections see Section 5.8.8, The Section Layout Definition: Locating
Sections.

Section definition

Sections are defined with the .SECTION/.ENDSEC directive and have a name.The names have a special
meaning to the locating process and have to start with a predefined name, optionally extended by a dot
'.' and a user defined name. Optionally, you can specify the at() attribute to locate a section at a specific
address.

  .SECTION  name[,at(address)]
   ; instructions etc.
  .ENDSEC

See the description of the .SECTION directive for more information.

Examples

  .SECTION .data               ; Declare a .data section
   ; ...

53

Assembly Language



  .ENDSEC

  .SECTION .data.abs, at(0x0)  ; Declare a .data.abs section at 
                               ; an absolute address
   ; ...
  .ENDSEC

2.8. Defining Interrupts in Assembly

The TASKING C compiler supports a number of function qualifiers and keywords to program interrupt
service routines (ISR).This is explained in Section 1.10.5, Interrupt Functions. The C compiler generates
the correct assembly code. If you want to write your own interrupt function in assembly, you need to define
a global symbol that corresponds to a vector entry in the vector table. The linker locates the code in the
vector table based on the symbol. Two vector tables are defined in the linker script file
lc87.lsl:vector_reset and vector_table.

DescriptionGlobal symbol

Reset vector.reset_0

First entry in vector_table.vector_0

Second entry in vector_table.vector_1

Third entry in vector_table.vector_2

Fourth entry in vector_table.vector_3

Fifth entry in vector_table.vector_4

Sixth entry in vector_table.vector_5

Seventh entry in vector_table.vector_6

Eighth entry in vector_table.vector_7

Ninth entry in vector_table.vector_8

Tenth entry in vector_table.vector_9

If you do not define a global symbol, the linker generates default code. For the reset vector the default
code is "jmp __START", so there is no need to put that in your assembly code. For the interrupt vector
slots the default is a loop (a jump to itself).

Sections must be named ".text0" or must be prefixed with ".text0." followed by a user defined suffix.

For example, if you want to overrule the reset vector with a jump to your own start label (for example
__MY_START), you can use the following code:

        .extern  __MY_START
        .section .text0.my_reset
        .global  .reset_0
.reset_0:
        jmp __MY_START
        .endsec
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Other examples:

        .section .text0.my_isr0
        .global .vector_0
.vector_0:
        reti
        .endsec

        .section .text0.my_isr1
        .global .vector_1
.vector_1:
        nop
        nop
        nop
        nop
        nop
        nop
        nop
        nop
        nop
        nop
        reti
        .endsec

In this example the first interrupt routine fits in the first vector slot (1 byte) and the second interrupt routine
does not fit into the second vector slot (11 bytes). The linker takes care of this automatically. The linker
inlines the small routine in the vector while for the larger routine the linker generates a jmp in the vector.

2.9. Built-in Assembly Functions

The TASKING assembler has several built-in functions to support data conversion, string comparison,
and math computations.You can use functions as terms in any expression.

Syntax of an assembly function

@function_name([argument[,argument]...])

Functions start with the '@' character and have zero or more arguments, and are always followed by
opening and closing parentheses. White space (a blank or tab) is not allowed between the function name
and the opening parenthesis and between the (comma-separated) arguments.

The names of assembly functions are case insensitive.

Overview of assembly functions

DescriptionFunction

Test whether macro argument is present@ARG('symbol' | expr)

Bank number of the expression@BANK(expr)
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DescriptionFunction

Bank page of the expression@BPAG(expr)

Return number of macro arguments@CNT()

Test whether symbol exists@DEFINED('symbol' | symbol)

Most significant byte of the least significant word of the
expression

@HI(expr)

Least significant byte of the least significant word of the
expression

@LO(expr)

Least significant byte of the expression@LSB(expr)

Least significant word of the expression@LSW(expr)

Most significant byte of the expression@MSB(expr)

Most significant word of the expression@MSW(expr)

Negate expression and return the least significant number of
bits

@NEG(expr,bits)

Page number of the expression@PAGE(expr)

Page offset of the expression@POFF(expr)

Concatenate str1 and str2@STRCAT(str1,str2)

Compare str1 with str2@STRCMP(str1,str2)

Return length of string@STRLEN(string)

Return position of str2 in str1@STRPOS(str1,str2[,start])

Detailed Description of Built-in Assembly Functions

@ARG('symbol' | expression)

Returns integer 1 if the macro argument represented by symbol or expression is present, 0 otherwise.

You can specify the argument with a symbol name (the name of a macro argument enclosed in single
quotes) or with expression (the ordinal number of the argument in the macro formal argument list). If you
use this function when macro expansion is not active, the assembler issues a warning.

Example:

  .IF @ARG('TWIDDLE') ;is argument twiddle present?
  .IF @ARG(1)             ;is first argument present?

@BANK(expression)

Returns the bank number (bit 17), 0 or 1, of the result of the expression. The result of the expression is
calculated as an 18-bit program memory address.@BANK(expression) is equivalent to ((expression
>> 17) & 0x1).

Example:
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  .DB  @BANK(0x0abcd)     ; stores 0
  .DB  @BANK(0x1abcd)     ; stores 0
  .DB  @BANK(0x2abcd)     ; stores 1
  .DB  @BANK(0x3abcd)     ; stores 1

@BPAG(expression)

Returns the bank page (bit 16), 0 or 1, of the result of the expression. The result of the expression is
calculated as a 17-bit banked program memory address. @BPAG(expression) is equivalent to
((expression >> 16) & 0x1).

Example:

  .DB  @BPAG(0x0abcd)     ; stores 0 (page 0 of bank 0)
  .DB  @BPAG(0x1abcd)     ; stores 1 (page 1 of bank 0)
  .DB  @BPAG(0x2abcd)     ; stores 0 (page 0 of bank 1)
  .DB  @BPAG(0x3abcd)     ; stores 1 (page 1 of bank 1)

@CNT()

Returns the number of macro arguments of the current macro expansion as an integer. If you use this
function when macro expansion is not active, the assembler issues a warning.

Example:

  ARGCOUNT .SET @CNT()    ; reserve argument count

@DEFINED('symbol' | symbol)

Returns 1 if symbol has been defined, 0 otherwise. If symbol is quoted, it is looked up as a .DEFINE
symbol; if it is not quoted, it is looked up as an ordinary symbol, macro or label.

Example:

  .IF @DEFINED('ANGLE')   ;is symbol ANGLE defined?
  .IF @DEFINED(ANGLE)     ;does label ANGLE exist?

@HI(expression)

Returns the most significant byte of the least significant word of the result of the expression.
@HI(expression) is equivalent to ((expression >> 8) & 0xff).

Example:

  .DB  @HI(0x21)          ; stores 0x00
  .DB  @HI(0x4321)        ; stores 0x43
  .DB  @HI(0x654321)      ; stores 0x43
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@LO(expression)

Returns the least significant byte of the least significant word of the result of the expression.
@LO(expression) is equivalent to ((expression) & 0xff).

Example:

  .DB  @LO(0x21)          ; stores 0x21
  .DB  @LO(0x4321)        ; stores 0x21
  .DB  @LO(0x654321)      ; stores 0x21

@LSB(expression)

Returns the least significant byte of the result of the expression.

Example:

  .DB  @LSB(0x4321)       ; stores 0x21
  .DB  @MSB(0x4321)       ; stores 0x43

@LSW(expression)

Returns the least significant word (bits 0..31) of the result of the expression.

Example:

  .DW  @LSW(0x654321)     ; stores 0x4321
  .DW  @MSW(0x654321)     ; stores 0x0065

@MSB(expression)

Returns the most significant byte of the result of the expression.

@MSW(expression)

Returns the most significant word of the result of the expression.

@NEG(expression,size)

Negates the expression and returns the least significant bits. The number of bits returned is specified by
size and must be equal to 8, 16 or 24. @NEG(expression,size) is equivalent to ((-expression)
& ((1 << size) -1)).

Example:

  .DB  @NEG(0xf1,8)       ; stores 0x0f
  .DW  @NEG(0xf1,16)      ; stores 0xff0f
  .DW  @NEG(0x654321,16)  ; stores 0xbcdf
  .DW  @NEG(0x874321,16)  ; stores 0xbcdf
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@PAGE(expression)

Returns the least significant byte of the most significant word of the result of the expression.This is usually
the 64kB memory page number of a 24-bit address, but the function can also be applied to 18-bit program
memory addresses. @PAGE(expression) is equivalent to ((expression >> 16) & 0xff).

Example:

  .DB  @PAGE(0x21)        ; stores 0x00
  .DB  @PAGE(0x4321)      ; stores 0x00
  .DB  @PAGE(0x654321)    ; stores 0x65

@POFF(expression)

Returns the least significant word of the result of the expression. This is usually the offset of a 24-bit
address in a 64kB memory page, but the function can also be applied to 18-bit program memory addresses.
@POFF(expression) is equivalent to ((expression) & 0xffff).

Example:

  .DW  @POFF(0x21)        ; stores 0x0021
  .DW  @POFF(0x4321)      ; stores 0x4321
  .DW  @POFF(0x654321)    ; stores 0x4321

@STRCAT(string1,string2)

Concatenates string1 and string2 and returns them as a single string.You must enclose string1 and
string2 either with single quotes or with double quotes.

Example:

  .DEFINE ID "@STRCAT('TAS','KING')"  ; ID = 'TASKING'

@STRCMP(string1,string2)

Compares string1 with string2 by comparing the characters in the string.The function returns the difference
between the characters at the first position where they disagree, or zero when the strings are equal:

<0 if string1 < string2

0 if string1 == string2

>0 if string1 > string2

Example:

  .IF (@STRCMP(STR,'MAIN'))==0  ; does STR equal 'MAIN'?

@STRLEN(string)

Returns the length of string as an integer.
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Example:

  SLEN .SET @STRLEN('string')    ; SLEN = 6

@STRPOS(string1,string2[,start])

Returns the position of string2 in string1 as an integer. If string2 does not occur in string1, the last string
position + 1 is returned.

With start you can specify the starting position of the search. If you do not specify start, the search is
started from the beginning of string1.

Example:

  ID .set @STRPOS('TASKING','ASK')  ; ID = 1
  ID .set @STRPOS('TASKING','BUG')  ; ID = 7

2.10. Assembler Directives

An assembler directive is simply a message to the assembler. Assembler directives are not translated
into machine instructions. There are three main groups of assembler directives.

• Assembler directives that tell the assembler how to go about translating instructions into machine code.
This is the most typical form of assembly directives. Typically they tell the assembler where to put a
program in memory, what space to allocate for variables, and allow you to initialize memory with data.
When the assembly source is assembled, a location counter in the assembler keeps track of where
the code and data is to go in memory.

The following directives fall under this group:

• Assembly control directives

• Symbol definition and section directives

• Data definition / Storage allocation directives

• High Level Language (HLL) directives

• Directives that are interpreted by the macro preprocessor.These directives tell the macro preprocessor
how to manipulate your assembly code before it is actually being assembled.You can use these
directives to write macros and to write conditional source code. Parts of the code that do not match the
condition, will not be assembled at all. Unlike other directives, preprocessor directives can start in the
first column.

• Some directives act as assembler options and most of them indeed do have an equivalent assembler
(command line) option.The advantage of using a directive is that with such a directive you can overrule
the assembler option for a particular part of the code. Directives of this kind are called controls. A typical
example is to tell the assembler with an option to generate a list file while with the directives .NOLIST
and .LIST you overrule this option for a part of the code that you do not want to appear in the list file.
Directives of this kind sometimes are called controls.
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Each assembler directive has its own syntax. Some assembler directives can be preceded with a label.
If you do not precede an assembler directive with a label, you must use white space instead (spaces or
tabs).You can use assembler directives in the assembly code as pseudo instructions. The assembler
recognizes both uppercase and lowercase for directives.
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2.10.1. Overview of Assembler Directives

The following tables provide an overview of all assembler directives. For a detailed description of these
directives, refer to Section 2.10.2, Detailed Description of Assembler Directives.

Overview of assembly control directives

DescriptionDirective

Indicates the end of an assembly module.END

Include file.INCLUDE

Programmer generated message.MESSAGE

Overview of symbol definition and section directives

DescriptionDirective

Create an alias for a symbol.ALIAS

Set permanent value to a symbol.EQU

Import global section symbol.EXTERN

Declare global section symbol.GLOBAL

Resume a previously defined section.RESUME

Start a new section.SECTION, .ENDSEC

Set temporary value to a symbol.SET

Set size of symbol in the ELF symbol table.SIZE

Specify name of original C source file.SOURCE

Set symbol type in the ELF symbol table.TYPE

Mark a symbol as 'weak'.WEAK

Overview of data definition / storage allocation directives

DescriptionDirective

Align location counter.ALIGN

Define block storage (initialized).BS, .BSB, .BSW, .BSL

Define bit.DBIT

Define byte.DB

Define word (16 bits).DW

Define long word (32 bits).DL

Define storage.DS, .DSBIT, .DSB, .DSW,
.DSL
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Overview of macro preprocessor directives

DescriptionDirective

Define substitution string.DEFINE

Break out of current macro expansion.BREAK

Repeat sequence of source lines.REPEAT, .ENDREP

Repeat sequence of source lines n times.FOR, .ENDFOR

Conditional assembly directive.IF, .ELIF, .ELSE

End of conditional assembly directive.ENDIF

Define macro.MACRO, .ENDM

Undefine .DEFINE symbol or macro.UNDEF

Overview of listing control directives

DescriptionDirective

Print / do not print source lines to list file.LIST, .NOLIST

Set top of page/size of page.PAGE

Set program title in header of assembly list file.TITLE

Overview of HLL directives

DescriptionDirective

Pass call tree information and/or stack usage information.CALLS

Pass MISRA-C information.MISRAC

2.10.2. Detailed Description of Assembler Directives
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.ALIAS

Syntax

alias-name .ALIAS symbol-name

Description

With the .ALIAS directive you can create an alias of a symbol. The C compiler generates this directive
when you use the #pragma alias.

Example

_exit .ALIAS __Exit
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.ALIGN

Syntax

.ALIGN expression

Description

With the .ALIGN directive you instruct the assembler to align the location counter. By default the assembler
aligns on one byte.

When the assembler encounters the .ALIGN directive, it advances the location counter to an address
that is aligned as specified by expression and places the next instruction or directive on that address.
The alignment is in minimal addressable units (MAUs).The assembler fills the ‘gap’ with NOP instructions
for code sections or with zeros for data sections. If the location counter is already aligned on the specified
alignment, it remains unchanged. The location of absolute sections will not be changed.

The expression must be a power of two: 1, 2, 4, 8, 16, ... If you specify another value, the assembler
changes the alignment to the next higher power of two and issues a warning.

The assembler aligns sections automatically to the largest alignment value occurring in that section.

A label is not allowed before this directive.

Example

  .SECTION  .text
  .ALIGN 2     ; the assembler aligns

instruction  ; this instruction at 2 MAUs and
               ; fills the 'gap' with NOP instructions.
  .ENDSEC

  .SECTION  .text
  .ALIGN 3     ; WRONG: not a power of two, the

instruction  ; assembler aligns this instruction at
               ; 4 MAUs and issues a warning.
  .ENDSEC
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.BREAK

Syntax

.BREAK

Description

The .BREAK directive causes immediate termination of a macro expansion, a .FOR loop expansion or a
.REPEAT loop expansion. In case of nested loops or macros, the .BREAK directive returns to the previous
level of expansion.

The .BREAK directive is, for example, useful in combination with the .IF directive to terminate expansion
when error conditions are detected.

The assembler does not allow a label with this directive.

Example

.FOR MYVAR IN 10 TO 20
  ...   ;
  ...   ; assembly source lines
  ...   ;
  .IF MYVAR > 15
    .BREAK
  .ENDIF
.ENDFOR
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.BS, .BSB, .BSW, .BSL

Syntax

[label] .BS count[,value]
[label] .BSB count[,value]]
[label] .BSW count[,value]
[label] .BSL count[,value]

Description

With the .BS directive the assembler reserves a block of memory. The reserved block of memory is
initialized to the value of value, or zero if omitted.

With count you specify the number of minimum addressable units (MAUs) you want to reserve, and how
much the location counter will advance. The expression must be an integer greater than zero and cannot
contain any forward references to address labels (labels that have not yet been defined).

With value you can specify a value to initialize the block with. Only the least significant MAU of value is
used. If you omit value, the default is zero.

If you specify the optional label, it gets the value of the location counter at the start of the directive
processing.

You cannot initialize of a block of memory in sections with prefix .bss. In those sections, the
assembler issues a warning and only reserves space, just as with .DS.

The .BSB, .BSW and .BSL directives are variants of the .BS directive. The difference is the number of
bits that are reserved for the count argument:

Reserved bitsDirective

8.BSB

16.BSW

32.BSL

Example

The .BSB directive is for example useful to define and initialize an array that is only partially filled:

    .section .data
    .DB 84,101,115,116  ; initialize 4 bytes
    .BSB 96,0xFF        ; reserve another 96 bytes, initialized with 0xFF
    .endsec

Related Information

.DB (Define Memory)

.DS (Define Storage)
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.CALLS

Syntax

.CALLS ’caller’,’callee’

or

.CALLS ’caller’,’’,stack_usage[,...]

Description

The first syntax creates a call graph reference between caller and callee.The linker needs this information
to build a call graph. caller and callee are names of functions.

The second syntax specifies stack information. When callee is an empty name, this means we define the
stack usage of the function itself. The value specified is the stack usage in bytes at the time of the call
including the return address. A function can use multiple stacks.

This information is used by the linker to compute the used stack within the application. The information
is found in the generated linker map file within the Memory Usage.

This directive is generated by the C compiler. Use the .CALLS directive in hand-coded assembly when
the assembly code calls a C function. If you manually add .CALLS directives, make sure they connect
to the compiler generated .CALLS directives: the name of the caller must also be named as a callee in
another directive.

A label is not allowed before this directive.

Example

  .CALLS '_main','_nfunc'

Indicates that the function main calls the function nfunc.

  .CALLS '_main','',8

The function main uses 8 bytes on the stack.
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.DBIT, .DB, .DW, .DL

Syntax

[label] .DBIT argument[,argument]...
[label] .DB argument[,argument]...
[label] .DW argument[,argument]...
[label] .DL argument[,argument]...

Description

With these directive you can define memory. With each directive the assembler allocates and initializes
one or more bytes of memory for each argument.

If you specify the optional label, it gets the value of the location counter at the start of the directive
processing.

An argument can be a single- or multiple-character string constant, an expression or empty. Multiple
arguments must be separated by commas with no intervening spaces. Empty arguments are stored as
0 (zero). For single bit initialization (.DBIT) the argument must be a positive absolute expression and
each argument represents a bit to be initialized.

The following table shows the number of bits initialized.

BitsDirective

1.DBIT

8.DB

16.DW

32.DL

When these directives are used in a bit section (.bitdata / .mbitdata), each argument initializes the
number of bits defined for the used directive and the location counter of the current section is incremented
with this number of bits.

The .DBIT directive can be used in a bit section only (.bitdata / .mbitdata). Each argument represents
a bit to be initialized to 0 or 1. The location counter of the current section is incremented by a number of
bits equal to the number of arguments.

The value of the arguments must be in range with the size of the directive; floating-point numbers are not
allowed. If the evaluated argument is too large to be represented in a word / long, the assembler issues
a warning and truncates the value.

String constants

Single-character strings are stored in a byte whose lower seven bits represent the ASCII value of the
character, for example:

.DB 'R'        ; = 0x52
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Multiple-character strings are stored in consecutive byte addresses, as shown below. The standard C
language escape characters like ‘\n’ are permitted.

.DB 'AB',,'C'  ; = 0x41420043 (second argument is empty)

Example

When a string is supplied as argument of a directive that initializes multiple bytes, each character in the
string is stored in consecutive bytes whose lower seven bits represent the ASCII value of the character.
For example:

WTBL: .DW 'ABC',,'D'   ; results in 0x424100004400 , the 'C' is truncated
LTBL: .DL 'ABC'        ; results in 0x43424100

Related Information

.BS (Block Storage)

.DS (Define Storage)
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.DEFINE

Syntax

.DEFINE symbol  string

Description

With the .DEFINE directive you define a substitution string that you can use on all following source lines.
The assembler searches all succeeding lines for an occurrence of symbol, and replaces it with string. If
the symbol occurs in a double quoted string it is also replaced. Strings between single quotes are not
expanded.

This directive is useful for providing better documentation in the source program. A symbol can consist
of letters, digits and underscore characters (_), and the first character cannot be a digit.

Macros represent a special case. .DEFINE directive translations will be applied to the macro definition
as it is encountered. When the macro is expanded, any active .DEFINE directive translations will again
be applied.

The assembler issues a warning if you redefine an existing symbol.

A label is not allowed before this directive.

Example

Suppose you defined the symbol LEN with the substitution string "32":

  .DEFINE LEN "32"

Then you can use the symbol LEN for example as follows:

  .DS LEN
  .MESSAGE "The length is: LEN"

The assembler preprocessor replaces LEN with "32" and assembles the following lines:

  .DS 32
  .MESSAGE "The length is: 32"

Related Information

.UNDEF (Undefine a .DEFINE symbol)

.MACRO, .ENDM (Define a macro)
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.DS, .DSBIT, .DSB, .DSW, .DSL

Syntax

[label] .DS expression
[label] .DSBIT expression
[label] .DSB expression
[label] .DSW expression
[label] .DSL expression

Description

With the .DS directive the assembler reserves a block in memory. The reserved block of memory is not
initialized to any value.

With the expression you specify the number of MAUs (Minimal Addressable Units) that you want to
reserve, and how much the location counter will advance. The expression must evaluate to an integer
greater than zero and cannot contain any forward references (symbols that have not yet been defined).
In a bit section, the MAU size is 1, thus the .DS directive will initializes a number of bits equal to the result
of the expression.

If you specify the optional label, it gets the value of the location counter at the start of the directive
processing.

The .DSBIT, .DSB, .DSW and .DSL directives are variants of the .DS directive. The difference is the
number of bits that are reserved per expression argument:

Reserved bitsDirective

1.DSBIT

8.DSB

16.DSW

32.DSL

Example

      .section .bss
RES:  .DS 5+3   ; allocate 8 bytes
      .endsec

Related Information

.BS (Block Storage)

.DB (Define Memory)
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.END

Syntax

.END

Description

With the optional .END directive you tell the assembler that the end of the module is reached. If the
assembler finds assembly source lines beyond the .END directive, it ignores those lines and issues a
warning.

You cannot use the .END directive in a macro expansion.

The assembler does not allow a label with this directive.

Example

    .section .text
      ; source lines
    .endsec
    .END                ; End of assembly module
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.EQU

Syntax

symbol .EQU expression

.EQU symbol expression

Description

With the .EQU directive you assign the value of expression to symbol permanently. The expression can
be relative or absolute. Once defined, you cannot redefine the symbol. With the .GLOBAL directive you
can declare the symbol global.

Example

To assign the value 0x4000 permanently to the symbol MYSYMBOL:

MYSYMBOL .EQU  0x4000

You cannot redefine the symbol MYSYMBOL after this.

Related Information

.SET (Set temporary value to a symbol)
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.EXTERN

Syntax

.EXTERN symbol[:type][,symbol[:type]]...

Description

With the .EXTERN directive you define an external symbol. It means that the specified symbol is referenced
in the current module, but is not defined within the current module. This symbol must either have been
defined outside of any module or declared as globally accessible within another module with the .GLOBAL
directive.

The type of the symbol is inherited from the section (see .SECTION directive) in which it is defined. The
assembler uses the type to check the symbol’s use. In other words, if the symbol does not fit the
instruction’s operand, the assembler will issue a warning. If you do not specify the type information with
the .EXTERN directive, the assembler will not perform type checking when the symbol is used as an
instruction operand.You can specify the following types: text, rodata, data, mdata, sdata, bdata,
bitdata, mbitdata, xdata.

If you do not use the .EXTERN directive and the symbol is not defined within the current module, the
assembler issues a warning and inserts the .EXTERN directive.

A label is not allowed with this directive.

Example

     .EXTERN AVAR:data      ;defined elsewhere

Related Information

See Section 2.6.4, Symbol Types for more information on the type keywords.

.GLOBAL (Declare global section symbol)
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.FOR, .ENDFOR

Syntax

[label] .FOR var IN expression[,expression]...
    ....

.ENDFOR

or:

[label] .FOR var IN start TO end [STEP step]
    ....

.ENDFOR

Description

With the .FOR/.ENDFOR directive you can repeat a block of assembly source lines with an iterator. As
shown by the syntax, you can use the .FOR/.ENDFOR in two ways.

1. In the first method, the block of source statements is repeated as many times as the number of
arguments following IN. If you use the symbol var in the assembly lines between .FOR and .ENDFOR,
for each repetition the symbol var is substituted by a subsequent expression from the argument list. If
the argument is a null, then the block is repeated with each occurrence of the symbol var removed. If
an argument includes an embedded blank or other assembler-significant character, it must be enclosed
with single quotes.

2. In the second method, the block of source statements is repeated using the symbol var as a counter.
The counter passes all integer values from start to end with a step. If you do not specify step, the
counter is increased by one for every repetition.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

In the following example the block of source statements is repeated 4 times (there are four arguments).
With the .DB directive you allocate and initialize a byte of memory for each repetition of the loop (a word
for the .DW directive). Effectively, the preprocessor duplicates the .DB and .DW directives four times in
the assembly source.

  .FOR VAR1 IN 1,2+3,4,12
      .DB VAR1
      .DW (VAR1*VAR1)
  .ENDFOR

In the following example the loop is repeated 16 times. With the .DW directive you allocate and initialize
four bytes of memory for each repetition of the loop. Effectively, the preprocessor duplicates the .DW
directive 16 times in the assembled file, and substitutes VAR2 with the subsequent numbers.

  .FOR VAR2 IN 1 to 0x10
      .DW (VAR1*VAR1)
  .ENDFOR
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Related Information

.REPEAT,.ENDREP (Repeat sequence of source lines)
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.GLOBAL

Syntax

.GLOBAL symbol[,symbol]...

Description

All symbols or labels defined in the current section or module are local to the module by default.You can
change this default behavior with assembler option --symbol-scope=global.

With the .GLOBAL directive you declare one of more symbols as global. It means that the specified
symbols are defined within the current section or module, and that those definitions should be accessible
by all modules.

To access a symbol, defined with .GLOBAL, from another module, use the .EXTERN directive.

Only program labels and symbols defined with .EQU can be made global.

If the symbols that appear in the operand field are not used in the module, the assembler gives a warning.

The assembler does not allow a label with this directive.

Example

LOOPA .EQU 1          ; definition of symbol LOOPA
      .GLOBAL  LOOPA  ; LOOPA will be globally
                      ; accessible by other modules

Related Information

.EXTERN (Import global section symbol)
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.IF, .ELIF, .ELSE, .ENDIF

Syntax

.IF expression
   .
   .
  [.ELIF expression]  ; the .ELIF directive is optional
   .
   .
  [.ELSE]           ; the .ELSE directive is optional
   .
   .

.ENDIF

Description

With the .IF/.ENDIF directives you can create a part of conditional assembly code. The assembler
assembles only the code that matches a specified condition.

The expression must evaluate to an absolute integer and cannot contain forward references. If expression
evaluates to zero, the IF-condition is considered FALSE, any non-zero result of expression is considered
as TRUE.

If the optional .ELSE and/or .ELIF directives are not present, then the source statements following the
.IF directive and up to the next .ENDIF directive will be included as part of the source file being assembled
only if the expression had a non-zero result.

If the expression has a value of zero, the source file will be assembled as if those statements between
the .IF and the .ENDIF directives were never encountered.

If the .ELSE directive is present and expression has a nonzero result, then the statements between the
.IF and .ELSE directives will be assembled, and the statement between the .ELSE and .ENDIF directives
will be skipped. Alternatively, if expression has a value of zero, then the statements between the .IF and
.ELSE directives will be skipped, and the statements between the .ELSE and .ENDIF directives will be
assembled.

You can nest .IF directives to any level. The .ELSE and .ELIF directive always refer to the nearest
previous .IF directive.

A label is not allowed with this directive.

Example

Suppose you have an assemble source file with specific code for a test version, for a demo version and
for the final version. Within the assembly source you define this code conditionally as follows:

  .IF   TEST
  ... ; code for the test version
  .ELIF DEMO
  ... ; code for the demo version
  .ELSE
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  ... ; code for the final version
  .ENDIF

Before assembling the file you can set the values of the symbols TEST and DEMO in the assembly source
before the .IF directive is reached. For example, to assemble the demo version:

TEST .SET 0
DEMO .SET 1

Related Information

Assembler option --define (Define preprocessor macro)
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.INCLUDE

Syntax

.INCLUDE "filename" | <filename>

Description

With the .INCLUDE directive you include another file at the exact location where the .INCLUDE occurs.
This happens before the resulting file is assembled. The .INCLUDE directive works similarly to the
#include statement in C. The source from the include file is assembled as if it followed the point of the
.INCLUDE directive. When the end of the included file is reached, assembly of the original file continues.

The string specifies the filename of the file to be included. The filename must be compatible with the
operating system (forward/backward slashes) and can contain a directory specification. If you omit a
filename extension, the assembler assumes the extension .asm.

If an absolute pathname is specified, the assembler searches for that file. If a relative path is specified
or just a filename, the order in which the assembler searches for include files is:

1. The current directory if you use the "filename" construction.

The current directory is not searched if you use the <filename> syntax.

2. The path that is specified with the assembler option --include-directory.

3. The path that is specified in the environment variable AS87INC when the product was installed.

4. The default include directory in the installation directory.

The assembler does not allow a label with this directive.

The state of the assembler is not changed when an include file is processed. The lines of the include file
are inserted just as if they belong to the file where it is included.

Example

Suppose that your assembly source file test.src contains the following line:

  .INCLUDE "c:\myincludes\myinc.inc"

The assembler issues an error if it cannot find the file at the specified location.

  .INCLUDE "myinc.inc"

The assembler searches the file myinc.inc according to the rules described above.

Related Information

Assembler option --include-directory (Add directory to include file search path)
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.LIST, .NOLIST

Syntax

.NOLIST
   .
   .  ; assembly source lines
   .
.LIST

Description

If you generate a list file with the assembler option --list-file, you can use the directives .LIST and
.NOLIST to specify which source lines the assembler must write to the list file. Without the assembler
option --list-file these directives have no effect. The directives take effect starting at the next line.

The assembler prints all source lines to the list file, until it encounters a .NOLIST directive.The assembler
does not print the .NOLIST directive and subsequent source lines. When the assembler encounters the
.LIST directive, it resumes printing to the list file.

It is possible to nest the .LIST/.NOLIST directives.

Example

Suppose you assemble the following assembly code with the assembler option --list-file:

   .SECTION .text
    ...  ; source line 1
   .NOLIST
    ...  ; source line 2
   .LIST
    ...  ; source line 3
   .ENDSEC

The assembler generates a list file with the following lines:

   .SECTION .text
    ...  ; source line 1
    ...  ; source line 3
   .ENDSEC

Related Information

Assembler option --list-file (Generate list file)
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.MACRO, .ENDM

Syntax

macro_name .MACRO [argument[,argument]...]
    ...

macro_definition_statements
    ...

.ENDM

Description

With the .MACRO directive you define a macro. Macros provide a shorthand method for handling a repeated
pattern of code or group of instructions.You can define the pattern as a macro, and then call the macro
at the points in the program where the pattern would repeat.

The definition of a macro consists of three parts:

• Header, which assigns a name to the macro and defines the arguments (.MACRO directive).

• Body, which contains the code or instructions to be inserted when the macro is called.

• Terminator, which indicates the end of the macro definition (.ENDM directive).

The arguments are symbolic names that the macro processor replaces with the literal arguments when
the macro is expanded (called). Each formal argument must follow the same rules as symbol names: the
name can consist of letters, digits and underscore characters (_). The first character cannot be a digit.
Argument names cannot start with a percent sign (%).

Macro definitions can be nested but the nested macro will not be defined until the primary macro is
expanded.

You can use the following operators in macro definition statements:

DescriptionNameOperator

Concatenates a macro argument with adjacent
alphanumeric characters.

Macro argument concatenation\

Substitutes the ?symbol sequence with a character string
that represents the decimal value of the symbol.

Return decimal value of symbol?

Substitutes the %symbol sequence with a character string
that represents the hexadecimal value of the symbol.

Return hex value of symbol%

Allows the use of macro arguments as literal strings.Macro string delimiter“

Prevents name mangling on labels in macros.Macro local label override^

Example

The macro definition:

macro_a  .MACRO  arg1,arg2                   ;header
    .db arg1                                 ;body
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    .dw (arg1*arg2)
    .ENDM                                    ;terminator

The macro call:

    .section .data
macro_a 2,3
    .endsec

The macro expands as follows:

    .db 2
    .dw (2*3)

Related Information

Section 2.11, Macro Operations

.DEFINE (Define a substitution string)
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.MESSAGE

Syntax

.MESSAGE type [{str|exp}[,{str|exp}]...]

Description

With the .MESSAGE directive you tell the assembler to print a message to stderr during the assembling
process.

With type you can specify the following types of messages:

Information message. Error and warning counts are not affected and the assembler continues
the assembling process.

I

Warning message. Increments the warning count and the assembler continues the assembling
process.

W

Error message. Increments the error count and the assembler continues the assembling process.E

Fatal error message.The assembler immediately aborts the assembling process and generates
no object file or list file.

F

An arbitrary number of strings and expressions, in any order but separated by commas with no intervening
white space, can be specified to describe the nature of the generated message. If you use expressions,
the assembler outputs the result. The assembler outputs a space between each argument.

The error and warning counts will not be affected. The .MESSAGE directive is for example useful in
combination with conditional assembly to indicate which part is assembled. The assembling process
proceeds normally after the message has been printed.

This directive has no effect on the exit code of the assembler.

A label is not allowed with this directive.

Example

   .MESSAGE I 'Generating tables'

ID .EQU 4
   .MESSAGE E 'The value of ID is',ID

   .DEFINE LONG "SHORT"
   .MESSAGE I 'This is a LONG string'
   .MESSAGE I "This is a LONG string"

Within single quotes, the defined symbol LONG is not expanded. Within double quotes the symbol LONG
is expanded so the actual message is printed as:

This is a LONG string
This is a SHORT string
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.MISRAC

Syntax

.MISRAC string

Description

The C compiler can generate the .MISRAC directive to pass the compiler’s MISRA-C settings to the object
file. The linker performs checks on these settings and can generate a report. It is not recommended to
use this directive in hand-coded assembly.

Example

  .MISRAC 'MISRA-C:2004,64,e2,0b,e,e11,27,6,ef83,e1,ef,66,cb75,af1,eff,e7,
           e7f,8d,63,87ff7,6ff3,4'

Related Information

Section 3.7.2, C Code Checking: MISRA-C

C compiler option --misrac

86

TASKING VX-toolset for LC87 User Guide



.PAGE

Syntax

.PAGE [pagewidth[,pagelength[,blanktop[,blankbtm[,blankleft]]]]

Default

.PAGE 132,72,0,0,0

Description

If you generate a list file with the assembler option --list-file, you can use the directive .PAGE to format
the generated list file.

The arguments may be any positive absolute integer expression, and must be separated by commas.

Number of columns per line. The default is 132, the minimum is 40.pagewidth

Total number of lines per page. The default is 72, the minimum is 10.
As a special case, a page length of 0 turns off page breaks.

pagelength

Number of blank lines at the top of the page. The default is 0, the
minimum is 0 and the maximum must be a value so that (blanktop +
blankbtm) ≤ (pagelength - 10).

blanktop

Number of blank lines at the bottom of the page. The default is 0, the
minimum is 0 and the maximum must be a value so that (blanktop +
blankbtm) ≤ (pagelength - 10).

blankbtm

Number of blank columns at the left of the page. The default is 0, the
minimum is 0, and the maximum must maintain the relationship: blankleft
< pagewidth.

blankleft

If you use the .PAGE directive without arguments, it causes a 'formfeed': the next source line is printed
on the next page in the list file. The .PAGE directive itself is not printed.

You can omit an argument by using two adjacent commas. If the remaining arguments after an argument
are all empty, you can omit them.

Example

  .PAGE        ; formfeed, the next source line is printed
               ; on the next page in the list file.

  .PAGE 96     ; set page width to 96. Note that you can
               ; omit the last four arguments.

  .PAGE ,,3,3  ; use 3 line top/bottom margins.

Related Information

.TITLE (Set program title in header of assembler list file)
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Assembler option --list-file
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.REPEAT, .ENDREP

Syntax

[label] .REPEAT expression
    ....

.ENDREP

Description

With the .REPEAT/.ENDREP directive you can repeat a sequence of assembly source lines.With expression
you specify the number of times the loop is repeated. If the expression evaluates to a number less than
or equal to 0, the sequence of lines will not be included in the assembler output. The expression result
must be an absolute integer and cannot contain any forward references (symbols that have not already
been defined). The .REPEAT directive may be nested to any level.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

In this example the loop is repeated 3 times. Effectively, the preprocessor repeats the source lines (.DB
10) three times, then the assembler assembles the result:

  .REPEAT 3
  .DB 10  ; assembly source lines
  .ENDREP

Related Information

.FOR,.ENDFOR (Repeat sequence of source lines n times)
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.RESUME

Syntax

.RESUME name[,attribute]...

Description

With the .SECTION you always start a new section. With the .RESUME directive you can reactivate a
previously defined section. See the .SECTION directive for a list of available section attributes. If you
omit the attribute, the previously defined section with the same name is reactivated (ignoring the
attribute(s)). If you specify an attribute you reactivate the section with that same attribute.

Example

  .SECTION .text              ; First .text section
   ...
  .SECTION .data              ; First .data section
   ...
  .SECTION .text              ; Second .text section
   ...
  .SECTION .data, at(0x0)     ; Second .data section
   ...
  .RESUME .text               ; Resume in the second .text section
   ...
  .RESUME .data               ; Resume in the first .data section
   ...
  .RESUME .data, at(0x0)      ; Resume in the second .data section

Related Information

.SECTION (Start a new section)
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.SECTION, .ENDSEC

Syntax

.SECTION name[,attribute]...
   ....

.ENDSEC

Description

With the .SECTION directive you define a new section. Each time you use the .SECTION directive, a
new section is created. It is possible to create multiple sections with exactly the same name.

If you define a section, you must always specify the section name. The names have a special meaning
to the locating process and have to start with a predefined name, optionally extended by a dot '.' and a
user defined name. The predefined section name also determines the type of the section. Optionally, you
can specify section attributes.

You can use the following predefined section names:

Symbol typeLocationDescriptionSection name

text0x00000 - 0x3FFFF
(2 pages of 128 kB)

code sections in ROM.text

text0x00000 - 0x1FFFFcode sections in ROM bank 0.text0

text0x20000 - 0x3FFFFcode sections in ROM bank 1.text1

text0x00000 - 0x0FFFFcode sections in lowest 64 kB ROM.ztext0

text0x20000 - 0x2FFFFcode sections in lowest 64 kB ROM of
bank 1

.ztext1

data0x0000 - 0xFFFF
(sfr and system areas
reserved)

initialized data.data

data0x0000 - 0xFFFF
(sfr and system areas
reserved)

uninitialized data (cleared).bss

bdata0x0000 - 0x00FFinitialized data.bdata

bdata0x0000 - 0x00FFuninitialized data (cleared).bbss

sdata0x0000 - 0x01FFinitialized short addressable data.sdata

sdata0x0000 - 0x01FFuninitialized short addressable data
(cleared)

.sbss

mdata0x0000 - 0x1FFFinitialized medium addressable data.mdata

mdata0x0000 - 0x1FFFuninitialized medium addressable data
(cleared)

.mbss

bitdata0x0000 - 0x07FF
(bit addresses)

initialized bit-addressable data.bitdata
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Symbol typeLocationDescriptionSection name

bitdata0x0000 - 0x07FF
(bit addresses)

uninitialized bit-addressable data (cleared).bitbss

mbitdata0x0000 - 0xFFFF
(bit addresses)

medium bit-addressable initialized data.mbitdata

mbitdata0x0000 - 0xFFFF
(bit addresses)

uninitialized medium bit-addressable data
(cleared)

.mbitbss

xdata0x000000 - 0xFFFFFF
(pages of 64 kB)

initialized paged external data.xdata

xdata0x000000 - 0xFFFFFF
(pages of 64 kB)

uninitialized paged external data (cleared).xbss

xdata0x000000 - 0xFFFFFFuninitialized external data (cleared).hxbss

xdata0x000000 - 0xFFFFFFinitialized external data.hxdata

xdata0x000000 - 0xFFFFFF
(pages of 64 kB)

paged external constant data in ROM.xrodata

xdata0x000000 - 0xFFFFFFexternal constant data in ROM.hxrodata

rodata0x00000 - 0x3FFFF
(2 pages of 128 kB)

constant data in ROM.rodata

rodata0x00000 - 0x1FFFFconstant data in ROM bank 0.rodata0

rodata0x20000 - 0x3FFFFconstant data in ROM bank 1.rodata1

rodata0x00000 - 0x0FFFFconstant data in lowest 64 kB ROM.zrodata0

rodata0x20000 - 0x2FFFFconstant data in lowest 64 kB ROM of bank
1

.zrodata1

debugdebug sections.debug

Note that objects with symbol type rodata can only be accessed indirectly by means of the ldcw
instruction. Objects of type xdata can only be accessed indirectly by means of the stx and ldx
instructions. Bit-addressable internal memory can only be accessed directly, by means of a byte address
destination and a bit offset (the assembler also accepts bit address destinations, i.e. (byte address << 3)
+ bit offset).

The defined attributes are listed in the following table. The section attributes are case insensitive.

DescriptionAttribute

Locate the section at the given address.AT( address )

When data sections with the same name occur in different object modules with the
MAX attribute, the linker generates a section of which the size is the maximum of
the sizes in the individual object modules.

MAX

Section is not zeroed at startup. Can only be used on BSS sections (.bss, .bbss,
.sbss, .mbss, .bitbss, .mbitbss, .xbss, .hxbss).

NOCLEAR

Tells the linker to exclude a section from unreferenced section removal and duplicate
section removal.

PROTECT
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Sections of a specified type are located by the linker in a memory space. The space names are defined
in a so-called 'linker script file' (files with the extension .lsl) delivered with the product in the directory
installation-dir\include.lsl.

Example

  .SECTION .data                 ; Declare a .data section
     ;;
  .ENDSEC

  .SECTION .data.abs, at(0x100)  ; Declare a .data.abs section at 
                                 ; an absolute address
     ;;
  .ENDSEC

Related Information

.RESUME (Resume a previously defined section)

Section 2.6.4, Symbol Types.
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.SET

Syntax

symbol .SET expression

.SET symbol expression

Description

With the .SET directive you assign the value of expression to symbol temporarily. If a symbol was defined
with the .SET directive, you can redefine that symbol in another part of the assembly source, using the
.SET directive again. Symbols that you define with the .SET directive are always local: you cannot define
the symbol global with the .GLOBAL directive.

The .SET directive is useful in establishing temporary or reusable counters within macros. expression
must be absolute and cannot include a symbol that is not yet defined (no forward references are allowed).

Example

COUNT  .SET  0   ; Initialize count. Later on you can
                 ; assign other values to the symbol

Related Information

.EQU (Set permanent value to a symbol)
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.SIZE

Syntax

.SIZE symbol,expression

Description

With the .SIZE directive you set the size of the specified symbol to the value represented by expression.

The .SIZE directive may occur anywhere in the source file unless the specified symbol is a function. In
this case, the .SIZE directive must occur after the function has been defined.

Example

        .section        .text
        .global _main
        .align  1
; Function _main
_main:  .type   func
         ;
        .SIZE   _main,$-_main
        .endsec

Related Information

.TYPE (Set symbol type)
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.SOURCE

Syntax

.SOURCE string

Description

With the .SOURCE directive you specify the name of the original C source module. This directive is
generated by the C compiler.You do not need this directive in hand-written assembly.

Example

  .SOURCE 'main.c'
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.TITLE

Syntax

.TITLE ["string"]

Default

.TITLE ""

Description

If you generate a list file with the assembler option --list-file, you can use the .TITLE directive to specify
the program title which is printed at the top of each page in the assembler list file.

If you use the .TITLE directive without the argument, the title becomes empty. This is also the default.
The specified title is valid until the assembler encounters a new .TITLE directive.

The .TITLE directive itself will not be printed in the source listing.

If the page width is too small for the title to fit in the header, it will be truncated.

Example

  .TITLE  "This is the title"

Related Information

.PAGE (Format the assembler list file)

Assembler option --list-file
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.TYPE

Syntax

symbol .TYPE typeid

Description

With the .TYPE directive you set a symbol's type to the specified value in the ELF symbol table. Valid
symbol types are:

The symbol is associated with a function or other executable code.FUNC

The symbol is associated with an object such as a variable, an array, or a structure.OBJECT

The symbol name represents the filename of the compilation unit.FILE

Labels in code sections have the default type FUNC. Labels in data sections have the default type OBJECT.

Example

_Afunc:  .type   func

Related Information

.SIZE (Set symbol size)
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.UNDEF

Syntax

.UNDEF symbol

Description

With the .UNDEF directive you can undefine a substitution string that was previously defined with the
.DEFINE directive. The substitution string associated with symbol is released, and symbol will no longer
represent a valid .DEFINE substitution or macro.

The assembler issues a warning if you redefine an existing symbol.

The assembler does not allow a label with this directive.

Example

The following example undefines the LEN substitution string that was previously defined with the .DEFINE
directive:

  .UNDEF LEN

Related Information

.DEFINE (Define a substitution string)

.MACRO,.ENDM (Define a macro)
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.WEAK

Syntax

.WEAK symbol[,symbol]...

Description

With the .WEAK directive you mark one or more symbols as 'weak'. The symbol can be defined in the
same module with the .GLOBAL directive or the .EXTERN directive. If the symbol does not already exist,
it will be created.

A 'weak' external reference is resolved by the linker when a global (or weak) definition is found in one of
the object files. However, a weak reference will not cause the extraction of a module from a library to
resolve the reference.

You can overrule a weak definition with a .GLOBAL definition in another module. The linker will not
complain about the duplicate definition, and ignore the weak definition.

Only program labels and symbols defined with .EQU can be made weak.

Example

LOOPA .EQU 1          ; definition of symbol LOOPA
      .GLOBAL  LOOPA  ; LOOPA will be globally
                      ; accessible by other modules
      .WEAK LOOPA     ; mark symbol LOOPA as weak

Related Information

.EXTERN (Import global section symbol)

.GLOBAL (Declare global section symbol)
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2.11. Macro Operations

Macros provide a shorthand method for inserting a repeated pattern of code or group of instructions.You
can define the pattern as a macro, and then call the macro at the points in the program where the pattern
would repeat.

Some patterns contain variable entries which change for each repetition of the pattern. Others are subject
to conditional assembly.

When a macro is called, the assembler executes the macro and replaces the call by the resulting in-line
source statements. 'In-line' means that all replacements act as if they are on the same line as the macro
call. The generated statements may contain substitutable arguments. The statements produced by a
macro can be any processor instruction, almost any assembler directive, or any previously-defined macro.
Source statements resulting from a macro call are subject to the same conditions and restrictions as any
other statements.

Macros can be nested. The assembler processes nested macros when the outer macro is expanded.

2.11.1. Defining a Macro

The first step in using a macro is to define it.

The definition of a macro consists of three parts:

• Header, which assigns a name to the macro and defines the arguments (.MACRO directive).

• Body, which contains the code or instructions to be inserted when the macro is called.

• Terminator, which indicates the end of the macro definition (.ENDM directive).

A macro definition takes the following form:

macro_name .MACRO [argument[,argument]...]
    ...

macro_definition_statements
    ...

.ENDM

For more information on the definition see the description of the .MACRO directive.

2.11.2. Calling a Macro

To invoke a macro, construct a source statement with the following format:

[label] macro_name [argument[,argument]...]  [; comment]

where,

An optional label that corresponds to the value of the location counter
at the start of the macro expansion.

label

The name of the macro. This may not start in the first column.macro_name
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One or more optional, substitutable arguments. Multiple arguments
must be separated by commas.

argument

An optional comment.comment

The following applies to macro arguments:

• Each argument must correspond one-to-one with the formal arguments of the macro definition. If the
macro call does not contain the same number of arguments as the macro definition, the assembler
issues a warning.

• If an argument has an embedded comma or space, you must surround the argument by single quotes
(').

• You can declare a macro call argument as null in three ways:

• enter delimiting commas in succession with no intervening spaces

macroname ARG1,,ARG3 ; the second argument is a null argument

• terminate the argument list with a comma, the arguments that normally would follow, are now
considered null

macroname ARG1,      ; the second and all following arguments are null

• declare the argument as a null string

• No character is substituted in the generated statements that reference a null argument.

2.11.3. Using Operators for Macro Arguments

The assembler recognizes certain text operators within macro definitions which allow text substitution of
arguments during macro expansion.You can use these operators for text concatenation, numeric
conversion, and string handling.

DescriptionNameOperator

Concatenates a macro argument with adjacent
alphanumeric characters.

Macro argument concatenation\

Substitutes the ?symbol sequence with a character string
that represents the decimal value of the symbol.

Return decimal value of symbol?

Substitutes the %symbol sequence with a character string
that represents the hexadecimal value of the symbol.

Return hex value of symbol%

Allows the use of macro arguments as literal strings.Macro string delimiter“

Prevents name mangling on labels in macros.Macro local label override^
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Example: Argument Concatenation Operator - \

Consider the following macro definition:

MAC_A .MACRO reg,val
   ldw   #val
   stw   r\regl
   .ENDM

The macro is called as follows:

MAC_A 4,1

The macro expands as follows:

   ldw   #1
   stw   r4

The macro preprocessor substitutes the character '4' for the argument reg, and the character '1' for the
argument val. The concatenation operator (\) indicates to the macro preprocessor that the substitution
characters for the arguments are to be concatenated with the characters 'r'.

Without the '\' operator the macro would expand as:

   ldw   #1
   stw   rreg

which results in an assembler warning (local symbol "rreg" not defined in this module; made external).

Example: Decimal Value Operator - ?

Instead of substituting the formal arguments with the actual macro call arguments, you can also use the
value of the macro call arguments.

Consider the following source code that calls the macro MAC_A after the argument AVAL has been set to
1.

AVAL .SET  1
     MAC_A 4,AVAL

If you want to replace the argument val with the value of AVAL rather than with the literal string 'AVAL',
you can use the ? operator and modify the macro as follows:

MAC_A .MACRO reg,val
   ldw   #?val
   stw   r\regl
   .ENDM

Example: Hex Value Operator - %

The percent sign (%) is similar to the standard decimal value operator (?) except that it returns the
hexadecimal value of a symbol.
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Consider the following macro definition:

GEN_LAB   .MACRO  LAB,VAL,STMT
LAB\%VAL  STMT
     .ENDM

The macro is called after NUM has been set to 10:

NUM  .SET      10
     GEN_LAB   HEX,NUM,NOP

The macro expands as follows:

HEXA NOP

The %VAL argument is replaced by the character 'A' which represents the hexadecimal value 10 of the
argument VAL.

Example: Argument String Operator - "

To generate a literal string, enclosed by single quotes ('), you must use the argument string operator (")
in the macro definition.

Consider the following macro definition:

STR_MAC    .MACRO  STRING
    .DB    "STRING"
    .ENDM

The macro is called as follows:

    STR_MAC  ABCD

The macro expands as follows:

    .DB     'ABCD'

Within double quotes .DEFINE directive definitions can be expanded.Take care when using constructions
with single quotes and double quotes to avoid inappropriate expansions. Since .DEFINE expansion
occurs before macro substitution, any .DEFINE symbols are replaced first within a macro argument string:

    .DEFINE LONG  'short'
STR_MAC    .MACRO  STRING
    .MESSAGE I 'This is a LONG STRING'
    .MESSAGE I "This is a LONG STRING"
    .ENDM

If the macro is called as follows:

    STR_MAC  sentence
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it expands as:

    .MESSAGE I 'This is a LONG STRING'
    .MESSAGE I 'This is a short sentence'

Macro Local Label Override Operator - ^

If you use labels in macros, the assembler normally generates another unique name for the labels (such
as LOCAL__M_L000001).

The macro ^-operator prevents name mangling on macro local labels.

Consider the following macro definition:

Consider the following macro definition:

INIT  .MACRO  addr
LOCAL:  ldw   #^addr
      .ENDM

The macro is called as follows:

LOCAL:
       INIT LOCAL

The macro expands as:

LOCAL__M_L000001:  ldw   #LOCAL

If you would not have used the ̂  operator, the macro preprocessor would choose another name for LOCAL
because the label already exists. The macro would expand like:

LOCAL__M_L000001:  ldw   #LOCAL__M_L000001

2.12. Generic Instructions

The assembler supports so-called 'generic instructions'. Generic instructions are pseudo instructions (no
instructions from the instruction set). Depending on the situation in which a generic instruction is used,
the assembler replaces the generic instruction with appropriate real assembly instruction(s).

By default the assembler will rewrite conditional branch instructions to an inverted conditional branch
instruction and an unconditional branch instruction if the target label is out of range of the original conditional
branch instruction. This applies to the following inverse conditional pairs of instructions:

Inverse conditional instructionInstruction

bnzbz

bnzwbzw

bnebe

bnebel
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Inverse conditional instructionInstruction

bneldbz

dbnzldbzl

bnbp

bnmbpm

For example, the following statement:

        bz    _label

will be rewritten to:

        bnz   __T1
        br    _label
__T1:

if the label is out-of-range of the bz instruction.

Note that the PC-relative br instruction in the rewrite may be replaced by an absolute jmp instruction if
the label is also out-of-range of the br instruction, unless the assembler option --no-rel12-to-abs17 was
specified. After such a replacement the rewrite will produce the same machine code as the following:

        bnz   __T1
        jmp   _label
__T1:

A similar rewrite exists for the bpc instruction, but since this instruction does not have an inverse the
rewrite is a bit more elaborate. For example, the following statement:

        bpc   r2h,3,_label

will be rewritten to:

        bpc   r2h,3,__T1
        br    __T2
__T1:   br    _label
__T2:

if the label is out-of-range of the bpc instruction.

Again, the second PC-relative br instruction in the rewrite may be replaced by an absolute jmp instruction
if the label is also out-of-range of the second br instruction, unless the assembler option
--no-rel12-to-abs17 was specified.

You can disable automatic generation of these rewrites by specifying assembler option
--optimize=-generics (-OG). However, compiler generated assembly code relies upon these rewrites
being enabled.
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Chapter 3. Using the C Compiler
This chapter describes the compilation process and explains how to call the C compiler.

The TASKING VX-toolset for LC87 under Eclipse can use the internal builder (default) or the TASKING
makefile generator (external builder) to build your entire embedded project, from C source till the final
ELF/DWARF object file which serves as input for the debugger.

Although in Eclipse you cannot run the C compiler separately from the other tools, this section discusses
the options that you can specify for the C compiler.

On the command line it is possible to call the C compiler separately from the other tools. However, it is
recommended to use the control program for command line invocations of the toolset (see Section 6.1,
Control Program). With the control program it is possible to call the entire toolset with only one command
line.

The C compiler takes the following files for input and output:

This chapter first describes the compilation process which consists of a frontend and a backend part.
Next it is described how to call the C compiler and how to use its options. An extensive list of all options
and their descriptions is included in Section 8.2, C Compiler Options. Finally, a few important basic tasks
are described, such as including the C startup code and performing various optimizations.

3.1. Compilation Process

During the compilation of a C program, the C compiler runs through a number of phases that are divided
into two parts: frontend and backend.

The backend part is not called for each C statement, but starts after a complete C module or set of modules
has been processed by the frontend (in memory). This allows better optimization.

The C compiler requires only one pass over the input file which results in relative fast compilation.

Frontend phases

1. The preprocessor phase:

The preprocessor includes files and substitutes macros by C source. It uses only string manipulations
on the C source. The syntax for the preprocessor is independent of the C syntax but is also described
in the ISO/IEC 9899:1999(E) standard.
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2. The scanner phase:

The scanner converts the preprocessor output to a stream of tokens.

3. The parser phase:

The tokens are fed to a parser for the C grammar. The parser performs a syntactic and semantic
analysis of the program, and generates an intermediate representation of the program. This code is
called MIL (Medium level Intermediate Language).

4. The frontend optimization phase:

Target processor independent optimizations are performed by transforming the intermediate code.

Backend phases

1. Instruction selector phase:

This phase reads the MIL input and translates it into Low level Intermediate Language (LIL). The LIL
objects correspond to a processor instruction, with an opcode, operands and information used within
the C compiler.

2. Peephole optimizer phase:

This phase replaces instruction sequences by equivalent but faster and/or shorter sequences and
deletes unnecessary instructions.

3. Register allocator phase:

This phase chooses a physical register to use for each virtual register.

4. The backend optimization phase:

Performs target processor independent and dependent optimizations which operate on the Low level
Intermediate Language.

5. The code generation/formatter phase:

This phase reads through the LIL operations to generate assembly language output.

3.2. Calling the C Compiler

The TASKING VX-toolset for LC87 under Eclipse can use the internal builder (default) or the TASKING
makefile generator (external builder) to build your entire project. After you have built your project, the
output files are available in a subdirectory of your project directory, depending on the active configuration
you have set in the C/C++ Build » Settings page of the Project » Properties for dialog.

Building a project under Eclipse

You have several ways of building your project:
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• Build Selected File(s) ( ). This compiles and assembles the selected file(s) without calling the linker.

1. In the C/C++ Projects view, select the files you want to compile.

2. Right-click in the C/C++ Projects view and select Build Selected File(s).

• Build Individual Project ( ).

To build individual projects incrementally, select Project » Build project.

• Rebuild Project ( ). This builds every file in the project whether or not a file has been modified since
the last build. A rebuild is a clean followed by a build.

1. Select Project » Clean...

2. Enable the option Start a build immediately and click OK.

• Build Automatically. This performs a build of all projects whenever any project file is saved, such as
your makefile.

This way of building is not recommended for C/C++ development, but to enable this feature select
Project » Build Automatically and ensure there is a check mark beside the Build Automatically
menu item. In order for this option to work, you must also enable option Build on resource save (Auto
build) on the Behaviour tab of the C/C++ Build page of the Project » Properties for dialog.

Select a target processor (core)

Processor options affect the invocation of all tools in the toolset. In Eclipse you only need to set them
once. Based on the target processor, the compiler includes a special function register file.This is a regular
include file which enables you to use virtual registers that are located in memory.

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Processor.

In the right pane the Processor page appears.

3. From the Processor selection list, select a processor.

To access the C compiler options

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler.
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4. Select the sub-entries and set the options in the various pages.

Note that the C compiler options are used to create an object file from a C file. The options you
enter in the Assembler page are not only used for hand-coded assembly files, but also for
intermediate assembly files.

You can find a detailed description of all C compiler options in Section 8.2, C Compiler Options.

Invocation syntax on the command line (Windows Command Prompt):

c87 [ [option]... [file]... ]...

3.3. How the Compiler Searches Include Files

When you use include files (with the #include statement), you can specify their location in several ways.
The compiler searches the specified locations in the following order:

1. If the #include statement contains an absolute pathname, the compiler looks for this file. If no path
or a relative path is specified, the compiler looks in the same directory as the source file. This is only
possible for include files that are enclosed in "".

This first step is not done for include files enclosed in <>.

2. When the compiler did not find the include file, it looks in the directories that are specified in the C
Compiler » Include Paths page in the C/C++ Build » Settings » Tool Settings tab of the Project
Properties dialog (equivalent to the -I command line option).

3. When the compiler did not find the include file (because it is not in the specified include directory or
because no directory is specified), it looks in the path(s) specified in the environment variable C87INC.

4. When the compiler still did not find the include file, it finally tries the default include directory relative
to the installation directory (unless you specified option --no-stdinc).

Example

Suppose that the C source file test.c contains the following lines:

#include <stdio.h>
#include "myinc.h"

You can call the compiler as follows:

c87 -Imyinclude test.c

First the compiler looks for the file stdio.h in the directory myinclude relative to the current directory.
If it was not found, the compiler searches in the environment variable C87INC and then in the default
include directory.
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The compiler now looks for the file myinc.h, in the directory where test.c is located. If the file is not
there the compiler searches in the directory myinclude. If it was still not found, the compiler searches
in the environment variable C87INC and then in the default include directory.

3.4. Compiling for Debugging

Compiling your files is the first step to get your application ready to run on a target. However, during
development of your application you first may want to debug your application.

To create an object file that can be used for debugging, you must instruct the compiler to include symbolic
debug information in the source file.

To include symbolic debug information

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » Debugging.

4. Select Default in the Generate symbolic debug information box.

Debug and optimizations

Due to different compiler optimizations, it might be possible that certain debug information is optimized
away. Therefore, if you encounter strange behavior during debugging it might be necessary to reduce
the optimization level, so that the source code is still suitable for debugging. For more information on
optimization see Section 3.5, Compiler Optimizations.

Invocation syntax on the command line (Windows Command Prompt)

The invocation syntax on the command line is:

c87 -g file.c

3.5. Compiler Optimizations

The compiler has a number of optimizations which you can enable or disable.

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.
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In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » Optimization.

4. Select an optimization level in the Optimization level box.

or:

In the Optimization level box select Custom optimization and enable the optimizations you want
on the Custom optimization page.

Optimization levels

The TASKING C compiler offers four optimization levels and a custom level, at each level a specific set
of optimizations is enabled.

• Level 0 - No optimization: No optimizations are performed. The compiler tries to achieve a 1-to-1
resemblance between source code and produced code. Expressions are evaluated in the order written
in the source code, associative and commutative properties are not used.

• Level 1 - Optimize: Enables optimizations that do not affect the debug-ability of the source code. Use
this level when you encounter problems during debugging your source code with optimization level 2.

• Level 2 - Optimize more (default): Enables more optimizations to reduce the memory footprint and/or
execution time. This is the default optimization level.

• Level 3 - Optimize most: This is the highest optimization level. Use this level when your
program/hardware has become too slow to meet your real-time requirements.

• Custom optimization: you can enable/disable specific optimizations on the Custom optimization page.

Optimization pragmas

If you specify a certain optimization, all code in the module is subject to that optimization. Within the C
source file you can overrule the C compiler options for optimizations with #pragma optimize flag
and #pragma endoptimize. Nesting is allowed:

#pragma optimize e    /* Enable expression
...                      simplification               */
... C source ...
...
#pragma optimize c    /* Enable common expression
...                      elimination. Expression
... C source ...         simplification still enabled */
...
#pragma endoptimize   /* Disable common expression
...                      elimination                  */
#pragma endoptimize   /* Disable expression
...                      simplification               */

The compiler optimizes the code between the pragma pair as specified.
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You can enable or disable the optimizations described in the following subsection. The command line
option for each optimization is given in brackets.

3.5.1. Generic Optimizations (frontend)

Common subexpression elimination (CSE) (option -Oc/-OC)

The compiler detects repeated use of the same (sub-)expression. Such a "common" expression is replaced
by a variable that is initialized with the value of the expression to avoid recomputation. This method is
called common subexpression elimination (CSE).

Expression simplification (option -Oe/-OE)

Multiplication by 0 or 1 and additions or subtractions of 0 are removed. Such useless expressions may
be introduced by macros or by the compiler itself (for example, array subscripting).

Constant propagation (option -Op/-OP)

A variable with a known value is replaced by that value.

Automatic function inlining (option -Oi/-OI)

Small functions that are not too often called, are inlined. This reduces execution time at the cost of code
size.

Control flow simplification (option -Of/-OF)

A number of techniques to simplify the flow of the program by removing unnecessary code and reducing
the number of jumps. For example:

• Switch optimization: A number of optimizations of a switch statement are performed, such as removing
redundant case labels or even removing an entire switch.

• Jump chaining: A (conditional) jump to a label which is immediately followed by an unconditional jump
may be replaced by a jump to the destination label of the second jump. This optimization speeds up
execution.

• Conditional jump reversal: A conditional jump over an unconditional jump is transformed into one
conditional jump with the jump condition reversed. This reduces both the code size and the execution
time.

• Dead code elimination: Code that is never reached, is removed. The compiler generates a warning
messages because this may indicate a coding error.

Subscript strength reduction (option -Os/-OS)

An array or pointer subscripted with a loop iterator variable (or a simple linear function of the iterator
variable), is replaced by the dereference of a pointer that is updated whenever the iterator is updated.
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Loop transformations (option -Ol/-OL)

Transform a loop with the entry point at the bottom, to a loop with the entry point at the top. This enables
constant propagation in the initial loop test and code motion of loop invariant code by the CSE optimization.

Forward store (option -Oo/-OO)

A temporary variable is used to cache multiple assignments (stores) to the same non-automatic variable.

3.5.2. Core Specific Optimizations (backend)

Coalescer (option -Oa/-OA)

The coalescer seeks for possibilities to reduce the number of moves (MOV instruction) by smart use of
registers. This optimizes both speed and code size.

Interprocedural register optimization (option -Ob/-OB)

Register allocation is improved by taking note of register usage in functions called by a given function.

Peephole optimizations (option -Oy/-OY)

The generated assembly code is improved by replacing instruction sequences by equivalent but faster
and/or shorter sequences, or by deleting unnecessary instructions.

Generic assembly optimizations (option -Og/-OG)

A set of target independent optimizations that increase speed and decrease code size.

3.5.3. Optimize for Code Size or Execution Speed

You can tell the compiler to focus on execution speed or code size during optimizations.You can do this
by specifying a size/speed trade-off level from 0 (speed) to 4 (size).This trade-off does not turn optimization
phases on or off. Instead, its level is a weight factor that is used in the different optimization phases to
influence the heuristics. The higher the level, the more the compiler focusses on code size optimization.
To choose a trade-off value read the description below about which optimizations are affected and the
impact of the different trade-off values.

Note that the trade-off settings are directions and there is no guarantee that these are followed. The
compiler may decide to generate different code if it assessed that this would improve the result.

Optimization hint: Optimizing for size has a speed penalty and vice versa. The advice is to
optimize for size by default and only optimize those areas for speed that are critical for the
application with respect to speed. Using the tradeoff options -t0, -t1 and -t2 globally for the
application is not recommended.

To specify the size/speed trade-off optimization level:

1. From the Project menu, select Properties for
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The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » Optimization.

4. Select a trade-off level in the Trade-off between speed and size box.

See also C compiler option --tradeoff (-t)

Instruction Selection

Trade-off levels 0, 1 and 2: the compiler selects the instructions with the smallest number of cycles.

Trade-off levels 3 and 4: the compiler selects the instructions with the smallest number of bytes.

Switch Jump Chain versus Jump Table

Instruction selection for the switch statements follows different trade-off rules. A switch statement can
result in a jump chain or a jump table. The compiler makes the decision between those by measuring
and weighing bytes and cycles. This weigh is controlled with the trade-off values:

SizeTimeTrade-off value

0%100%0

25%75%1

50%50%2

75%25%3

100%0%4

Loop Optimization

For a top-loop, the loop is entered at the top of the loop. A bottom-loop is entered at the bottom. Every
loop has a test and a jump at the bottom of the loop, otherwise it is not possible to create a loop. Some
top-loops also have a conditional jump before the loop. This is only necessary when the number of loop
iterations is unknown. The number of iterations might be zero, in this case the conditional jump jumps
over the loop.

Bottom loops always have an unconditional jump to the loop test at the bottom of the loop.

Optimize loops for
size/speed

Try to rewrite top-loops to
bottom-loops

Trade-off value

speedno0

speedyes1

speedyes2

sizeyes3
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Optimize loops for
size/speed

Try to rewrite top-loops to
bottom-loops

Trade-off value

sizeyes4

Example:

int a;

void i( int l, int m )
{
    int i;

    for ( i = m; i < l; i++ )
    {
        a++;
    }
    return;
}

Coded as a bottom loop (compiled with --tradeoff=4) is:

        ldw    _a
        stw    r4
        br     .L2         ;; unconditional branch to loop test at bottom
.L3:                       ;; loop entry point
        incw   r4
        incw   r2
.L2:
        ldw    r2
        pushw  r1
        fsubw
        bn     b,7,.L4
        bn     psw,ov,.L3
        br     .L5
.L4:
        bp     psw,ov,.L3
.L5:
        ldw    r4
        stw    _a

Coded as a top loop (compiled with --tradeoff=0) is:

        ldw    _a
        stw    r4
        ldw    r2          ;;
        pushw  r1          ;;
        fsubw              ;;
        bn     b,7,.L2     ;; test for at least one loop iteration, can
        bp     psw,ov,.L4  ;; be omitted when number of iterations is known
        br     .L3         ;;
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.L2:
        bn     psw,ov,.L4
.L3:
.L5:                       ;; loop entry point
        incw   r4
        incw   r2
        ldw    r2
        pushw  r1
        fsubw
        bn     b,7,.L6
        bn     psw,ov,.L5
        br     .L7
.L6:
        bp     psw,ov,.L5
.L7:
.L4:
        ldw    r4
        stw    _a

Automatic Function Inlining

You can enable automatic function inlining with the option --optimize=+inline (-Oi) or by using #pragma
optimize +inline. This option is also part of the -O3 predefined option set.

When automatic inlining is enabled, you can use the options --inline-max-incr and --inline-max-size (or
their corresponding pragmas inline_max_incr / inline_max_size) to control automatic inlining.
By default their values are set to -1. This means that the compiler will select a value depending upon the
selected trade-off level. The defaults are:

inline-max-sizeinline-max-incrTrade-off value

501000

25501

20202

10103

004

For example with trade-off value 1, the compiler inlines all functions that are smaller or equal to 25 internal
compiler units. After that the compiler tries to inline even more functions as long as the function will not
grow more than 50%.

When these options/pragmas are set to a value >= 0, the specified value is used instead of the values
from the table above.

Static functions that are called only once, are always inlined, independent of the values chosen for
inline-max-incr and inline-max-size.
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3.6. Influencing the Build Time

In general many settings have influence on the build time of a project. Any change in the tool settings of
your project source will have more or less impact on the build time.The following sections describe several
issues that can have significant influence on the build time.

Optimization Options

In general any optimization may require more work to be done by the compiler. But this does not mean
that disabling all optimizations (level 0) gives the fastest compilation time. Disabling optimizations may
result in more code being generated, resulting in more work for other parts of the compiler, like for example
the register allocator.

Automatic Inlining

Automatic inlining is an optimization which can result in significant longer build time.The overall functions
will get bigger, often making it possible to do more optimizations. But also often resulting in more registers
to be in use in a function, giving the register allocation a tougher job.

Compiler Cache

The C compiler has support for caching intermediate results to avoid full compilations. When the source
code after preprocessing and relevant compiler options and the compiler version are the same as in a
previous invocation, the previous result is copied to the output file. The cache only works when there is
a single C input file and a single output file.

To enable caching from Eclipse:

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » Optimization » Compilation Speed.

4. Enable the option Cache generated code to improve the compilation speed.

5. In the Directory for cached files field, enter the name for the location of the cache.

By default this is the .cache directory under your project directory.

6. Specify the Maximum days files will live in the cache.

7. (Optional) Enable the option Clear cache upon project clean.

Each time you use Project » Clean... the cache is cleared.
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Eclipse calls the C compiler with option --cache. The cache directory may be shared, for instance by
placing it on a network drive. The compiler creates a directory c87cache in the specified directory.

When a result from the cache is used, the C compiler generates a comment line in the assembly source
file to notify that. In that case be aware of the following:

• In case source merging is enabled an older version of the source is still shown. As long as a source
change has no effect on the preprocessed code, the cached version of the output file is used.

• Some options, like --define, --include-directory and --output are not part of the hash used for the
cache. As long as a change in these options has no influence on the preprocessed code, the cached
version of the output is used.This means that the options listed as comments in the generated assembly
file might not match the options actually used.

With every compilation of a file that results in a cache miss, a new file is stored in the cache. Old files are
not removed from the cache automatically because that would slow down the compiler too much.To keep
the cache size reasonable specify a maximum number of days the files will live in the cache. Eclipse uses
the utility expire87 for this. It is recommended to run this utility frequently, for example with each time the
project is linked. For more information on this utility see Section 6.5, Expire Cache Utility.

Header Files

Many applications include all header files in each module, often by including them all within a single
include file. Processing header files takes time. It is a good programming practice to only include the
header files that are really required in a module, because:

• it is clear what interfaces are used by a module

• an incremental build after modifying a header file results in less modules required to be rebuild

• it reduces compile time

Parallel Build

The make utility amk, which is used by Eclipse, has a feature to build jobs in parallel. This means that
multiple modules can be compiled in parallel. With today's multi-core processors this means that each
core can be fully utilized. In practice even on single core machines the compile time decreases when
using parallel jobs. On multi-core machines the build time even improves further when specifying more
parallel jobs than the number of cores.

In Eclipse you can control the parallel build behavior:

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, select C/C++ Build.

In the right pane the C/C++ Build page appears.

3. On the Behaviour tab, select Use parallel build.
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4. You can specify the number of parallel jobs, or you can use an optimal number of jobs. In the last
case, amk will fork as many jobs in parallel as cores are available.

3.7. Static Code Analysis

Static code analysis (SCA) is a relatively new feature in compilers. Various approaches and algorithms
exist to perform SCA, each having specific pros and cons.

SCA Implementation Design Philosophy

SCA is implemented in the TASKING compiler based on the following design criteria:

• An SCA phase does not take up an excessive amount of execution time. Therefore, the SCA can be
performed during a normal edit-compile-debug cycle.

• SCA is implemented in the compiler front-end. Therefore, no new makefiles or work procedures have
to be developed to perform SCA.

• The number of emitted false positives is kept to a minimum. A false positive is a message that indicates
that a correct code fragment contains a violation of a rule/recommendation. A number of warnings is
issued in two variants, one variant when it is guaranteed that the rule is violated when the code is
executed, and the other variant when the rules is potentially violated, as indicated by a preceding
warning message.

For example see the following code fragment:

extern int some_condition(int);
void f(void)
{
    char buf[10];
    int i;

    for (i = 0; i <= 10; i++)
    {
        if (some_condition(i))
        {
            buf[i] = 0; /* subscript may be out of bounds */
        }
    }
}

As you can see in this example, if i=10 the array buf[] might be accessed beyond its upper boundary,
depending on the result of some_condition(i). If the compiler cannot determine the result of this
function at run-time, the compiler issues the warning "subscript is possibly out of bounds" preceding
the CERT warning "ARR35: do not allow loops to iterate beyond the end of an array". If the compiler
can determine the result, or if the if statement is omitted, the compiler can guarantee that the "subscript
is out of bounds".

• The SCA implementation has real practical value in embedded system development.There are no real
objective criteria to measure this claim.Therefore, the TASKING compilers support well known standards
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for safety critical software development such as the MISRA guidelines for creating software for safety
critical automotive systems and secure "CERT C Secure Coding Standard" released by CERT. CERT
is founded by the US government and studies internet and networked systems security vulnerabilities,
and develops information to improve security.

Effect of optimization level on SCA results

The SCA implementation in the TASKING compilers has the following limitations:

• Some violations of rules will only be detected when a particular optimization is enabled, because they
rely on the analysis done for that optimization, or on the transformations performed by that optimization.
In particular, the constant propagation and the CSE/PRE optimizations are required for some checks.
It is preferred that you enable these optimizations. These optimizations are enabled with the default
setting of the optimization level (-O2).

• Some checks require cross-module inspections and violations will only be detected when multiple
source files are compiled and linked together by the compiler in a single invocation.

3.7.1. C Code Checking: CERT C

The CERT C Secure Coding Standard provides rules and recommendations for secure coding in the C
programming language. The goal of these rules and recommendations is to eliminate insecure coding
practices and undefined behaviors that can lead to exploitable vulnerabilities.The application of the secure
coding standard will lead to higher-quality systems that are robust and more resistant to attack.

For details about the standard, see the CERT C Secure Coding Standard web site. For general information
about CERT secure coding, see www.cert.org/secure-coding.

Versions of the CERT C standard

Version 1.0 of the CERT C Secure Coding Standard is available as a book by Robert C. Seacord
[Addison-Wesley]. Whereas the web site is a wiki and reflects the latest information, the book serves as
a fixed point of reference for the development of compliant applications and source code analysis tools.

The rules and recommendations supported by the TASKING compiler reflect the version of the CERT
web site as of June 1 2009.

The following rules/recommendations implemented by the TASKING compiler, are not part of the book:
PRE11-C, FLP35-C, FLP36-C, MSC32-C

For a complete overview of the supported CERT C recommendations/rules by the TASKING compiler,
see Chapter 14, CERT C Secure Coding Standard.

Priority and Levels of CERT C

Each CERT C rule and recommendation has an assigned priority. Three values are assigned for each
rule on a scale of 1 to 3 for

• severity - how serious are the consequences of the rule being ignored

1. low (denial-of-service attack, abnormal termination)
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2. medium (data integrity violation, unintentional information disclosure)

3. high (run arbitrary code)

• likelihood - how likely is it that a flaw introduced by ignoring the rule could lead to an exploitable
vulnerability

1. unlikely

2. probable

3. likely

• remediation cost - how expensive is it to comply with the rule

1. high (manual detection and correction)

2. medium (automatic detection and manual correction)

3. low (automatic detection and correction)

The three values are then multiplied together for each rule. This product provides a measure that can be
used in prioritizing the application of the rules. These products range from 1 to 27. Rules and
recommendations with a priority in the range of 1-4 are level 3 rules (low severity, unlikely, expensive to
repair flaws), 6-9 are level 2 (medium severity, probable, medium cost to repair flaws), and 12-27 are
level 1 (high severity, likely, inexpensive to repair flaws).

The TASKING compiler checks most of the level 1 and some of the level 2 CERT C recommendations/rules.

For a complete overview of the supported CERT C recommendations/rules by the TASKING compiler,
see Chapter 14, CERT C Secure Coding Standard.

To apply CERT C code checking to your application

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » CERT C Secure Coding.

4. Make a selection from the CERT C secure code checking list.

5. If you selected Custom, expand the Custom CERT C entry and enable one or more individual
recommendations/rules.

On the command line you can use the option --cert.

c87 --cert={all | name [-name],...]
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With --diag=cert you can see a list of the available checks, or you can use a three-letter mnemonic to
list only the checks in a particular category. For example, --diag=pre lists all supported checks in the
preprocessor category.

3.7.2. C Code Checking: MISRA-C

The C programming language is a standard for high level language programming in embedded systems,
yet it is considered somewhat unsuitable for programming safety-related applications.Through enhanced
code checking and strict enforcement of best practice programming rules, TASKING MISRA-C code
checking helps you to produce more robust code.

MISRA-C specifies a subset of the C programming language which is intended to be suitable for embedded
automotive systems. It consists of a set of rules, defined in MISRA-C:2004, Guidelines for the Use of the
C Language in Critical Systems (Motor Industry Research Association (MIRA), 2004).

The compiler also supports MISRA-C:1998, the first version of MISRA-C.You can select this version with
the following C compiler option:

--misrac-version=1998

For a complete overview of all MISRA-C rules, see Chapter 15, MISRA-C Rules.

Implementation issues

The MISRA-C implementation in the compiler supports nearly all rules. Only a few rules are not supported
because they address documentation, run-time behavior, or other issues that cannot be checked by static
source code inspection, or because they require an application-wide overview.

During compilation of the code, violations of the enabled MISRA-C rules are indicated with error messages
and the build process is halted.

MISRA-C rules are divided in required rules and advisory rules. If rules are violated, errors are generated
causing the compiler to stop. With the following options warnings, instead of errors, are generated for
either or both the required rules and the advisory rules:

--misrac-required-warnings
--misrac-advisory-warnings

Note that not all MISRA-C violations will be reported when other errors are detected in the input
source. For instance, when there is a syntax error, all semantic checks will be skipped, including
some of the MISRA-C checks. Also note that some checks cannot be performed when the
optimizations are switched off.

Quality Assurance report

To ensure compliance to the MISRA-C rules throughout the entire project, the TASKING linker can
generate a MISRA-C Quality Assurance report. This report lists the various modules in the project with
the respective MISRA-C settings at the time of compilation.You can use this in your company's quality
assurance system to provide proof that company rules for best practice programming have been applied
in the particular project.
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To apply MISRA-C code checking to your application

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » MISRA-C.

4. Select the MISRA-C version (2004 or 1998).

5. In the MISRA-C checking box select a MISRA-C configuration. Select a predefined configuration
for conformance with the required rules in the MISRA-C guidelines.

6. (Optional) In the Custom 2004 or Custom 1998 entry, specify the individual rules.

On the command line you can use the option --misrac.

c87 --misrac={all | number [-number],...]

3.8. C Compiler Error Messages

The C compiler reports the following types of error messages in the Problems view of Eclipse.

F ( Fatal errors)

After a fatal error the compiler immediately aborts compilation.

E (Errors)

Errors are reported, but the compiler continues compilation. No output files are produced unless you have
set the C compiler option --keep-output-files (the resulting output file may be incomplete).

W (Warnings)

Warning messages do not result into an erroneous assembly output file. They are meant to draw your
attention to assumptions of the compiler for a situation which may not be correct.You can control warnings
in the C/C++ Build » Settings » Tool Settings » C Compiler » Diagnostics page of the Project »
Properties for menu (C compiler option --no-warnings).

I (Information)

Information messages are always preceded by an error message. Information messages give extra
information about the error.
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S (System errors)

System errors occur when internal consistency checks fail and should never occur.When you still receive
the system error message

S9##: internal consistency check failed - please report

please report the error number and as many details as possible about the context in which the error
occurred.

Display detailed information on diagnostics

1. From the Window menu, select Show View » Other » TASKING » Problems.

The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.

A popup menu appears.

3. Select Detailed Diagnostics Info.

A dialog box appears with additional information.

On the command line you can use the C compiler option --diag to see an explanation of a diagnostic
message:

c87 --diag=[format:]{all | number,...]
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Chapter 4. Using the Assembler
This chapter describes the assembly process and explains how to call the assembler.

The assembler converts hand-written or compiler-generated assembly language programs into machine
language, resulting in object files in the ELF/DWARF object format.

The assembler takes the following files for input and output:

The following information is described:

• The assembly process.

• How to call the assembler and how to use its options. An extensive list of all options and their descriptions
is included in Section 8.3, Assembler Options.

• The various assembler optimizations.

• How to generate a list file.

• Types of assembler messages.

4.1. Assembly Process

The assembler generates relocatable output files with the extension .obj. These files serve as input for
the linker.

Phases of the assembly process

• Parsing of the source file: preprocessing of assembler directives and checking of the syntax of
instructions

• Optimization (instruction size and generic instructions)

• Generation of the relocatable object file and optionally a list file

The assembler integrates file inclusion and macro facilities. See Section 2.11, Macro Operations for more
information.
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4.2. Calling the Assembler

The TASKING VX-toolset for LC87 under Eclipse can use the internal builder (default) or the TASKING
makefile generator (external builder) to build your entire project. After you have built your project, the
output files are available in a subdirectory of your project directory, depending on the active configuration
you have set in the C/C++ Build » Settings page of the Project » Properties for dialog.

Building a project under Eclipse

You have several ways of building your project:

• Build Selected File(s) ( ). This compiles and assembles the selected file(s) without calling the linker.

1. In the C/C++ Projects view, select the files you want to compile.

2. Right-click in the C/C++ Projects view and select Build Selected File(s).

• Build Individual Project ( ).

To build individual projects incrementally, select Project » Build project.

• Rebuild Project ( ). This builds every file in the project whether or not a file has been modified since
the last build. A rebuild is a clean followed by a build.

1. Select Project » Clean...

2. Enable the option Start a build immediately and click OK.

• Build Automatically. This performs a build of all projects whenever any project file is saved, such as
your makefile.

This way of building is not recommended for C/C++ development, but to enable this feature select
Project » Build Automatically and ensure there is a check mark beside the Build Automatically
menu item. In order for this option to work, you must also enable option Build on resource save (Auto
build) on the Behaviour tab of the C/C++ Build page of the Project » Properties for dialog.

Select a target processor (core)

Processor options affect the invocation of all tools in the toolset. In Eclipse you only need to set them
once. Based on the target processor, the compiler includes a special function register file.This is a regular
include file which enables you to use virtual registers that are located in memory.

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Processor.

In the right pane the Processor page appears.

3. From the Processor selection list, select a processor.
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To access the assembler options

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Assembler.

4. Select the sub-entries and set the options in the various pages.

Note that the options you enter in the Assembler page are not only used for hand-coded assembly
files, but also for the assembly files generated by the compiler.

You can find a detailed description of all assembler options in Section 8.3, Assembler Options.

Invocation syntax on the command line (Windows Command Prompt):

as87 [ [option]... [file]... ]...

The input file must be an assembly source file (.asm or .src).

4.3. How the Assembler Searches Include Files

When you use include files (with the .INCLUDE directive), you can specify their location in several ways.
The assembler searches the specified locations in the following order:

1. If the .INCLUDE directive contains an absolute path name, the assembler looks for this file. If no path
or a relative path is specified, the assembler looks in the same directory as the source file.

2. When the assembler did not find the include file, it looks in the directories that are specified in the
Assembler » Include Paths page in the C/C++ Build » Settings » Tool Settings tab of the Project
Properties dialog (equivalent to option --include-directory (-I)).

3. When the assembler did not find the include file (because it is not in the specified include directory or
because no directory is specified), it looks in the path(s) specified in the environment variable AS87INC.

4. When the assembler still did not find the include file, it finally tries the default include directory relative
to the installation directory.

Example

Suppose that the assembly source file test.asm contains the following lines:

.INCLUDE 'myinc.inc'
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You can call the assembler as follows:

as87 -Imyinclude test.asm

First the assembler looks for the file myinc.asm, in the directory where test.asm is located. If the file
is not there the assembler searches in the directory myinclude. If it was still not found, the assembler
searches in the environment variable AS87INC and then in the default include directory.

4.4. Assembler Optimizations

The assembler can perform various optimizations that you can enable or disable.

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Assembler » Optimization.

4. Enable one or more optimizations.

You can enable or disable the optimizations described below. The command line option for each
optimization is given in brackets.

Allow generic instructions (option -Og/-OG)

When this option is enabled, you can use generic instructions in your assembly source. The assembler
tries to replace instructions by faster or smaller instructions. For more information see Section 2.12,
Generic Instructions.

By default this option is enabled. Because shorter instructions may influence the number of cycles, you
may want to disable this option when you have written timed code. In that case the assembler encodes
all instructions as they are.

Optimize instruction size (option -Os/-OS)

When this option is enabled, the assembler tries to find the shortest possible operand encoding for
instructions. By default this option is enabled.

4.5. Generating a List File

The list file is an additional output file that contains information about the generated code.You can
customize the amount and form of information.

If the assembler generates errors or warnings, these are reported in the list file just below the source line
that caused the error or warning.
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To generate a list file

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Assembler » List File.

4. Enable the option Generate list file.

5. (Optional) Enable the options to include that information in the list file.

Example on the command line (Windows Command Prompt)

The following command generates the list file test.lst:

as87 -l test.asm

See Section 10.1, Assembler List File Format, for an explanation of the format of the list file.

4.6. Assembler Error Messages

The assembler reports the following types of error messages in the Problems view of Eclipse.

F ( Fatal errors)

After a fatal error the assembler immediately aborts the assembly process.

E (Errors)

Errors are reported, but the assembler continues assembling. No output files are produced unless you
have set the assembler option --keep-output-files (the resulting output file may be incomplete).

W (Warnings)

Warning messages do not result into an erroneous assembly output file. They are meant to draw your
attention to assumptions of the assembler for a situation which may not be correct.You can control
warnings in the C/C++ Build » Settings » Tool Settings » Assembler » Diagnostics page of the Project
» Properties for menu (assembler option --no-warnings).

Display detailed information on diagnostics

1. From the Window menu, select Show View » Other » TASKING » Problems.

The Problems view is added to the current perspective.
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2. In the Problems view right-click on a message.

A popup menu appears.

3. Select Detailed Diagnostics Info.

A dialog box appears with additional information.

On the command line you can use the assembler option --diag to see an explanation of a diagnostic
message:

as87 --diag=[format:]{all | number,...]
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Chapter 5. Using the Linker
This chapter describes the linking process, how to call the linker and how to control the linker with a script
file.

The TASKING linker is a combined linker/locator. The linker phase combines relocatable object files
(.obj files, generated by the assembler), and libraries into a single relocatable linker object file (.out).
The locator phase assigns absolute addresses to the linker object file and creates an absolute object file
which you can load into a target processor. From this point the term linker is used for the combined
linker/locator.

The linker can simultaneously link and locate all programs for all cores available on a target board. The
target board may be of arbitrary complexity. A simple target board may contain one standard processor
with some external memory that executes one task. A complex target board may contain multiple standard
processors and DSPs combined with configurable IP-cores loaded in an FPGA. Each core may execute
a different program, and external memory may be shared by multiple cores.

The linker takes the following files for input and output:

This chapter first describes the linking process. Then it describes how to call the linker and how to use
its options. An extensive list of all options and their descriptions is included in Section 8.4, Linker Options.

To control the link process, you can write a script for the linker.This chapter shortly describes the purpose
and basic principles of the Linker Script Language (LSL) on the basis of an example. A complete description
of the LSL is included in Linker Script Language.

5.1. Linking Process

The linker combines and transforms relocatable object files (.obj) into a single absolute object file. This
process consists of two phases: the linking phase and the locating phase.

In the first phase the linker combines the supplied relocatable object files and libraries into a single
relocatable object file. In the second phase, the linker assigns absolute addresses to the object file so it
can actually be loaded into a target.
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Terms used in the linking process

DefinitionTerm

Object code in which addresses have fixed absolute values, ready to load into a
target.

Absolute object file

A specification of a location in an address space.Address

The set of possible addresses. A core can support multiple spaces, for example in
a Harvard architecture the addresses that identify the location of an instruction
refer to code space, whereas addresses that identify the location of a data object
refer to a data space.

Address space

A description of the characteristics of a core that are of interest for the linker. This
encompasses the address space(s) and the internal bus structure. Given this
information the linker can convert logical addresses into physical addresses.

Architecture

A section created by the linker. This section contains data that specifies how the
startup code initializes the data sections. For each section the copy table contains
the following fields:

• action: defines whether a section is copied or zeroed

• destination: defines the section's address in RAM

• source: defines the sections address in ROM

• length: defines the size of the section in MAUs of the destination space

Copy table

An instance of an architecture.Core

The design of a processor. A description of one or more cores including internal
memory and any number of buses.

Derivative

Collection of relocatable object files. Usually each object file in a library contains
one symbol definition (for example, a function).

Library

An address as encoded in an instruction word, an address generated by a core
(CPU).

Logical address

The set of linker script files that are passed to the linker.LSL file

Minimum Addressable Unit. For a given processor the number of bits between an
address and the next address. This is not necessarily a byte or a word.

MAU

The binary machine language representation of the C source.Object code

An address generated by the memory system.Physical address

An instance of a derivative. Usually implemented as a (custom) chip, but can also
be implemented in an FPGA, in which case the derivative can be designed by the
developer.

Processor

Object code in which addresses are represented by symbols and thus relocatable.Relocatable object
file

The process of assigning absolute addresses.Relocation
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DefinitionTerm

Information about how the linker must modify the machine code instructions when
it relocates addresses.

Relocation
information

A group of instructions and/or data objects that occupy a contiguous range of
addresses.

Section

Attributes that define how the section should be linked or located.Section attributes

The hardware board on which an application is executing. A board contains at least
one processor. However, a complex target may contain multiple processors and
external memory and may be shared between processors.

Target

A reference to a symbol for which the linker did not find a definition yet.Unresolved
reference

5.1.1. Phase 1: Linking

The linker takes one or more relocatable object files and/or libraries as input. A relocatable object file, as
generated by the assembler, contains the following information:

• Header information: Overall information about the file, such as the code size, name of the source file
it was assembled from, and creation date.

• Object code: Binary code and data, divided into various named sections. Sections are contiguous
chunks of code that have to be placed in specific parts of the memory. The program addresses start
at zero for each section in the object file.

• Symbols: Some symbols are exported - defined within the file for use in other files. Other symbols are
imported - used in the file but not defined (external symbols). Generally these symbols are names of
routines or names of data objects.

• Relocation information: A list of places with symbolic references that the linker has to replace with
actual addresses. When in the code an external symbol (a symbol defined in another file or in a library)
is referenced, the assembler does not know the symbol's size and address. Instead, the assembler
generates a call to a preliminary relocatable address (usually 0000), while stating the symbol name.

• Debug information: Other information about the object code that is used by a debugger.The assembler
optionally generates this information and can consist of line numbers, C source code, local symbols
and descriptions of data structures.

The linker resolves the external references between the supplied relocatable object files and/or libraries
and combines the files into a single relocatable linker object file.

The linker starts its task by scanning all specified relocatable object files and libraries. If the linker
encounters an unresolved symbol, it remembers its name and continues scanning. The symbol may be
defined elsewhere in the same file, or in one of the other files or libraries that you specified to the linker.
If the symbol is defined in a library, the linker extracts the object file with the symbol definition from the
library. This way the linker collects all definitions and references of all of the symbols.

Next, the linker combines sections with the same section name and attributes into single sections. The
linker also substitutes (external) symbol references by (relocatable) numerical addresses where possible.
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At the end of the linking phase, the linker either writes the results to a file (a single relocatable object file)
or keeps the results in memory for further processing during the locating phase.

The resulting file of the linking phase is a single relocatable object file (.out). If this file contains unresolved
references, you can link this file with other relocatable object files (.obj) or libraries (.lib) to resolve
the remaining unresolved references.

With the linker command line option --link-only, you can tell the linker to only perform this linking phase
and skip the locating phase. The linker complains if any unresolved references are left.

5.1.2. Phase 2: Locating

In the locating phase, the linker assigns absolute addresses to the object code, placing each section in
a specific part of the target memory.The linker also replaces references to symbols by the actual address
of those symbols. The resulting file is an absolute object file which you can actually load into a target
memory. Optionally, when the resulting file should be loaded into a ROM device the linker creates a
so-called copy table section which is used by the startup code to initialize the data sections.

Code modification

When the linker assigns absolute addresses to the object code, it needs to modify this code according
to certain rules or relocation expressions to reflect the new addresses. These relocation expressions are
stored in the relocatable object file. Consider the following snippet of x86 code that moves the contents
of variable a to variable b via the eax register:

A1 3412 0000 mov a,%eax   (a defined at 0x1234, byte reversed)
A3 0000 0000 mov %eax,b   (b is imported so the instruction refers to
                            0x0000 since its location is unknown)

Now assume that the linker links this code so that the section in which a is located is relocated by 0x10000
bytes, and b turns out to be at 0x9A12. The linker modifies the code to be:

A1 3412 0100 mov a,%eax   (0x10000 added to the address)
A3 129A 0000 mov %eax,b   (0x9A12 patched in for b)

These adjustments affect instructions, but keep in mind that any pointers in the data part of a relocatable
object file have to be modified as well.

Output formats

The linker can produce its output in different file formats.The default ELF/DWARF format (.abs) contains
an image of the executable code and data, and can contain additional debug information. The Intel-Hex
format (.hex) and Motorola S-record format (.sre) only contain an image of the executable code and
data.You can specify a format with the options --output (-o) and --chip-output (-c).

Controlling the linker

Via a so-called linker script file you can gain complete control over the linker.The script language is called
the Linker Script Language (LSL). Using LSL you can define:

• The memory installed in the embedded target system:
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To assign locations to code and data sections, the linker must know what memory devices are actually
installed in the embedded target system. For each physical memory device the linker must know its
start-address, its size, and whether the memory is read-write accessible (RAM) or read-only accessible
(ROM).

• How and where code and data should be placed in the physical memory:

Embedded systems can have complex memory systems. If for example on-chip and off-chip memory
devices are available, the code and data located in internal memory is typically accessed faster and
with dissipating less power. To improve the performance of an application, specific code and data
sections should be located in on-chip memory. By writing your own LSL file, you gain full control over
the locating process.

• The underlying hardware architecture of the target processor.

To perform its task the linker must have a model of the underlying hardware architecture of the processor
you are using. For example the linker must know how to translate an address used within the object
file (a logical address) into an offset in a particular memory device (a physical address). In most linkers
this model is hard coded in the executable and can not be modified. For the TASKING linker this
hardware model is described in the linker script file. This solution is chosen to support configurable
cores that are used in system-on-chip designs.

When you want to write your own linker script file, you can use the standard linker script files with
architecture descriptions delivered with the product.

See also Section 5.8, Controlling the Linker with a Script.

5.2. Calling the Linker

In Eclipse you can set options specific for the linker. After you have built your project, the output files are
available in a subdirectory of your project directory, depending on the active configuration you have set
in the C/C++ Build » Settings page of the Project » Properties for dialog.

Building a project under Eclipse

You have several ways of building your project:

• Build Individual Project ( ).

To build individual projects incrementally, select Project » Build project.

• Rebuild Project ( ). This builds every file in the project whether or not a file has been modified since
the last build. A rebuild is a clean followed by a build.

1. Select Project » Clean...

2. Enable the option Start a build immediately and click OK.
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• Build Automatically. This performs a build of all projects whenever any project file is saved, such as
your makefile.

This way of building is not recommended, but to enable this feature select Project » Build Automatically
and ensure there is a check mark beside the Build Automatically menu item. In order for this option
to work, you must also enable option Build on resource save (Auto build) on the Behaviour tab of
the C/C++ Build page of the Project » Properties for dialog.

To access the linker options

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker.

4. Select the sub-entries and set the options in the various pages.

You can find a detailed description of all linker options in Section 8.4, Linker Options.

Invocation syntax on the command line (Windows Command Prompt):

lk87 [ [option]... [file]... ]...

When you are linking multiple files, either relocatable object files (.obj) or libraries (.lib), it is important
to specify the files in the right order. This is explained in Section 5.3, Linking with Libraries.

Example:

lk87 -dlc87.lsl test.obj

This links and locates the file test.obj and generates the file test.abs.

5.3. Linking with Libraries

There are two kinds of libraries: system libraries and user libraries.

System library

System libraries are stored in the directories:

<LC87 installation path>\lib

An overview of the system libraries is given in the following table:
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DescriptionLibraries

C libraries
Mandatory letter:
s | d = RAM model sdata or data (control program option --ram-model)
Optional letter:
w = wide character support (control program option --wchar)
s = single precision floating-point (control program option --no-double)

lc87c{s|d}[w][s].lib

Floating-point libraries (contains floating-point functions needed by the C
compiler)
Optional letter:
t = trapping (control program option --fp-trap)

lc87fp[t].lib

Run-time library (contains other run-time functions needed by the C
compiler)

lc87rt.lib

To link the default C (system) libraries

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Libraries.

4. Enable the option Link default libraries.

When you want to link system libraries from the command line, you must specify this with the option
--library (-l). For example, to specify the system library lc87cd.lib, type:

lk87 --library=cd test.obj

User library

You can create your own libraries. Section 6.3, Archiver describes how you can use the archiver to create
your own library with object modules.

To link user libraries

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Libraries.
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4. Add your libraries to the Libraries box.

When you want to link user libraries from the command line, you must specify their filenames on the
command line:

lk87 start.obj mylib.lib

If the library resides in a sub-directory, specify that directory with the library name:

lk87 start.obj mylibs\mylib.lib

If you do not specify a directory, the linker searches the library in the current directory only.

Library order

The order in which libraries appear on the command line is important. By default the linker processes
object files and libraries in the order in which they appear at the command line. Therefore, when you use
a weak symbol construction, like printf, in an object file or your own library, you must position this
object/library before the C library.

With the option --first-library-first you can tell the linker to scan the libraries from left to right, and extract
symbols from the first library where the linker finds it. This can be useful when you want to use newer
versions of a library routine:

lk87 --first-library-first a.lib test.obj b.lib

If the file test.obj calls a function which is both present in a.lib and b.lib, normally the function in
b.lib would be extracted. With this option the linker first tries to extract the symbol from the first library
a.lib.

Note that routines in b.lib that call other routines that are present in both a.lib and b.lib are now
also resolved from a.lib.

5.3.1. How the Linker Searches Libraries

System libraries

You can specify the location of system libraries in several ways.The linker searches the specified locations
in the following order:

1. The linker first looks in the Library search path that are specified in the Linker » Libraries page in
the C/C++ Build » Settings » Tool Settings tab of the Project Properties dialog (equivalent to the -L
command line option). If you specify the -L option without a pathname, the linker stops searching after
this step.

2. When the linker did not find the library (because it is not in the specified library directory or because
no directory is specified), it looks in the path(s) specified in the environment variable LIBLC87.

3. When the linker did not find the library, it tries the default lib directory relative to the installation
directory (or a processor specific sub-directory).
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User library

If you use your own library, the linker searches the library in the current directory only.

5.3.2. How the Linker Extracts Objects from Libraries

A library built with the TASKING archiver ar87 always contains an index part at the beginning of the
library. The linker scans this index while searching for unresolved externals. However, to keep the index
as small as possible, only the defined symbols of the library members are recorded in this area.

When the linker finds a symbol that matches an unresolved external, the corresponding object file is
extracted from the library and is processed. After processing the object file, the remaining library index
is searched. If after a complete search of the library unresolved externals are introduced, the library index
will be scanned again. After all files and libraries are processed, and there are still unresolved externals
and you did not specify the linker option --no-rescan, all libraries are rescanned again. This way you do
not have to worry about the library order on the command line and the order of the object files in the
libraries. However, this rescanning does not work for 'weak symbols'. If you use a weak symbol construction,
like printf, in an object file or your own library, you must position this object/library before the C library.

The option--verbose (-v) shows how libraries have been searched and which objects have been extracted.

Resolving symbols

If you are linking from libraries, only the objects that contain symbols to which you refer, are extracted
from the library. This implies that if you invoke the linker like:

lk87 mylib.lib

nothing is linked and no output file will be produced, because there are no unresolved symbols when the
linker searches through mylib.lib.

It is possible to force a symbol as external (unresolved symbol) with the option --extern (-e):

lk87 --extern=main mylib.lib

In this case the linker searches for the symbol main in the library and (if found) extracts the object that
contains main.

If this module contains new unresolved symbols, the linker looks again in mylib.lib. This process
repeats until no new unresolved symbols are found.

5.4. Incremental Linking

With the TASKING linker it is possible to link incrementally. Incremental linking means that you link some,
but not all .obj modules to a relocatable object file .out. In this case the linker does not perform the
locating phase. With the second invocation, you specify both new .obj files as the .out file you had
created with the first invocation.

Incremental linking is only possible on the command line.
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lk87 -dlc87.lsl --incremental test1.obj -otest.out
lk87 -dlc87.lsl test2.obj test.out

This links the file test1.obj and generates the file test.out.This file is used again and linked together
with test2.obj to create the file test.abs (the default name if no output filename is given in the default
ELF/DWARF format).

With incremental linking it is normal to have unresolved references in the output file until all .obj files
are linked and the final .out or .abs file has been reached.The option --incremental (-r) for incremental
linking also suppresses warnings and errors because of unresolved symbols.

5.5. Importing Binary Files

With the TASKING linker it is possible to add a binary file to your absolute output file. In an embedded
application you usually do not have a file system where you can get your data from. With the linker option
--import-object you can add raw data to your application. This makes it possible for example to display
images on a device or play audio.The linker puts the raw data from the binary file in a section.The section
is aligned on a 4-byte boundary.The section name is derived from the filename, in which dots are replaced
by an underscore. So, when importing a file called my.mp3, a section with the name my_mp3 is created.
In your application you can refer to the created section by using linker labels.

For example:

#include <stdio.h>
extern char   _lc_ub_my_mp3; /* linker labels */
extern char   _lc_ue_my_mp3;
char*   mp3 = &_lc_ub_my_mp3;

void main(void)
{
  int size = &_lc_ue_my_mp3 - &_lc_ub_my_mp3;
  int i;
  for (i=0;i<size;i++)
    putchar(mp3[i]);
}

If you want to use the export functionality of Eclipse, the binary file has to be part of your project.

5.6. Linking OPT Files and CGR Files

OPT files (.opt) and CGR files (.crd) are generated in Intel Hex format by the su.exe and cgr2.exe
tools respectively. They must be imported into the Eclipse project for inclusion in the executable image
by the linker.
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Automatically add an OPT file when you create a project

When you create a project with the New C Project wizard you can choose to add the derivative specific
OPT file to your project. This is explained in section Create a Project of the Getting Started with the
TASKING VX-toolset for LC87.

To add OPT files and/or CGR files to your project manually

1. In Eclipse, from the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Data Objects.

4. Browse for an OPT file or a CGR file, for example myproject.opt.

For example, if you added myproject.opt to the project, Eclipse will call the utility hex2bin to convert
the Intel Hex file myproject.opt to the binary file lc87opt_myproject.bin. Eclipse then calls the
linker with the option --import-object=lc87opt_myproject.bin.

To add OPT files and/or CGR files on the command line

Suppose you already have a myproject.obj, on the command line you can use the following commands:

hex2bin myproject.opt -o lc87opt_myproject.bin
lk87    myproject.obj --import-object=lc87opt_myproject.bin
        -o myproject.abs -lc -lfp -lrt

5.7. Linker Optimizations

During the linking and locating phase, the linker looks for opportunities to optimize the object code. Both
code size and execution speed can be optimized.

To enable or disable optimizations

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Optimization.

4. Enable one or more optimizations.
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You can enable or disable the optimizations described below. The command line option for each
optimization is given in brackets.

Delete unreferenced sections (option -Oc/-OC)

This optimization removes unused sections from the resulting object file.

First fit decreasing (option -Ol/-OL)

When the physical memory is fragmented or when address spaces are nested it may be possible that a
given application cannot be located although the size of the available physical memory is larger than the
sum of the section sizes. Enable the first-fit-decreasing optimization when this occurs and re-link your
application.

The linker's default behavior is to place sections in the order that is specified in the LSL file (that is, working
from low to high memory addresses or vice versa). This also applies to sections within an unrestricted
group. If a memory range is partially filled and a section must be located that is larger than the remainder
of this range, then the section and all subsequent sections are placed in a next memory range. As a result
of this gaps occur at the end of a memory range.

When the first-fit-decreasing optimization is enabled the linker will first place the largest sections in the
smallest memory ranges that can contain the section. Small sections are located last and can likely fit in
the remaining gaps.

Compress copy table (option -Ot/-OT)

The startup code initializes the application's data areas.The information about which memory addresses
should be zeroed and which memory ranges should be copied from ROM to RAM is stored in the copy
table.

When this optimization is enabled the linker will try to locate sections in such a way that the copy table
is as small as possible thereby reducing the application's ROM image.

Delete duplicate code (option -Ox/-OX)

Delete duplicate constant data (option -Oy/-OY)

These two optimizations remove code and constant data that is defined more than once, from the resulting
object file.

5.8. Controlling the Linker with a Script

With the options on the command line you can control the linker's behavior to a certain degree. From
Eclipse it is also possible to determine where your sections will be located, how much memory is available,
which sorts of memory are available, and so on. Eclipse passes these locating directions to the linker via
a script file. If you want even more control over the locating process you can supply your own script.
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The language for the script is called the Linker Script Language, or shortly LSL.You can specify the script
file to the linker, which reads it and locates your application exactly as defined in the script. If you do not
specify your own script file, the linker always reads a standard script file which is supplied with the toolset.

5.8.1. Purpose of the Linker Script Language

The Linker Script Language (LSL) serves three purposes:

1. It provides the linker with a definition of the target's core architecture. This definition is supplied with
the toolset.

2. It provides the linker with a specification of the memory attached to the target processor.

3. It provides the linker with information on how your application should be located in memory. This gives
you, for example, the possibility to create overlaying sections.

The linker accepts multiple LSL files.You can use the specifications of the core architectures that Altium
has supplied in the include.lsl directory. Do not change these files.

If you use a different memory layout than described in the LSL file supplied for the target core, you must
specify this in a separate LSL file and pass both the LSL file that describes the core architecture and your
LSL file that contains the memory specification to the linker. Next you may want to specify how sections
should be located and overlaid.You can do this in the same file or in another LSL file.

LSL has its own syntax. In addition, you can use the standard C preprocessor keywords, such as #include
and #define, because the linker sends the script file first to the C preprocessor before it starts interpreting
the script.

The complete LSL syntax is described in Chapter 12, Linker Script Language (LSL).

5.8.2. Eclipse and LSL

In Eclipse you can specify the size of the stack and heap; the physical memory attached to the processor;
identify that particular address ranges are reserved; and specify which sections are located where in
memory. Eclipse translates your input into an LSL file that is stored in the project directory under the
name project_name.lsl and passes this file to the linker. If you want to learn more about LSL you can
inspect the generated file project_name.lsl.

To add a generated Linker Script File to your project

1. From the File menu, select File » New » TASKING LC87 C Project.

The New C Project wizard appears.

2. Fill in the project settings in each dialog and click Next > until the following dialog appears.

145

Using the Linker



3. Enable the option Add linker script file to the project and click Finish.

Eclipse creates your project and the file "project_name.lsl" in the project directory.

If you do not add the linker script file here, you can always add it later with File » New » Linker Script
File (LSL)

To change the Linker Script File in Eclipse

There are two ways of changing the LSL file in Eclipse.

• You can change the LSL file directly in an editor.

1. Double-click on the file project_name.lsl.

The project LSL file opens in the editor area.
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2. You can edit the LSL file directly in the project_name.lsl editor.

A * appears in front of the name of the LSL file to indicate that the file has changes.

3. Click  or select File » Save to save the changes.

• You can also make changes to the property pages Memory and Stack/Heap.

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Memory or Stack/Heap.

In the right pane the corresponding property page appears.

3. Make changes to memory and/or stack/heap and click OK.

The project LSL file is updated automatically according to the changes you make in the pages.

You can quickly navigate through the LSL file by using the Outline view (Window » Show View » Outline).

5.8.3. Structure of a Linker Script File

A script file consists of several definitions. The definitions can appear in any order.

The architecture definition (required)

In essence an architecture definition describes how the linker should convert logical addresses into
physical addresses for a given type of core. If the core supports multiple address spaces, then for each
space the linker must know how to perform this conversion. In this context a physical address is an offset
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on a given internal or external bus. Additionally the architecture definition contains information about items
such as the (hardware) stack and the vector table.

This specification is normally written by Altium. Altium supplies LSL files in the include.lsl directory.

The architecture definition of the LSL file should not be changed by you unless you also modify the core's
hardware architecture. If the LSL file describes a multi-core system an architecture definition must be
available for each different type of core.

The linker uses the architecture name in the LSL file to identify the target. For example, the default library
search path can be different for each core architecture.

The derivative definition

The derivative definition describes the configuration of the internal (on-chip) bus and memory system.
Basically it tells the linker how to convert offsets on the buses specified in the architecture definition into
offsets in internal memory. Microcontrollers and DSPs often have internal memory and I/O sub-systems
apart from one or more cores. The design of such a chip is called a derivative.

When you want to use multiple cores of the same type, you must instantiate the cores in a derivative
definition, since the linker automatically instantiates only a single core for an unused architecture.

The processor definition

The processor definition describes an instance of a derivative. A processor definition is only needed in a
multi-processor embedded system. It allows you to define multiple processors of the same type.

If for a derivative 'A' no processor is defined in the LSL file, the linker automatically creates a processor
named 'A' of derivative 'A'.This is why for single-processor applications it is enough to specify the derivative
in the LSL file.

The memory and bus definitions (optional)

Memory and bus definitions are used within the context of a derivative definition to specify internal memory
and on-chip buses. In the context of a board specification the memory and bus definitions are used to
define external (off-chip) memory and buses. Given the above definitions the linker can convert a logical
address into an offset into an on-chip or off-chip memory device.

The board specification

The processor definition and memory and bus definitions together form a board specification. LSL provides
language constructs to easily describe single-core and heterogeneous or homogeneous multi-core
systems.The board specification describes all characteristics of your target board's system buses, memory
devices, I/O sub-systems, and cores that are of interest to the linker. Based on the information provided
in the board specification the linker can for each core:

• convert a logical address to an offset within a memory device

• locate sections in physical memory

• maintain an overall view of the used and free physical memory within the whole system while locating
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The section layout definition (optional)

The optional section layout definition enables you to exactly control where input sections are located.
Features are provided such as: the ability to place sections at a given address, to place sections in a
given order, and to overlay code and/or data sections.

Example: Skeleton of a Linker Script File

A linker script file that defines a derivative "X'" based on the LC87 architecture, its external memory and
how sections are located in memory, may have the following skeleton:

architecture LC87
{
    // Specification of the LC87 core architecture.
    // Written by Altium.
}

derivative X  // derivative name is arbitrary
{
    // Specification of the derivative.
    // Written by Altium.
    core LC87        // always specify the core
    {
       architecture = LC87;
    }

    bus local_bus   // local bus
    {
       // maps to bus "local_bus" in "LC87" core
    }

    // internal memory
}

processor spe        // processor name is arbitrary
{
    derivative = X;

    // You can omit this part, except if you use a
    // multi-core system.
}

memory ext_name
{
    // external memory definition
}

section_layout spe:LC87:code    // section layout
{
    // section placement statements
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    // sections are located in address space 'code'
    // of core 'LC87' of processor 'spe'
}

Overview of LSL files delivered by Altium

Altium supplies the following LSL files in the directory include.lsl.

DescriptionLSL file

Defines the base architecture and contains a default specification of the external
memory attached to the target processor.

lc87.lsl

Default LSL file on the command line.generic.lsl

This file includes a processor specific LSL file based on the selected processor.
See control program option --cpu.

device.lsl

Processor specific LSL file with a specification of the external memory attached
to the target processor.

processor.lsl

This file is used by Eclipse as a template for the project LSL file. It includes
the file lc87.lsl or device.lsl.

template.lsl

When you select to add a linker script file when you create a project in Eclipse, Eclipse makes a copy of
the file template.lsl and names it "project_name.lsl". On the command line, the linker uses the file
generic.lsl, unless you specify another file with the linker option --lsl-file (-d).

5.8.4.The Architecture Definition

Although you will probably not need to write an architecture definition (unless you are building your own
processor core) it helps to understand the Linker Script Language and how the definitions are interrelated.

Within an architecture definition the characteristics of a target processor core that are important for the
linking process are defined. These include:

• space definitions: the logical address spaces and their properties

• bus definitions: the I/O buses of the core architecture

• mappings: the address translations between logical address spaces, the connections between logical
address spaces and buses and the address translations between buses

Address spaces

A logical address space is a memory range for which the core has a separate way to encode an address
into instructions. Most microcontrollers and DSPs support multiple address spaces. For example, separate
spaces for code and data. Normally, the size of an address space is 2N, with N the number of bits used
to encode the addresses.

The relation of an address space with another address space can be one of the following:

• one space is a subset of the other. These are often used for "small" absolute or relative addressing.
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• the addresses in the two address spaces represent different locations so they do not overlap. This
means the core must have separate sets of address lines for the address spaces. For example, in
Harvard architectures we can identify at least a code and a data memory space.

Address spaces (even nested) can have different minimal addressable units (MAU), alignment restrictions,
and page sizes. All address spaces have a number that identifies the logical space (id). The following
table lists the different address spaces for the architecture LC87 as defined in lc87.lsl.

DescriptionMAUIdSpace

Code address space, specifies the start address.81code

Code address space bank 0, contains definitions for the copy table and the
vector table.

82code_bank0

Code address space bank 1.83code_bank1

Paged external data.84xdata

Indirect addressable data space, contains definitions for the stack and heap.86idata

Medium addressable data space.87mdata

Short addressable data space.88sdata

Data space.89bdata

Medium bit-addressable data space.110mbitdata

Bit-addressable data.111bitdata

Code address space in lowest 64 kB ROM.812zcode_bank0

Code address space in lowest 64 kB ROM of bank 1.813zcode_bank1

The LC87 architecture in LSL notation

The best way to program the architecture definition, is to start with a drawing. The figure below shows a
part of the architecture LC87

The figure shows three address spaces called idata, mdata and code. The address space mdata is
a subset of the address space idata. All address spaces have attributes like a number that identifies
the logical space (id), a MAU and an alignment. In LSL notation the definition of these address spaces
look as follows:
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space idata
{
     id  = 6;
     mau = 8;
     map (size=64k, dest_offset=0x0, dest=bus:idata_bus);
}

space mdata
{
     id  = 7;
     mau = 8;
     map (size=0x200, dest_offset=0x00, dest=space:idata);
}

space code
{
     id  = 1;
     mau = 8;
     page;
     page_size = 128;
     map (size=256k, dest_offset=0x00, dest=bus:program_bus);
}

The keyword map corresponds with the dotted lines in the drawing.You can map:

• address space => address space

• address space => bus

• memory => bus (not shown in the drawing)

• bus => bus (not shown in the drawing)

Next the internal buses named idata_bus and program_bus must be defined in LSL:

bus idata_bus
{
    mau = 8;
    width = 8;  // there are 8 data lines on the bus
}

bus program_bus
{
    mau = 8;
    width = 8;
}

This completes the LSL code in the architecture definition. Note that all code above goes into the
architecture definition, thus between:

architecture LC87
{
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    // All code above goes here.
}

5.8.5.The Derivative Definition

Although you will probably not need to write a derivative definition (unless you are using multiple cores
that both access the same memory device) it helps to understand the Linker Script Language and how
the definitions are interrelated.

A derivative is the design of a processor, as implemented on a chip (or FPGA). It comprises one or more
cores and on-chip memory. The derivative definition includes:

• core definition: an instance of a core architecture

• bus definition: the I/O buses of the core architecture

• memory definitions: internal (or on-chip) memory

Core

Each derivative must have at least one core and each core must have a specification of its core architecture.
This core architecture must be defined somewhere in the LSL file(s).

core LC87
{
    architecture = LC87;
}

Bus

Each derivative can contain a bus definition for connecting external memory. In this example, the bus
program_bus maps to the bus program_bus defined in the architecture definition of core LC87:

bus program_bus
{
   mau = 8;
   width = 8;
   map (dest=bus:LC87:program_bus, dest_offset=0, size=256k);
}

Memory

Memory is usually described in a separate memory definition, but you can specify on-chip memory for a
derivative. For example:
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According to the drawing, the LC87 contains internal RAM called i_ram with a size of 0xFE00. This is
physical memory which is mapped to the internal bus idata_bus. And LC87 contains two ROM banks
of 128k called i_rom0 and i_rom1 which are mapped to bus program_bus:

#define __IRAM_SIZE   0xFE00
#define __BANK0_SIZE  128k
#define __BANK1_SIZE  128k

memory i_ram
{
    mau  = 8;
    type = ram;
    size = __IRAM_SIZE;
    map( dest=bus:LC87:idata_bus, size = __IRAM_SIZE );
         // dest_offset and src_offset are zero by default
}

memory i_rom0
{
    mau  = 8;
    type = rom;
    size = __BANK0_SIZE;
    map( dest=bus:LC87:program_bus, size = __BANK0_SIZE );
         // dest_offset and src_offset are zero by default
}

memory i_rom1
{
    mau  = 8;
    type = rom;
    size = __BANK1_SIZE;
    map( dest=bus:LC87:program_bus, dest_offset=0x20000, 
         size = __BANK1_SIZE );
         // src_offset is zero by default
}

154

TASKING VX-toolset for LC87 User Guide



This completes the LSL code in the derivative definition. Note that all code above goes into the derivative
definition, thus between:

derivative X    // name of derivative
{
    // All code above goes here
}

5.8.6.The Processor Definition

The processor definition is only needed when you write an LSL file for a multi-processor embedded
system. The processor definition explicitly instantiates a derivative, allowing multiple processors of the
same type.

processor name
{
    derivative = derivative_name;
}

If no processor definition is available that instantiates a derivative, a processor is created with the same
name as the derivative.

5.8.7.The Memory Definition

Once the core architecture is defined in LSL, you may want to extend the processor with external (or
off-chip) memory.You need to specify the location and size of the physical external memory devices in
the target system.

The principle is the same as defining the core's architecture but now you need to fill the memory definition:

memory name
{
    // memory definitions
}

Suppose your embedded system has 56kB of external RAM, named x_ram, 8 kB of external NVRAM,
named my_nvram and 64kB of external ROM, named x_rom. x_ram, my_nvram and x_rom are all
connected to the bus xdata_bus. In LSL this looks like follows:

memory my_nvram
{
    mau = 8;
    type = nvram;
    size = 8k;
    map (dest = bus:LC87:xdata_bus, src_offset = 0, dest_offset = 0,
         size=8k);
}

memory x_ram
{
    mau = 8;
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    type = ram;
    size = 56k;
    map (dest = bus:LC87:xdata_bus, src_offset = 0, dest_offset = 8k,
         size=56k);
}

memory x_rom
{
    mau = 8;
    type = rom;
    size = 64k;
    map (dest = bus:LC87:xdata_bus, src_offset = 0, dest_offset = 64k,
         size=64k);
}

If you use a different memory layout than described in the LSL file supplied for the target core, you can
specify this in Eclipse or you can specify this in a separate LSL file and pass both the LSL file that describes
the core architecture and your LSL file that contains the memory specification to the linker.

To add memory using Eclipse

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Memory.

In the right pane the Memory page appears.

3. Open the Memory tab and click on the Add... button.

The Add new memory dialog appears.

4. Enter the memory name (for example my_nvram), type (for example nvram) and size.

5. Click on the Add... button.

The Add new mapping dialog appears.

6. You have to specify at least one mapping. Enter the mapping name (optional), address, size and
destination and click OK.

The new mapping is added to the list of mappings.

7. Click OK.

The new memory is added to the list of memories (user memory).

8. Click OK to close the Properties dialog.

The updated settings are stored in the project LSL file.
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If you make changes to the on-chip memory as defined in the architecture LSL file, the memory is copied
to your project LSL file and the line #define __MEMORY is added. If you remove all the on-chip memory
from your project LSL file, also make sure you remove this define.

5.8.8.The Section Layout Definition: Locating Sections

Once you have defined the internal core architecture and optional memory, you can actually define where
your application must be located in the physical memory.

During compilation, the compiler divides the application into sections. Sections have a name, an indication
(section type) in which address space it should be located and attributes like writable or read-only.

In the section layout definition you can exactly define how input sections are placed in address spaces,
relative to each other, and what their absolute run-time and load-time addresses will be.

Example: section propagation through the toolset

To illustrate section placement, the following example of a C program (bat.c) is used. The program
saves the number of times it has been executed in battery back-upped memory, and prints the number.

#define BATTERY_BACKUP_TAG  0xa5f0
#include <stdio.h>

int  uninitialized_data;
int  initialized_data = 1;
#pragma noclear
int  battery_backup_tag;
int  battery_backup_invok;
#pragma clear

void main (void)
{
    if (battery_backup_tag != BATTERY_BACKUP_TAG )
    {
        // battery back-upped memory area contains invalid data
        // initialize the memory
        battery_backup_tag = BATTERY_BACKUP_TAG;
        battery_backup_invok = 0;
    }
    printf( "This application has been invoked %d times\n",
             battery_backup_invok++);
}

The compiler assigns names and attributes to sections. The battery_backup_tag and
battery_backup_invok are placed in a section with the name ”.bss". Note that ".bss" sections are
cleared at startup. However, battery back-upped sections should not be cleared and therefore we used
#pragma noclear.
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Section placement

The number of invocations of the example program should be saved in non-volatile (battery back-upped)
memory. This is the memory my_nvram from the example in Section 5.8.7, The Memory Definition.

To control the locating of sections, you need to write one or more section definitions in the LSL file. At
least one for each address space where you want to change the default behavior of the linker.

section_layout ::xdata
{
    select "ELF sections";
    // Section placement statements
}

The space, in this case xdata, and the ELF sections must be a valid combination from the table in
Section 5.8.4, The Architecture Definition.

To locate sections, you must create a group in which you select sections from your program. For the
battery back-up example, we need to define one group, which contains the section .bss. All other sections
are located using the defaults specified in the architecture definition. Section .bss should be placed in
non-volatile ram. To achieve this, the run address refers to our non-volatile memory called my_nvram.

group ( ordered, run_addr = mem:my_nvram )
{
     select ".bss";
}

This completes the LSL file for the sample architecture and sample program.You can now invoke the
linker with this file and the sample program to obtain an application that works for this architecture.

For a complete description of the Linker Script Language, refer to Chapter 12, Linker Script Language
(LSL).

5.9. Linker Labels

The linker creates labels that you can use to refer to from within the application software. Some of these
labels are real labels at the beginning or the end of a section. Other labels have a second function, these
labels are used to address generated data in the locating phase. The data is only generated if the label
is used.

Linker labels are labels starting with _lc_. The linker assigns addresses to the following labels when
they are referenced:

DescriptionLabel

Begin of section name. Also used to mark the begin of the stack or heap or
copy table.

_lc_ub_name

_lc_b_name
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DescriptionLabel

End of section name. Also used to mark the end of the stack or heap._lc_ue_name

_lc_e_name

Start address of an overlay section in ROM._lc_cb_name

End address of an overlay section in ROM._lc_ce_name

Begin of group name. This label appears in the output file even if no reference
to the label exists in the input file.

_lc_gb_name

End of group name. This label appears in the output file even if no reference
to the label exists in the input file.

_lc_ge_name

The linker only allocates space for the stack and/or heap when a reference to either of the section labels
exists in one of the input object files.

If you want to use linker labels in your C source for sections that have a dot (.) in the name, you
have to replace all dots by underscores.

Example: refer to a label with section name with dots from C

Suppose a section has the name .text. When you want to refer to the begin of this section you have to
replace all dots in the section name by underscores:

#include <stdio.h>
extern void * _lc_ub__text;

void main(void)
{
    printf("The function main is located at %x\n",
            &_lc_ub__text);
}

Example: refer to the stack

Suppose in an LSL file a stack section is defined with the name "stack" (with the keyword stack).You
can refer to the begin and end of the stack from your C source as follows:

#include <stdio.h>
extern char _lc_ub_stack[];
extern char _lc_ue_stack[];
void main()
{
  printf( "Size of stack is %d\n", 
          _lc_ue_stack - _lc_ub_stack );
}

From assembly you can refer to the begin of the stack with:
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  .extern _lc_ub_stack   ; begin of stack

5.10. Generating a Map File

The map file is an additional output file that contains information about the location of sections and symbols.
You can customize the type of information that should be included in the map file.

To generate a map file

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Map File.

4. Enable the option Generate XML map file format (.mapxml) for map file viewer.

5. (Optional) Enable the option Generate map file (.map).

6. (Optional) Enable the options to include that information in the map file.

Example on the command line (Windows Command Prompt)

The following command generates the map file test.map:

lk87 --map-file test.obj

With this command the map file test.map is created.

See Section 10.2, Linker Map File Format, for an explanation of the format of the map file.

5.11. Linker Error Messages

The linker reports the following types of error messages in the Problems view of Eclipse.

F ( Fatal errors)

After a fatal error the linker immediately aborts the link/locate process.

E (Errors)

Errors are reported, but the linker continues linking and locating. No output files are produced unless you
have set the linker option--keep-output-files.
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W (Warnings)

Warning messages do not result into an erroneous output file. They are meant to draw your attention to
assumptions of the linker for a situation which may not be correct.You can control warnings in the C/C++
Build » Settings » Tool Settings » Linker » Diagnostics page of the Project » Properties for menu
(linker option --no-warnings).

I (Information)

Verbose information messages do not indicate an error but tell something about a process or the state
of the linker. To see verbose information, use the linker option--verbose.

S (System errors)

System errors occur when internal consistency checks fail and should never occur.When you still receive
the system error message

S6##: message

please report the error number and as many details as possible about the context in which the error
occurred.

Display detailed information on diagnostics

1. From the Window menu, select Show View » Other » TASKING » Problems.

The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.

A popup menu appears.

3. Select Detailed Diagnostics Info.

A dialog box appears with additional information.

On the command line you can use the linker option --diag to see an explanation of a diagnostic message:

lk87 --diag=[format:]{all | number,...]
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Chapter 6. Using the Utilities
The TASKING VX-toolset for LC87 comes with a number of utilities:

A control program. The control program invokes all tools in the toolset and lets you quickly
generate an absolute object file from C and/or assembly source input files. Eclipse uses
the control program to call the compiler, assembler and linker.

cc87

The make utility which is used in Eclipse. It supports parallelism which utilizes the multiple
cores found on modern host hardware.

amk

An archiver. With this utility you create and maintain library files with relocatable object
modules (.obj) generated by the assembler.

ar87

A high level language (HLL) object dumper.With this utility you can dump information about
an absolute object file (.abs) . Key features are a disassembler with HLL source intermixing
and HLL symbol display and a HLL symbol listing of static and global symbols.

hldump87

A utility to limit the size of the cache by removing all files older than a few days or by
removing older files until the total size of the cache is smaller than a specified size.

expire87

A utility to convert Motorola S-record files and Intel Hex files to binary files. Use this utility
to convert OPT files and CGR files to binary files.

hex2bin

6.1. Control Program

The control program is a tool that invokes all tools in the toolset for you. It provides a quick and easy way
to generate the final absolute object file out of your C sources without the need to invoke the compiler,
assembler and linker manually.

Eclipse uses the control program to call the C compiler, assembler and linker, but you can call the control
program from the command line. The invocation syntax is:

cc87 [ [option]... [file]... ]...

Recognized input files

• Files with a .c suffix are interpreted as C source programs and are passed to the compiler.

• Files with a .asm suffix are interpreted as hand-written assembly source files which have to be passed
to the assembler.

• Files with a .src suffix are interpreted as compiled assembly source files. They are directly passed to
the assembler.

• Files with a .lib suffix are interpreted as library files and are passed to the linker.

• Files with a .obj suffix are interpreted as object files and are passed to the linker.

• Files with a .out suffix are interpreted as linked object files and are passed to the locating phase of
the linker. The linker accepts only one .out file in the invocation.
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• Files with a .lsl suffix are interpreted as linker script files and are passed to the linker.

Options

The control program accepts several command line options. If you specify an unknown option to the
control program, the control program looks if it is an option for a specific tool. If so, it passes the option
directly to the tool. However, it is recommended to use the control program options --pass-* (-Wc, -Wa,
-Wl) to pass arguments directly to tools.

For a complete list and description of all control program options, see Section 8.5, Control Program
Options.

Example with verbose output

cc87 --verbose test.c

The control program calls all tools in the toolset and generates the absolute object file test.abs. With
option --verbose (-v) you can see how the control program calls the tools:

+ "path\c87" -o cc3248a.src test.c
+ "path\as87" -o cc3248b.obj cc3248a.src
+ "path\lk87" cc3248b.obj -o test.abs --map-file 
      -lc -lfp -lrt"

The control program produces unique filenames for intermediate steps in the compilation process (such
as cc3248a.src and cc3248b.obj in the example above) which are removed afterwards, unless you
specify command line option --keep-temporary-files (-t).

Example with argument passing to a tool

cc87 --pass-compiler=-Oc test.c

The option -Oc is directly passed to the compiler.
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6.2. Make Utility amk

amk is the make utility Eclipse uses to maintain, update, and reconstruct groups of programs. But you
can also use it on the command line. The main difference compared to other make utilities, is that amk
features parallelism which utilizes the multiple cores found on modern host hardware, hardening for path
names with embedded white space and it has an (internal) interface to provide progress information for
updating a progress bar. It does not use an external command shell (/bin/sh, cmd.exe) but executes
commands directly.

The primary purpose of any make utility is to speed up the edit-build-test cycle. To avoid having to build
everything from scratch even when only one source file changes, it is necessary to describe dependencies
between source files and output files and the commands needed for updating the output files. This is
done in a so called "makefile".

6.2.1. Makefile Rules

A makefile dependency rule is a single line of the form:

[target ...] : [prerequisite ...]

where target and prerequisite are path names to files. Example:

test.obj : test.c

This states that target test.obj depends on prerequisite test.c. So, whenever the latter is modified
the first must be updated. Dependencies accumulate: prerequisites and targets can be mentioned in
multiple dependency rules (circular dependencies are not allowed however).The command(s) for updating
a target when any of its prerequisites have been modified must be specified with leading white space
after any of the dependency rule(s) for the target in question. Example:

test.obj :
  cc87 test.c   # leading white space

Command rules may contain dependencies too. Combining the above for example yields:

test.obj : test.c
  cc87 test.c

White space around the colon is not required. When a path name contains special characters such as
':', '#' (start of comment), '=' (macro assignment) or any white space, then the path name must be enclosed
in single or double quotes. Quoted strings can contain anything except the quote character itself and a
newline. Two strings without white space in between are interpreted as one, so it is possible to embed
single and double quotes themselves by switching the quote character.

When a target does not exist, its modification time is assumed to be very old. So, amk will try to make it.
When a prerequisite does not exist possibly after having tried to make it, it is assumed to be very new.
So, the update commands for the current target will be executed in that case. amk will only try to make
targets which are specified on the command line.The default target is the first target in the makefile which
does not start with a dot.
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Static pattern rules

Static pattern rules are rules which specify multiple targets and construct the prerequisite names for each
target based on the target name.

[target ...] : target-pattern : [prerequisite-patterns ...]

The target specifies the targets the rules applies to. The target-pattern and prerequisite-patterns specify
how to compute the prerequisites of each target. Each target is matched against the target-pattern to
extract a part of the target name, called the stem. This stem is substituted into each of the
prerequisite-patterns to make the prerequisite names (one from each prerequisite-pattern).

Each pattern normally contains the character '%' just once. When the target-pattern matches a target,
the '%' can match any part of the target name; this part is called the stem. The rest of the pattern must
match exactly. For example, the target foo.obj matches the pattern '%.obj', with 'foo' as the stem.
The targets foo.c and foo.abs do not match that pattern.

The prerequisite names for each target are made by substituting the stem for the '%' in each prerequisite
pattern.

Example:

objects = test.obj filter.obj

all: $(objects)

$(objects): %.obj: %.c
    cc87 -c $< -o $@
    echo the stem is $*

Here '$<' is the automatic variable that holds the name of the prerequisite, '$@' is the automatic variable
that holds the name of the target and '$*' is the stem that matches the pattern. Internally this translates
to the following two rules:

test.obj: test.c
    cc87 -c test.c -o test.obj
    echo the stem is test

filter.obj: filter.c
    cc87 -c filter.c -o filter.obj
    echo the stem is filter

Each target specified must match the target pattern; a warning is issued for each target that does not.
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Special targets

There are a number of special targets. Their names begin with a period.

DescriptionTarget

If you call the make utility with a target that has no definition in the makefile, this
target is built.

.DEFAULT

When the make utility has finished building the specified targets, it continues with
the rules following this target.

.DONE

The rules following this target are executed before any other targets are built..INIT

The prerequisites of this target are considered to be phony targets. A phony target
is a target that is not really the name of a file. The rules following a phony target are
executed unconditionally, regardless of whether a file with that name exists or what
its last-modification time is.

For example:

.PHONY: clean

clean:
        rm *.obj

With amk clean, the command is executed regardless of whether there is a file
named clean.

.PHONY

6.2.2. Makefile Directives

Directives inside makefiles are executed while reading the makefile. When a line starts with the word
"include" or "-include" then the remaining arguments on that line are considered filenames whose
contents are to be inserted at the current line. "-include" will silently skip files which are not present.
You can include several files. Include files may be nested.

Example:

include makefile2 makefile3

White spaces (tabs or spaces) in front of the directive are allowed.

6.2.3. Macro Definitions

A macro is a symbol name that is replaced with its definition before the makefile is executed. Although
the macro name can consist of lowercase or uppercase characters, uppercase is an accepted convention.
When a line does not start with white space and contains the assignment operator '=', ':=' or '+=' then the
line is interpreted as a macro definition. White space around the assignment operator and white space
at the end of the line is discarded. Single character macro evaluation happens by prefixing the name with
'$'. To evaluate macros with names longer than one character put the name between parentheses '()' or
curly braces '{}'. Macro names may contain anything, even white space or other macro evaluations.
Example:
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DINNER = $(FOOD) and $(BEVERAGE)
FOOD = pizza
BEVERAGE = sparkling water
FOOD += with cheese

With the += operator you can add a string to an existing macro. An extra space is inserted before the
added string automatically.

Macros are evaluated recursively. Whenever $(DINNER) or ${DINNER} is mentioned after the above,
it will be replaced by the text "pizza with cheese and sparkling water". The left hand side in
a macro definition is evaluated before the definition takes place. Right hand side evaluation depends on
the assignment operator:

Evaluate the macro at the moment it is used.=

Evaluate the replacement text before defining the macro.:=

Subsequent '+=' assignments will inherit the evaluation behavior from the previous assignment. If there
is none, then '+=' is the same as '='.The default value for any macro is taken from the environment. Macro
definitions inside the makefile overrule environment variables. Macro definitions on the amk command
line will be evaluated first and overrule definitions inside the makefile.

Predefined macros

DescriptionMacro

This macro translates to a dollar sign.Thus you can use "$$" in the makefile to represent
a single "$".

$

The name of the current target. When a rule has multiple targets, then it is the name
of the target that caused the rule commands to be run.

@

The basename (or stem) of the current target. The stem is either provided via a static
pattern rule or is calculated by removing all characters found after and including the
last dot in the current target name. If the target name is 'test.c' then the stem is
'test' (if the target was not created via a static pattern rule).

*

The name of the first prerequisite.<

The amk path name (quoted if necessary). Optionally followed by the options -n and
-s.

MAKE

The name of the directory where amk is installed (quoted if necessary).ORIGIN

The argument of option -G. If you have nested makes with -G options, the paths are
combined. This macro is defined in the environment (i.e. default macro value).

SUBDIR

The @, * and < macros may be suffixed by 'D' to specify the directory component or by 'F' to specify the
filename component. $(@D) evaluates to the directory name holding the file$(@F). $(@D)/$(@F) is
equivalent to $@. Note that on MS-Windows most programs accept forward slashes, even for UNC path
names.

The result of the predefined macros @, * and < and 'D' and 'F' variants is not quoted, so it may be necessary
to put quotes around it.
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Note that stem calculation can cause unexpected values. For example:

$@ $*
    /home/.wine/test      /home/
    /home/test/.project   /home/test/
    /../file              /.

Macro string substitution

When the macro name in an evaluation is followed by a colon and equal sign as in

$(MACRO:string1=string2)

then amk will replace string1 at the end of every word in $(MACRO) by string2 during evaluation. When
$(MACRO) contains quoted path names, the quote character must be mentioned in both the original string
and the replacement string1. For example:

$(MACRO:.obj"=.d")

6.2.4. Makefile Functions

A function not only expands but also performs a certain operation. The following functions are available:

$(filter pattern ...,item ...)

The filter function filters a list of items using a pattern. It returns items that do match any of the pattern
words, removing any items that do not match. The patterns are written using '%',

    ${filter %.c %.h, test.c test.h test.obj readme.txt .project output.c}

results in:

    test.c test.h output.c

$(filter-out pattern ...,item ...)

The filter-out function returns all items that do not match any of the pattern words, removing the
items that do match one or more. This is the exact opposite of the filter function.

    ${filter-out %.c %.h, test.c test.h test.obj readme.txt .project output.c}

results in:

    test.obj readme.txt .project

1Internally, amk tokenizes the evaluated text, but performs substitution on the original input text to preserve compatibility here with
existing make implementations and POSIX.
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$(foreach var-name, item ..., action)

The foreach function runs through a list of items and performs the same action for each item. The
var-name is the name of the macro which gets dynamically filled with an item while iterating through the
item list. In the action you can refer to this macro. For example:

    ${foreach T, test filter output, ${T}.c ${T}.h}

results in:

    test.c test.h filter.c filter.h output.c output.h

6.2.5. Conditional Processing

Lines containing ifdef, ifndef, else or endif are used for conditional processing of the makefile.
They are used in the following way:

ifdef macro-name
if-lines
else
else-lines
endif

The if-lines and else-lines may contain any number of lines or text of any kind, even other ifdef, ifndef,
else and endif lines, or no lines at all.The else line may be omitted, along with the else-lines following
it. White spaces (tabs or spaces) in front of preprocessing directives are allowed.

First the macro-name after the ifdef command is checked for definition. If the macro is defined then
the if-lines are interpreted and the else-lines are discarded (if present). Otherwise the if-lines are discarded;
and if there is an else line, the else-lines are interpreted; but if there is no else line, then no lines are
interpreted.

When you use the ifndef line instead of ifdef, the macro is tested for not being defined. These
conditional lines can be nested to any level.

You can also add tests based on strings. With ifeq the result is true if the two strings match, with ifneq
the result is true if the two strings do not match. They are used in the following way:

ifeq(string1,string2)
if-lines
else
else-lines
endif

6.2.6. Makefile Parsing

amk reads and interprets a makefile in the following order:

1. When the last character on a line is a backslash (\) (i.e. without trailing white space) then that line and
the next line will be concatenated, removing the backslash and newline.
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2. The unquoted '#' character indicates start of comment and may be placed anywhere on a line. It will
be removed in this phase.

# this comment line is continued\
on the next line

3. Trailing white space is removed.

4. When a line starts with white space and it is not followed by a directive or preprocessing directive, then
it is interpreted as a command for updating a target.

5. Otherwise, when a line contains the unquoted text '=', '+=' or ':=' operator, then it will be interpreted as
a macro definition.

6. Otherwise, all macros on the line are evaluated before considering the next steps.

7. When the resulting line contains an unquoted ':' the line is interpreted as a dependency rule.

8. When the first token on the line is "include" or "-include" (which by now must start on the first
column of the line), amk will execute the directive.

9. Otherwise, the line must be empty.

Macros in commands for updating a target are evaluated right before the actual execution takes place
(or would take place when you use the -n option).

6.2.7. Makefile Command Processing

A line with leading white space (tabs or spaces) without a (preprocessing) directive is considered as a
command for updating a target. When you use the option -j or -J, amk will execute the commands for
updating different targets in parallel. In that case standard input will not be available and standard output
and error output will be merged and displayed on standard output only after the commands have finished
for a target.

You can precede a command by one or more of the following characters:

Do not show the command. By default, commands are shown prior to their output.@

Continue upon error. This means that amk ignores a non-zero exit code of the command.-

Execute the command, even when you use option -n (dry run).+

Execute the command on the foreground with standard input, standard output and error
output available.

|

Built-in commands

DescriptionCommand

This command does nothing. Arguments are ignored.true

This command does nothing, except failing with exit code 1. Arguments are
ignored.

false
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DescriptionCommand

Display a line of text.echo arg...

Exit with defined code. Depending on the program arguments and/or the extra
rule options '-' this will cause amk to exit with the provided code. Please note
that 'exit 0' has currently no result.

exit code

Create an argument file suitable for the --option-file (-f) option of all the other
tools. The first argfile argument is the name of the file to be created.
Subsequent arguments specify the contents. An existing argument file is not
modified unless necessary. So, the argument file itself can be used to create
a dependency to options of the command for updating a target.

argfile file arg...

Remove the specified file(s). The following options are available:

Remove directories and their contents recursively.-r, --recursive

Force deletion. Ignore non-existent files, never prompt.-f, --force

Interactive. Prompt before every removal.-i, --interactive

Verbose mode. Explain what is being done.-v, --verbose

Read options from file..-m file

Show usage.-?, --help

rm [option]... file...

6.2.8. Calling the amk Make Utility

The invocation syntax of amk is:

amk [option]... [target]... [macro=def]...

For example:

amk test.abs

You can specify any target that is defined in the makefile. A target can also be one
of the intermediate files specified in the makefile.

target

Macro definition.This definition remains fixed for the amk invocation. It overrides any
regular definitions for the specified macro within the makefiles and from the
environment. It is not inherited by subordinate amk's

macro=def

For a complete list and description of all amk make utility options, see Section 8.6,
Parallel Make Utility Options.

option

Exit status

The make utility returns an exit status of 1 when it halts as a result of an error. Otherwise it returns an
exit status of 0.
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6.3. Archiver

The archiver ar87 is a program to build and maintain your own library files. A library file is a file with
extension .lib and contains one or more object files (.obj) that may be used by the linker.

The archiver has five main functions:

• Deleting an object module from the library

• Moving an object module to another position in the library file

• Replacing an object module in the library or add a new object module

• Showing a table of contents of the library file

• Extracting an object module from the library

The archiver takes the following files for input and output:

The linker optionally includes object modules from a library if that module resolves an external symbol
definition in one of the modules that are read before.

6.3.1. Calling the Archiver

You can create a library in Eclipse, which calls the archiver or you can call the archiver on the command
line.

To create a library in Eclipse

Instead of creating an LC87 absolute ELF file, you can choose to create a library.You do this when you
create a new project with the New C Project wizard.

1. From the File menu, select New » TASKING LC87 C Project.

The New C Project wizard appears.

2. Enter a project name.

3. In the Project type box, select TASKING LC87 Library and clickNext >.

4. Follow the rest of the wizard and click Finish.

5. Add the files to your project.
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6. Build the project as usual. For example, select Project » Build Project ( ).

Eclipse builds the library. Instead of calling the linker, Eclipse now calls the archiver.

Command line invocation

You can call the archiver from the command line. The invocation syntax is:

ar87 key_option [sub_option...] library [object_file]

With a key option you specify the main task which the archiver should perform.You
must always specify a key option.

key_option

Sub-options specify into more detail how the archiver should perform the task that is
specified with the key option. It is not obligatory to specify sub-options.

sub_option

The name of the library file on which the archiver performs the specified action.You
must always specify a library name, except for the options -? and -V. When the library
is not in the current directory, specify the complete path (either absolute or relative) to
the library.

library

The name of an object file.You must always specify an object file name when you
add, extract, replace or remove an object file from the library.

object_file

Options of the archiver utility

The following archiver options are available:

Sub-optionOptionDescription

Main functions (key options)

-a -b -c -u -v-rReplace or add an object module

-v-xExtract an object module from the library

-v-dDelete object module from library

-a -b -v-mMove object module to another position

-s0 -s1-tPrint a table of contents of the library

-pPrint object module to standard output

Sub-options

-a nameAppend or move new modules after existing module name

-b nameAppend or move new modules before existing module name

-cCreate library without notification if library does not exis

-oPreserve last-modified date from the library

-s{0|1}Print symbols in library modules

-uReplace only newer modules

-vVerbose

Miscellaneous
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Sub-optionOptionDescription

-?Display options

-VDisplay version header

-f fileRead options from file

-wnSuppress warnings above level n

For a complete list and description of all archiver options, see Section 8.7, Archiver Options.

6.3.2. Archiver Examples

Create a new library

If you add modules to a library that does not yet exist, the library is created. To create a new library with
the name mylib.lib and add the object modules cstart.obj and calc.obj to it:

ar87 -r mylib.lib cstart.obj calc.obj

Add a new module to an existing library

If you add a new module to an existing library, the module is added at the end of the module. (If the
module already exists in the library, it is replaced.)

ar87 -r mylib.lib mod3.obj

Print a list of object modules in the library

To inspect the contents of the library:

ar87 -t mylib.lib

The library has the following contents:

cstart.obj
calc.obj
mod3.obj

Move an object module to another position

To move mod3.obj to the beginning of the library, position it just before cstart.obj:

ar87 -mb cstart.obj mylib.lib mod3.obj

Delete an object module from the library

To delete the object module cstart.obj from the library mylib.lib:

ar87 -d mylib.lib cstart.obj
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Extract all modules from the library

Extract all modules from the library mylib.lib:

ar87 -x mylib.lib
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6.4. HLL Object Dumper

The high level language (HLL) dumper hldump87 is a program to dump information about an absolute
object file (.abs) . Key features are a disassembler with HLL source intermixing and HLL symbol display
and a HLL symbol listing of static and global symbols.

6.4.1. Invocation

Command line invocation

You can call the HLL dumper from the command line. The invocation syntax is:

hldump87 [option]... file...

The input file must be an ELF file with or without DWARF debug info (.abs).

The HLL dumper can process multiple input files. Files and options can be intermixed on the command
line. Options apply to all supplied files. If multiple files are supplied, the disassembly of each file is preceded
by a header to indicate which file is dumped. For example:

========== file.abs ==========

For a complete list and description of all options, see Section 8.8, HLL Object Dumper Options. With
hldump87 --help you will see the options on stdout.

6.4.2. HLL Dump Output Format

The HLL dumper produces output in text format by default, but you can also specify the XML output format
with --output-type=xml. The XML output is mainly for use in the Eclipse editor. The output is printed on
stdout, unless you specify an output file with --output=filename.

The parts of the output are dumped in the following order:

1. Module list

2. Section list

3. Section dump (disassembly)

4. HLL symbol table

5. Assembly level symbol table

6. Note sections

With the option --dump-format=flag you can control which parts are shown. By default, all parts are
shown.
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Example

Suppose we have a simple "Hello World" program in a file called hello.c. We call the control program
as follows:

cc87 -g -t hello.c

Option -g tells to include DWARF debug information. Option -t tells to keep the intermediate files. This
command results (among other files) in the file hello.abs (the absolute output file).

We can dump information about the absolute object file with the following command:

hldump87 hello.abs

---------- Module list ----------

Name    Full path
hello.c hello.c

---------- Section list ----------

Address  Size   Align Type Name
00000675      9     1 text .text.hello.main
00000133     14     1 bss  .data.hello.$1$str
0000004e     29     1 text .text0.libc.__START
000002de    169     1 text .text.libc.__cinit

---------- Section dump ----------

                                       .section .text.hello.main
00000675 47 33 01     _main            ldw    #0x0133
00000678 97 02 00                      stw    r1
0000067b 20 e5 03                      jmp   _printf
                                       .endsec

    .section [.data.hello.$1$str]
    , at 000006ec
    .db 48,65,6c,6c,6f,20,77,6f,72,6c,64,21,0a,00      ; Hello world!..
    .endsec

---------- HLL symbol table ----------

Address       Size HLL Type             Name
6:00000006       2 void                 _Exit(int __data val)
6:0000001a      80 static char   __data stdin_buf[80] [_iob.c]
6:0000006a      80 static char   __data stdout_buf[80] [_iob.c]
6:000003e5      79 int __rom __reentrant printf(const char __data * restrict format, ...)
6:000000ba      11 struct        __data _dbg_request [dbg.c]
6:00000675       9 void                 main()

---------- assembly level symbol table ----------
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Address     Size    Type Name
0:00000000               
0:00000000               _Exit.c
0:00000000               hello.c
1:00000006        2 code __Exit
1:000004df       79 code _printf
1:0000074b       10 code _main
2:00000108       29 code __START
6:00000100       11 data __dbg_request

Module list

This part lists all modules (C files) found in the object file(s). It lists the filename and the complete path
name at the time the module was built.

Section list

This part lists all sections found in the object file(s).

The start address of the section. Hexadecimal, 8 digits, 32-bit.Address

The size (length) of the section in bytes. Decimal, filled up with spaces.Size

The alignment of the section in number of bytes. Decimal, filled up with spaces.Align

The section type.Type

The name of the section.Name

With option --sections=name[,name]... you can specify a list of sections that should be dumped.

Section dump

This part contains the disassembly. It consists of the following columns:

Contains the address of the instruction or directive that is shown in the disassembly.
If the section is relocatable the section start address is assumed to be 0. The
address is represented in hexadecimal and has a fixed width. The address is
padded with zeros. No 0x prefix is displayed. For example, on a 32-bit architecture,
the address 0x32 is displayed as 00000032.

address column

Shows the hexadecimal encoding of the instruction (code sections) or it shows the
hexadecimal representation of data (data sections). The encoding column has a
maximum width of eight digits, i.e. it can represent a 32-bit hexadecimal value.
The encoding is padded to the size of the data or instruction. For example, a 16-bit
instruction only shows four hexadecimal digits. The encoding is aligned left and
padded with spaces to fill the eight digits.

encoding column

Displays the label depending on the option --symbols=[hll|asm|none].The default
is asm, meaning that the low level (ELF) symbols are used.With hll, HLL (DWARF)
symbols are used. With none, no symbols will be included in the disassembly.

label column
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For code sections the instructions are disassembled. Operands are replaced with
labels, depending on the option --symbols=[hll|asm|none].

The contents of data sections are represented by directives. A new directive will
be generated for each symbol. ELF labels in the section are used to determine
the start of a directive. ROM sections are represented with .db, .dh, .dw, .dd
kind of directives, depending on the size of the data. RAM sections are represented
with .ds directives, with a size operand depending on the data size. This can be
either the size specified in the ELF symbol, or the size up to the next label.

disassembly column

With option --hex, no directives will be generated for ROM data sections and no disassembly dump will
be done for code sections. Instead a hex dump is done with the following format:

AAAAAAAA H0 H1 H2 H3 H4 H5 H6 H7 H8 H9 HA HB HC HD HE HF RRRRRRRRRRRRRRRR

where,

A = Address (8 digits, 32-bit)

Hx = Hex contents, one byte (16 bytes max)

R = ASCII representation (16 characters max)

For example:

                          section 55 ([.data]):
000000fa 48 65 6c 6c 6f 20 77 6f 72 6c 64 21 0a 00     Hello %s!..

With option --hex, RAM sections will be represented with only a start address and a size indicator:

AAAAAAAA Space: 48 bytes

With option --disassembly-intermix you can intermix the disassembly with HLL source code.

HLL symbol table

This part contains a symbol listing based on the HLL (DWARF) symbols found in the object file(s). The
symbols are sorted on address.

The start address of the symbol. Hexadecimal, 8 digits, 32-bit.The number in front
of the address indicates the space id number as specified in the LSL file. For
example, 6: indicates space idata.

Address

The size of the symbol from the DWARF info in bytes.Size

The HLL symbol type.HLL Type

The name of the HLL symbol.Name

HLL arrays are indicated by adding the size in square brackets to the symbol name. For example:

6:0000001a      80 static char   __data stdin_buf[80] [_iob.c]
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With option --expand-symbols=+basic-types HLL struct and union symbols are listed including all fields.
Array members are expanded in one array member per line regardless of the HLL type. For example:

6:0000001a      80 static char   __data stdin_buf[80] [_iob.c]
6:0000001a       1   char
6:0000001b       1   char
6:0000001c       1   char
  ...
6:00000069       1   char

HLL struct and union symbols are listed by default without fields. For example:

6:000000ba      11 struct        __data _dbg_request [dbg.c]

With option --expand-symbols all struct, union and array fields are included as well. For the fields the
types and names are indented with two spaces. For example:

6:000000ba      11 struct        __data _dbg_request [dbg.c]
6:000000ba       2   int                  _errno
6:000000bc       1   enum                 nr
6:000000bd       8   union                u
6:000000bd       2     struct               exit
6:000000bd       2       int                  status
6:000000bd       4     struct               open
6:000000bd       2       const char  __data * pathname
6:000000bf       2       unsigned short int   flags
   ...

Functions are displayed with the full function prototype. Size is the size of the function. HLL Type is the
return type of the function. For example:

6:000003e5      79 int __rom __reentrant printf(const char __data * restrict format, ...)

The local and static symbols get an identification between square brackets. The filename is printed if and
if a function scope is known the function name is printed between the square brackets as well. If multiple
files with the same name exist, the unique part of the path is added. For example:

6:0000010b       2 int                  count [file.c, somefunc()]
6:0000010d       2 int                  count [x\a.c]
6:0000010f       2 int                  count [y\a.c, foo()]

Global symbols do not get information in square brackets.

Assembly level symbol table

This part contains a symbol listing based on the assembly level (ELF) symbols found in the object file(s).
The symbols are sorted on address.

The start address of the symbol. Hexadecimal, 8 digits, 32-bit.The number in front
of the address indicates the space id number as specified in the LSL file. For
example, 1: indicates space code.

Address
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The size of the symbol from the ELF info in bytes. If this field is empty, the size is
zero.

Size

Code or Data, depending on the section the symbol belongs to. If this field is empty,
the symbol does not belong to a section.

Type

The name of the ELF symbol.Name
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6.5. Expire Cache Utility

With the utility expire87 you can limit the size of the cache (C compiler option --cache) by removing all
files older than a few days or by removing older files until the total size of the cache is smaller than a
specified size. See also section Compiler Cache in Section 3.6, Influencing the Build Time.

The invocation syntax is:

expire87 [option]... cache-directory

The compiler cache is present in the directory c87cache under the specified cache-directory.

For a complete list and description of all options, see Section 8.9, Expire Cache Utility Options. With
expire87 --help you will see the options on stdout.

Examples

To remove all files older than seven days, enter:

expire87 --days=7 "installation-dir\mproject\.cache"

To reduce the compiler cache size to 4 MB, enter:

expire87 --megabytes=4 "installation-dir\mproject\.cache"

Older files are removed until the total size of the cache is smaller than 4 MB.

To clear the compiler cache, enter:

expire87 --megabytes=0 "installation-dir\mproject\.cache"
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6.6. Hex to Binary Converter

hex2bin is a utility to convert Motorola S-record files and Intel Hex files to binary files. Use this utility to
convert OPT files and CGR files to binary files.

The invocation syntax is:

hex2bin [option...] [sre] [hex] [opt] [crd]

The following options are available:

DescriptionOption

Specify the Motorola S-record file-m sre

Specify the Intel Hex file-i hex

Specify the binary output file-o bin

You can omit the -m and -i options when the Hex file has a standard suffix: .sre for Motorola S-record
file, .hex, .opt and .crd for Intel hex file. The output file will have the suffix .bin.

For example:

hex2bin myproject.opt -o lc87opt_myproject.bin
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Chapter 7. Using the Debugger
This chapter describes the debugger and how you can run and debug a C application. This chapter only
describes the TASKING specific parts.

7.1. Reading the Eclipse Documentation

Before you start with this chapter, it is recommended to read the Eclipse documentation first. It provides
general information about the debugging process.This chapter guides you through a number of examples
using the TASKING debugger with simulation as target.

You can find the Eclipse documentation as follows:

1. Start Eclipse.

2. From the Help menu, select Help Contents.

The help screen overlays the Eclipse Workbench.

3. In the left pane, select C/C++ Development User Guide.

4. Open the Getting Started entry and select Debugging projects.

This Eclipse tutorial provides an overview of the debugging process. Be aware that the Eclipse
example does not use the TASKING tools and TASKING debugger.

7.2.Target Board Support

To debug a project on a target board you need to connect the target board to your computer.You can
use a TCB87 Type C on-chip debugger or you can use an Easy Micon board with a sub board on top.
The following table shows how to configure the switches on the Easy Micon board for each sub board.

Easy Micon switchesSub board

SW5 all ON, SW4 all OFFEMS48-03-UM-016

SW5 all OFF, SW4 1-4 ON, SW4 5-8 OFFEMS36-04-BHD-002

SW5 all OFF, SW4 1-4 ON, SW4 5-8 OFFEMS24-04-BGD-002

SW5 all ON, SW4 all OFFEMS16-04-ON-002

Note that when you start the debugger, the debugger checks if the firmware loaded on the Easy Micon
board matches the sub board which is mounted on the Easy Micon board. If the firmware does not match,
the debugger asks you to confirm to update the firmware. If you do not accept the update, you will not be
able to debug.
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7.3. Creating a Customized Debug Configuration

Before you can debug a project, you need a Debug launch configuration. Such a configuration, identified
by a name, contains all information about the debug project: which debugger is used, which project is
used, which binary debug file is used, which perspective is used, ... and so forth.

You can create a debug launch configuration when you create a new project with the New C Project
wizard. If you have not done this you have to create a debug launch configuration.

To debug a project, you need at least one opened and active project in your workbench. In this
chapter, it is assumed that the myproject is opened and active in your workbench.

Create or customize your debug configuration

To create or change a debug configuration follow the steps below.

1. From the Debug menu, select Debug Configurations...

The Debug Configurations dialog appears.

2. Select TASKING C/C++ Debugger and click the New launch configuration button (
) to add a new configuration.
Or: In the left pane, select the configuration you want to change, for example, TASKING C/C++
Debugger » myproject.simulator.

3. In the Name field enter the name of the configuration. By default, this is the name of the project, but
you can give your configuration any name you want to distinguish it from the project name. For
example enter myproject.simulator to identify the simulator debug configuration.

4. On the Target tab, select the TASKING LC87 Simulator or TCB87 On-chip Debugger.

The dialog shows several tabs.

Target tab

On the Target tab you can select on which target the application should be debugged. An application
can run on an external evaluation board, or on a simulator using your own PC. On this tab you can also
select the connection settings USB).The information in this tab is based on the Debug Target Configuration
(DTC) files as explained in Chapter 13, Debug Target Configuration Files.
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Initialization tab

On the Initialization tab enable one or more of the following options:

• Initial download of program

If enabled, the target application is downloaded onto the target. If disabled, only the debug information
in the file is loaded, which may be useful when the application has already been downloaded (or flashed)
earlier. If downloading fails, the debugger will shut down.

• Verify download of program
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If enabled, the debugger verifies whether the code and data has been downloaded successfully. This
takes some extra time but may be useful if the connection to the target is unreliable.

• Program flash when downloading

If enabled, also flash devices are programmed (if necessary). Flash programming will not work when
you use a simulator.

• Reset target

If enabled, the target is immediately reset after downloading has completed.

• Goto main

If enabled, only the C startup code is processed when the debugger is launched.The application stops
executing when it reaches the first C instruction in the function main(). Usually you enable this option
in combination with the option Reset Target.

• Break on exit

If enabled, the target halts automatically when the exit() function is called.

• Reduce target state polling

If you have set a breakpoint, the debugger checks the status of the target every number of seconds to
find out if the breakpoint is hit. In this field you can change the polling frequency.

• Monitor file (Flash settings)

Filename of the monitor, usually an Intel Hex or S-Record file.

• Sector buffer size (Flash settings)

Specifies the buffer size for buffering a flash sector.

• Workspace address (Flash settings)

The address of the workspace of the flash programming monitor.

Project tab

On the Project tab, you can set the properties for the debug configuration such as a name for the project
and the application binary file which are used when you choose this configuration.
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• In the Project field, you can choose the project for which you want to make a debug configuration.
Because the project myproject is the active project, this project is filled in automatically. Click the
Browse... button to select a different project. Only the opened projects in your workbench are listed.

• In the C/C++ Application field, you can choose the binary file to debug. The file myproject.abs is
automatically selected from the active project.

Arguments tab

If your application's main() function takes arguments, you can pass them in this tab. Arguments are
conventionally passed in the argv[] array. Because this array is allocated in target memory, make sure
you have allocated sufficient memory space for it.
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Source tab

On the Source tab, you can add additional source code locations in which the debugger should search
for debug data.

• Usually, the default source code location is correct.

Miscellaneous tab

On the Miscellaneous tab you can specify several file locations.

• Debugger location
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The location of the debugger itself. This should not be changed.

• FSS root directory

The initial directory used by file system simulation (FSS) calls. See the description of the FSS view.

• ORTI file and KSM module

If you wish to use the debugger's special facilities for kernel-aware debugging, specify the name of a
Kernel Debug Interface (KDI) compatible KSM module (shared library) in the appropriate edit box. The
toolset comes with a KSM suitable for OSEK kernels. If you wish to use this, browse for the file
osek_radm.dll in the bin directory of the toolset. See also the description of the RTOS view.

• GDI log file and Debug instrument log file

You can use the options GDI log file and Debug instrument log file (if applicable) to control the generation
of internal log files.These are primarily intended for use by or at the request of Altium support personnel.

• Cache target access

Except when using a simulator, the debugger's performance is generally strongly dependent on the
throughput and latency of the connection to the target. Depending on the situation, enabling this option
may result in a noticeable improvement, as the debugger will then avoid re-reading registers and
memory while the target remains halted. However, be aware that this may cause the debugger to show
the wrong data if tasks with a higher priority or external sources can influence the halted target's state.

• Launch in background

When this option is disabled you will see a progress bar when the debugger starts. If you do not want
to see the progress bar and want that the debugger launches in the background you can enable this
option.

• Use linker/locator memory map file (.mdf) for memory map

You can use this option to find errors in your application that cause access to non-existent memory or
cause an attempt to write to read-only memory. When building your project, the linker/locator creates
a memory description file (.mdf) file which describes the memory regions of the target you selected
in your project properties. The debugger uses this file to initialize the debugging target.

This option is only useful in combination with a simulator as debug target. The debugger may fail to
start if you use this option in combination with other debugging targets than a simulator.

7.4.Troubleshooting

If the debugger does not launch properly, this is likely due to mistakes in the settings of the execution
environment or to an improper connection between the host computer and the execution environment.
Always read the notes for your particular execution environment.

Some common problems you may check for, are:
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SolutionProblem

Make sure the specified device name is correct.Wrong device name in the launch
configuration

Specify baud rate that matches the baud rate the execution
environment is configured to expect.

Invalid baud rate

Make sure the execution environment or attached probe is powered.No power to the execution
environment.

Make sure you are using the correct type of RS-232 cable.Wrong type of RS–232 cable.

Some target machines and hosts have several ports. Make sure
you connect the cable to the correct port.

Cable connected to the wrong port
on the execution environment or host.

A device driver or background application may use the same
communications port on the host system as the debugger. Disable
any service that uses the same port-number or choose a different
port-number if possible.

Conflict between communication
ports.

The port may already be in use by another user on some UNIX
hosts, or being allocated by a login process. Some target machines
and hosts have several ports. Make sure you connect the cable to
the correct port.

Port already in use by another user.

7.5.TASKING Debug Perspective

After you have launched the debugger, you are either asked if the TASKING Debug perspective should
be opened or it is opened automatically. The Debug perspective consists of several views.

To open views in the Debug perspective:

1. Make sure the Debug perspective is opened

2. From the Window menu, select Show View »

3. Select a view from the menu or choose Other... for more views.

By default, the Debug perspective is opened with the following views:
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7.5.1. Debug View

The Debug view shows the target information in a tree hierarchy shown below with a sample of the
possible icons:

DescriptionSession itemIcon

Launch configuration name and launch typeLaunch instance

Debugger name and stateDebugger instance

Thread number and stateThread instance

Stack frame number, function, file name, and file line numberStack frame
instance

The number beside the thread label is a reference counter, not a thread identification number (TID).

Stack display

During debugging (running) the actual stack is displayed as it increases or decreases during program
execution. By default, all views present information that is related to the current stack item (variables,
memory, source code etc.). To obtain the information from other stack items, click on the item you want.
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The Debug view displays stack frames as child elements. It displays the reason for the suspension beside
the thread, (such as end of stepping range, breakpoint hit, and signal received). When a program exits,
the exit code is displayed.

The Debug view contains numerous functions for controlling the individual stepping of your programs and
controlling the debug session.You can perform actions such as terminating the session and stopping the
program. All functions are available from the right-click menu, though commonly used functions are also
available from the toolbar.

Controlling debug sessions

DescriptionActionIcon

Removes all terminated launches.Remove all

Resets the target system and restarts the application.Reset target
system

Restarts the application. The target system is not reset.Restart

Resumes the application after it was suspended (manually, breakpoint,
signal).

Resume

Suspends the application (pause). Use the Resume button to continue.Suspend

Right-click menu. Restarts the selected debug session when it was
terminated. If the debug session is still running, a new debug session is
launched.

Relaunch

Reloads the current application without restarting the debug session. The
application does restart of course.

Reload current
application

Ends the selected debug session and/or process. Use Relaunch to restart
this debug session, or start another debug session.

Terminate

Right-click menu. As terminate. Ends all debug sessions.Terminate all

Right-click menu. Ends the debug session and removes it from the Debug
view.

Terminate and
remove

Right-click menu. Ends the debug session and relaunches it. This is the
same as choosing Terminate and then Relaunch.

Terminate and
Relaunch

Detaches the debugger from the selected process (useful for debugging
attached processes).

Disconnect

Stepping through the application

DescriptionActionIcon

Steps to the next source line or instruction.Step into

Steps over a called function. The function is executed and the application
suspends at the next instruction after the call.

Step over

Executes the current function. The application suspends at the next
instruction after the return of the function.

Step return

194

TASKING VX-toolset for LC87 User Guide



DescriptionActionIcon

Toggle. If enabled, the stepping functions are performed on instruction level
instead of on C source line level.

Instruction
stepping

Toggle. If enabled, the stepping functions do not step into an interrupt when
it occurs.

Interrupt aware
stepping

Miscellaneous

DescriptionActionIcon

Right-click menu. Copies the stack as text to the windows clipboard.You
can paste the copied selection as text in, for example, a text editor.

Copy Stack

Right-click menu. Opens the debug configuration dialog to let you edit the
current debug configuration.

Edit project...

Right-click menu. Opens the Edit Source Lookup Path window to let you
edit the search path for locating source files.

Edit Source
Lookup...

7.5.2. Breakpoints View

You can add, disable and remove breakpoints by clicking in the marker bar (left margin) of the Editor
view. This is explained in the Getting Started manual.

Description

The Breakpoints view shows a list of breakpoints that are currently set. The button bar in the Breakpoints
view gives access to several common functions. The right-most button  opens the Breakpoints menu.

Types of breakpoints

To access the breakpoints dialog, add a breakpoint as follows:

1. Click the Add TASKING Breakpoint button ( ).

The Breakpoints dialog appears.

Each tab lets you set a breakpoint of a special type.You can set the following types of breakpoints:

• File breakpoint

The target halts when it reaches the specified line of the specified source file. Note that it is possible
that a source line corresponds to multiple addresses, for example when a header file has been included
into two different source files or when inlining has occurred. If so, the breakpoint will be associated with
all those addresses.

• Function

The target halts when it reaches the first line of the specified function. If no source file has been specified
and there are multiple functions with the given name, the target halts on all of those. Note that function
breakpoints generally will not work on inlined instances of a function.
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• Address

The target halts when it reaches the specified instruction address.

• Stack

The target halts when it reaches the specified stack level.

• Data

The target halts when the given variable or memory location (specified in terms of an absolute address)
is read or written to, as specified.

• Instruction

The target halts when the given number of instructions has been executed.

• Cycle

The target halts when the given number of clock cycles has elapsed.

• Timer

The target halts when the given amount of time elapsed.

In addition to the type of the breakpoint, you can specify the condition that must be met to halt the program.

In the Condition field, type a condition.The condition is an expression which evaluates to 'true' (non-zero)
or 'false' (zero). The program only halts on the breakpoint if the condition evaluates to 'true'.

In the Ignore count field, you can specify the number of times the breakpoint is ignored before the program
halts. For example, if you want the program to halt only in the fifth iteration of a while-loop, type '4': the
first four iterations are ignored.

7.5.3. File System Simulation (FSS) View

Description

The File System Simulation (FSS) view is automatically opened when the target requests FSS input or
generates FSS output. The virtual terminal that the FSS view represents, follows the VT100 standard. If
you right-click in the view area of the FSS view, a menu is presented which gives access to some
self-explanatory functions.

VT100 characteristics

The queens example demonstrates some of the VT100 features. (You can find the queens example in
the <LC87 installation path>\examples directory from where you can import it into your
workspace.) Per debugging session, you can have more than one FSS view, each of which is associated
with a positive integer. By default, the view "FSS #1" is associated with the standard streams stdin,
stdout, stderr and stdaux. Other views can be accessed by opening a file named "terminal window
<number>", as shown in the example below.
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FILE * f3 = fopen("terminal window 3", "rw");
fprintf(f3, "Hello, window 3.\n");
fclose(f3);

You can set the initial working directory of the target application in the Debug configuration dialog (see
also Section 7.3, Creating a Customized Debug Configuration):

1. On the Debugger tab, select the Miscellaneous sub-tab.

2. In the FSS root directory field, specify the FSS root directory.

The FSS implementation is designed to work without user intervention. Nevertheless, there are some
aspects that you need to be aware of.

First, the interaction between the C library code (in the files dbg*.c and dbg*.h; see Section 9.1.3,
dbg.h) and the debugger takes place via a breakpoint, which incidentally is not shown in the Breakpoints
view. Depending on the situation this may be a hardware breakpoint, which may be in short supply.

Secondly, proper operation requires certain code in the C library to have debug information. This debug
information should normally be present but might get lost when this information is stripped later in the
development process.

7.5.4. Disassembly View

The Disassembly view shows target memory disassembled into instructions and / or data. If possible, the
associated C source code is shown as well.The Address field shows the address of the current selected
line of code.

To view the contents of a specific memory location, type the address in the Address field. If the address
is invalid, the field turns red.

7.5.5. Expressions View

The Expressions view allows you to evaluate and watch regular C expressions.

To add an expression:

Click OK to add the expression.

1. Right-click in the Expressions View and select Add Watch Expression.

The Add Watch Expression dialog appears.

2. Enter an expression you want to watch during debugging, for example, the variable name "i"

If you have added one or more expressions to watch, the right-click menu provides options to Remove
and Edit or Enable and Disable added expressions.

• You can access target registers directly using #NAME. For example "arr[#R0 << 3]" or "#TIMER3
= m++". If a register is memory-mapped, you can also take its address, for example, "&#ADCIN".
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• Expressions may contain target function calls like for example "g1 + invert(&g2)". Be aware that
this will not work if the compiler has optimized the code in such a way that the original function code
does not actually exist anymore. This may be the case, for example, as a result of inlining. Also, be
aware that the function and its callees use the same stack(s) as your application, which may cause
problems if there is too little stack space. Finally, any breakpoints present affect the invoked code in
the normal way.

7.5.6. Memory View

Use the Memory view to inspect and change process memory. The Memory view supports the same
addressing as the C language.You can address memory using expressions such as:

• 0x0847d3c

• (&y)+1024

• *ptr

Monitors

To monitor process memory, you need to add a monitor:

1. In the Debug view, select a debug session. Selecting a thread or stack frame automatically selects
the associated session.

2. Click the Add Memory Monitor button in the Memory Monitors pane.

The Monitor Memory dialog appears.

3. Enter an expression or select a memory space (ROM, RAM, RAM9 or XRAM) and enter the address
that specifies the memory section you want to monitor and click OK.

The monitor appears in the monitor list and the Memory Renderings pane displays the contents of
memory locations beginning at the specified address.

Note that when you select the RAM9 memory space, the memory view shows the ninth bit of the RAM
byte content. This only displays useful results when you use the Hex rendering.

To remove a monitor:

1. In the Monitors pane, right-click on a monitor.

2. From the popup menu, select Remove Memory Monitor.

Renderings

You can inspect the memory in so-called renderings. A rendering specifies how the output is displayed:
hexadecimal, ASCII, signed integer, unsigned integer or traditional.You can add or remove renderings
per monitor. Though you cannot change a rendering, you can add or remove them:

1. Click the New Renderings... tab in the Memory Renderings pane.
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The Add Memory Rendering dialog appears.

2. Select the rendering you want (Hex Integer, Hex, ASCII, Signed Integer, Unsigned Integer or
Traditional) and click Add Rendering(s).

To remove a rendering:

1. Right-click on a memory address in the rendering.

2. From the popup menu, select Remove Rendering.

Changing memory contents

In a rendering you can change the memory contents. Simply type a new value.

Warning: Changing process memory can cause a program to crash.

The right-click popup menu gives some more options for changing the memory contents or to change the
layout of the memory representation.

7.5.7. Compare Application View

You can use the Compare Application view to check if the downloaded application matches the application
in memory. Differences may occur, for example, if you changed memory addresses in the Memory view.

• To check for differences, click the Compare button.

7.5.8. Heap View

With the Heap view you can inspect the status of the heap memory. This can be illustrated with the
following example:

    string = (char *) malloc(100);
    strcpy ( string, "abcdefgh" );
    free (string);

If you step through these lines during debugging, the Heap view shows the situation after each line has
been executed. Before any of these lines has been executed, there is no memory allocated and the Heap
view is empty.

• After the first line the Heap view shows that memory is occupied, the description tells where the block
starts, how large it is (100 MAUs) and what its content is (0x0, 0x0, ...).

• After the second line, "abcdefgh" has been copied to the allocated block of memory. The description
field of the Heap view again shows the actual contents of the memory block (0x61, 0x62,...).

• The third line frees the memory. The Heap view is empty again because after this line no memory is
allocated anymore.
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7.5.9. Logging View

Use the Logging view to control the generation of internal log files. This view is intended mainly for use
by or at the request of Altium support personnel.

7.5.10. RTOS View

The debugger has special support for debugging real-time operating systems (RTOSs). This support is
implemented in an RTOS-specific shared library called a kernel support module (KSM) or RTOS-aware
debugging module (RADM). Specifically, the TASKING VX-toolset for LC87 ships with a KSM supporting
the OSEK standard.You have to create your own OSEK Run Time Interface (ORTI) and specify this file
on the Miscellaneous tab while configuring a customized debug configuration (see also Section 7.3,
Creating a Customized Debug Configuration):

1. From the Debug menu, select Debug Configurations...

The Debug Configurations dialog appears.

2. In the left pane, select the configuration you want to change, for example, TASKING C/C++ Debugger
» myproject.simulator.

Or: click the New launch configuration button ( ) to add a new configuration.

3. Open the Miscellaneous tab

4. In the ORTI file field, specify the name of your own ORTI file.

5. If you want to use the supplied KSM suitable for OSEK kernels, in the KSM module field browse for
the file osek_radm.dll in the bin directory of the toolset.

The debugger supports ORTI specifications v2.0 and v2.1.

7.5.11. Registers View

In the Registers view you can examine the value of registers while stepping through your application.The
registers are organized in a number of register groups, which together contain all known registers.You
can select a group to see which registers it contains. This view has a number of features:

• While you step through the application, the registers involved in the step turn yellow. If you scroll in the
view or switch groups, some registers may appear on a lighter yellow background, indicating that the
debugger does not know whether the registers have changed because the debugger did not read the
registers before the step began.
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• You can change each register's value.

• You can search for a specific register: right-click on a register and from the popup menu select Find
Register.... Enter a group or register name filter, click the register you want to see and click OK. The
register of your interest will be shown in the view.

7.5.12.Trace View

If tracing is enabled, the Trace view shows the code was most recently executed. For example, while you
step through the application, the Trace view shows the executed code of each step. To enable tracing:

• Right-click in the Trace view and select Trace.

A check mark appears when tracing is enabled.

The view has three tabs, Source, Instruction and Raw, each of which represents the trace in a different
way. However, not all target environments will support all three of these.The view is updated automatically
each time the target halts.

7.5.12.1. Hardware Trigger and Tracing

When you are debugging using an evaluation board, you can use the chip's trigger and tracing features.
To configure hardware trigger and/or tracing:

• Right-click in the Trace view and select Configure....

or

Click the Configure Hardware Trigger and Tracing button ( ) in the Breakpoints view.

The Configure Hardware Trigger and Tracing dialog appears.
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The contents of the dialog closely correspond to the chip's trigger and tracing features. The chip can
watch up to four addresses, two in ROM (PC 1 and PC 2), one in internal RAM and one in the SFR area.
You can specify to stop producing trace information if the chip accesses one of these addresses (Stop
tracing:Yes). Tracing stops even if the chip keeps running. New trace data is shown when the target
breaks for whatever other reason.

In case of RAM or SFR you can specify two other conditions as well. Firstly, you can specify the kind of
access: read, write, or either. Secondly, you may put a restriction on the data read and/or written. For
example, if you specify XXXXXXXX1, only the reading and/or writing of odd values will qualify. If the chip
accesses one of these addresses and these other conditions are satisfied as well, in response it can
break (in which case it acts like a breakpoint).

Under Trace delay you can specify how long tracing should continue after the nominal stopping conditions
have been satisfied. The number (1-15) does not represent the number of instructions, but the number
of low-level tracing packets generated by the chip. A packet is a small block of data that the chip generates
for every flow change (branch, call, return or interrupt). Depending on your situation, it may therefore be
difficult to predict the effect of a particular number. Normally, it is best to specify 1 here, which stops the
trace immediately.
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Alternatively, if you select Trace all instructions, all executed instructions are traced. The Stop tracing
and Trace delay boxes are disabled then.

Note that some of these hardware facilities may be used for hardware code breakpoints as well. If you
set one or more of such breakpoints, the facilities under PC 1 and/or PC 2 may not be available, and vice
versa.

203

Using the Debugger



204

TASKING VX-toolset for LC87 User Guide



Chapter 8.Tool Options
This chapter provides a detailed description of the options for the compiler, assembler, linker, control
program, make utility and the archiver.

Tool options in Eclipse (Menu entry)

For each tool option that you can set from within Eclipse, a Menu entry description is available. In Eclipse
you can customize the tools and tool options in the following dialog:

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. Open the Tool Settings tab.

You can set all tool options here.

Unless stated otherwise, all Menu entry descriptions expect that you have this Tool Settings tab
open.

The following tables give an overview of all tool options on the Tool Settings tab in Eclipse with hyperlinks
to the corresponding command line options (if available).

Global Options

Description or optionEclipse option

Directory where the TASKING toolset is
installed

Use global 'product directory' preference

Control program option --warnings-as-errorsTreat warnings as errors

Control program option
--keep-temporary-files (-t)

Keep temporary files

Control program option --verbose (-v)Verbose mode of control program

C Compiler

Description or optionEclipse option

Preprocessing

Control program option --include-sfr-fileAutomatic inclusion of '.sfr' file

Control program option --preprocess (-E) /
--no-preprocessing-only

Store preprocessor output in <file>.pre
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Description or optionEclipse option

Control program option
--preprocess=+comments

Keep comments in preprocessor output

Control program option
--preprocess=-noline

Keep #line info in preprocessor output

C compiler option --defineDefined symbols

C compiler option --include-filePre-include files

Include Paths

C compiler option --include-directoryInclude paths

Memory Model

C compiler option --ram-modelRAM data model

C compiler option --rom-modelROM data model

C compiler option --rom-constConstants in ROM

C compiler option --string-literal-memoryString literal space

Language

C compiler option --isoComply to C standard

C compiler option --language=+gccAllow GNU C extensions

C compiler option --language=+commentsAllow // comments in ISO C90 mode

C compiler option --language=-stringsCheck assignment of string literal to non-'const' string
pointer

C compiler option --ucharTreat 'char' variables as unsigned

C compiler option --signed-bitfieldsTreat 'int' bit-fields as signed

C compiler option --no-doubleTreat 'double' as 'float'

C compiler option --integer-enumerationTreat enumerated types always as integer

C compiler option --language=-volatileAllow optimization across volatile access

C compiler option --language=+kanjiAllow Shift JIS Kanji in strings

Allocation

C compiler option --rename-sectionsRename sections

Optimization

C compiler option --optimizeOptimization level

C compiler option --tradeoffTrade-off between speed and size

C compiler option --inlineAlways inline function calls

C compiler option --inline-max-incrMaximum size increment when inlining (in %)

C compiler option --inline-max-sizeMaximum size for functions to always inline

C compiler option --optimizeCustom Optimization

C compiler option --cacheCompilation Speed

Debugging
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Description or optionEclipse option

C compiler option --debug-infoGenerate symbolic debug information

MISRA-C

C compiler option --misracMISRA-C checking

C compiler option --misrac-versionMISRA-C version

C compiler option
--misrac-required-warnings

Warnings instead of errors for required rules

C compiler option
--misrac-advisory-warnings

Warnings instead of errors for advisory rules

C compiler option --misracCustom 1998 / Custom 2004

CERT C Secure Coding

C compiler option --certCERT C secure code checking

C compiler option --warnings-as-errorsWarnings instead of errors

C compiler option --certCustom CERT C

Diagnostics

C compiler option --no-warnings=numSuppress C compiler warnings

C compiler option --no-warningsSuppress all warnings

C compiler option --global-type-checkingPerform global type checking on C code

Miscellaneous

C compiler option --sourceMerge C source code with generated assembly

C compiler option --no-clearClear uninitialized global and static variables

C compiler options, Control program optionsAdditional options

Assembler

Description or optionEclipse option

Preprocessing

Assembler option --preprocessor-typeUse TASKING preprocessor

Control program option --asm-sfr-fileAutomatic inclusion of '.sfr' file

Assembler option --defineDefined symbols

Assembler option --include-filePre-include files

Include Paths

Assembler option --include-directoryInclude paths

Symbols

Assembler option --debug-infoGenerate symbolic debug

Assembler option --case-insensitiveCase insensitive identifiers

Assembler option --symbol-scopeSet default symbol scope to global
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Description or optionEclipse option

Optimization

Assembler option --optimize=+genericsOptimize generic instructions

Assembler option --optimize=+instr-sizeOptimize instruction size

List File

Control program option --list-filesGenerate list file

Assembler option --list-formatList ...

Assembler option --section-info=+listList section summary

Diagnostics

Assembler option --no-warnings=numSuppress warnings

Assembler option --no-warningsSuppress all warnings

Assembler option --section-info=+consoleDisplay section summary

Assembler option --error-limitMaximum number of emitted errors

Miscellaneous

Assembler option --nested-sectionsAllow nested sections

Assembler option --kanjiAllow Shift JIS Kanji in strings

Assembler optionsAdditional options

Linker

Description or optionEclipse option

Output Format

Linker option --output=file:IHEXGenerate Intel Hex format file

Linker option --output=file:SRECGenerate S-records file

Linker option --chip-outputCreate file for each memory chip

Linker option --output=file:IHEX:sizeSize of addresses (in bytes) for Intel Hex records

Linker option --hex-record-sizeSize of data record (in bytes) for Intel Hex records

Linker option --output=file:SREC:sizeSize of addresses (in bytes) for Motorola S records

Linker option --hex-format=gEmit type 2 instead of type 4 records

Linker option --hex-format=sEmit start address record

Linker option --define=__ROM_FILLFill gaps in ROM with 0xFF

Libraries

Control program option --fp-trapUse trapped floating-point library

Control program option --wcharUse C library with wide character support

Control program option --no-default-librariesLink default libraries

Linker option --no-rescanRescan libraries to solve unresolved externals
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Description or optionEclipse option

The libraries are added as files on the
command line.

Libraries

Linker option --library-directoryLibrary search path

Data Objects

Linker option --import-objectData objects

Utility hex2bin and Linker option
--import-object

OPT file / CGR file

Script File

Linker option --defineDefined symbols

Linker option --lsl-fileLinker script file (.lsl)

Optimization

Linker option --optimize=cDelete unreferenced sections

Linker option --optimize=lUse a 'first-fit decreasing' algorithm

Linker option --optimize=tCompress copy table

Linker option --optimize=xDelete duplicate code

Linker option --optimize=yDelete duplicate data

Map File

Control program option --no-map-fileGenerate map file (.map)

Linker option --map-file=file.mapxml:XMLGenerate XML map file format (.mapxml) for map file viewer

Linker option --map-file-formatInclude ...

Diagnostics

Linker option --no-warnings=numSuppress warnings

Linker option --no-warningsSuppress all warnings

Linker option --error-limitMaximum number of emitted errors

Miscellaneous

Linker option --strip-debugStrip symbolic debug information

Linker option --case-insensitiveLink case insensitive

Linker option
--user-provided-initialization-code

Do not use standard copy table for initialization

Linker option --verboseShow link phases during processing

Linker option --bank-switchingGenerate bank switching stubs

Linker optionsAdditional options
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8.1. Configuring the Command Line Environment

If you want to use the tools on the command line (using a Windows command prompt), you can set
environment variables.

You can set the following environment variables:

DescriptionEnvironment
variable

With this variable you specify one or more additional directories in which the
assembler looks for include files. See Section 4.3, How the Assembler Searches
Include Files.

AS87INC

With this variable you specify one or more additional directories in which the C
compiler looks for include files. See Section 3.3, How the Compiler Searches Include
Files.

C87INC

When this variable is set, the control program prepends the directory specified by
this variable to the names of the tools invoked.

CC87BIN

With this variable you specify one or more additional directories in which the linker
looks for libraries. See Section 5.3.1, How the Linker Searches Libraries.

LIBLC87

With this variable you specify the directory in which the executables reside. This
allows you to call the executables when you are not in the bin directory. Usually
your system already uses the PATH variable for other purposes. To keep these
settings, you need to add (rather than replace) the path. Use a semicolon (;) to
separate path names.

PATH

With this variable you specify the location where programs can create temporary
files. Usually your system already uses this variable. In this case you do not need
to change it.

TMPDIR

See the documentation of your operating system on how to set environment variables.
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8.2. C Compiler Options

This section lists all C compiler options.

Options in Eclipse versus options on the command line

Most command line options have an equivalent option in Eclipse but some options are only available on
the command line. Eclipse invokes the compiler via the control program. Therefore, it uses the syntax of
the control program to pass options and files to the C compiler. If there is no equivalent option in Eclipse,
you can specify a command line option in Eclipse as follows:

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » Miscellaneous.

4. In the Additional options field, enter one or more command line options.

Because Eclipse uses the control program, you have to precede the option with -Wc to pass the
option via the control program directly to the C compiler.

Be aware that some command line options are not useful in Eclipse or just do not have any effect. For
example, the option -n sends output to stdout instead of a file and has no effect in Eclipse.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters.You can abbreviate long option
names as long as it forms a unique name.You can mix short and long option names on the command
line.

Options can have flags or suboptions. To switch a flag 'on', use a lowercase letter or a +longflag. To
switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following
two invocations are equivalent:

c87 -Oac test.c
c87 --optimize=+coalesce,+cse test.c

When you do not specify an option, a default value may become active.
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C compiler option: --cache

Menu entry

1. Select C Compiler » Optimization » Compilation Speed.

2. Enable the option Cache generated code to improve the compilation speed.

3. In the Directory for cached files field, enter the name for the location of the cache.

Command line syntax

--cache[=directory]

Default on command line: . (current directory)

Default in Eclipse: .cache directory under project directory

Description

This option enables a cache for output files in the specified directory. When the source code after
preprocessing and relevant compiler options and the compiler version are the same as in a previous
invocation, the previous result is copied to the output file. The cache only works when there is a single C
input file and a single output file.

You can also enable the cache and specify the cache directory with the environment variable C87CACHE.
This option takes precedence over the environment variable.

The cache directory may be shared, for instance by placing it on a network drive.You can control the
maximum size and/or age of the cache directory with the separate expiration tool expire87.

The compiler creates a directory c87cache in the directory specified with the option --cache or the
environment variable C87CACHE. The directory is only created when it does not yet exist. The cache
files are stored in this directory.

Example

To improve the compilation speed and put cached files in directory .cache, enter:

c87 --cache=.cache test.c

Related information

Section 3.6, Influencing the Build Time

Section 6.5, Expire Cache Utility
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C compiler option: --cert

Menu entry

1. Select C Compiler » CERT C Secure Coding.

2. Make a selection from the CERT C secure code checking list.

3. If you selected Custom, expand the Custom CERT C entry and enable one or more individual
recommendations/rules.

Command line syntax

--cert={all | name[-name],...}

Default format: all

Description

With this option you can enable one or more checks for CERT C Secure Coding Standard
recommendations/rules. When you omit the argument, all checks are enabled. name is the name of a
CERT recommendation/rule, consisting of three letters and two digits. Specify only the three-letter
mnemonic to select a whole category. For the list of names you can use, see Chapter 14, CERT C Secure
Coding Standard.

On the command line you can use --diag=cert to see a list of the available checks, or you can use a
three-letter mnemonic to list only the checks in a particular category. For example, --diag=pre lists all
supported preprocessor checks.

Example

To enable the check for CERT rule STR30-C, enter:

c87 --cert=str30 test.c

Related information

Chapter 14, CERT C Secure Coding Standard

C compiler option --diag (Explanation of diagnostic messages)
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C compiler option: --check

Menu entry

-

Command line syntax

--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves
time in developing your application because the code will not actually be compiled.

The compiler reports any warnings and/or errors.

This option is available on the command line only.

Related information

Assembler option --check (Check syntax)
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C compiler option: --debug-info (-g)

Menu entry

1. Select C Compiler » Debugging.

2. To generate symbolic debug information, select Default, Small set or Full.
To disable the generation of debug information, select None.

Command line syntax

--debug-info[=suboption]

-g[suboption]

You can set the following suboptions:

Emit small set of debug information.1 / csmall

Emit default symbolic debug information.2 / ddefault

Emit full symbolic debug information.3 / aall

Default: --debug-info (same as --debug-info=default)

Description

With this option you tell the compiler to add directives to the output file for including symbolic information.
This facilitates high level debugging but increases the size of the resulting assembler file (and thus the
size of the object file). For the final application, compile your C files without debug information.

The DWARF debug format allows for a flexible approach as to how much symbolic information is included,
as long as the structure is valid. Adding all possible DWARF data for a program is not practical. The
amount of DWARF information per compilation unit can be huge. And for large projects, with many object
modules the link time can grow unacceptably long.That is why the compiler has several debug information
levels. In general terms one can say, the higher the level the more DWARF information is produced.

The DWARF data in an object module is not only used for debugging. The toolset can also do "type
checking" of the whole application. In that case the linker will use the DWARF information of all object
modules to determine if every use of a symbol is done with the same type. In other words, if the application
is built with type checking enabled then the compiler will add DWARF information too.

Small set of debug information

With this suboption only DWARF call frame information and type information are generated.This enables
you to inspect parameters of nested functions.The type information improves debugging.You can perform
a stack trace, but stepping is not possible because debug information on function bodies is not generated.
You can use this suboption, for example, to compact libraries.
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Default debug information

This provides all debug information you need to debug your application. It meets the debugging
requirements in most cases without resulting in oversized assembler/object files.

Full debug information

With this suboption extra debug information is generated about unused typedefs and DWARF "lookup
table sections". Under normal circumstances this extra debug information is not needed to debug the
program. Information about unused typedefs concerns all typedefs, even the ones that are not used for
any variable in the program. (Possibly, these unused typedefs are listed in the standard include files.)
With this suboption, the resulting assembler/object file will increase significantly.

In the following table you see in more detail what DWARF information is included for the debug option
levels.

Remarkstype check-g3-g2-g1Feature

info such as symbol name and type++++basic info

this is information for a debugger to compute
a stack trace when a program has stopped
at a breakpoint

++++call frame

this is information about where symbols live
(e.g. on stack at offset so and so, when the
program counter is in this range)

++symbol lifetime

file name, line number, column number+++line number info

DWARF sections ... this is an optimization
for the DWARF data, it is not essential

+”lookup tables"

in the C code of the program there can be
(many) typedefs that are not used for any
variable. Sometimes this can cause
enormous expansion of the DWARF data and
thus it is only included in -g3.

+unused typedefs

Related information

-
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C compiler option: --define (-D)

Menu entry

1. Select C Compiler » Preprocessing.

The Defined symbols box shows the symbols that are currently defined.

2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, demo=1)

Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

--define=macro_name[=macro_definition]

-Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the preprocessor. If you only specify a macro
name (no macro definition), the macro expands as '1'.

You can specify as many macros as you like. Simply use the Add button to add new macro definitions.

On the command line, you can use the option --define (-D) multiple times. If the command line exceeds
the limit of the operating system, you can define the macros in an option file which you then must specify
to the compiler with the option --option-file (-f) file.

Defining macros with this option (instead of in the C source) is, for example, useful to compile conditional
C source as shown in the example below.

Example

Consider the following C program with conditional code to compile a demo program and a real program:

void main( void )
{
#if DEMO
    demo_func();   /* compile for the demo program */
#else
    real_func();   /* compile for the real program */
#endif
}

You can now use a macro definition to set the DEMO flag:
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c87 --define=DEMO test.c
c87 --define=DEMO=1 test.c

Note that both invocations have the same effect.

The next example shows how to define a macro with arguments. Note that the macro name and definition
are placed between double quotes because otherwise the spaces would indicate a new option.

c87 --define="MAX(A,B)=((A) > (B) ? (A) : (B))" test.c

Related information

C compiler option --undefine (Remove preprocessor macro)

C compiler option --option-file (Specify an option file)
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C compiler option: --dep-file

Menu entry

Eclipse uses this option in the background to create a file with extension .d (one for every input file).

Command line syntax

--dep-file[=file]

Description

With this option you tell the compiler to generate dependency lines that can be used in a Makefile. In
contrast to the option --preprocess=+make, the dependency information will be generated in addition to
the normal output file.

By default, the information is written to a file with extension .d (one for every input file).When you specify
a filename, all dependencies will be combined in the specified file.

Example

c87 --dep-file=test.dep test.c

The compiler compiles the file test.c, which results in the output file test.src, and generates
dependency lines in the file test.dep. For example:

test.obj :    test.c
test.c :
test.obj :    <install-dir>/c87/include/stdio.h
<install-dir>/c87/include/stdio.h :
test.obj :    <install-dir>/c87/include/stdarg.h
<install-dir>/c87/include/stdarg.h :

Related information

C compiler option --preprocess=+make (Generate dependencies for make)
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C compiler option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems.

The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.

A popup menu appears.

3. Select Detailed Diagnostics Info.

A dialog box appears with additional information.

Command line syntax

--diag=[format:]{all | msg[-msg],...}

You can set the following output formats:

HTML output.html

Rich Text Format.rtf

ASCII text.text

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify. The compiler does
not compile any files.You can specify the following formats: html, rtf or text (default). To create a file
with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given (except for the CERT checks). If
you want the description of one or more selected error messages, you can specify the error message
numbers, separated by commas, or you can specify a range.

With --diag=cert you can see a list of the available CERT checks, or you can use a three-letter mnemonic
to list only the checks in a particular category. For example, --diag=pre lists all supported preprocessor
checks.

Example

To display an explanation of message number 282, enter:

c87 --diag=282

This results in the following message and explanation:
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E282: unterminated comment

Make sure that every comment starting with /* has a matching */.
Nested comments are not possible.

To write an explanation of all errors and warnings in HTML format to file cerrors.html, use redirection
and enter:

c87 --diag=html:all > cerrors.html

Related information

Section 3.8, C Compiler Error Messages

C compiler option --cert (Enable individual CERT checks)
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C compiler option: --error-file

Menu entry

-

Command line syntax

--error-file[=file]

Description

With this option the compiler redirects error messages to a file. If you do not specify a filename, the error
file will be named after the output file with extension .err.

Example

To write errors to errors.err instead of stderr, enter:

c87 --error-file=errors.err test.c

Related information

-
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C compiler option: --global-type-checking

Menu entry

1. Select C Compiler » Diagnostics.

2. Enable the option Perform global type checking on C code.

Command line syntax

--global-type-checking

Description

The C compiler already performs type checking within each module. Use this option when you want the
linker to perform type checking between modules.

Related information

-
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C compiler option: --help (-?)

Menu entry

-

Command line syntax

--help[=item]

-?

You can specify the following arguments:

Show the list of intrinsic functionsiintrinsics

Show extended option descriptionsooptions

Show the list of supported pragmasppragmas

Show the list of predefined typedefsttypedefs

Description

Displays an overview of all command line options. With an argument you can specify which extended
information is shown.

Example

The following invocations all display a list of the available command line options:

c87 -?
c87 --help
c87

The following invocation displays a list of the available pragmas:

c87 --help=pragmas

Related information

-
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C compiler option: --include-directory (-I)

Menu entry

1. Select C Compiler » Include Paths.

The Include paths box shows the directories that are added to the search path for include files.

2. To define a new directory for the search path, click on the Add button in the Include paths box.

3. Type or select a path.

Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax

--include-directory=path,...

-Ipath,...

Description

With this option you can specify the path where your include files are located. A relative path will be
relative to the current directory,

The order in which the compiler searches for include files is:

1. The pathname in the C source file and the directory of the C source (only for #include files that are
enclosed in "")

2. The path or paths that are specified with this option. Multiple paths/options are handled by the C
compiler from left to right.

3. The path that is specified in the environment variable C87INC when the product was installed.

4. The default directory $(PRODDIR)\include (unless you specified option --no-stdinc).

Example

Suppose that the C source file test.c contains the following lines:

#include <stdio.h>
#include "myinc.h"

You can call the compiler as follows:

c87 --include-directory=myinclude test.c

First the compiler looks for the file stdio.h in the directory myinclude relative to the current directory.
If it was not found, the compiler searches in the environment variable and then in the default include
directory.
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The compiler now looks for the file myinc.h in the directory where test.c is located. If the file is not
there the compiler searches in the directory myinclude. If it was still not found, the compiler searches
in the environment variable and then in the default include directory.

Related information

C compiler option --include-file (Include file at the start of a compilation)

C compiler option --no-stdinc (Skip standard include files directory)
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C compiler option: --include-file (-H)

Menu entry

1. Select C Compiler » Preprocessing.

The Pre-include files box shows the files that are currently included before the compilation starts.

2. To define a new file, click on the Add button in the Pre-include files box.

3. Type the full path and file name or select a file.

Use the Edit and Delete button to change a file name or to remove a file from the list.

Command line syntax

--include-file=file,...

-Hfile,...

Description

With this option you include one or more extra files at the beginning of each C source file, before other
includes. This is the same as specifying #include "file" at the beginning of each of your C sources.

Example

c87 --include-file=stdio.h test1.c test2.c

The file stdio.h is included at the beginning of both test1.c and test2.c.

Related information

C compiler option --include-directory (Add directory to include file search path)
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C compiler option: --inline

Menu entry

1. Select C Compiler » Optimization.

2. Enable the option Always inline function calls.

Command line syntax

--inline

Description

With this option you instruct the compiler to inline calls to functions without the __noinline function
qualifier whenever possible. This option has the same effect as a #pragma inline at the start of the
source file.

Example

To always inline function calls:

c87 --optimize=+compact --inline test.c

Related information

Section 1.10.4, Inlining Functions: inline
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C compiler option: --inline-max-incr / --inline-max-size

Menu entry

1. Select C Compiler » Optimization.

2. In the Maximum size increment when inlining field, enter a value (default -1).

3. In the Maximum size for functions to always inline field, enter a value (default -1).

Command line syntax

--inline-max-incr=percentage  (default: -1)

--inline-max-size=threshold   (default: -1)

Description

With these options you can control the automatic function inlining optimization process of the compiler.
These options only have effect when you have enabled the inlining optimization (option --optimize=+inline
or Optimize most).

Regardless of the optimization process, the compiler always inlines all functions that have the
function qualifier inline.

With the option --inline-max-size you can specify the maximum size of functions that the compiler inlines
as part of the optimization process. The compiler always inlines all functions that are smaller than the
specified threshold. The threshold is measured in compiler internal units and the compiler uses this
measure to decide which functions are small enough to inline. The default threshold is -1, which means
that the threshold depends on the option --tradeoff.

After the compiler has inlined all functions that have the function qualifier inline and all functions that
are smaller than the specified threshold, the compiler looks whether it can inline more functions without
increasing the code size too much.With the option --inline-max-incr you can specify how much the code
size is allowed to increase. The default value is -1, which means that the value depends on the option
--tradeoff.

Example

c87 --optimize=+inline --inline-max-incr=40 --inline-max-size=15 test.c

The compiler first inlines all functions with the function qualifier inline and all functions that are smaller
than the specified threshold of 15. If the code size has still not increased with 40%, the compiler decides
which other functions it can inline.

Related information

C compiler option --optimize=+inline (Optimization: automatic function inlining)

Section 1.10.4, Inlining Functions: inline
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Section 3.5.3, Optimize for Code Size or Execution Speed
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C compiler option: --integer-enumeration

Menu entry

1. Select C Compiler » Language.

2. Enable the option Treat enumerated types always as integer.

Command line syntax

--integer-enumeration

Description

Normally the compiler treats enumerated types as the smallest data type possible (char or short instead
of int).This reduces code size.With this option the compiler always treats enum-types as int as defined
in the ISO C99 standard.

Related information

Section 1.1, Data Types
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C compiler option: --iso (-c)

Menu entry

1. Select C Compiler » Language.

2. From the Comply to C standard list, select ISO C99 or ISO C90.

Command line syntax

--iso={90|99}

-c{90|99}

Default: --iso=99

Description

With this option you select the ISO C standard. C90 is also referred to as the "ANSI C standard". C99
refers to the newer ISO/IEC 9899:1999 (E) standard. C99 is the default.

Example

To select the ISO C90 standard on the command line:

c87 --iso=90 test.c

Related information

C compiler option --language (Language extensions)
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C compiler option: --keep-output-files (-k)

Menu entry

Eclipse always removes the .src file when errors occur during compilation.

Command line syntax

--keep-output-files

-k

Description

If an error occurs during compilation, the resulting .src file may be incomplete or incorrect. With this
option you keep the generated output file (.src) when an error occurs.

By default the compiler removes the generated output file (.src) when an error occurs. This is useful
when you use the make utility. If the erroneous files are not removed, the make utility may process corrupt
files on a subsequent invocation.

Use this option when you still want to inspect the generated assembly source. Even if it is incomplete or
incorrect.

Example

c87 --keep-output-files test.c

When an error occurs during compilation, the generated output file test.src will not be removed.

Related information

C compiler option --warnings-as-errors (Treat warnings as errors)
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C compiler option: --language (-A)

Menu entry

1. Select C Compiler » Language.

2. Enable or disable one or more of the following options:

• Allow GNU C extensions

• Allow // comments in ISO C90 mode

• Check assignment of string literal to non-'const' string pointer

• Allow optimization across volatile access

• Allow Shift JIS Kanji in strings

Command line syntax

--language=[flags]

-A[flags]

You can set the following flags:

enable a number of gcc extensionsg/G+/-gcc

support for Shift JIS Kanji in stringsk/K+/-kanji

// comments in ISO C90 modep/P+/-comments

don't optimize across volatile accessv/V+/-volatile

relaxed const check for string literalsx/X+/-strings

Default: -AGkpVx

Default (without flags): -AGKPVX

Description

With this option you control the language extensions the compiler can accept.

The option --language (-A) without flags disables all language extensions.

GNU C extensions

The --language=+gcc (-Ag) option enables the following gcc language extensions:

• The identifier __FUNCTION__ expands to the current function name.

• Alternative syntax for variadic macros.
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• Alternative syntax for designated initializers.

• Allow zero sized arrays.

• Allow empty struct/union.

• Allow unnamed struct/union fields.

• Allow empty initializer list.

• Allow initialization of static objects by compound literals.

• The middle operand of a ? : operator may be omitted.

• Allow a compound statement inside braces as expression.

• Allow arithmetic on void pointers and function pointers.

• Allow a range of values after a single case label.

• Additional preprocessor directive #warning.

• Allow comma operator, conditional operator and cast as lvalue.

• An inline function without "static" or "extern" will be global.

• An "extern inline" function will not be compiled on its own.

• An __attribute__ directly following a struct/union definition relates to that tag instead of to the
objects in the declaration.

For a more complete description of these extensions, you can refer to the UNIX gcc info pages (info
gcc).

Shift JIS Kanji support

With --language=+kanji (-Ak) you tell the compiler to support Shift JIS encoded Kanji multi-byte characters
in strings, (wide) character constants and // comments. Without this option, encodings with 0x5c as the
second byte conflict with the use of the backslash as an escape character. Shift JIS in /*...*/ comments
is supported regardless of this option. Note that Shift JIS also includes Katakana and Hiragana.

Comments in ISO C90 mode

With --language=+comments (-Ap) you tell the compiler to allow C++ style comments (//) in ISO C90
mode (option --iso=90). In ISO C99 mode this style of comments is always accepted.

Check assignment of string literal to non-const string pointer

With --language=+strings (-Ax) you disable warnings about discarded const qualifiers when a string
literal is assigned to a non-const pointer.

char *p;
void main( void ) { p = "hello"; }
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Optimization across volatile access

With the --language=+volatile (-Av) option, the compiler will block optimizations when reading or writing
a volatile object, by treating the access as a call to an unknown function. With this option you can prevent
for example that code below the volatile object is optimized away to somewhere above the volatile object.

Example:

extern unsigned int variable;
extern volatile unsigned int access;

void TestFunc( unsigned int flag )
{
    access = 0;
    variable |= flag;
    if( variable == 3 )
    {
        variable = 0;
    }
    variable |= 0x8000;
    access = 1;
}

Result with --language=-volatile (default):

_TestFunc:  .type   func
    ldw     #0
    stw     _access         ; <== Volatile access
    ldw     r1
    pushw   _variable
    forw
    stw     r4
    ldw     #3
    pushw   r4
    fsubw
    bnzw    .L2
    stw     r4
.L2:
    set1    r4h,7
    ldw     #1
    stw     _access         ; <== Volatile access
    ldw     r4
    stw     _variable       ; <== Moved across volatile access
    ret

Result with --language=+volatile:

_TestFunc:  .type   func
    ldw     #0
    stw     _access         ; <== Volatile access
    ldw     r1
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    pushw   _variable
    forw
    stw     r4
    ldw     #3
    pushw   r4
    fsubw
    bnzw    .L2
    stw     r4
.L2:
    set1    r4h,7
    ldw     r4
    stw     _variable
    ldw     #1
    stw     _access         ; <== Volatile access
    ret

Note that the volatile behavior of the compiler with option --language=-volatile or --language=+volatile
is ISO C compliant in both cases.

Example

c87 --language=-comments,+strings --iso=90 test.c
c87 -APx -c90 test.c

The compiler compiles in ISO C90 mode, accepts assignments of a constant string to a non-constant
string pointer and does not allow C++ style comments.

Related information

C compiler option --iso (ISO C standard)

Section 1.4, Shift JIS Kanji Support
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C compiler option: --make-target

Menu entry

-

Command line syntax

--make-target=name

Description

With this option you can overrule the default target name in the make dependencies generated by the
options --preprocess=+make (-Em) and --dep-file.The default target name is the basename of the input
file, with extension .obj.

Example

c87 --preprocess=+make --make-target=mytarget.obj test.c

The compiler generates dependency lines with the default target name mytarget.obj instead of
test.obj.

mytarget.obj :   test.c
test.c :

Related information

C compiler option --preprocess=+make (Generate dependencies for make)

C compiler option --dep-file (Generate dependencies in a file)
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C compiler option: --misrac

Menu entry

1. Select C Compiler » MISRA-C.

2. Make a selection from the MISRA-C checking list.

3. If you selected Custom, expand the Custom 2004 or Custom 1998 entry and enable one or more
individual rules.

Command line syntax

--misrac={all | nr[-nr]},...

Description

With this option you specify to the compiler which MISRA-C rules must be checked. With the option
--misrac=all the compiler checks for all supported MISRA-C rules.

Example

c87 --misrac=9-13 test.c

The compiler generates an error for each MISRA-C rule 9, 10, 11, 12 or 13 violation in file test.c.

Related information

Section 3.7.2, C Code Checking: MISRA-C

C compiler option --misrac-advisory-warnings

C compiler option --misrac-required-warnings

Linker option --misrac-report
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C compiler option: --misrac-advisory-warnings / --misrac-required-warnings

Menu entry

1. Select C Compiler » MISRA-C.

2. Make a selection from the MISRA-C checking list.

3. Enable one or both options Warnings instead of errors for required rules and Warnings instead
of errors for advisory rules.

Command line syntax

--misrac-advisory-warnings

--misrac-required-warnings

Description

Normally, if an advisory rule or required rule is violated, the compiler generates an error. As a consequence,
no output file is generated. With this option, the compiler generates a warning instead of an error.

Related information

Section 3.7.2, C Code Checking: MISRA-C

C compiler option --misrac

Linker option --misrac-report
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C compiler option: --misrac-version

Menu entry

1. Select C Compiler » MISRA-C.

2. Select the MISRA-C version: 2004 or 1998.

Command line syntax

--misrac-version={1998|2004}

Default: 2004

Description

MISRA-C rules exist in two versions: MISRA-C:1998 and MISRA-C:2004. By default, the C source is
checked against the MISRA-C:2004 rules. With this option you can specify to check against the
MISRA-C:1998 rules.

Related information

Section 3.7.2, C Code Checking: MISRA-C

C compiler option --misrac
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C compiler option: --no-clear

Menu entry

1. Select C Compiler » Miscellaneous.

2. Disable the option Clear uninitialized global and static variables.

Command line syntax

--no-clear

Description

Normally uninitialized global/static variables are cleared at program startup. With this option you tell the
compiler to generate code to prevent uninitialized global/static variables from being cleared at program
startup.

This option applies to constant as well as non-constant variables.

Related information

Pragmas clear/noclear
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C compiler option: --no-double (-F)

Menu entry

1. Select C Compiler » Language.

2. Enable the option Treat 'double' as 'float'.

Command line syntax

--no-double

-F

Description

With this option you tell the compiler to treat variables and constants of type double as float. Because
the float type takes less space, execution speed increases and code size decreases, both at the cost
of less precision.

Example

c87 --no-double test.c

The file test.c is compiled where variables and constants of type double are treated as float.

Related information

-
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C compiler option: --no-stdinc

Menu entry

1. Select C Compiler » Miscellaneous.

2. Add the option --no-stdinc to the Additional options field.

Command line syntax

--no-stdinc

Description

With this option you tell the compiler not to look in the default include directory relative to the installation
directory, when searching for include files. This way the compiler only searches in the include file search
paths you specified.

Related information

C compiler option --include-directory (Add directory to include file search path)

Section 3.3, How the Compiler Searches Include Files

244

TASKING VX-toolset for LC87 User Guide



C compiler option: --no-warnings (-w)

Menu entry

1. Select C Compiler » Diagnostics.

The Suppress C compiler warnings box shows the warnings that are currently suppressed.

2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas or as a range, of the warnings you want to suppress (for
example 537,538). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.

Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

--no-warnings[=number[-number],...]

-w[number[-number],...]

Description

With this option you can suppresses all warning messages or specific warning messages.

On the command line this option works as follows:

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings are suppressed.

• If you specify this option with a number or a range, only the specified warnings are suppressed.You
can specify the option --no-warnings=number multiple times.

Example

To suppress warnings 537 and 538, enter:

c87 test.c --no-warnings=537,538

Related information

C compiler option --warnings-as-errors (Treat warnings as errors)

Pragma warning
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C compiler option: --optimize (-O)

Menu entry

1. Select C Compiler » Optimization.

2. Select an optimization level in the Optimization level box.

Command line syntax

--optimize[=flags]

-Oflags

You can set the following flags:

Coalescer: remove unnecessary movesa/A+/-coalesce

Interprocedural register optimizationsb/B+/-ipro

Common subexpression eliminationc/C+/-cse

Expression simplificatione/E+/-expression

Control flow simplificationf/F+/-flow

Generic assembly code optimizationsg/G+/-glo

Automatic function inliningi/I+/-inline

Loop transformationsl/L+/-loop

Forward storeo/O+/-forward

Constant propagationp/P+/-propagate

Subscript strength reductions/S+/-subscript

Peephole optimizationsy/Y+/-peephole

Use the following options for predefined sets of flags:

No optimization
Alias for -OaBCEFGILOPSY

-O0--optimize=0

No optimizations are performed except for the coalescer (to allow better debug information).The compiler
tries to achieve an optimal resemblance between source code and produced code. Expressions are
evaluated in the same order as written in the source code, associative and commutative properties are
not used.

Optimize
Alias for -OabcefgILOPSy

-O1--optimize=1

Enables optimizations that do not affect the debug ability of the source code. Use this level when you
encounter problems during debugging your source code with optimization level 2.
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Optimize more (default)
Alias for -OabcefgIlopsy

-O2--optimize=2

Enables more optimizations to reduce code size and/or execution time. This is the default optimization
level.

Optimize most
Alias for -Oabcefgilopsy

-O3--optimize=3

This is the highest optimization level. Use this level to decrease execution time to meet your real-time
requirements.

Default: --optimize=2

Description

With this option you can control the level of optimization. If you do not use this option, the default
optimization level is Optimize more (option --optimize=2 or --optimize).

When you use this option to specify a set of optimizations, you can overrule these settings in your C
source file with #pragma optimize flag / #pragma endoptimize.

In addition to the option --optimize, you can specify the option --tradeoff (-t). With this option you specify
whether the used optimizations should optimize for more speed (regardless of code size) or for smaller
code size (regardless of speed).

Example

The following invocations are equivalent and result all in the default optimization set:

c87 test.c

c87 --optimize=2 test.c
c87 -O2 test.c

c87 --optimize test.c
c87 -O test.c

c87 -OabcefgIlopsy test.c
c87 --optimize=+coalesce,+ipro,+cse,+expression,+flow,
      +glo,-inline,+loop,+forward,+propagate,
      +subscript,+peephole test.c

Related information

C compiler option --tradeoff (Trade off between speed and size)

Pragma optimize/endoptimize

Section 3.5, Compiler Optimizations
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C compiler option: --option-file (-f)

Menu entry

1. Select C Compiler » Miscellaneous.

2. Add the option --option-file to the Additional options field.

Be aware that the options in the option file are added to the C compiler options you have set in the
other pages. Only in extraordinary cases you may want to use them in combination.

Command line syntax

--option-file=file,...

-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line,
you can create an option file which contains all options and flags you want to specify. With this option
you specify the option file to the compiler.

Use an option file when the command line would exceed the limits of the operating system, or just to store
options and save typing.

You can specify the option --option-file multiple times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and
vise versa:

"This has a single quote ' embedded"

'This has a double quote " embedded'

'This has a double quote " and a single quote '"' embedded"

• When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is
preserved.

"This is a continuation \
line"

         -> "This is a continuation line"
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• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

--debug-info
--define=DEMO=1
test.c

Specify the option file to the compiler:

c87 --option-file=myoptions

This is equivalent to the following command line:

c87 --debug-info --define=DEMO=1 test.c

Related information

-
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C compiler option: --output (-o)

Menu entry

Eclipse names the output file always after the C source file.

Command line syntax

--output=file

-o file

Description

With this option you can specify another filename for the output file of the compiler. Without this option
the basename of the C source file is used with extension .src.

Example

To create the file output.src instead of test.src, enter:

c87 --output=output.src test.c

Related information

-
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C compiler option: --preprocess (-E)

Menu entry

1. Select C Compiler » Preprocessing.

2. Enable the option Store preprocessor output in <file>.pre.

3. (Optional) Enable the option Keep comments in preprocessor output.

4. (Optional) Enable the option Keep #line info in preprocessor output.

Command line syntax

--preprocess[=flags]

-E[flags]

You can set the following flags:

keep commentsc/C+/-comments

generate a list of included source filesi/I+/-includes

generate a list of macro definitionsl/L+/-list

generate dependencies for makem/M+/-make

strip #line source position informationp/P+/-noline

Default: -ECILMP

Description

With this option you tell the compiler to preprocess the C source. Under Eclipse the compiler sends the
preprocessed output to the file name.pre (where name is the name of the C source file to compile).
Eclipse also compiles the C source.

On the command line, the compiler sends the preprocessed file to stdout. To capture the information in
a file, specify an output file with the option --output.

With --preprocess=+comments you tell the preprocessor to keep the comments from the C source file
in the preprocessed output.

With --preprocess=+includes the compiler will generate a list of all included source files.The preprocessor
output is discarded.

With --preprocess=+list the compiler will generate a list of all macro definitions.The preprocessor output
is discarded.

With --preprocess=+make the compiler will generate dependency lines that can be used in a Makefile.
The preprocessor output is discarded. The default target name is the basename of the input file, with the
extension .obj.With the option --make-target you can specify a target name which overrules the default
target name.
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With --preprocess=+noline you tell the preprocessor to strip the #line source position information (lines
starting with #line). These lines are normally processed by the assembler and not needed in the
preprocessed output. When you leave these lines out, the output is easier to read.

Example

c87 --preprocess=+comments,+includes,-list,-make,-noline test.c --output=test.pre

The compiler preprocesses the file test.c and sends the output to the file test.pre. Comments and
a list of all included source files are included but no list of macro definitions and no dependencies are
generated and the line source position information is not stripped from the output file.

Related information

C compiler option --dep-file (Generate dependencies in a file)

C compiler option --make-target (Specify target name for -Em output)
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C compiler option: --ram-model

Menu entry

1. Select C Compiler » Memory Model.

2. Select a RAM data model.

Command line syntax

--ram-model=model

You can set the following flags:

Full 64kB internal data memoryddata

Lowest 512 bytes of internal data memoryssdata

Default: --ram-model=data

Description

With this option you can select the RAM data model. All RAM data models allow all memory type qualifiers
to be used. Each model has a default memory type qualifier, which is used for objects defined without a
memory type qualifier. Depending on the model used, the compiler sets a predefined macro.

Predefined macroDefault data memory typeRAM data model

__RAM_DATA____datadata

__RAM_SDATA____sdatasdata

Example

To select the sdata RAM model:

c87 --ram-model=sdata test.c

Related information

C compiler option --rom-model (Select ROM data model)

Section 1.3.2, Memory Models and Default Memory Type for Data
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C compiler option: --rename-sections (-R)

Menu entry

1. Select C Compiler » Allocation

The Rename sections box shows the sections that are currently renamed.

2. To rename a section, click on the Add button in the Rename sections box.

3. Type the rename rule in the format type=format or format (for example, data={module}.{attrib})

Use the Edit and Delete button to change a section renaming or to remove an entry from the list.

Command line syntax

--rename-sections[=[type=][format_string]],...

-R[type=][format_string]],...

Default section name: .type.{module}.{name}

Description

By default the compiler extends the standard ELF section names with the module name and the name
of the symbol that is allocated in the section.You can use this option to create your own unique section
names to ease selection in linker script files for locating.

With the type argument you select which sections are renamed. When the type of a section matches, the
section name will get the specified format string as suffix.

You can specify the following section types:

Section typesMemory space

ztext0, ztext1, text0, text1, text, zrodata0, zrodata1,
rodata0, rodata1, rodata

Program memory space

bdata, bbss, sdata, sbss, mdata, mbss, data, bss, bitdata,
bitbss, mbitdata, mbitbss

Internal data memory space

xdata, xbss, xrodata, hxdata, hxbss, hxrodataExternal data memory space

allOther

When you omit the type or use type "all", all sections will be renamed.

With the format_string you specify the string that extends the ELF section name. The format string can
contain characters and may contain the following format specifiers:

Expands to the section attributes, separated by underscores. The cluster attribute,
used when debug information is enabled, is not included.

{attrib}
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Expands to the basename of the module name.{module}

Expands to the object name, name of variable or function.{name}

In format specifier expansions (for example, a module name with an extra dot), dots ('.') are replaced by
dollars ($).

When you omit the format_string, only the section type will be used as the section name.

Example

To rename sections of memory type data to .data.c87.variable_name:

c87 --rename-sections=data=c87.{name} test.c

To generate the section name .type.NEW instead of the default section name
.type.module_name.symbol_name, enter:

c87 -RNEW test.c

To generate the section name section_type_prefix instead of the default section name
section_type_prefix.module_name.symbol_name, enter:

c87 -R test.c

Related information

Section 1.11, Section Naming
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C compiler option: --rom-const

Menu entry

1. Select C Compiler » Memory Model.

2. Enable the option Constants in ROM.

Command line syntax

--rom-const

Description

Allocate all const objects without a memory type qualifier in ROM (program memory space). In addition
all const pointers without a memory type qualifier will be referring to ROM. When you use this option,
the memory type qualifier is selected by the option --rom-model. Otherwise the option --ram-model will
select the memory type qualifier. This option does not apply to __bit objects (or pointers to __bit),
because the program memory space is not bit-addressable.

With this option set the predefined macro __ROM_CONST__ expands to 1.

Related information

C compiler option --rom-model (Select ROM data model)

C compiler option --ram-model (Select RAM data model)

Section 1.3.2, Memory Models and Default Memory Type for Data
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C compiler option: --rom-model

Menu entry

1. Select C Compiler » Memory Model.

2. Select a ROM data model.

Command line syntax

--rom-model=model

You can set the following flags:

Bank 0 in program memorybb0

Any bank in program memoryrrom

Lowest 64kB in bank 0 of program memoryzz0

Bank 1 in program memoryb1

Lowest 64kB in bank 1 of program memoryz1

Default: --rom-model=z0

Description

With this option you can select the ROM data model. All ROM data models allow all memory type qualifiers
to be used. Each model has a default memory type qualifier, which is used for objects defined without a
memory type qualifier. Depending on the model used, the compiler sets a predefined macro.

Predefined macroDefault data memory typeROM data model

__ROM_BANK0____bank0b0

__ROM_BANK1____bank1b1

__ROM_ZERO0____zero0z0

__ROM_ZERO1____zero1z1

__ROM_ROM____romrom

When an object is explicitly or automatically qualified with the default memory type qualifier, the compiler
can generate better optimized code to access the object.

Example

extern const   int c;
extern __zero1 int cz1;
extern __zero0 int cz0;

int func( void )
{
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    return c + cz0 + cz1;
}

When translated with:

c87 --rom-model=z1 func.c

Object c is allocated in __data and is not affected by the option --rom-model. Access to object cz1 can
be optimized because it explicitly uses the default memory type qualifier.

When translated with:

c87 --rom-model=z1 --rom-const func.c

Object c is moved to ROM, and receives the default memory type qualifier. Therefore, access to object
c can be optimized like the access to object cz1.

Because object cz0 is not allocated in the default ROM space, an access to this object requires more
code.

Related information

C compiler option --rom-const (Allocate constants in ROM)

C compiler option --ram-model (Select RAM data model)

Section 1.3.2, Memory Models and Default Memory Type for Data
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C compiler option: --signed-bitfields

Menu entry

1. Select C Compiler » Language.

2. Enable the option Treat 'int' bit-fields as signed.

Command line syntax

--signed-bitfields

Description

For bit-fields it depends on the implementation whether a plain int is treated as signed int or unsigned
int. By default an int bit-field is treated as unsigned int. This offers the best performance. With this
option you tell the compiler to treat int bit-fields as signed int. In this case, you can still add the
keyword unsigned to treat a particular int bit-field as unsigned.

Related information

Section 1.1, Data Types
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C compiler option: --source (-s)

Menu entry

1. Select C Compiler » Miscellaneous.

2. Enable the option Merge C source code with generated assembly.

Command line syntax

--source

-s

Description

With this option you tell the compiler to merge C source code with generated assembly code in the output
file. The C source lines are included as comments.

Related information

Pragmas source/nosource

260

TASKING VX-toolset for LC87 User Guide



C compiler option: --stdout (-n)

Menu entry

-

Command line syntax

--stdout

-n

Description

With this option you tell the compiler to send the output to stdout (usually your screen). No files are
created. This option is for example useful to quickly inspect the output or to redirect the output to other
tools.

Related information

-
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C compiler option: --string-literal-memory

Menu entry

1. Select C Compiler » Memory Model.

2. Select a String literal space.

Command line syntax

--string-literal-memory=space

Default: --string-literal-memory=model

Description

With this option you can control the allocation of string literals. The space must be one of: __bdata,
__sdata, __mdata, __data, __xdata, __hxdata, __xrom, __hxrom, __rom, __bank0, __bank1,
__zero0, __zero1 or model

When the space differs from the default memory model space, pointers to string literals may need
qualification. Also, C library functions accepting a default pointer to char/wchar_t may need to be
recompiled with a different name/prototype.

When the space is set to model, string literals will be allocated according to the settings of the options
--ram-model / --rom-model.

In the context of this option, a string literal used to initialize an array, as in:

char array[] = "string";

is not considered a string literal; i.e. this is an array initializer written as a string, equivalent to:

char array[] = { 's', 't', 'r', 'i', 'n', 'g', '\0' };

Strings literals as used in:

char * s = "string";

or:

printf( "formatter %s\n", "string" );

are affected by this option.

Example

To allocate string literals in __b0 memory:

c87 --string-literal-memory=__b0 test.c
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Related information

Pragma string_literal_memory

C compiler option --rom-model (Select ROM data model)

C compiler option --ram-model (Select RAM data model)

Section 1.3.2, Memory Models and Default Memory Type for Data

Section 1.9, Strings
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C compiler option: --tradeoff (-t)

Menu entry

1. Select C Compiler » Optimization.

2. Select a trade-off level in the Trade-off between speed and size box.

Command line syntax

--tradeoff={0|1|2|3|4}

-t{0|1|2|3|4}

Default: --tradeoff=4

Description

If the compiler uses certain optimizations (option --optimize), you can use this option to specify whether
the used optimizations should optimize for more speed (regardless of code size) or for smaller code size
(regardless of speed).

By default the compiler optimizes for code size (--tradeoff=4).

If you have not specified the option --optimize, the compiler uses the default Optimize more
optimization. In this case it is still useful to specify a trade-off level.

Example

To set the trade-off level for the used optimizations:

c87 --tradeoff=2 --thumb test.c

The compiler uses the default Optimize more optimization level and optimizes for code size.

Related information

C compiler option --optimize (Specify optimization level)

Section 3.5.3, Optimize for Code Size or Execution Speed
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C compiler option: --uchar (-u)

Menu entry

1. Select C Compiler » Language.

2. Enable the option Treat 'char' variables as unsigned.

Command line syntax

--uchar

-u

Description

By default char is the same as specifying signed char.With this option char is the same as unsigned
char.

Related information

Section 1.1, Data Types
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C compiler option: --undefine (-U)

Menu entry

1. Select C Compiler » Preprocessing

The Defined symbols box shows the symbols that are currently defined.

2. To remove a defined symbol, select the symbol in the Defined symbols box and click on the Delete
button.

Command line syntax

--undefine=macro_name

-Umacro_name

Description

With this option you can undefine an earlier defined macro as with #undef. This option is for example
useful to undefine predefined macros.

The following predefined ISO C standard macros cannot be undefined:

current source filename__FILE__

current source line number (int type)__LINE__

hh:mm:ss__TIME__

Mmm dd yyyy__DATE__

level of ANSI standard__STDC__

Example

To undefine the predefined macro __TASKING__:

c87 --undefine=__TASKING__ test.c

Related information

C compiler option --define (Define preprocessor macro)

Section 1.8, Predefined Preprocessor Macros
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C compiler option: --verbose (-v)

Menu entry

-

Command line syntax

--verbose

-v

Description

With this option you put the C compiler in verbose mode. The C compiler performs its tasks while it prints
the steps it performs to stdout.

Related information

-
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C compiler option: --version (-V)

Menu entry

-

Command line syntax

--version

-V

Description

Display version information. The compiler ignores all other options or input files.

Related information

-
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C compiler option: --warnings-as-errors

Menu entry

1. Select Global Options.

2. Enable the option Treat warnings as errors.

Command line syntax

--warnings-as-errors[=number[-number],...]

Description

If the compiler encounters an error, it stops compiling. When you use this option without arguments, you
tell the compiler to treat all warnings not suppressed by option --no-warnings (or #pragma warning)
as errors. This means that the exit status of the compiler will be non-zero after one or more compiler
warnings. As a consequence, the compiler now also stops after encountering a warning.

You can limit this option to specific warnings by specifying a comma-separated list of warning numbers
or ranges. In this case, this option takes precedence over option --no-warnings (and #pragma warning).

Related information

C compiler option --no-warnings (Suppress some or all warnings)

Pragma warning
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8.3. Assembler Options

This section lists all assembler options.

Options in Eclipse versus options on the command line

Most command line options have an equivalent option in Eclipse but some options are only available on
the command line. Eclipse invokes the assembler via the control program. Therefore, it uses the syntax
of the control program to pass options and files to the assembler. If there is no equivalent option in Eclipse,
you can specify a command line option in Eclipse as follows:

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Assembler » Miscellaneous.

4. In the Additional options field, enter one or more command line options.

Because Eclipse uses the control program, Eclipse automatically precedes the option with -Wa to
pass the option via the control program directly to the assembler.

Note that the options you enter in the Assembler page are not only used for hand-coded assembly
files, but also for the assembly files generated by the compiler.

Be aware that some command line options are not useful in Eclipse or just do not have any effect. For
example, the option -V displays version header information and has no effect in Eclipse.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters.You can abbreviate long option
names as long as it forms a unique name.You can mix short and long option names on the command
line.

Options can have flags or suboptions. To switch a flag 'on', use a lowercase letter or a +longflag. To
switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following
two invocations are equivalent:

as87 -l -LeM test.src
as87 --list-file --list-format=+symbol,-macro test.src

When you do not specify an option, a default value may become active.
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Assembler option: --case-insensitive (-c)

Menu entry

1. Select Assembler » Symbols.

2. Enable the option Case insensitive identifiers.

Command line syntax

--case-insensitive

-c

Default: case sensitive

Description

With this option you tell the assembler not to distinguish between uppercase and lowercase characters.
By default the assembler considers uppercase and lowercase characters as different characters.

Assembly source files that are generated by the compiler must always be assembled case sensitive.
When you are writing your own assembly code, you may want to specify the case insensitive mode.

Example

When assembling case insensitive, the label LabelName is the same label as labelname.

as87 --case-insensitive test.src

Related information

-
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Assembler option: --check

Menu entry

-

Command line syntax

--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves
time in developing your application.

The assembler reports any warnings and/or errors.

This option is available on the command line only.

Related information

C compiler option --check (Check syntax)
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Assembler option: --debug-info (-g)

Menu entry

1. Select Assembler » Symbols.

2. Select an option from the Generate symbolic debug list.

Command line syntax

--debug-info[=flags]

-g[flags]

You can set the following flags:

Assembly source line informationa/A+/-asm

Pass high level language debug information (HLL)h/H+/-hll

Assembler local symbols debug informationl/L+/-local

Smart debug informations/S+/-smart

Default: --debug-info=+hll

Default (without flags): --debug-info=+smart

Description

With this option you tell the assembler which kind of debug information to emit in the object file.

You cannot specify --debug-info=+asm,+hll. Either the assembler generates assembly source line
information, or it passes HLL debug information.

When you specify --debug-info=+smart, the assembler selects which flags to use. If high level language
information is available in the source file, the assembler passes this information (same as
--debug-info=-asm,+hll,-local). If not, the assembler generates assembly source line information (same
as --debug-info=+asm,-hll,+local).

With --debug-info=AHLS the assembler does not generate any debug information.

Related information

-
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Assembler option: --define (-D)

Menu entry

1. Select Assembler » Preprocessing.

The Defined symbols box right-below shows the symbols that are currently defined.

2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, demo=1)

Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

--define=macro_name[=macro_definition]

-Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the assembler preprocessor. If you only specify
a macro name (no macro definition), the macro expands as '1'.

You can specify as many macros as you like. Simply use the Add button to add new macro definitions.

On the command line, use the option --define (-D) multiple times. If the command line exceeds the limit
of the operating system, you can define the macros in an option file which you then must specify to the
assembler with the option --option-file (-f) file.

Defining macros with this option (instead of in the assembly source) is, for example, useful in combination
with conditional assembly as shown in the example below.

This option has the same effect as defining symbols via the .DEFINE, .SET, and .EQU directives.
(similar to #define in the C language). With the .MACRO directive you can define more complex
macros.

Example

Consider the following assembly program with conditional code to assemble a demo program and a real
program:

.IF DEMO == 1

...        ; instructions for demo application

.ELSE

...        ; instructions for the real application

.ENDIF
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You can now use a macro definition to set the DEMO flag:

as87 --define=DEMO test.src
as87 --define=DEMO=1 test.src

Note that both invocations have the same effect.

Related information

Assembler option --option-file (Specify an option file)
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Assembler option: --dep-file

Menu entry

-

Command line syntax

--dep-file[=file]

Description

With this option you tell the assembler to generate dependency lines that can be used in a Makefile. The
dependency information will be generated in addition to the normal output file.

By default, the information is written to a file with extension .d. When you specify a filename, all
dependencies will be combined in the specified file.

Example

as87 --dep-file=test.dep test.src

The assembler assembles the file test.src, which results in the output file test.obj, and generates
dependency lines in the file test.dep.

Related information

Assembler option --make-target (Specify target name for --dep-file output)
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Assembler option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems.

The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.

A popup menu appears.

3. Select Detailed Diagnostics Info.

A dialog box appears with additional information.

Command line syntax

--diag=[format:]{all | nr,...}

You can set the following output formats:

HTML output.html

Rich Text Format.rtf

ASCII text.text

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify.You can specify the
following formats: html, rtf or text (default). To create a file with the descriptions, you must redirect the
output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one
or more selected error messages, you can specify the error message numbers, separated by commas.

Example

To display an explanation of message number 244, enter:

as87 --diag=244

This results in the following message and explanation:

W244: additional input files will be ignored

The assembler supports only a single input file. All other input files are ignored.
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To write an explanation of all errors and warnings in HTML format to file aserrors.html, use redirection
and enter:

as87 --diag=html:all > aserrors.html

Related information

Section 4.6, Assembler Error Messages
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Assembler option: --dwarf-version

Menu entry

-

Command line syntax

--dwarf-version={2|3}

Default: 3

Description

With this option you tell the assembler which DWARF debug version to generate, DWARF2 or DWARF3
(default).

Related information

Section 11.1, ELF/DWARF Object Format
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Assembler option: --error-file

Menu entry

-

Command line syntax

--error-file[=file]

Description

With this option the assembler redirects error messages to a file. If you do not specify a filename, the
error file will be named after the output file with extension .ers.

Example

To write errors to errors.ers instead of stderr, enter:

as87 --error-file=errors.ers test.src

Related information

Section 4.6, Assembler Error Messages
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Assembler option: --error-limit

Menu entry

1. Select Assembler » Diagnostics.

2. Enter a value in the Maximum number of emitted errors field.

Command line syntax

--error-limit=number

Default: 42

Description

With this option you tell the assembler to only emit the specified maximum number of errors. When 0
(null) is specified, the assembler emits all errors. Without this option the maximum number of errors is
42.

Related information

Section 4.6, Assembler Error Messages
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Assembler option: --help (-?)

Menu entry

-

Command line syntax

--help[=item]

-?

You can specify the following arguments:

Show extended option descriptionsoptions

Description

Displays an overview of all command line options. When you specify the argument options you can list
detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

as87 -?
as87 --help
as87

To see a detailed description of the available options, enter:

as87 --help=options

Related information

-
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Assembler option: --include-directory (-I)

Menu entry

1. Select Assembler » Include Paths.

The Include paths box shows the directories that are added to the search path for include files.

2. To define a new directory for the search path, click on the Add button in the Include paths box.

3. Type or select a path.

Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax

--include-directory=path,...

-Ipath,...

Description

With this option you can specify the path where your include files are located. A relative path will be
relative to the current directory,

The order in which the assembler searches for include files is:

1. The pathname in the assembly file and the directory of the assembly source.

2. The path that is specified with this option.

3. The path that is specified in the environment variable AS87INC when the product was installed.

4. The default directory $(PRODDIR)\include.

Example

Suppose that the assembly source file test.src contains the following lines:

.INCLUDE 'myinc.inc'

You can call the assembler as follows:

as87 --include-directory=c:\proj\include test.src

First the assembler looks for the file myinc.inc in the directory where test.src is located. If it does
not find the file, it looks in the directory c:\proj\include (this option). If the file is still not found, the
assembler searches in the environment variable and then in the default include directory.
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Related information

Assembler option --include-file (Include file at the start of the input file)
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Assembler option: --include-file (-H)

Menu entry

1. Select Assembler » Preprocessing.

The Pre-include files box shows the files that are currently included before the assembling starts.

2. To define a new file, click on the Add button in the Pre-include files box.

3. Type the full path and file name or select a file.

Use the Edit and Delete button to change a file name or to remove a file from the list.

Command line syntax

--include-file=file,...

-Hfile,...

Description

With this option (set at project level) you include one extra file at the beginning of the assembly source
file.The specified include file is included before all other includes.This is the same as specifying .INCLUDE
'file' at the beginning of your assembly source.

Example

as87 --include-file=myinc.inc test.src

The file myinc.inc is included at the beginning of test.src before it is assembled.

Related information

Assembler option --include-directory (Add directory to include file search path)

285

Tool Options



Assembler option: --kanji

Menu entry

1. Select Assembler » Miscellaneous.

2. Enable the option Allow Shift JIS Kanji in strings.

Command line syntax

--kanji

Description

With this option you tell the assembler to support Shift JIS encoded Kanji multi-byte characters in strings.
Without this option, encodings with 0x5c as the second byte conflict with the use of the backslash as an
escape character. Shift JIS in comments is supported regardless of this option.

Note that Shift JIS also includes Katakana and Hiragana.

Related information

C compiler option --language=+kanji (Allow Shift JIS Kanji in strings)
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Assembler option: --keep-output-files (-k)

Menu entry

Eclipse always removes the object file when errors occur during assembling.

Command line syntax

--keep-output-files

-k

Description

If an error occurs during assembling, the resulting object file (.obj) may be incomplete or incorrect. With
this option you keep the generated object file when an error occurs.

By default the assembler removes the generated object file when an error occurs. This is useful when
you use the make utility. If the erroneous files are not removed, the make utility may process corrupt files
on a subsequent invocation.

Use this option when you still want to use the generated object. For example when you know that a
particular error does not result in a corrupt object file.

Related information

Assembler option --warnings-as-errors (Treat warnings as errors)
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Assembler option: --list-file (-l)

Menu entry

1. Select Assembler » List File.

2. Enable the option Generate list file.

3. Enable or disable the types of information to be included.

Command line syntax

--list-file[=file]

-l[file]

Default: no list file is generated

Description

With this option you tell the assembler to generate a list file. A list file shows the generated object code
and the relative addresses. Note that the assembler generates a relocatable object file with relative
addresses.

With the optional file you can specify an alternative name for the list file. By default, the name of the list
file is the basename of the output file with the extension .lst.

Related information

Assembler option --list-format (Format list file)
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Assembler option: --list-format (-L)

Menu entry

1. Select Assembler » List File.

2. Enable the option Generate list file.

3. Enable or disable the types of information to be included.

Command line syntax

--list-format=flag,...

-Lflags

You can set the following flags:

List section directives (.SECTION)d/D+/-section

List symbol definition directivese/E+/-symbol

List expansion of generic instructionsg/G+/-generic-expansion

List generic instructionsi/I+/-generic

List C preprocessor #line directivesl/L+/-line

List macro definitionsm/M+/-macro

List empty source lines (newline)n/N+/-empty-line

List conditional assemblyp/P+/-conditional

List equate and set directives (.EQU, .SET)q/Q+/-equate

List relocations characters ( 'r' )r/R+/-relocations

List HLL symbolic debug informationss/S+/-hll

List equate and set valuesv/V+/-equate-values

Wrap source linesw/W+/-wrap-lines

List macro expansionsx/X+/-macro-expansion

List cycle countsy/Y+/-cycle-count

List define expansionsz/Z+/-define-expansion

Use the following options for predefined sets of flags:

All options disabled
Alias for --list-format=DEGILMNPQRSVWXYZ

-L0--list-format=0

All options enabled
Alias for --list-format=degilmnpqrsvwxyz

-L1--list-format=1

Default: --list-format=dEgilMnPqrsVwXyZ
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Description

With this option you specify which information you want to include in the list file.

On the command line you must use this option in combination with the option --list-file (-l).

Related information

Assembler option --list-file (Generate list file)

Assembler option --section-info=+list (Display section information in list file)
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Assembler option: --make-target

Menu entry

-

Command line syntax

--make-target=name

Description

With this option you can overrule the default target name in the make dependencies generated by the
option --dep-file. The default target name is the basename of the input file, with extension .obj.

Example

as87 --dep-file --make-target=../mytarget.obj test.src

The assembler generates dependency lines with the default target name ../mytarget.obj instead of
test.obj.

Related information

Assembler option --dep-file (Generate dependencies in a file)
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Assembler option: --nested-sections (-N)

Menu entry

1. Select Assembler » Miscellaneous.

2. Enable the option Allow nested sections.

Command line syntax

--nested-sections

-N

Description

With this option it is allowed to have nested sections in your assembly source file. When you use this
option every .SECTION directive must have a corresponding .ENDSEC directive.

Example

    .SECTION .data
       ; section
    .SECTION .data
       ; nested section
    .ENDSEC
    .ENDSEC

Related information

Assembler directive .SECTION
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Assembler option: --no-abs17-to-rel12

Menu entry

-

Command line syntax

--no-abs17-to-rel12

Description

By default the assembler replaces a 3-byte absolute CALL/JMP instruction by a 2-byte PC-relative
RCALL/BR instruction if the target is known to be in range and in the same section. With this option you
can disable this replacement.

Related information

Section 2.12, Generic Instructions
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Assembler option: --no-rel12-to-abs17

Menu entry

-

Command line syntax

--no-rel12-to-abs17

Description

By default the assembler replaces a 2-byte PC-relative RCALL/BR instruction by a 3-byte absolute
CALL/JMP instruction if the target is known to be out-of-range or in another section. With this option you
can disable this replacement.

Related information

Section 2.12, Generic Instructions
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Assembler option: --no-warnings (-w)

Menu entry

1. Select Assembler » Diagnostics.

The Suppress warnings box shows the warnings that are currently suppressed.

2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas, of the warnings you want to suppress (for example
201,202). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.

Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

--no-warnings[=number,...]

-w[number,...]

Description

With this option you can suppresses all warning messages or specific warning messages.

On the command line this option works as follows:

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings are suppressed.

• If you specify this option with a number, only the specified warning is suppressed.You can specify the
option --no-warnings=number multiple times.

Example

To suppress warnings 201 and 202, enter:

as87 test.src --no-warnings=201,202

Related information

Assembler option --warnings-as-errors (Treat warnings as errors)
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Assembler option: --optimize (-O)

Menu entry

1. Select Assembler » Optimization.

2. Select one or more of the following options:

• Optimize generic instructions

• Optimize instruction size

Command line syntax

--optimize=flag,...

-Oflags

You can set the following flags:

Allow generic instructionsg/G+/-generics

Optimize instruction sizes/S+/-instr-size

Default: --optimize=gs

Description

With this option you can control the level of optimization. For details about each optimization see
Section 4.4, Assembler Optimizations.

Related information

Section 4.4, Assembler Optimizations
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Assembler option: --option-file (-f)

Menu entry

1. Select Assembler » Miscellaneous.

2. Add the option --option-file to the Additional options field.

Be aware that the options in the option file are added to the assembler options you have set in the
other pages. Only in extraordinary cases you may want to use them in combination.

Command line syntax

--option-file=file,...

-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line,
you can create an option file which contains all options and flags you want to specify. With this option
you specify the option file to the assembler.

Use an option file when the command line would exceed the limits of the operating system, or just to store
options and save typing.

Option files can also be generated on the fly, for example by the make utility.You can specify the option
--option-file multiple times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and
vise versa:

"This has a single quote ' embedded"

'This has a double quote " embedded'

'This has a double quote " and a single quote '"' embedded"

• When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is
preserved.

"This is a continuation \
line"

         -> "This is a continuation line"
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• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

--debug=+asm,-local
test.src

Specify the option file to the assembler:

as87 --option-file=myoptions

This is equivalent to the following command line:

as87 --debug=+asm,-local test.src

Related information

-
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Assembler option: --output (-o)

Menu entry

Eclipse names the output file always after the input file.

Command line syntax

--output=file

-o file

Description

With this option you can specify another filename for the output file of the assembler. Without this option,
the basename of the assembly source file is used with extension .obj.

Example

To create the file relobj.obj instead of asm.obj, enter:

as87 --output=relobj.obj asm.src

Related information

-
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Assembler option: --page-length

Menu entry

1. Select Assembler » Miscellaneous.

2. Add the option --page-length to the Additional options field.

Command line syntax

--page-length=number

Default: 72

Description

If you generate a list file with the assembler option --list-file, this option sets the number of lines in a page
in the list file. The default is 72, the minimum is 10. As a special case, a page length of 0 turns off page
breaks.

Related information

Assembler option --list-file (Generate list file)

Assembler directive .PAGE
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Assembler option: --page-width

Menu entry

1. Select Assembler » Miscellaneous.

2. Add the option --page-width to the Additional options field.

Command line syntax

--page-width=number

Default: 132

Description

If you generate a list file with the assembler option --list-file, this option sets the number of columns per
line on a page in the list file. The default is 132, the minimum is 40.

Related information

Assembler option --list-file (Generate list file)

Assembler directive .PAGE
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Assembler option: --preprocess (-E)

Menu entry

-

Command line syntax

--preprocess

-E

Description

With this option the assembler will only preprocess the assembly source file. The assembler sends the
preprocessed file to stdout.

Related information

-
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Assembler option: --preprocessor-type (-m)

Menu entry

1. Select Assembler » Preprocessing.

2. Enable or disable the option Use TASKING preprocessor.

Command line syntax

--preprocessor-type=type

-mtype

You can set the following preprocessor types:

No preprocessornnone

TASKING preprocessorttasking

Default: --preprocessor-type=tasking

Description

With this option you select the preprocessor that the assembler will use. By default, the assembler uses
the TASKING preprocessor.

When the assembly source file does not contain any preprocessor symbols, you can specify to the
assembler not to use a preprocessor.

Related information

-
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Assembler option: --section-info (-t)

Menu entry

1. Select Assembler » List File.

2. Enable the option Generate list file.

3. Enable the option List section summary.

and/or

1. Select Assembler » Diagnostics.

2. Enable the option Display section summary.

Command line syntax

--section-info[=flag,...]

-t[flags]

You can set the following flags:

Display section summary on consolec/C+/-console

List section summary in list filel/L+/-list

Default: --section-info=CL

Default (without flags): --section-info=cl

Description

With this option you tell the assembler to display section information. For each section its memory space,
size, total cycle counts and name is listed on stdout and/or in the list file.

The cycle count consists of two parts: the total accumulated count for the section and the total accumulated
count for all repeated instructions. In the case of nested loops it is possible that the total supersedes the
section total.

Example

To writes the section information to the list file and also display the section information on stdout, enter:

as87 --list-file --section-info asm.src

Related information

Assembler option --list-file (Generate list file)
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Assembler option: --short-idata

Menu entry

-

Command line syntax

--short-idata

Description

With this option the assembler selects instructions with short range internal data destinations only, unless
the M-form or the L-form of an instruction is used explicitly.

Related information

Section 2.12, Generic Instructions
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Assembler option: --symbol-scope (-i)

Menu entry

1. Select Assembler » Symbols.

2. Enable or disable the option Set default symbol scope to global.

Command line syntax

--symbol-scope=scope

-iscope

You can set the following scope:

Default symbol scope is globalgglobal

Default symbol scope is localllocal

Default: --symbol-scope=local

Description

With this option you tell the assembler how to treat symbols that you have not specified explicitly as global
or local. By default the assembler treats all symbols as local symbols unless you have defined them
explicitly as global.

Related information

Assembler directive .GLOBAL
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Assembler option: --version (-V)

Menu entry

-

Command line syntax

--version

-V

Description

Display version information. The assembler ignores all other options or input files.

Related information

-
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Assembler option: --warnings-as-errors

Menu entry

1. Select Global Options.

2. Enable the option Treat warnings as errors.

Command line syntax

--warnings-as-errors[=number,...]

Description

If the assembler encounters an error, it stops assembling. When you use this option without arguments,
you tell the assembler to treat all warnings as errors. This means that the exit status of the assembler will
be non-zero after one or more assembler warnings. As a consequence, the assembler now also stops
after encountering a warning.

You can limit this option to specific warnings by specifying a comma-separated list of warning numbers.

Related information

Assembler option --no-warnings (Suppress some or all warnings)
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8.4. Linker Options

This section lists all linker options.

Options in Eclipse versus options on the command line

Most command line options have an equivalent option in Eclipse but some options are only available on
the command line. Eclipse invokes the linker via the control program. Therefore, it uses the syntax of the
control program to pass options and files to the linker. If there is no equivalent option in Eclipse, you can
specify a command line option in Eclipse as follows:

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Miscellaneous.

4. In the Additional options field, enter one or more command line options.

Because Eclipse uses the control program, Eclipse automatically precedes the option with -Wl to
pass the option via the control program directly to the linker.

Be aware that some command line options are not useful in Eclipse or just do not have any effect. For
example, the option --keep-output-files keeps files after an error occurred. When you specify this option
in Eclipse, it will have no effect because Eclipse always removes the output file after an error had occurred.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters.You can abbreviate long option
names as long as it forms a unique name.You can mix short and long option names on the command
line.

Options can have flags or suboptions. To switch a flag 'on', use a lowercase letter or a +longflag. To
switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following
two invocations are equivalent:

lk87 -mfkl test.obj
lk87 --map-file-format=+files,+link,+locate test.obj

When you do not specify an option, a default value may become active.
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Linker option: --bank-switching

Menu entry

1. Select Linker » Miscellaneous.

2. Enable the option Generate bank switching stubs.

Command line syntax

--bank-switching

Description

With this option you enable the linker to generate a bank switching stub if the target address of a JMP or
CALL instruction is in the other program memory bank. The locating process of the linker may become
less efficient if you enable this option, even if it turns out that no stubs are required after all. Therefore,
you should use this option only if your hardware has two memory banks.

Related information

-
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Linker option: --case-insensitive

Menu entry

1. Select Linker » Miscellaneous.

2. Enable the option Link case insensitive.

Command line syntax

--case-insensitive

Default: case sensitive

Description

With this option you tell the linker not to distinguish between uppercase and lowercase characters in
symbols. By default the linker considers uppercase and lowercase characters as different characters.

Assembly source files that are generated by the compiler must always be assembled and thus linked
case sensitive. When you have written your own assembly code and specified to assemble it case
insensitive, you must also link the .obj file case insensitive.

Related information

Assembler option --case-insensitive
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Linker option: --chip-output (-c)

Menu entry

1. Select Linker » Output Format.

2. Enable the option Generate Intel Hex format file and/or Generate S-records file.

3. Enable the option Create file for each memory chip.

4. Optionally, specify the Size of addresses.

Eclipse always uses the project name as the basename for the output file.

Command line syntax

--chip-output=[basename]:format[:addr_size],...

-c[basename]:format[:addr_size],...

You can specify the following formats:

Intel HexIHEX

Motorola S-recordsSREC

The addr_size specifies the size of the addresses in bytes (record length). For Intel Hex you can use the
values 1, 2 or 4 bytes (default). For Motorola-S you can specify: 2 (S1 records), 3 (S2 records) or 4 bytes
(S3 records, default).

Description

With this option you specify the Intel Hex or Motorola S-record output format for loading into a
PROM-programmer. The linker generates a file for each ROM memory defined in the LSL file, where
sections are located:

memory memname
{  type=rom;  }

The name of the file is the name of the Eclipse project or, on the command line, the name of the memory
device that was emitted with extension .hex or .sre. Optionally, you can specify a basename which
prepends the generated file name.

The linker always outputs a debugging file in ELF/DWARF format and optionally an absolute
object file in Intel Hex-format and/or Motorola S-record format.

Example

To generate Intel Hex output files for each defined memory, enter the following on the command line:

lk87 --chip-output=myfile:IHEX test1.obj

312

TASKING VX-toolset for LC87 User Guide



In this case, this generates the file myfile_memname.hex.

Related information

Linker option --output (Output file)
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Linker option: --define (-D)

Menu entry

1. Select Linker » Script File.

The Defined symbols box shows the symbols that are currently defined.

2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, demo=1)

Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

--define=macro_name[=macro_definition]

-Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the linker LSL file preprocessor. If you only
specify a macro name (no macro definition), the macro expands as '1'.

You can specify as many macros as you like; just use the option --define (-D) multiple times. If the
command line exceeds the limit of the operating system, you can define the macros in an option file which
you then must specify to the linker with the option --option-file (-f) file.

The definition can be tested by the preprocessor with #if, #ifdef and #ifndef, for conditional locating.

Example

To define the stack size which is used in the linker script file lc87.lsl, enter:

lk87 test.obj -otest.abs --lsl-file=lc87.lsl --define=__STACK_SIZE=128

Related information

Linker option --option-file (Specify an option file)
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Linker option: --dep-file

Menu entry

Eclipse uses this option in the background to create a file with extension .d (one for every input file).

Command line syntax

--dep-file[=file]

Description

With this option you tell the linker to generate dependency lines that can be used in a Makefile. The
dependency information will be generated in addition to the normal output file.

By default, the information is written to the file lk87.d. When you specify a filename, all dependencies
will be combined in the specified file.

Example

lk87 --dep-file=test.dep test.obj

The linker links the file test.obj, which results in the output file test.abs, and generates dependency
lines in the file test.dep.

Related information

Linker option --make-target (Target to use in dependencies file)
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Linker option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems.

The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.

A popup menu appears.

3. Select Detailed Diagnostics Info.

A dialog box appears with additional information.

Command line syntax

--diag=[format:]{all | nr,...}

You can set the following output formats:

HTML output.html

Rich Text Format.rtf

ASCII text.text

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify.You can specify the
following formats: html, rtf or text (default). To create a file with the descriptions, you must redirect the
output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one
or more selected error messages, you can specify the error message numbers, separated by commas.

With this option the linker does not link/locate any files.

Example

To display an explanation of message number 106, enter:

lk87 --diag=106

This results in the following message and explanation:

E106: unresolved external: <message>

The linker could not resolve all external symbols.
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This is an error when the incremental linking option is disabled.
The <message> indicates the symbol that is unresolved.

To write an explanation of all errors and warnings in HTML format to file lkerrors.html, use redirection
and enter:

lk87 --diag=html:all > lkerrors.html

Related information

Section 5.11, Linker Error Messages
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Linker option: --error-file

Menu entry

-

Command line syntax

--error-file[=file]

Description

With this option the linker redirects error messages to a file. If you do not specify a filename, the error file
is lk87.elk.

Example

To write errors to errors.elk instead of stderr, enter:

lk87 --error-file=errors.elk test.obj

Related information

Section 5.11, Linker Error Messages
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Linker option: --error-limit

Menu entry

1. Select Linker » Diagnostics.

2. Enter a value in the Maximum number of emitted errors field.

Command line syntax

--error-limit=number

Default: 42

Description

With this option you tell the linker to only emit the specified maximum number of errors. When 0 (null) is
specified, the linker emits all errors. Without this option the maximum number of errors is 42.

Related information

Section 5.11, Linker Error Messages
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Linker option: --extern (-e)

Menu entry

-

Command line syntax

--extern=symbol,...

-esymbol,...

Description

With this option you force the linker to consider the given symbol as an undefined reference. The linker
tries to resolve this symbol, either the symbol is defined in an object file or the linker extracts the
corresponding symbol definition from a library.

This option is, for example, useful if the startup code is part of a library. Because your own application
does not refer to the startup code, you can force the startup code to be extracted by specifying the symbol
__START as an unresolved external.

Example

Consider the following invocation:

lk87 mylib.lib

Nothing is linked and no output file will be produced, because there are no unresolved symbols when the
linker searches through mylib.lib.

lk87 --extern=__START mylib.lib

In this case the linker searches for the symbol __START in the library and (if found) extracts the object
that contains __START, the startup code. If this module contains new unresolved symbols, the linker looks
again in mylib.lib. This process repeats until no new unresolved symbols are found.

Related information

Section 5.3, Linking with Libraries
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Linker option: --first-library-first

Menu entry

-

Command line syntax

--first-library-first

Description

When the linker processes a library it searches for symbols that are referenced by the objects and libraries
processed so far. If the library contains a definition for an unresolved reference the linker extracts the
object that contains the definition from the library.

By default the linker processes object files and libraries in the order in which they appear on the command
line. If you specify the option --first-library-first the linker always tries to take the symbol definition from
the library that appears first on the command line before scanning subsequent libraries.

This is for example useful when you are working with a newer version of a library that partially overlaps
the older version. Because they do not contain exactly the same functions, you have to link them both.
However, when a function is present in both libraries, you may want the linker to extract the most recent
function.

Example

Consider the following example:

lk87 --first-library-first a.lib test.obj b.lib

If the file test.obj calls a function which is both present in a.lib and b.lib, normally the function in
b.lib would be extracted. With this option the linker first tries to extract the symbol from the first library
a.lib.

Note that routines in b.lib that call other routines that are present in both a.lib and b.lib
are now also resolved from a.lib.

Related information

Linker option --no-rescan (Rescan libraries to solve unresolved externals)
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Linker option: --global-type-checking

Menu entry

-

Command line syntax

--global-type-checking

Description

Use this option when you want the linker to check the types of variable and function references against
their definitions, using DWARF 2 or DWARF 3 debug information.

This check should give the same result as the C compiler when you use MIL linking.

Related information

C compiler option --global-type-checking (Global type checking)
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Linker option: --help (-?)

Menu entry

-

Command line syntax

--help[=item]

-?

You can specify the following arguments:

Show extended option descriptionsoptions

Description

Displays an overview of all command line options. When you specify the argument options you can list
detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

lk87 -?
lk87 --help
lk87

To see a detailed description of the available options, enter:

lk87 --help=options

Related information

-
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Linker option: --hex-format

Menu entry

1. Select Linker » Output Format.

2. Enable the option Generate Intel Hex format file.

3. Enable or disable the option Emit type 2 instead of type 4 records.

4. Enable or disable the option Emit start address record.

Command line syntax

--hex-format=flag,...

You can set the following flag:

Emit type 2 instead of type 4 recordsg/G+/-segmented-ihex

Emit start address records/S+/-start-address

Default: --hex-format=gS

Description

With this option you can change some attributes for all generated Intel Hex files.You can specify to emit
or omit the start address record from the hex file. With flag +segmented-hex the linker emits Intel Hex
type 2 segment records instead of type 4 linear address records.

Related information

Linker option --output (Output file)
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Linker option: --hex-record-size

Menu entry

1. Select Linker » Output Format.

2. Enable the option Generate Intel Hex format file.

3. Specify a Size of data record (in bytes) for Intel Hex records.

Command line syntax

--hex-record-size=size

Default: 16

Description

With this option you can set the size (width) of the Intel Hex data records.

Related information

Linker option --output (Output file)

Section 11.2, Intel Hex Record Format
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Linker option: --import-object

Menu entry

1. Select Linker » Data Objects.

The Data objects box shows the list of object files that are imported.

2. To add a data object, click on the Add button in the Data objects box.

3. Type or select a binary file (including its path).

Use the Edit and Delete button to change a filename or to remove a data object from the list.

Command line syntax

--import-object=file,...

Description

With this option the linker imports a binary file containing raw data and places it in a section. The section
name is derived from the filename, in which dots are replaced by an underscore. So, when importing a
file called my.jpg, a section with the name my_jpg is created. In your application you can refer to the
created section by using linker labels.

Related information

Section 5.5, Importing Binary Files
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Linker option: --include-directory (-I)

Menu entry

-

Command line syntax

--include-directory=path,...

-Ipath,...

Description

With this option you can specify the path where your LSL include files are located. A relative path will be
relative to the current directory.

The order in which the linker searches for LSL include files is:

1. The pathname in the LSL file and the directory where the LSL file is located (only for #include files that
are enclosed in "")

2. The path that is specified with this option.

3. The default directory $(PRODDIR)\include.lsl.

Example

Suppose that your linker script file mylsl.lsl contains the following line:

#include "myinc.inc"

You can call the linker as follows:

lk87 --include-directory=c:\proj\include --lsl-file=mylsl.lsl test.obj

First the linker looks for the file myinc.inc in the directory where mylsl.lsl is located. If it does not
find the file, it looks in the directory c:\proj\include (this option). Finally it looks in the directory
$(PRODDIR)\include.lsl.

Related information

Linker option --lsl-file (Specify linker script file)
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Linker option: --incremental (-r)

Menu entry

-

Command line syntax

--incremental

-r

Description

Normally the linker links and locates the specified object files. With this option you tell the linker only to
link the specified files. The linker creates a linker output file .out.You then can link this file again with
other object files until you have reached the final linker output file that is ready for locating.

In the last pass, you call the linker without this option with the final linker output file .out. The linker will
now locate the file.

Example

In this example, the files test1.obj, test2.obj and test3.obj are incrementally linked:

1. lk87 --incremental test1.obj test2.obj --output=test.out

test1.obj and test2.obj are linked

2. lk87 --incremental test3.obj test.out

test3.obj and test.out are linked, task1.out is created

3. lk87 task1.out

task1.out is located

Related information

Section 5.4, Incremental Linking
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Linker option: --keep-output-files (-k)

Menu entry

Eclipse always removes the output files when errors occurred.

Command line syntax

--keep-output-files

-k

Description

If an error occurs during linking, the resulting output file may be incomplete or incorrect. With this option
you keep the generated output files when an error occurs.

By default the linker removes the generated output file when an error occurs.This is useful when you use
the make utility. If the erroneous files are not removed, the make utility may process corrupt files on a
subsequent invocation.

Use this option when you still want to use the generated file. For example when you know that a particular
error does not result in a corrupt object file, or when you want to inspect the output file, or send it to Altium
support.

Related information

Linker option --warnings-as-errors (Treat warnings as errors)
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Linker option: --library (-l)

Menu entry

1. Select Linker » Libraries.

The Libraries box shows the list of libraries that are linked with the project.

2. To add a library, click on the Add button in the Libraries box.

3. Type or select a library (including its path).

4. Optionally, disable the option Link default libraries.

Use the Edit and Delete button to change a library name or to remove a library from the list.

Command line syntax

--library=name

-lname

Description

With this option you tell the linker to use system library lc87name.lib, where name is a string. The
linker first searches for system libraries in any directories specified with --library-directory, then in the
directories specified with the environment variables LIBLC87, unless you used the option
--ignore-default-library-path.

Example

To search in the system library lc87c.lib (C library):

lk87 test.obj mylib.lib --library=c

The linker links the file test.obj and first looks in library mylib.lib (in the current directory only),
then in the system library lc87c.lib to resolve unresolved symbols.

Related information

Linker option --library-directory (Additional search path for system libraries)

Section 5.3, Linking with Libraries
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Linker option: --library-directory (-L) / --ignore-default-library-path

Menu entry

1. Select Linker » Libraries.

The Library search path box shows the directories that are added to the search path for library files.

2. To define a new directory for the search path, click on the Add button in the Library search path
box.

3. Type or select a path.

Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax

--library-directory=path,...
-Lpath,...

--ignore-default-library-path
-L

Description

With this option you can specify the path(s) where your system libraries, specified with the option --library
(-l), are located. If you want to specify multiple paths, use the option --library-directory for each separate
path.

The default path is$(PRODDIR)\lib\.

If you specify only -L (without a pathname) or the long option --ignore-default-library-path, the linker
will not search the default path and also not in the paths specified in the environment variables LIBLC87.
So, the linker ignores steps 2 and 3 as listed below.

The priority order in which the linker searches for system libraries specified with the option --library (-l)
is:

1. The path that is specified with the option --library-directory.

2. The path that is specified in the environment variables LIBLC87.

3. The default directory $(PRODDIR)\lib.

Example

Suppose you call the linker as follows:

lk87 test.obj --library-directory=c:\mylibs --library=c
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First the linker looks in the directory c:\mylibs for library lc87c.lib (this option). If it does not find
the requested libraries, it looks in the directory that is set with the environment variables LIBLC87. Then
the linker looks in the default directory $(PRODDIR)\lib for libraries.

Related information

Linker option --library (Link system library)

Section 5.3.1, How the Linker Searches Libraries
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Linker option: --link-only

Menu entry

-

Command line syntax

--link-only

Description

With this option you suppress the locating phase. The linker stops after linking and informs you about
unresolved references.

Related information

Control program option --create=relocatable (-cl) (Stop after linking)
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Linker option: --lsl-check

Menu entry

-

Command line syntax

--lsl-check

Description

With this option the linker just checks the syntax of the LSL file(s) and exits. No linking or locating is
performed. Use the option --lsl-file to specify the name of the Linker Script File you want to test.

Related information

Linker option --lsl-file (Linker script file)

Linker option --lsl-dump (Dump LSL info)

Section 5.8, Controlling the Linker with a Script
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Linker option: --lsl-dump

Menu entry

-

Command line syntax

--lsl-dump[=file]

Description

With this option you tell the linker to dump the LSL part of the map file in a separate file, independent of
the option --map-file (generate map file). If you do not specify a filename, the file lk87.ldf is used.

Related information

Linker option --map-file-format (Map file formatting)
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Linker option: --lsl-file (-d)

Menu entry

An LSL file can be generated when you create your project in Eclipse:

1. From the File menu, select File » New » TASKING LC87 C Project.

The New C Project wizard appears.

2. Fill in the project settings in each dialog and click Next > until the LC87 Project Settings appear.

3. Enable the option Add linker script file to the project and click Finish.

Eclipse creates your project and the file project.lsl in the project directory.

The LSL file can be specified in the Properties dialog:

1. Select Linker » Script File.

2. Specify a LSL file in the Linker script file (.lsl) field (default ../${ProjName}.lsl).

Command line syntax

--lsl-file=file

-dfile

Description

A linker script file contains vital information about the core for the locating phase of the linker. A linker
script file is coded in LSL and contains the following types of information:

• the architecture definition describes the core's hardware architecture.

• the memory definition describes the physical memory available in the system.

• the section layout definition describes how to locate sections in memory.

With this option you specify a linker script file to the linker. If you do not specify this option, the linker uses
a default script file (default.lsl).You can specify the existing file target.lsl or the name of a manually
written linker script file.You can use this option multiple times. The linker processes the LSL files in the
order in which they appear on the command line.

Related information

Linker option --lsl-check (Check LSL file(s) and exit)

Section 5.8, Controlling the Linker with a Script
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Linker option: --make-target

Menu entry

-

Command line syntax

--make-target=name

Description

With this option you can overrule the default target name in the make dependencies generated by the
option --dep-file. The default target name is the basename of the input file, with extension .abs.

Example

lk87 --make-target=mytarget.abs test.obj

The linker generates dependency lines with the default target name mytarget.abs instead of test.abs.

Related information

Linker option --dep-file (Generate dependencies in a file)
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Linker option: --map-file (-M)

Menu entry

1. Select Linker » Map File.

2. Enable the option Generate XML map file format (.mapxml) for map file viewer.

3. (Optional) Enable the option Generate map file.

4. Enable or disable the types of information to be included.

Command line syntax

--map-file[=file][:XML]

-M[file][:XML]

Default (Eclipse): XML map file is generated

Default (linker): no map file is generated

Description

With this option you tell the linker to generate a linker map file. If you do not specify a filename and you
specified the option --output, the linker uses the same basename as the output file with the extension
.map. If you did not specify the option --output, the linker uses the file task1.map. Eclipse names the
.map file after the project.

In Eclipse the XML variant of the map file (extension .mapxml) is used for graphical display in the map
file viewer.

A linker map file is a text file that shows how the linker has mapped the sections and symbols from the
various object files (.obj) to the linked object file. A locate part shows the absolute position of each
section. External symbols are listed per space with their absolute address, both sorted on symbol and
sorted on address.

Related information

Linker option --map-file-format (Format map file)

Section 10.2, Linker Map File Format
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Linker option: --map-file-format (-m)

Menu entry

1. Select Linker » Map File.

2. Enable the option Generate XML map file format (.mapxml) for map file viewer.

3. (Optional) Enable the option Generate map file.

4. Enable or disable the types of information to be included.

Command line syntax

--map-file-format=flag,...

-mflags

You can set the following flags:

Include call graph informationc/C+/-callgraph

Include information on removed sectionsd/D+/-removed

Include processed files informationf/F+/-files

Include information on invocation and toolsi/I+/-invocation

Include link result informationk/K+/-link

Include locate result informationl/L+/-locate

Include memory usage informationm/M+/-memory

Include information of non-alloc sectionsn/N+/-nonalloc

Include overlay informationo/O+/-overlay

Include module local symbols informationq/Q+/-statics

Include cross references informationr/R+/-crossref

Include processor and memory informations/S+/-lsl

Include locate rulesu/U+/-rules

Use the following options for predefined sets of flags:

Link information
Alias for -mcDfikLMNoQrSU

-m0--map-file-format=0

Locate information
Alias for -mCDfiKlMNoQRSU

-m1--map-file-format=1

Most information
Alias for -mcdfiklmNoQrSu

-m2--map-file-format=2

Default: --map-file-format=2
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Description

With this option you specify which information you want to include in the map file.

On the command line you must use this option in combination with the option --map-file (-M).

Related information

Linker option --map-file (Generate map file)

Section 10.2, Linker Map File Format
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Linker option: --misra-c-report

Menu entry

-

Command line syntax

--misra-c-report[=file]

Description

With this option you tell the linker to create a MISRA-C Quality Assurance report. This report lists the
various modules in the project with the respective MISRA-C settings at the time of compilation. If you do
not specify a filename, the file basename.mcr is used.

Related information

C compiler option --misrac (MISRA-C checking)
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Linker option: --no-rescan

Menu entry

1. Select Linker » Libraries.

2. Disable the option Rescan libraries to solve unresolved externals.

Command line syntax

--no-rescan

Description

When the linker processes a library it searches for symbol definitions that are referenced by the objects
and libraries processed so far. If the library contains a definition for an unresolved reference the linker
extracts the object that contains the definition from the library. The linker processes object files and
libraries in the order in which they appear on the command line.

When all objects and libraries are processed the linker checks if there are unresolved symbols left. If so,
the default behavior of the linker is to rescan all libraries in the order given at the command line. The
linker stops rescanning the libraries when all symbols are resolved, or when the linker could not resolve
any symbol(s) during the rescan of all libraries. Notice that resolving one symbol may introduce new
unresolved symbols.

With this option, you tell the linker to scan the object files and libraries only once. When the linker has
not resolved all symbols after the first scan, it reports which symbols are still unresolved. This option is
useful if you are building your own libraries. The libraries are most efficiently organized if the linker needs
only one pass to resolve all symbols.

Related information

Linker option --first-library-first (Scan libraries in given order)
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Linker option: --no-rom-copy (-N)

Menu entry

-

Command line syntax

--no-rom-copy

-N

Description

With this option the linker will not generate a ROM copy for data sections. A copy table is generated and
contains entries to clear BSS sections. However, no entries to copy data sections from ROM to RAM are
placed in the copy table.

The data sections are initialized when the application is downloaded.The data sections are not re-initialized
when the application is restarted.

Related information

-
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Linker option: --no-warnings (-w)

Menu entry

1. Select Linker » Diagnostics.

The Suppress warnings box shows the warnings that are currently suppressed.

2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas, of the warnings you want to suppress (for example
135,136). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.

Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

--no-warnings[=number,...]

-w[number,...]

Description

With this option you can suppresses all warning messages or specific warning messages.

On the command line this option works as follows:

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings are suppressed.

• If you specify this option with a number, only the specified warning is suppressed.You can specify the
option --no-warnings=number multiple times.

Example

To suppress warnings 135 and 136, enter:

lk87 --no-warnings=135,136 test.obj

Related information

Linker option --warnings-as-errors (Treat warnings as errors)
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Linker option: --optimize (-O)

Menu entry

1. Select Linker » Optimization.

2. Select one or more of the following options:

• Delete unreferenced sections

• Use a 'first-fit decreasing' algorithm

• Compress copy table

• Delete duplicate code

• Delete duplicate data

Command line syntax

--optimize=flag,...

-Oflags

You can set the following flags:

Delete unreferenced sections from the output
file

c/C+/-delete-unreferenced-sections

Use a 'first-fit decreasing' algorithm to locate
unrestricted sections in memory

l/L+/-first-fit-decreasing

Emit smart restrictions to reduce copy table sizet/T+/-copytable-compression

Delete duplicate code sections from the output
file

x/X+/-delete-duplicate-code

Delete duplicate constant data from the output
file

y/Y+/-delete-duplicate-data

Use the following options for predefined sets of flags:

No optimization
Alias for -OCLTXY

-O0--optimize=0

Default optimization
Alias for -OcLtXY

-O1--optimize=1

All optimizations
Alias for -Ocltxy

-O2--optimize=2

Default: --optimize=1
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Description

With this option you can control the level of optimization.

Related information

For details about each optimization see Section 5.7, Linker Optimizations.
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Linker option: --option-file (-f)

Menu entry

1. Select Linker » Miscellaneous.

2. Add the option --option-file to the Additional options field.

Be aware that the options in the option file are added to the linker options you have set in the other
pages. Only in extraordinary cases you may want to use them in combination.

Command line syntax

--option-file=file,...

-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line,
you can create an option file which contains all options and flags you want to specify. With this option
you specify the option file to the linker.

Use an option file when the command line would exceed the limits of the operating system, or just to store
options and save typing.

Option files can also be generated on the fly, for example by the make utility.You can specify the option
--option-file multiple times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and
vise versa:

"This has a single quote ' embedded"

'This has a double quote " embedded'

'This has a double quote " and a single quote '"' embedded"

• When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is
preserved.

"This is a continuation \
line"

         -> "This is a continuation line"
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• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

--map-file=my.map               (generate a map file)
test.obj                        (input file)
--library-directory=c:\mylibs   (additional search path for system libraries)

Specify the option file to the linker:

lk87 --option-file=myoptions

This is equivalent to the following command line:

lk87 --map-file=my.map test.obj --library-directory=c:\mylibs

Related information

-
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Linker option: --output (-o)

Menu entry

1. Select Linker » Output Format.

2. Enable one or more output formats.

For some output formats you can specify a number of suboptions.

Eclipse always uses the project name as the basename for the output file.

Command line syntax

--output=[filename][:format[:addr_size][,space_name]]...

-o[filename][:format[:addr_size]]...

You can specify the following formats:

ELF/DWARFELF

Intel HexIHEX

Motorola S-recordsSREC

Description

By default, the linker generates an output file in ELF/DWARF format, with the name task1.abs.

With this option you can specify an alternative filename, and an alternative output format. The default
output format is the format of the first input file.

You can use the --output option multiple times. This is useful to generate multiple output formats. With
the first occurrence of the --output option you specify the basename (the filename without extension),
which is used for subsequent --output options with no filename specified. If you do not specify a filename,
or you do not specify the --output option at all, the linker uses the default basename taskn.

IHEX and SREC formats

If you specify the Intel Hex format or the Motorola S-records format, you can use the argument addr_size
to specify the size of addresses in bytes (record length). For Intel Hex you can use the values: 1, 2, and
4 (default). For Motorola S-records you can specify: 2 (S1 records), 3 (S2 records, default) or 4 bytes (S3
records). Note that if you make the addr_size too small, the linker might give a fatal object writer error
indicating an address overflow.

The name of the output file will be filename with the extension .hex or .sre and contains the code and
data allocated in the default address space. If they exist, any other address spaces are also emitted
whereas their output files are named filename_spacename with the extension .hex or .sre.

Use option --chip-output (-c) to create Intel Hex or Motorola S-record output files for each chip defined
in the LSL file (suitable for loading into a PROM-programmer).
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Example

To create the output file myfile.hex of the default address space, enter:

lk87 test.obj --output=myfile.hex:IHEX:4

Related information

Linker option --chip-output (Generate an output file for each chip)

Linker option --hex-format (Specify Hex file format settings)
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Linker option: --strip-debug (-S)

Menu entry

1. Select Linker » Miscellaneous.

2. Enable the option Strip symbolic debug information.

Command line syntax

--strip-debug

-S

Description

With this option you specify not to include symbolic debug information in the resulting output file.

Related information

-

351

Tool Options



Linker option: --user-provided-initialization-code (-i)

Menu entry

1. Select Linker » Miscellaneous.

2. Enable the option Do not use standard copy table for initialization.

Command line syntax

--user-provided-initialization-code

-i

Description

It is possible to use your own initialization code, for example, to save ROM space. With this option you
tell the linker not to generate a copy table for initialize/clear sections. Use linker labels in your source
code to access the positions of the sections when located.

If the linker detects references to the TASKING initialization code, an error is emitted: it is either the
TASKING initialization routine or your own, not both.

Note that the option --no-rom-copy may vary independently. The 'copytable-compression' optimization
(--optimize=t) is automatically disabled when you enable this option.

Related information

Linker option --no-rom-copy (Do not generate ROM copy)

Linker option --optimize (Specify optimization)
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Linker option: --verbose (-v)

Menu entry

1. Select Linker » Miscellaneous.

2. Enable the option Show link phases during processing.

The verbose output is displayed in the Problems view and the Console view.

Command line syntax

--verbose

-v

Description

With this option you put the linker in verbose mode. The linker prints the link phases while it processes
the files. The linker prints one entry for each action it executes for a task. When you use this option twice
(-vv) you put the linker in extra verbose mode. In this mode the linker also prints the filenames and it
shows which objects are extracted from libraries and it shows verbose information that would normally
be hidden when you use the normal verbose mode or when you run without verbose. With this option you
can monitor the current status of the linker.

Related information

-
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Linker option: --version (-V)

Menu entry

-

Command line syntax

--version

-V

Description

Display version information. The linker ignores all other options or input files.

Related information

-
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Linker option: --warnings-as-errors

Menu entry

1. Select Global Options.

2. Enable the option Treat warnings as errors.

Command line syntax

--warnings-as-errors[=number,...]

Description

When the linker detects an error or warning, it tries to continue the link process and reports other errors
and warnings. When you use this option without arguments, you tell the linker to treat all warnings as
errors. This means that the exit status of the linker will be non-zero after the detection of one or more
linker warnings. As a consequence, the linker will not produce any output files.

You can also limit this option to specific warnings by specifying a comma-separated list of warning numbers.

Related information

Linker option --no-warnings (Suppress some or all warnings)
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Linker option: --whole-archive

Menu entry

1. Select Linker » Miscellaneous.

2. Add the option --whole-archive to the Additional options field.

Command line syntax

--whole-archive=file

Description

This option tells the linker to directly load all object modules in a library, as if they were placed on the
command line. This is different from libraries specified as input files or with the -l option, which are only
used to resolve references in object files that were loaded earlier.

Example

Suppose the library myarchive.lib contains the objects my1.obj, my2.obj and my3.obj. Specifying

lk87 --whole-archive=myarchive.lib

is the same as specifying

lk87 my1.obj my3.obj my3.obj

Related information

Linker option --library (Link system library)
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8.5. Control Program Options

The control program cc87 facilitates the invocation of the various components of the LC87 toolset from
a single command line.

Options in Eclipse versus options on the command line

Eclipse invokes the compiler, assembler and linker via the control program. Therefore, it uses the syntax
of the control program to pass options and files to the tools. The control program processes command
line options either by itself, or, when the option is unknown to the control program, it looks whether it can
pass the option to one of the other tools. However, for directly passing an option to the C compiler,
assembler or linker, it is recommended to use the control program options --pass-c, --pass-assembler,
--pass-linker.

See the previous sections for details on the options of the tools.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters.You can abbreviate long option
names as long as it forms a unique name.You can mix short and long option names on the command
line.

Options can have flags or suboptions. To switch a flag 'on', use a lowercase letter or a +longflag. To
switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following
two invocations are equivalent:

cc87 -Wc-Oac test.c
cc87 --pass-c=--optimize=+coalesce,+cse test.c

When you do not specify an option, a default value may become active.

357

Tool Options



Control program option: --address-size

Menu entry

1. Select Linker » Output Format.

2. Enable the option Generate Intel Hex format file and/or Generate S-records file.

3. Specify the Size of addresses.

Eclipse always uses the project name as the basename for the output file.

Command line syntax

--address-size=addr_size

Description

If you specify IHEX or SREC with the control option --format, you can additionally specify the record
length to be emitted in the output files.

With this option you can specify the size of the addresses in bytes (record length). For Intel Hex you can
use the values 1, 2 or 4 bytes (default). For Motorola-S you can specify: 2 (S1 records), 3 (S2 records)
or 4 bytes (S3 records, default).

If you do not specify addr_size, the default address size is generated.

Example

To create the SREC file test.sre with S1 records, type:

cc87 --format=SREC --address-size=2 test.c

Related information

Control program option --format (Set linker output format)

Control program option --output (Output file)
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Control program option: --check

Menu entry

-

Command line syntax

--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves
time in developing your application because the code will not actually be compiled.

The compiler/assembler reports any warnings and/or errors.

This option is available on the command line only.

Related information

C compiler option --check (Check syntax)

Assembler option --check (Check syntax)
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Control program option: --cpu (-C)

Menu entry

1. Expand C/C++ Build and select Processor.

2. From the Processor selection list, select a processor or select LC87 Generic.

Command line syntax

--cpu=id | name | cpu

-Cid | name | cpu

Description

With this option you define the target processor for which you create your application.You can specify a
full processor name, like LC87F1M16, or a base CPU name, like lc87f1m16 or its unique id, like lc87f1m16.

Based on this option the C compiler can include the special function register file core.sfr if you also
specify option --include-sfr-file or core.inc for the assembler if you also specify option --asm-sfr-file.
In Eclipse this is done automatically.

The standard list of supported processors is defined in the file processors.xml. This file defines for
each processor its full name (for example, LC87F1M16), its ID, the base CPU name (for example,
lc87f1m16) and the core settings (for example, lc871m00) for that processor.To show a list of all supported
processors you can use option --cpu-list.

The control program reads the file processors.xml. The lookup sequence for names specified to this
option is as follows:

1. match with the 'id' attribute in processors.xml (case insensitive, for example tc26x)

2. if none matched, match with the 'name' attribute in processors.xml (case insensitive, for example
LC87F1M16)

3. if still none matched, match any of the base CPU names (the 'cpu' attribute in processors.xml, for
example lc87f1m16). If multiple processors exist with the same base CPU, a warning will be issued
and the first one is selected.

4. if still none matched, the control program issues a fatal error.

The preferred use of the option --cpu, is to specify an ID because that is always a unique name. For
example, --cpu=lc87f1m16. The control program will lookup this processor name in the file
processors.xml. The control program passes the options to the underlaying tools. For example,
-D__PROC_LC87F1M16__ to the linker. If you also specify option --include-sfr-file, the control program
passes the option -Hsfr/lc871m00.sfr to the C compiler. If you also specify option --asm-sfr-file, the
control program passes the option -Hsfr/lc871m00.inc to the assembler.

Example

To generate the file test.abs for the LC87F1M16 processor, enter:

360

TASKING VX-toolset for LC87 User Guide



cc87 --cpu=lc87f1m16 --include-sfr-file --asm-sfr-file -v -t test.c

The control program will call the tools as follows:

+ c87  -Hsfr/lc871m00.sfr -o test.src test.c
+ as87 -Hsfr/lc871m00.inc -o test.obj test.src
+ lk87 -o test.abs -D__PROC_LC87F1M16__ --map-file test.obj 
       -lc -lfp -lrt

Related information

Control program option --cpu-list (Show list of processors)

Control program option --processors (Read additional processor definitions)

Control program option --include-sfr-file (Include SFR file in compiler)

Control program option --asm-sfr-file (Include SFR file in assembler)
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Control program option: --cpu-list

Menu entry

-

Command line syntax

--cpu-list[=pattern]

Description

With this option the control program shows a list of supported processors as defined in the file
processors.xml. This can be useful when you want to select a processor name or id for the --cpu
option.

The pattern works similar to the UNIX grep utility.You can use it to limit the output list.

Example

To show a list of all processors, enter:

cc87 --cpu-list

To show all processors that have lc87 in their name, enter:

cc87 --cpu-list=lc87

--- ~/c87/etc/processors.xml ---
    id               name             CPU              core
    lc87             LC87             lc87             lc87
    lc87f0k08        LC87F0K08        lc87f0k08        lc870k00
    lc87f0n04        LC87F0N04        lc87f0n04        lc870n00
    lc87f1m16        LC87F1M16        lc87f1m16        lc871m00
    lc87f1jj2        LC87F1JJ2        lc87f1jj2        lc871j00
    lc87f1jj4        LC87F1JJ4        lc87f1jj4        lc871j00
    lc87f1jj8        LC87F1JJ8        lc87f1jj8        lc871j00
    lc87f5vp6        LC87F5VP6        lc87f5vp6        lc875v00
    lc87dbg08        LC87DBG08        lc87dbg08        lc87bg00
    lc87fbg08        LC87FBG08        lc87fbg08        lc87bg00
    lc87dbh08        LC87DBH08        lc87dbh08        lc87bh00
    lc87fbh08        LC87FBH08        lc87fbh08        lc87bh00

Related information

Control program option --cpu (Select processor)
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Control program option: --create (-c)

Menu entry

-

Command line syntax

--create[=stage]

-c[stage]

You can specify the following stages:

Stop after the files are linked to a linker object file (.out)lrelocatable

Stop after C files are compiled to MIL (.mil)mmil

Stop after the files are assembled to objects (.obj)oobject

Stop after C files are compiled to assembly (.src)sassembly

Default (without flags): --create=object

Description

Normally the control program generates an absolute object file of the specified output format from the file
you supplied as input.With this option you tell the control program to stop after a certain number of phases.

Example

To generate the object file test.obj:

cc87 --create test.c

The control program stops after the file is assembled. It does not link nor locate the generated output.

Related information

Linker option --link-only (Link only, no locating)
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Control program option: --debug-info (-g)

Menu entry

1. Select C Compiler » Debugging.

2. To generate symbolic debug information, select Default, Small set or Full.
To disable the generation of debug information, select None.

Command line syntax

--debug-info

-g

Description

With this option you tell the control program to include debug information in the generated object file.

The control program passes the option --debug-info (-g) to the C compiler and calls the assembler with
--debug-info=+smart,+local (-gsl).

Related information

C compiler option --debug-info (Generate symbolic debug information)

Assembler option --debug-info (Generate symbolic debug information)
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Control program option: --define (-D)

Menu entry

1. Select C Compiler » Preprocessing and/or Assembler » Preprocessing.

The Defined symbols box right-below shows the symbols that are currently defined.

2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, demo=1)

Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

--define=macro_name[=macro_definition]

-Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the preprocessor. If you only specify a macro
name (no macro definition), the macro expands as '1'.

You can specify as many macros as you like. Simply use the Add button to add new macro definitions.

On the command line, use the option --define (-D) multiple times. If the command line exceeds the limit
of the operating system, you can define the macros in an option file which you then must specify to the
compiler with the option --option-file (-f) file.

Defining macros with this option (instead of in the C source) is, for example, useful to compile conditional
C source as shown in the example below.

The control program passes the option --define (-D) to the compiler and the assembler.

Example

Consider the following C program with conditional code to compile a demo program and a real program:

void main( void )
{
#if DEMO
    demo_func();   /* compile for the demo program */
#else
    real_func();   /* compile for the real program */
#endif
}

You can now use a macro definition to set the DEMO flag:
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cc87 --define=DEMO test.c
cc87 --define=DEMO=1 test.c

Note that both invocations have the same effect.

The next example shows how to define a macro with arguments. Note that the macro name and definition
are placed between double quotes because otherwise the spaces would indicate a new option.

cc87 --define="MAX(A,B)=((A) > (B) ? (A) : (B))" test.c

Related information

Control program option --undefine (Remove preprocessor macro)

Control program option --option-file (Specify an option file)
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Control program option: --dep-file

Menu entry

-

Command line syntax

--dep-file[=file]

Description

With this option you tell the compiler to generate dependency lines that can be used in a Makefile. In
contrast to the option --preprocess=+make, the dependency information will be generated in addition to
the normal output file.

By default, the information is written to a file with extension .d (one for every input file).When you specify
a filename, all dependencies will be combined in the specified file.

Example

cc87 --dep-file=test.dep -t test.c

The compiler compiles the file test.c, which results in the output file test.src, and generates
dependency lines in the file test.dep.

Related information

Control program option --preprocess=+make (Generate dependencies for make)
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Control program option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems.

The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.

A popup menu appears.

3. Select Detailed Diagnostics Info.

A dialog box appears with additional information.

Command line syntax

--diag=[format:]{all | nr,...}

You can set the following output formats:

HTML output.html

Rich Text Format.rtf

ASCII text.text

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify.You can specify the
following formats: html, rtf or text (default). To create a file with the descriptions, you must redirect the
output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one
or more selected error messages, you can specify the error message numbers, separated by commas.

Example

To display an explanation of message number 103, enter:

cc87 --diag=103

This results in message 103 with explanation.

To write an explanation of all errors and warnings in HTML format to file ccerrors.html, use redirection
and enter:

cc87 --diag=html:all > ccerrors.html
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Related information

Section 3.8, C Compiler Error Messages
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Control program option: --dry-run (-n)

Menu entry

-

Command line syntax

--dry-run

-n

Description

With this option you put the control program in verbose mode. The control program prints the invocations
of the tools it would use to process the files without actually performing the steps.

Related information

Control program option --verbose (Verbose output)
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Control program option: --error-file

Menu entry

-

Command line syntax

--error-file

Description

With this option the control program tells the compiler, assembler and linker to redirect error messages
to a file.

The error file will be named after the output file with extension .err (for compiler) or .ers (for assembler).
For the linker, the error file is lk87.elk.

Example

To write errors to error files instead of stderr, enter:

cc87 --error-file -t test.c

Related information

Control Program option --warnings-as-errors (Treat warnings as errors)
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Control program option: --format

Menu entry

1. Select Linker » Output Format.

2. Enable the option Generate Intel Hex format file and/or Generate S-records file.

3. Optionally, specify the Size of addresses.

Eclipse always uses the project name as the basename for the output file.

Command line syntax

--format=format

You can specify the following formats:

ELF/DWARFELF

Intel HexIHEX

Motorola S-recordsSREC

Description

With this option you specify the output format for the resulting (absolute) object file. The default output
format is ELF/DWARF, which can directly be used by the debugger.

If you choose IHEX or SREC, you can additionally specify the address size of the chosen format (option
--address-size).

Example

To generate a Motorola S-record output file:

cc87 --format=SREC test1.c test2.c --output=test.sre

Related information

Control program option --address-size (Set address size for linker IHEX/SREC files)

Control program option --output (Output file)

Linker option --chip-output (Generate an output file for each chip)
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Control program option: --fp-trap

Menu entry

1. Select Linker » Libraries.

2. Enable the option Use trapped floating-point library.

Command line syntax

--fp-trap

Description

By default the control program uses the non-trapping floating-point library (lc87fp.lib).With this option
you tell the control program to use the trapping floating-point library (lc87fpt.lib).

If you use the trapping floating-point library, exceptional floating-point cases are intercepted and can be
handled separately by an application defined exception handler. Using this library decreases the execution
speed of your application.

Related information

Section 5.3, Linking with Libraries
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Control program option: --global-type-checking

Menu entry

1. Select C Compiler » Diagnostics.

2. Enable the option Perform global type checking on C code.

Command line syntax

--global-type-checking

Description

The C compiler already performs type checking within each module. Use this option when you want the
linker to perform type checking between modules. The control program passes this option to both the C
compiler and the linker.

Related information

-
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Control program option: --help (-?)

Menu entry

-

Command line syntax

--help[=item]

-?

You can specify the following argument:

Show extended option descriptionsoptions

Description

Displays an overview of all command line options. When you specify the argument options you can list
detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

cc87 -?
cc87 --help
cc87

To see a detailed description of the available options, enter:

cc87 --help=options

Related information

-
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Control program option: --include-directory (-I)

Menu entry

1. Select C Compiler » Include Paths.

The Include paths box shows the directories that are added to the search path for include files.

2. To define a new directory for the search path, click on the Add button in the Include paths box.

3. Type or select a path.

Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax

--include-directory=path,...

-Ipath,...

Description

With this option you can specify the path where your include files are located. A relative path will be
relative to the current directory.

The control program passes this option to the compiler and the assembler.

Example

Suppose that the C source file test.c contains the following lines:

#include <stdio.h>
#include "myinc.h"

You can call the control program as follows:

cc87 --include-directory=myinclude test.c

First the compiler looks for the file stdio.h in the directory myinclude relative to the current directory.
If it was not found, the compiler searches in the environment variable and then in the default include
directory.

The compiler now looks for the file myinc.h in the directory where test.c is located. If the file is not
there the compiler searches in the directory myinclude. If it was still not found, the compiler searches
in the environment variable and then in the default include directory.

Related information

C compiler option --include-directory (Add directory to include file search path)

C compiler option --include-file (Include file at the start of a compilation)
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Control program option: --include-sfr-file / --asm-sfr-file

Menu entry

1. Select C Compiler » Preprocessing.

2. Enable the option Automatic inclusion of '.sfr' file.

3. Select Assembler » Preprocessing.

4. Enable the option Automatic inclusion of '.sfr' file.

Command line syntax

--include-sfr-file

--asm-sfr-file

Description

With --include-sfr-file the compiler includes the register file core.sfr as based on the selected target
processor.

With --asm-sfr-file the assembler includes the register file core.inc as based on the selected target
processor.

In Eclipse both options are enabled by default.

Example

cc87 --cpu=lc87f1m16 --include-sfr-file --asm-sfr-file -v -t test.c

+ c87  -Hsfr/lc871m00.sfr -o test.src test.c
+ as87 -Hsfr/lc871m00.inc -o test.obj test.src
+ lk87 -o test.abs -D__PROC_LC87F1M16__ --map-file test.obj 
       -lc -lfp -lrt

Related information

Control program option --cpu (Select processor)
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Control program option: --iso

Menu entry

1. Select C Compiler » Language.

2. From the Comply to C standard list, select ISO C99 or ISO C90.

Command line syntax

--iso={90|99}

Default: --iso=99

Description

With this option you select the ISO C standard. C90 is also referred to as the "ANSI C standard". C99
refers to the newer ISO/IEC 9899:1999 (E) standard. C99 is the default.

Independent of the chosen ISO standard, the control program always links libraries with C99 support.

Example

To select the ISO C90 standard on the command line:

cc87 --iso=90 test.c

Related information

C compiler option --iso (ISO C standard)
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Control program option: --keep-output-files (-k)

Menu entry

Eclipse always removes generated output files when an error occurs.

Command line syntax

--keep-output-files

-k

Description

If an error occurs during the compilation, assembling or linking process, the resulting output file may be
incomplete or incorrect. With this option you keep the generated output files when an error occurs.

By default the control program removes generated output files when an error occurs. This is useful when
you use the make utility. If the erroneous files are not removed, the make utility may process corrupt files
on a subsequent invocation.

Use this option when you still want to use the generated files. For example when you know that a particular
error does not result in a corrupt file, or when you want to inspect the output file, or send it to Altium
support.

The control program passes this option to the compiler, assembler and linker.

Example

cc87 --keep-output-files test.c

When an error occurs during compiling, assembling or linking, the erroneous generated output files will
not be removed.

Related information

C compiler option --keep-output-files

Assembler option --keep-output-files

Linker option --keep-output-files
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Control program option: --keep-temporary-files (-t)

Menu entry

1. Select Global Options.

2. Enable the option Keep temporary files.

Command line syntax

--keep-temporary-files

-t

Description

By default, the control program removes intermediate files like the .src file (result of the compiler phase)
and the .obj file (result of the assembler phase).

With this option you tell the control program to keep temporary files it generates during the creation of
the absolute object file.

Example

cc87 --keep-temporary-files test.c

The control program keeps all intermediate files it generates while creating the absolute object file
test.abs.

Related information

-
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Control program option: --library (-l)

Menu entry

1. Select Linker » Libraries.

The Libraries box shows the list of libraries that are linked with the project.

2. To add a library, click on the Add button in the Libraries box.

3. Type or select a library (including its path).

4. Optionally, disable the option Link default libraries.

Use the Edit and Delete button to change a library name or to remove a library from the list.

Command line syntax

--library=name

-lname

Description

With this option you tell the linker via the control program to use system library lc87name.lib, where
name is a string. The linker first searches for system libraries in any directories specified with
--library-directory, then in the directories specified with the environment variables LIBLC87, unless you
used the option --ignore-default-library-path.

Example

To search in the system library lc87c.lib (C library):

cc87 test.obj mylib.lib --library=c

The linker links the file test.obj and first looks in library mylib.lib (in the current directory only),
then in the system library lc87c.lib to resolve unresolved symbols.

Related information

Control program option --no-default-libraries (Do not link default libraries)

Control program option --library-directory (Additional search path for system libraries)

Section 5.3, Linking with Libraries
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Control program option: --library-directory (-L) /
--ignore-default-library-path

Menu entry

1. Select Linker » Libraries.

The Library search path box shows the directories that are added to the search path for library files.

2. To define a new directory for the search path, click on the Add button in the Library search path
box.

3. Type or select a path.

Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax

--library-directory=path,...
-Lpath,...

--ignore-default-library-path
-L

Description

With this option you can specify the path(s) where your system libraries, specified with the option --library
(-l), are located. If you want to specify multiple paths, use the option --library-directory for each separate
path.

The default path is$(PRODDIR)\lib\architecture\endianness.

If you specify only -L (without a pathname) or the long option --ignore-default-library-path, the linker
will not search the default path and also not in the paths specified in the environment variables LIBLC87.
So, the linker ignores steps 2 and 3 as listed below.

The priority order in which the linker searches for system libraries specified with the option --library (-l)
is:

1. The path that is specified with the option --library-directory.

2. The path that is specified in the environment variables LIBLC87.

3. The default directory $(PRODDIR)\libarchitecture\endianness.

Example

Suppose you call the control program as follows:

cc87 test.c --library-directory=c:\mylibs --library=c
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First the linker looks in the directory c:\mylibs for library lc87c.lib (this option). If it does not find
the requested libraries, it looks in the directory that is set with the environment variables LIBLC87. Then
the linker looks in the default directory $(PRODDIR)\libarchitecture\endianness for libraries.

Related information

Control program option --library (Link system library)

Section 5.3.1, How the Linker Searches Libraries
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Control program option: --list-files

Menu entry

-

Command line syntax

--list-files[=file]

Default: no list files are generated

Description

With this option you tell the assembler via the control program to generate a list file for each specified
input file. A list file shows the generated object code and the relative addresses. Note that the assembler
generates a relocatable object file with relative addresses.

With the optional file you can specify a name for the list file. This is only possible if you specify only one
input file to the control program. If you do not specify a file name, or you specify more than one input file,
the control program names the generated list file(s) after the specified input file(s) with extension .lst.

Note that object files and library files are not counted as input files.

Related information

Assembler option --list-file (Generate list file)

Assembler option --list-format (Format list file)
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Control program option: --lsl-file (-d)

Menu entry

An LSL file can be generated when you create your project in Eclipse:

1. From the File menu, select File » New » TASKING LC87 C Project.

The New C Project wizard appears.

2. Fill in the project settings in each dialog and click Next > until the LC87 Project Settings appear.

3. Enable the option Add linker script file to the project and click Finish.

Eclipse creates your project and the file project.lsl in the project directory.

The LSL file can be specified in the Properties dialog:

1. Select Linker » Script File.

2. Specify a LSL file in the Linker script file (.lsl) field (default ../${ProjName}.lsl).

Command line syntax

--lsl-file=file,...

-dfile,...

Description

A linker script file contains vital information about the core for the locating phase of the linker. A linker
script file is coded in LSL and contains the following types of information:

• the architecture definition describes the core's hardware architecture.

• the memory definition describes the physical memory available in the system.

• the section layout definition describes how to locate sections in memory.

With this option you specify a linker script file via the control program to the linker. If you do not specify
this option, the linker uses a default script file (default.lsl).You can specify the existing file target.lsl
or the name of a manually written linker script file.You can use this option multiple times. The linker
processes the LSL files in the order in which they appear on the command line.

Related information

Section 5.8, Controlling the Linker with a Script
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Control program option: --make-target

Menu entry

-

Command line syntax

--make-target=name

Description

With this option you can overrule the default target name in the make dependencies generated by the
options --preprocess=+make (-Em) and --dep-file.The default target name is the basename of the input
file, with extension .obj.

Example

cc87 --preprocess=+make --make-target=../mytarget.obj test.c

The compiler generates dependency lines with the default target name ../mytarget.obj instead of
test.obj.

Related information

Control program option --preprocess=+make (Generate dependencies for make)

Control program option --dep-file (Generate dependencies in a file)
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Control program option: --no-default-libraries

Menu entry

1. Select Linker » Libraries.

2. Disable the option Link default libraries.

Command line syntax

--no-default-libraries

Description

By default the control program specifies the standard C libraries (C99) and run-time library to the linker.
With this option you tell the control program not to specify the standard C libraries and run-time library to
the linker.

In this case you must specify the libraries you want to link to the linker with the option --library=library_name
or pass the libraries as files on the command line. The control program recognizes the option --library
(-l) as an option for the linker and passes it as such.

Example

cc87 --no-default-libraries test.c

The control program does not specify any libraries to the linker. In normal cases this would result in
unresolved externals.

To specify your own libraries (lc87c.lib) and avoid unresolved externals:

cc87 --no-default-libraries --library=c test.c

Related information

Control program option --library (Link system library)

Section 5.3.1, How the Linker Searches Libraries
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Control program option: --no-double (-F)

Menu entry

1. Select C Compiler » Language.

2. Enable the option Treat double as float.

Command line syntax

--no-double

-F

Description

With this option you tell the compiler to treat variables of the type double as float. Because the float
type takes less space, execution speed increases and code size decreases, both at the cost of less
precision.

The control program also tells the linker to link the single-precision C library.

Related information

Section 5.3, Linking with Libraries
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Control program option: --no-map-file

Menu entry

1. Select Linker » Map File.

2. Disable the option Generate map file.

Command line syntax

--no-map-file

Description

By default the control program tells the linker to generate a linker map file.

A linker map file is a text file that shows how the linker has mapped the sections and symbols from the
various object files (.obj) to the linked object file. A locate part shows the absolute position of each
section. External symbols are listed per space with their absolute address, both sorted on symbol and
sorted on address.

With this option you prevent the generation of a map file.

Related information

-
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Control program option: --no-warnings (-w)

Menu entry

1. Select C Compiler » Diagnostics.

The Suppress C compiler warnings box shows the warnings that are currently suppressed.

2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas or as a range, of the warnings you want to suppress (for
example 537,538). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.

Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

--no-warnings[=number[-number],...]

-w[number[-number],...]

Description

With this option you can suppresses all warning messages for the various tools or specific control program
warning messages.

On the command line this option works as follows:

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings of all tools are suppressed.

• If you specify this option with a number or a range, only the specified control program warnings are
suppressed.You can specify the option --no-warnings=number multiple times.

Example

To suppress all warnings for all tools, enter:

cc87 test.c --no-warnings

Related information

Control program option --warnings-as-errors (Treat warnings as errors)
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Control program option: --option-file (-f)

Menu entry

-

Command line syntax

--option-file=file,...

-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line,
you can create an option file which contains all options and flags you want to specify. With this option
you specify the option file to the control program.

Use an option file when the command line would exceed the limits of the operating system, or just to store
options and save typing.

You can specify the option --option-file multiple times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and
vise versa:

"This has a single quote ' embedded"

'This has a double quote " embedded'

'This has a double quote " and a single quote '"' embedded"

• When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is
preserved.

"This is a continuation \
line"

         -> "This is a continuation line"

• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:
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--debug-info
--define=DEMO=1
test.c

Specify the option file to the control program:

cc87 --option-file=myoptions

This is equivalent to the following command line:

cc87 —-debug-info --define=DEMO=1 test.c

Related information

-
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Control program option: --output (-o)

Menu entry

Eclipse always uses the project name as the basename for the output file.

Command line syntax

--output=file

-o file

Description

By default, the control program generates a file with the same basename as the first specified input file.
With this option you specify another name for the resulting absolute object file.

The default output format is ELF/DWARF, but you can specify another output format with option --format.

Example

cc87 test.c prog.c

The control program generates an ELF/DWARF object file (default) with the name test.abs.

To generate the file result.abs:

cc87 --output=result.abs test.c prog.c

Related information

Control program option --format (Set linker output format)

Linker option --output (Output file)

Linker option --chip-output (Generate an output file for each chip)
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Control program option: --pass (-W)

Menu entry

1. Select C Compiler » Miscellaneous or Assembler » Miscellaneous or Linker » Miscellaneous.

2. Add an option to the Additional options field.

Be aware that the options in the option file are added to the options you have set in the other pages.
Only in extraordinary cases you may want to use them in combination. The assembler options are
preceded by -Wa and the linker options are preceded by -Wl. For the C options you have to do this
manually.

Command line syntax

Pass option directly to the assembler-Waoption--pass-assembler=option

Pass option directly to the C compiler-Wcoption--pass-c=option

Pass option directly to the linker-Wloption--pass-linker=option

Description

With this option you tell the control program to call a tool with the specified option. The control program
does not use or interpret the option itself, but specifies it directly to the tool which it calls.

Example

To pass the option --verbose directly to the linker, enter:

cc87 --pass-linker=--verbose test.c

Related information

-
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Control program option: --preprocess (-E) / --no-preprocessing-only

Menu entry

1. Select C Compiler » Preprocessing.

2. Enable the option Store preprocessor output in <file>.pre.

3. (Optional) Enable the option Keep comments in preprocessor output.

4. (Optional) Enable the option Keep #line info in preprocessor output.

Command line syntax

--preprocess[=flags]

-E[flags]

--no-preprocessing-only

You can set the following flags:

keep commentsc/C+/-comments

generate a list of included source filesi/I+/-includes

generate a list of macro definitionsl/L+/-list

generate dependencies for makem/M+/-make

strip #line source position informationp/P+/-noline

Default: -ECILMP

Description

With this option you tell the compiler to preprocess the C source.The C compiler sends the preprocessed
output to the file name.pre (where name is the name of the C source file to compile). Eclipse also
compiles the C source.

On the command line, the control program stops after preprocessing. If you also want to compile the C
source you can specify the option --no-preprocessing-only. In this case the control program calls the
compiler twice, once with option --preprocess and once for a regular compilation.

With --preprocess=+comments you tell the preprocessor to keep the comments from the C source file
in the preprocessed output.

With --preprocess=+includes the compiler will generate a list of all included source files.The preprocessor
output is discarded.

With --preprocess=+list the compiler will generate a list of all macro definitions.The preprocessor output
is discarded.
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With --preprocess=+make the compiler will generate dependency lines that can be used in a Makefile.
The information is written to a file with extension .d. The preprocessor output is discarded. The default
target name is the basename of the input file, with the extension .obj. With the option --make-target
you can specify a target name which overrules the default target name.

With --preprocess=+noline you tell the preprocessor to strip the #line source position information (lines
starting with #line). These lines are normally processed by the assembler and not needed in the
preprocessed output. When you leave these lines out, the output is easier to read.

Example

cc87 --preprocess=+comments,-make,-noline --no-preprocessing-only test.c

The compiler preprocesses the file test.c and sends the output to the file test.pre. Comments are
included but no dependencies are generated and the line source position information is not stripped from
the output file. Next, the control program calls the compiler, assembler and linker to create the final object
file test.abs

Related information

Control program option --dep-file (Generate dependencies in a file)

Control program option --make-target (Specify target name for -Em output)
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Control program option: --processors

Menu entry

1. From the Window menu, select Preferences.

The Preferences dialog appears.

2. Select TASKING » LC87.

3. Click the Add button to add additional processor definition files.

Command line syntax

--processors=file

Description

With this option you can specify an additional XML file with processor definitions.

The standard list of supported processors is defined in the file processors.xml. This file defines for
each processor its full name (for example, LC87F1M16), its ID, the base CPU name (for example,
lc87f1m16) and the core settings (for example, lc87) for that processor. Each processor also defines an
option to supply to the linker for preprocessing the LSL file for the applicable on-chip memory definitions.

The control program reads the specified file after the file processors.xml in the product's etc directory.
Additional XML files can override processor definitions made in XML files that are read before.

Multiple --processors options are allowed.

Eclipse generates a --processors option in the makefiles for each specified XML file.

Example

Specify an additional processor definition file (suppose processors-new.xml contains a new processor
LC87NEW):

cc87 --processors=processors-new.xml --cpu=LC87NEW test.c

Related information

Control program option --cpu (Select architecture)
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Control program option: --ram-model

Menu entry

1. Select C Compiler » Memory Model.

2. Select a RAM data model.

Command line syntax

--ram-model=model

You can set the following flags:

Full 64kB internal data memoryddata

Lowest 512 bytes of internal data memoryssdata

Default: --ram-model=data

Description

With this option you can select the RAM data model. All RAM data models allow all memory type qualifiers
to be used. Each model has a default memory type qualifier, which is used for objects defined without a
memory type qualifier.The control program passes the option to the compiler and links with an appropriate
variant of the C library. Depending on the model used, the compiler sets a predefined macro.

Predefined macroDefault data memory typeRAM data model

__RAM_DATA____datadata

__RAM_SDATA____sdatasdata

Example

To select the sdata RAM model:

cc87 --ram-model=sdata test.c

Related information

Control program option --rom-model (Select ROM data model)

Section 1.3.2, Memory Models and Default Memory Type for Data
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Control program option: --rom-const

Menu entry

1. Select C Compiler » Memory Model.

2. Enable the option Constants in ROM.

Command line syntax

--rom-const

Description

Allocate all const objects without a memory type qualifier in ROM (program memory space). In addition
all const pointers without a memory type qualifier will be referring to ROM. When you use this option,
the memory type qualifier is selected by the option--rom-model. This option does not apply to __bit
objects (or pointers to __bit), because the program memory space is not bit-addressable.

With this option set the predefined macro __ROM_CONST__ expands to 1.

Related information

Control program option --rom-model (Select ROM data model)

Control program option --ram-model (Select RAM data model)

Section 1.3.2, Memory Models and Default Memory Type for Data
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Control program option: --rom-model

Menu entry

1. Select C Compiler » Memory Model.

2. Select a ROM data model.

Command line syntax

--rom-model=model

You can set the following flags:

Bank 0 in program memorybb0

Any bank in program memoryrrom

Lowest 64kB in bank 0 of program memoryzz0

Bank 1 in program memoryb1

Lowest 64kB in bank 1 of program memoryz1

Default: --rom-model=z0

Description

With this option you can select the ROM data model. All ROM data models allow all memory type qualifiers
to be used. Each model has a default memory type qualifier, which is used for objects defined without a
memory type qualifier. Depending on the model used, the compiler sets a predefined macro.

Predefined macroDefault data memory typeROM data model

__ROM_BANK0____bank0b0

__ROM_BANK1____bank1b1

__ROM_ZERO0____zero0z0

__ROM_ZERO1____zero1z1

__ROM_ROM____romrom

When an object is explicitly or automatically qualified with the default memory type qualifier, the compiler
can generate better optimized code to access the object.

Example

extern const   int c;
extern __zero1 int cz1;
extern __zero0 int cz0;

int func( void )
{
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    return c + cz0 + cz1;
}

When translated with:

cc87 --rom-model=z1 func.c

Object c is allocated in __data and is not affected by the option --rom-model. Access to object cz1 can
be optimized because it explicitly uses the default memory type qualifier.

When translated with:

cc87 --rom-model=z1 --rom-const func.c

Object c is moved to ROM, and receives the default memory type qualifier. Therefore, access to object
c can be optimized like the access to object cz1.

Because object cz0 is not allocated in the default ROM space, an access to this object requires more
code.

Related information

Control program option --rom-const (Allocate constants in ROM)

Control program option --ram-model (Select RAM data model)

Section 1.3.2, Memory Models and Default Memory Type for Data
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Control program option: --undefine (-U)

Menu entry

1. Select C Compiler » Preprocessing

The Defined symbols box shows the symbols that are currently defined.

2. To remove a defined symbol, select the symbol in the Defined symbols box and click on the Delete
button.

Command line syntax

--undefine=macro_name

-Umacro_name

Description

With this option you can undefine an earlier defined macro as with #undef. This option is for example
useful to undefine predefined macros.

The following predefined ISO C standard macros cannot be undefined:

current source filename__FILE__

current source line number (int type)__LINE__

hh:mm:ss__TIME__

Mmm dd yyyy__DATE__

level of ANSI standard__STDC__

The control program passes the option --undefine (-U) to the compiler.

Example

To undefine the predefined macro __TASKING__:

cc87 --undefine=__TASKING__ test.c

Related information

Control program option --define (Define preprocessor macro)

Section 1.8, Predefined Preprocessor Macros
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Control program option: --verbose (-v)

Menu entry

1. Select Global Options.

2. Enable the option Verbose mode of control program.

Command line syntax

--verbose

-v

Description

With this option you put the control program in verbose mode. The control program performs its tasks
while it prints the steps it performs to stdout.

Related information

Control program option --dry-run (Verbose output and suppress execution)
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Control program option: --version (-V)

Menu entry

-

Command line syntax

--version

-V

Description

Display version information. The control program ignores all other options or input files.

Related information

-
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Control program option: --warnings-as-errors

Menu entry

1. Select Global Options.

2. Enable the option Treat warnings as errors.

Command line syntax

--warnings-as-errors[=number[-number],...]

Description

If one of the tools encounters an error, it stops processing the file(s). With this option you tell the tools to
treat warnings as errors or treat specific control program warning messages as errors:

• If you specify this option but without numbers, all warnings are treated as errors.

• If you specify this option with a number or a range, only the specified control program warnings are
treated as an error.You can specify the option --warnings-as-errors=number multiple times.

Use one of the --pass-tool options to pass this option directly to a tool when a specific warning for that
tool must be treated as an error. For example, use --pass-c=--warnings-as-errors=number to treat a
specific C compiler warning as an error.

Related information

Control program option --no-warnings (Suppress some or all warnings)

Control program option --pass (Pass option to tool)

405

Tool Options



Control program option: --wchar

Menu entry

1. Select Linker » Libraries.

2. Enable the option Use C library with wide character support.

Command line syntax

--wchar

Description

By default the control program uses the standard C library (lc87c.lib or lc87cs.lib). This C library
does not support wide character functions. With this option your application is linked with a version of the
C library that does include the wide character functions (lc87cw.lib or lc87cws.lib).

Related information

Section 5.3, Linking with Libraries
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8.6. Parallel Make Utility Options

When you build a project in Eclipse, Eclipse generates a makefile and uses the make utility amk to build
all your files. However, you can also use the make utility directly from the command line to build your
project.

The invocation syntax is:

amk [option...] [target...] [macro=def]

This section describes all options for the parallel make utility.

For detailed information about the parallel make utility and using makefiles see Section 6.2, Make Utility
amk.
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Parallel make utility option: --always-rebuild (-a)

Command line syntax

--always-rebuild

-a

Description

Normally the make utility rebuilds only those files that are out of date. With this option you tell the make
utility to rebuild all files, without checking whether they are out of date.

Example

amk -a

Rebuilds all your files, regardless of whether they are out of date or not.

Related information

-
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Parallel make utility option: --change-dir (-G)

Command line syntax

--change-dir=path

-G path

Description

Normally you must call the make utility from the directory where your makefile and other files are stored.

With the option -G you can call the make utility from within another directory. The path is the path to the
directory where your makefile and other files are stored and can be absolute or relative to your current
directory.

The macro SUBDIR is defined with the value of path.

Example

Suppose your makefile and other files are stored in the directory ..\myfiles.You can call the make
utility, for example, as follows:

amk -G ..\myfiles

Related information

-
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Parallel make utility option: --diag

Command line syntax

--diag=[format:]{all | nr,...}

You can set the following output formats:

HTML output.html

Rich Text Format.rtf

ASCII text.text

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify.You can specify the
following formats: html, rtf or text (default). To create a file with the descriptions, you must redirect the
output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one
or more selected error messages, you can specify the error message numbers, separated by commas.

Example

To display an explanation of message number 169, enter:

amk --diag=169

This results in the following message and explanation:

F169: target '%s' returned exit code %d

An error occured while executing one of the commands
of the target, and -k option is not specified.

To write an explanation of all errors and warnings in HTML format to file amkerrors.html, use redirection
and enter:

amk --diag=html:all > amkerrors.html

Related information

-
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Parallel make utility option: --dry-run (-n)

Command line syntax

--dry-run

-n

Description

With this option you tell the make utility to perform a dry run. The make utility shows what it would do but
does not actually perform these tasks.

This option is for example useful to quickly inspect what would happen if you call the make utility.

Example

amk -n

The make utility does not perform any tasks but displays what it would do if called without the option -n.

Related information

Parallel make utility option -s (Do not print commands before execution)
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Parallel make utility option: --help (-? / -h)

Command line syntax

--help[=item]

-h

-?

You can specify the following arguments:

Show extended option descriptionsoptions

Description

Displays an overview of all command line options. When you specify the argument options you can list
detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

amk -?
amk --help

To see a detailed description of the available options, enter:

amk --help=options

Related information

-

412

TASKING VX-toolset for LC87 User Guide



Parallel make utility option: --jobs (-j) / --jobs-limit (-J)

Menu

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, select C/C++ Build.

In the right pane the C/C++ Build page appears.

3. On the Behaviour tab, select Use parallel build.

4. You can specify the number of parallel jobs, or you can use an optimal number of jobs. In the last
case, amk will fork as many jobs in parallel as cores are available.

Command line syntax

--jobs[=number]
-j[number]

--jobs-limit[=number]
-J[number]

Description

When these options you can limit the number of parallel jobs.The default is 1. Zero means no limit. When
you omit the number, amk uses the number of cores detected.

Option -J is the same as -j, except that the number of parallel jobs is limited by the number of cores
detected.

Example

amk -j3

Limit the number of parallel jobs to 3.

Related information

-
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Parallel make utility option: --keep-going (-k)

Command line syntax

--keep-going

-k

Description

When during the make process the make utility encounters an error, it stops rebuilding your files.

With the option -k, the make utility only stops building the target that produced the error. All other targets
defined in the makefile are built.

Example

amk -k

If the make utility encounters an error, it stops building the current target but proceeds with the other
targets that are defined in the makefile.

Related information

-
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Parallel make utility option: --list-targets (-l)

Command line syntax

--list-targets

-l

Description

With this option, the make utility lists all "primary" targets that are out of date.

Example

amk -l
list of targets

Related information

-
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Parallel make utility option: --makefile (-f)

Command line syntax

--makefile=my_makefile

-f my_makefile

Description

By default the make utility uses the file makefile to build your files.

With this option you tell the make utility to use the specified file instead of the file makefile. Multiple -f
options act as if all the makefiles were concatenated in a left-to-right order.

If you use '-' instead of a makefile name it means that the information is read from stdin.

Example

amk -f mymake

The make utility uses the file mymake to build your files.

Related information

-
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Parallel make utility option: --no-warnings (-w)

Command line syntax

--no-warnings[=number,...]

-w[number,...]

Description

With this option you can suppresses all warning messages or specific warning messages.

On the command line this option works as follows:

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings are suppressed.

• If you specify this option with a number, only the specified warning is suppressed.You can specify the
option --no-warnings=number multiple times.

Example

To suppress warnings 751 and 756, enter:

amk --no-warnings=751,756

Related information

Parallel make utility option --warnings-as-errors (Treat warnings as errors)
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Parallel make utility option: --silent (-s)

Command line syntax

--silent

-s

Description

With this option you tell the make utility to perform its tasks without printing the commands it executes.
Error messages are normally printed.

Example

amk -s

The make utility rebuilds your files but does not print the commands it executes during the make process.

Related information

Parallel make utility option -n (Perform a dry run)
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Parallel make utility option: --version (-V)

Command line syntax

--version

-V

Description

Display version information. The make utility ignores all other options or input files.

Related information

-
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Parallel make utility option: --warnings-as-errors

Command line syntax

--warnings-as-errors[=number,...]

Description

If the make utility encounters an error, it stops. When you use this option without arguments, you tell the
make utility to treat all warnings as errors.This means that the exit status of the make utility will be non-zero
after one or more warnings. As a consequence, the make utility now also stops after encountering a
warning.

You can also limit this option to specific warnings by specifying a comma-separated list of warning numbers.

Related information

Parallel make utility option --no-warnings (Suppress some or all warnings)
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8.7. Archiver Options

The archiver and library maintainer ar87 is a tool to build library files and it offers the possibility to replace,
extract and remove modules from an existing library.

The invocation syntax is:

ar87 key_option [sub_option...] library [object_file]

This section describes all options for the archiver. Some suboptions can only be used in combination with
certain key options. They are described together. Suboptions that can always be used are described
separately.

For detailed information about the archiver, see Section 6.3, Archiver.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters.You can abbreviate long option
names as long as it forms a unique name.You can mix short and long option names on the command
line.

Overview of the options of the archiver utility

The following archiver options are available:

Sub-optionOptionDescription

Main functions (key options)

-a -b -c -n -u -v-rReplace or add an object module

-o -v-xExtract an object module from the library

-v-dDelete object module from library

-a -b -v-mMove object module to another position

-s0 -s1-tPrint a table of contents of the library

-pPrint object module to standard output

Sub-options

-a nameAppend or move new modules after existing module name

-b nameAppend or move new modules before existing module name

-cSuppress the message that is displayed when a new library is
created.

-nCreate a new library from scratch

-oPreserve last-modified date from the library

-s{0|1}Print symbols in library modules

-uReplace only newer modules

-vVerbose

421

Tool Options



Sub-optionOptionDescription

Miscellaneous

-?Display options

--diagDisplay description of one or more diagnostic messages

-VDisplay version header

-f fileRead options from file

-wnSuppress warnings above level n
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Archiver option: --diag

Command line syntax

--diag=[format:]{all | msg[-msg],...}

You can set the following output formats:

HTML output.html

Rich Text Format.rtf

ASCII text.text

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify. The archiver does
not perform any actions.You can specify the following formats: html, rtf or text (default). To create a file
with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one
or more selected error messages, you can specify the error message numbers, separated by commas,
or you can specify a range.

Example

To display an explanation of message number 102, enter:

ar87 --diag=102

This results in the following message and explanation:

F102: cannot create "<file>"

The output file or a temporary file could not be created. Check if you have
sufficient disk space and if you have write permissions for the specified
file.

To write an explanation of all errors and warnings in HTML format to file arerrors.html, use redirection
and enter:

ar87 --diag=html:all > arerrors.html

Related information

-
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Archiver option: --delete (-d)

Command line syntax

--delete [--verbose]

-d [-v]

Description

Delete the specified object modules from a library. With the suboption --verbose (-v) the archiver shows
which files are removed.

Verbose: the archiver shows which files are removed.-v--verbose

Example

ar87 --delete mylib.lib obj1.obj obj2.obj

The archiver deletes obj1.obj and obj2.obj from the library mylib.lib.

ar87 -d -v mylib.lib obj1.obj obj2.obj

The archiver deletes obj1.obj and obj2.obj from the library mylib.lib and displays which files are
removed.

Related information

-

424

TASKING VX-toolset for LC87 User Guide



Archiver option: --dump (-p)

Command line syntax

--dump

-p

Description

Print the specified object module(s) in the library to standard output.

This option is only useful when you redirect or pipe the output to other files or tools that serve your own
purposes. Normally you do not need this option.

Example

ar87 --dump mylib.lib obj1.obj > file.obj

The archiver prints the file obj1.obj to standard output where it is redirected to the file file.obj. The
effect of this example is very similar to extracting a file from the library but in this case the 'extracted' file
gets another name.

Related information

-
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Archiver option: --extract (-x)

Command line syntax

--extract [--modtime] [--verbose]

-x [-o] [-v]

Description

Extract an existing module from the library.

Give the extracted object module the same date as the last-modified
date that was recorded in the library. Without this suboption it
receives the last-modified date of the moment it is extracted.

-o--modtime

Verbose: the archiver shows which files are extracted.-v--verbose

Example

To extract the file obj1.obj from the library mylib.lib:

ar87 --extract mylib.lib obj1.obj

If you do not specify an object module, all object modules are extracted:

ar87 -x mylib.lib

Related information

-
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Archiver option: --help (-?)

Command line syntax

--help[=item]

-?

You can specify the following argument:

Show extended option descriptionsoptions

Description

Displays an overview of all command line options. When you specify the argument options you can list
detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

ar87 -?
ar87 --help
ar87

To see a detailed description of the available options, enter:

ar87 --help=options

Related information

-
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Archiver option: --move (-m)

Command line syntax

--move [-a posname] [-b posname]

-m [-a posname] [-b posname]

Description

Move the specified object modules to another position in the library.

The ordering of members in a library can make a difference in how programs are linked if a symbol is
defined in more than one member.

By default, the specified members are moved to the end of the archive. Use the suboptions -a or -b to
move them to a specified place instead.

Move the specified object module(s) after the existing module
posname.

-a
posname

--after=posname

Move the specified object module(s) before the existing
module posname.

-b
posname

--before=posname

Example

Suppose the library mylib.lib contains the following objects (see option --print):

obj1.obj
obj2.obj
obj3.obj

To move obj1.obj to the end of mylib.lib:

ar87 --move mylib.lib obj1.obj

To move obj3.obj just before obj2.obj:

ar87 -m -b obj3.obj mylib.lib obj2.obj

The library mylib.lib after these two invocations now looks like:

obj3.obj
obj2.obj
obj1.obj

Related information

Archiver option --print (-t) (Print library contents)
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Archiver option: --option-file (-f)

Command line syntax

--option-file=file

-f file

Description

Instead of typing all options on the command line, you can create an option file which contains all options
and flags you want to specify. With this option you specify the option file to the archiver.

Use an option file when the command line would exceed the limits of the operating system, or just to store
options and save typing.

You can specify the option --option-file (-f) multiple times.

If you use '-' instead of a filename it means that the options are read from stdin.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and
vise versa:

"This has a single quote ' embedded"

'This has a double quote " embedded'

'This has a double quote " and a single quote '"' embedded"

• When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is
preserved.

"This is a continuation \
line"

         -> "This is a continuation line"

• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

-x mylib.lib obj1.obj
-w5
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Specify the option file to the archiver:

ar87 --option-file=myoptions

This is equivalent to the following command line:

ar87 -x mylib.lib obj1.obj -w5

Related information

-
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Archiver option: --print (-t)

Command line syntax

--print [--symbols=0|1]

-t [-s0|-s1]

Description

Print a table of contents of the library to standard output. With the suboption -s0 the archiver displays all
symbols per object file.

Displays per object the name of the object itself and all symbols in
the object.

-s0--symbols=0

Displays the symbols of all object files in the library in the form
library_name:object_name:symbol_name

-s1--symbols=1

Example

ar87 --print mylib.lib

The archiver prints a list of all object modules in the library mylib.lib:

ar87 -t -s0 mylib.lib

The archiver prints per object all symbols in the library. For example:

cstart.obj
   symbols:
        _START

Related information

-
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Archiver option: --replace (-r)

Command line syntax

--replace [--after=posname] [--before=posname]
          [--create] [--new] [--newer-only] [--verbose]

-r [-a posname] [-b posname][-c] [-n] [-u] [-v]

Description

You can use the option --replace (-r) for several purposes:

• Adding new objects to the library

• Replacing objects in the library with the same object of a newer date

• Creating a new library

The option --replace (-r) normally adds a new module to the library. However, if the library already contains
a module with the specified name, the existing module is replaced. If you specify a library that does not
exist, the archiver creates a new library with the specified name.

If you add a module to the library without specifying the suboption -a or -b, the specified module is added
at the end of the archive. Use the suboptions -a or -b to insert them after/before a specified place instead.

Insert the specified object module(s) after the existing
module posname.

-a posname--after=posname

Insert the specified object module(s) before the existing
module posname.

-b posname--before=posname

Suppress the message that is displayed when a new library
is created.

-c--create

Create a new library from scratch. If the library already
exists, it is overwritten.

-n--new

Insert the specified object module only if it is newer than
the module in the library.

-u--newer-only

Verbose: the archiver shows which files are replaced.-v--verbose

The suboptions -a or -b have no effect when an object is added to the library.

Example

Suppose the library mylib.lib contains the following object (see option --print):

obj1.obj

To add obj2.obj to the end of mylib.lib:

ar87 --replace mylib.lib obj2.obj
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To insert obj3.obj just before obj2.obj:

ar87 -r -b obj2.obj mylib.lib obj3.obj

The library mylib.lib after these two invocations now looks like:

obj1.obj
obj3.obj
obj2.obj

Creating a new library

To create a new library file, add an object file and specify a library that does not yet exist:

ar87 --replace newlib.lib obj1.obj

The archiver creates the library newlib.lib and adds the object obj1.obj to it.

To create a new library file and overwrite an existing library, add an object file and specify an existing
library with the supoption --new (-n):

ar87 -r -n mylib.lib obj1.obj

The archiver overwrites the library mylib.lib and adds the object obj1.obj to it. The new library
mylib.lib only contains obj1.obj.

Related information

Archiver option --print (-t) (Print library contents)
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Archiver option: --version (-V)

Command line syntax

--version

-V

Description

Display version information. The archiver ignores all other options or input files.

Related information

-
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Archiver option: --warning (-w)

Command line syntax

--warning=level

-wlevel

Description

With this suboption you tell the archiver to suppress all warnings above the specified level. The level is
a number between 0 - 9.

The level of a message is printed between parentheses after the warning number. If you do not use the
-w option, the default warning level is 8.

Example

To suppress warnings above level 5:

ar87 --extract --warning=5 mylib.lib obj1.obj

Related information

-
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8.8. HLL Object Dumper Options

The high level language (HLL) dumper hldump87 is a program to dump information about an absolute
object file (.abs).

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters.You can abbreviate long option
names as long as it forms a unique name.You can mix short and long option names on the command
line.

Options can have flags or suboptions. To switch a flag 'on', use a lowercase letter or a +longflag. To
switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following
two invocations are equivalent:

hldump87 -FdhMsy test.abs
hldump87 --dump-format=+dump,+hllsymbols,-modules,+sections,+symbols test.abs

When you do not specify an option, a default value may become active.
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HLL object dumper option: --class (-c)

Command line syntax

--class[=class]

-c[class]

You can specify one of the following classes:

Dump contents of all sections.aall

Dump contents of code sections.ccode

Dump contents of data sections.ddata

Default: --class=all

Description

With this option you can restrict the output to code or data only. This option affects all parts of the output,
except the module list. The effect is listed in the following table.

Effect of --classOutput part

Not restrictedModule list

Only lists sections of the specified classSection list

Only dumps the contents of the sections of the specified classSection dump

Only lists symbols of the specified classHLL symbol table

Only lists symbols defined in sections of the specified classAssembly level symbol
table

Not restrictedNote sections

By default all sections are included.

Related information

Section 6.4.2, HLL Dump Output Format
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HLL object dumper option: --diag

Command line syntax

--diag=[format:]{all | msg[-msg],...}

You can set the following output formats:

HTML output.html

Rich Text Format.rtf

ASCII text.text

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify. The HLL object
dumper does not process any files.You can specify the following formats: html, rtf or text (default). To
create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one
or more selected error messages, you can specify the error message numbers, separated by commas,
or you can specify a range.

Example

To display an explanation of message number 101, enter:

hldump87 --diag=101

This results in the following message and explanation:

F101: cannot create "<file>"

The output file or a temporary file could not be created.
Check if you have sufficient disk space and if you have
write permissions for the specified file.

To write an explanation of all errors and warnings in HTML format to file hldumperrors.html, use
redirection and enter:

hldump87 --diag=html:all > hldumperrors.html

Related information

-
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HLL object dumper option: --disassembly-intermix (-i)

Command line syntax

--disassembly-intermix[=flag]

-i[flag]

You can specify the following format flags:

Force the insert to be limited to the first preceding source line.s/S+/-single-line

Default: --disassembly-intermix=S

Description

With this option the disassembly is intermixed with HLL source code. The source is searched for as
described with option --source-lookup-path

The +single-line sub-option forces the insert to be limited to the first preceding source line. With the
-single-line sub-option all source lines that belong to the address are prefixed. For example comments
are thus also visible. This is the default.

Example

hldump87 --disassembly-intermix --source-lookup-path=c:\mylib\src hello.abs

Related information

HLL object dumper option --source-lookup-path
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HLL object dumper option: --dump-format (-F)

Command line syntax

--dump-format[=flag,...]

-F[flag]...

You can specify the following format flags:

Dump the contents of the sections in the object file. Code sections
can be disassembled, data sections are dumped.

d/D+/-dump

List the high level language symbols, with address, size and type.h/H+/-hllsymbols

Print a list of modules found in object file.m/M+/-modules

Dump all ELF .note sections.n/N+/-note

Print a list of sections with start address, length and type.s/S+/-sections

List the low level symbols, with address and length (if known).y/Y+/-symbols

Alias for DHMNSY (nothing)0

Alias for DhMNSY (only HLL symbols)1

Alias for dHMNSY (only section contents)2

Alias for dhmnsy (default, everything)3

Default: --dump-format=dhmnsy

Description

With this option you can control which parts of the dump output you want to see. By default, all parts are
dumped.

1. Module list

2. Section list

3. Section dump (disassembly)

4. HLL symbol table

5. Assembly level symbol table

6. Note sections

You can limit the number of sections that will be dumped with the options --sections and --section-types.

Related information

Section 6.4.2, HLL Dump Output Format
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HLL object dumper option: --expand-symbols (-e)

Command line syntax

--expand-symbols[=flag],...

-e[flag]...

You can specify one of the following flags:

Expand arrays with basic C types.b/B+/-basic-types

Include the full path to the field level.f/F+/-fullpath

Default (no flags): --expand-symbols=BF

Description

With this option you specify that all struct, union and array symbols are expanded with their fields in the
HLL symbol dump.

With --expand-symbols=+basic-types, HLL struct and union symbols are listed including all fields. Array
members are expanded in one array member per line regardless of the HLL type. For the fields the types
and names are indented with 2 spaces.

With --expand-symbols=+fullpath, all fields of structs and unions and all members of non-basic type
arrays are expanded and prefixed with their parent's names.

Example

hldump87 -F1 hello.abs

---------- HLL symbol table ----------

6:0000001a      80 static char   __data stdin_buf[80] [_iob.c]
6:000000ba      11 struct        __data _dbg_request [dbg.c]

hldump87 -e -F1 hello.abs

---------- HLL symbol table ----------

6:0000001a      80 static char   __data stdin_buf[80] [_iob.c]
6:000000ba      11 struct        __data _dbg_request [dbg.c]
6:000000ba       2   int                  _errno
6:000000bc       1   enum                 nr
6:000000bd       8   union                u
6:000000bd       2     struct               exit
6:000000bd       2       int                  status
6:000000bd       4     struct               open
6:000000bd       2       const char  __data * pathname
6:000000bf       2       unsigned short int   flags
   ...
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hldump87 -eb -F1 hello.abs

---------- HLL symbol table ----------

6:0000001a      80 static char   __data stdin_buf[80] [_iob.c]
6:0000001a       1   char
6:0000001b       1   char
6:0000001c       1   char
  ...
6:00000069       1   char
6:000000ba      11 struct        __data _dbg_request [dbg.c]
6:000000ba       2   int                  _errno
6:000000bc       1   enum                 nr
6:000000bd       8   union                u
6:000000bd       2     struct               exit
6:000000bd       2       int                  status
6:000000bd       4     struct               open
6:000000bd       2       const char  __data * pathname
6:000000bf       2       unsigned short int   flags
   ...

hldump87 -ef -F1 hello.abs

---------- HLL symbol table ----------

6:0000001a      80 static char   __data stdin_buf[80] [_iob.c]
6:000000ba      11 struct        __data _dbg_request [dbg.c]
6:000000ba       2   int                  _dbg_request._errno
6:000000bc       1   enum                 _dbg_request.nr
6:000000bd       8   union                _dbg_request.u
6:000000bd       2     struct               _dbg_request.u.exit
6:000000bd       2       int                  _dbg_request.u.exit.status
6:000000bd       4     struct               _dbg_request.u.open
6:000000bd       2       const char  __data * _dbg_request.u.open.pathname
6:000000bf       2       unsigned short int   _dbg_request.u.open.flags
   ...

Related information

Section 6.4.2, HLL Dump Output Format
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HLL object dumper option: --help (-?)

Command line syntax

--help

-?

Description

Displays an overview of all command line options.

Example

The following invocations all display a list of the available command line options:

hldump87 -?
hldump87 --help
hldump87

Related information

-
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HLL object dumper option: --hex (-x)

Command line syntax

--hex

-x

Description

With this option you can control the way data sections and code sections are dumped. By default, the
contents of data sections are represented by directives. A new directive will be generated for each symbol.
ELF labels in the section are used to determine the start of a directive. ROM sections are represented
with .db, .dw, .dl kind of directives, depending on the size of the data. RAM sections are represented
with .ds directives, with a size operand depending on the data size. This can be either the size specified
in the ELF symbol, or the size up to the next label. Code sections are dumped as disassembly.

With option --hex, no directives will be generated for ROM data sections and no disassembly dump will
be done for code sections. Instead ROM data sections and code sections are dumped as hexadecimal
code with ASCII translation. RAM sections will be represented with only a start address and a size indicator.

Example

hldump87 -F2 --section=[.data] hello.abs

---------- Section dump ----------

    .section [.data]
    , at 000000fa
    .db 48,65,6c,6c,6f,20,77,6f,72,6c,64,21,0a,00      ; Hello world!..
    .endsec

hldump87 -F2 --section=.rodata --hex hello.abs

---------- Section dump ----------

                          section 55 ([.data]):
000000fa 48 65 6c 6c 6f 20 77 6f 72 6c 64 21 0a 00     Hello %s!..

Related information

Section 6.4.2, HLL Dump Output Format
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HLL object dumper option: --option-file (-f)

Command line syntax

--option-file=file,...

-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line,
you can create an option file which contains all options and flags you want to specify. With this option
you specify the option file to the HLL object dumper.

Use an option file when the command line would exceed the limits of the operating system, or just to store
options and save typing.

You can specify the option --option-file multiple times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and
vise versa:

"This has a single quote ' embedded"

'This has a double quote " embedded'

'This has a double quote " and a single quote '"' embedded"

• When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is
preserved.

"This is a continuation \
line"

         -> "This is a continuation line"

• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

--symbols=hll
--class=code
hello.abs
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Specify the option file to the HLL object dumper:

hldump87 --option-file=myoptions

This is equivalent to the following command line:

hldump87 --symbols=hll --class=code hello.abs

Related information

-
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HLL object dumper option: --output (-o)

Command line syntax

--output=file

-o file

Description

By default, the HLL object dumper dumps the output on stdout. With this option you specify to dump
the information in the specified file.

The default output format is text, but you can specify another output format with option --output-type.

Example

hldump87 --output=dump.txt hello.abs

The HLL object dumper dumps the output in file dump.txt.

Related information

HLL object dumper option --output-type
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HLL object dumper option: --output-type (-T)

Command line syntax

--output-type[=type]

-T[type]

You can specify one of the following types:

Output human readable text.ttext

Output XML.xxml

Default: --output-type=text

Description

With this option you can specify whether the output is formatted as plain text or as XML.

Related information

HLL object dumper option --output
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HLL object dumper option: --sections (-s)

Command line syntax

--sections=name,...

-sname,...

Description

With this option you can restrict the output to the specified sections only. This option affects the following
parts of the output:

Effect of --sectionsOutput part

Not restrictedModule list

Only lists the specified sectionsSection list

Only dumps the contents of the specified sectionsSection dump

Not restrictedHLL symbol table

Only lists symbols defined in the specified sectionsAssembly level symbol
table

Not restrictedNote sections

By default all sections are included.

Related information

Section 6.4.2, HLL Dump Output Format
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HLL object dumper option: --source-lookup-path (-L)

Command line syntax

--source-lookup-path=path

-Lpath

Description

With this option you can specify an additional path where your source files are located. If you want to
specify multiple paths, use the option --source-lookup-path for each separate path.

The order in which the HLL object dumper will search for source files when intermixed disassembly is
used, is:

1. The path obtained from the HLL debug information.

2. The path that is specified with the option --source-lookup-path. If multiple paths are specified, the
paths will be searched for in the order in which they are given on the command line.

Example

Suppose you call the HLL object dumper as follows:

hldump87 --disassembly-intermix --source-lookup-path=c:\mylib\src hello.abs

First the HLL object dumper looks in the directory found in the HLL debug information of file hello.abs
for the location of the source file(s). If it does not find the file(s), it looks in the directory c:\mylib\src.

Related information

HLL object dumper option --disassembly-intermix
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HLL object dumper option: --symbols (-S)

Command line syntax

--symbols[=type]

-S[type]

You can specify one of the following types:

Display assembly symbols in code dump.aasm

Display HLL symbols in code dump.hhll

Display plain addresses in code dump.nnone

Default: --symbols=asm

Description

With this option you can control symbolic information in the disassembly and data dump. For data sections
this only applies to symbols used as labels at the data addresses. Data within the data sections will never
be replaced with symbols.

Only symbols that are available in the ELF or DWARF information are used. If you build an application
without HLL debug information the --symbols=hll option will result in the same output as with
--symbols=none. The same applies to the --symbols=asm option when all symbols are stripped from
the ELF file.

Example

hldump87 -F2 hello.abs

----------- Section dump ----------

                                   .section .text
00000006 7f fe        __Exit       br      __Exit
                                   .endsec

hldump87 --symbols=none -F2 hello.abs

----------- Section dump ----------

                                   .section .text
00000006 7f fe        __Exit       br      0x0006
                                   .endsec

Related information

Section 6.4.2, HLL Dump Output Format
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HLL object dumper option: --version (-V)

Command line syntax

--version

-V

Description

Display version information. The HLL object dumper ignores all other options or input files.

Related information

-
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HLL object dumper option: --xml-base-filename (-X)

Command line syntax

--xml-base-filename

-X

Description

With this option the <File name> field in the XML output only contains the filename of the object file.
By default, any path name, if present, is printed as well.

Example

hldump87 --output-type=xml --output=hello.xml ../hello.abs

The field <File name="../hello.abs"> is used in hello.xml.

hldump87 --output-type=xml --output=hello.xml -X ../hello.abs

The field <File name="hello.abs"> is used in hello.xml. The path is stripped from the filename.

Related information

HLL object dumper option --output-type
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8.9. Expire Cache Utility Options

With the utility expire87 you can limit the size of the cache (C compiler option --cache) by removing all
files older than a few days or by removing older files until the total size of the cache is smaller than a
specified size. See also section Compiler Cache in Section 3.6, Influencing the Build Time.

The invocation syntax is:

expire87 [option]... cache-directory

The compiler cache is present in the directory c87cache under the specified cache-directory.

This section describes all options for the expire cache utility.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters.You can abbreviate long option
names as long as it forms a unique name.You can mix short and long option names on the command
line.
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Expire cache utility option: --access (-a)

Command line syntax

--access

-a

Description

Use the last access time instead of the last modification time to determine which files to delete.

Example

expire87 --access --days=7 "installation-dir\mproject\.cache"

Related information

-
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Expire cache utility option: --days (-d)

Menu entry

1. Select C Compiler » Optimization » Compilation Speed.

2. Enable the option Cache generated code to improve the compilation speed.

3. In the Directory for cached files field, enter the name for the location of the cache.

By default this is the .cache directory under your project directory.

4. Specify the Maximum days files will live in the cache.

Command line syntax

--days=n

-dn

Description

Remove all files older than n days from the cache.

Example

To remove all files older than seven days, enter:

expire87 --days=7 "installation-dir\mproject\.cache"

Related information

-
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Expire cache utility option: --diag

Command line syntax

--diag=[format:]{all | msg[-msg],...}

You can set the following output formats:

HTML output.html

Rich Text Format.rtf

ASCII text.text

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify.You can specify the
following formats: html, rtf or text (default). To create a file with the descriptions, you must redirect the
output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one
or more selected error messages, you can specify the error message numbers, separated by commas,
or you can specify a range.

With this option the expire cache utility does not remove any files.

Example

To display an explanation of message number 204, enter:

expire87 --diag=204

This results in the following message and explanation:

E204: failed to remove "<file>" <<cause>>

The removal of the indicated file failed. The <cause> 
provides more details of the problem.

To write an explanation of all errors and warnings in HTML format to file expire87_errors.html, use
redirection and enter:

expire87 --diag=html:all > expire87_errors.html

Related information

-
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Expire cache utility option: --dry-run (-n)

Command line syntax

--dry-run

-n

Description

With this option you put the expire utility in verbose mode. The utility shows which files would be deleted,
without actually removing them.

Related information

Expire cache utility option --verbose (Verbose output)
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Expire cache utility option: --help (-?)

Command line syntax

--help[=item]

-?

You can specify the following argument:

Show extended option descriptionsoptions

Description

Displays an overview of all command line options. When you specify the argument options you can list
detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

expire87 -?
expire87 --help
expire87

To see a detailed description of the available options, enter:

expire87 --help=options

Related information

-
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Expire cache utility option: --megabytes (-m)

Menu entry

1. Select C Compiler » Optimization » Compilation Speed.

2. Enable the option Cache generated code to improve the compilation speed.

3. In the Directory for cached files field, enter the name for the location of the cache.

By default this is the .cache directory under your project directory.

4. Enable the option Clear cache upon project clean.

Each time you use Project » Clean... the cache is cleared.

Command line syntax

--megabytes=m

-mm

Description

Reduce the size of the cache to m MBytes by removing files from the cache, starting with the oldest file.
With a size of 0 (zero) you clear the entire cache.

Example

To reduce the compiler cache size to 4 MB, enter:

expire87 --megabytes=4 "installation-dir\mproject\.cache"

Older files are removed until the total size of the cache is smaller than 4 MB.

To clear the compiler cache, enter:

expire87 --megabytes=0 "installation-dir\mproject\.cache"

Related information

-
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Expire cache utility option: --totals (-t)

Command line syntax

--totals

-t

Description

Show the total size of the cache and the number of directories and files. This option is implicit when
invoked without the --days and --megabytes options.

Example

expire87 -t "installation-dir\mproject\.cache"

installation-dir\mproject\.cache\c87cache:
1 MB, 3 directories, 3 files

Related information

-
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Expire cache utility option: --verbose (-v)

Command line syntax

--verbose

-v

Description

With this option you put the expire cache utility in verbose mode. The utility shows which files are being
deleted.

Example

expire87 -v --megabytes=0 "installation-dir\mproject\.cache"

2013-06-26 12:36:15 installation-dir\mproject\.cache\c87cache\cstart\30aa7935
2013-06-26 12:36:17 installation-dir\mproject\.cache\c87cache\myproject\6f0a3ba4

Related information

-
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Expire cache utility option: --version (-V)

Command line syntax

--version

-V

Description

Display version information and exit. The expire cache utility ignores all other options.

Related information

-
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Chapter 9. Libraries
This chapter contains an overview of all library functions that you can call in your C source. This includes
all functions of the standard C library (ISO C99) and some functions of the floating-point library.

A number of standard operations within C are too complex to generate inline code for (too much code).
These operations are implemented as run-time library functions to save code.

Section 9.1, Library Functions, gives an overview of all library functions you can use, grouped per header
file. A number of functions declared in wchar.h are parallel to functions in other header files. These are
discussed together.

Section 9.2, C Library Reentrancy, gives an overview of which functions are reentrant and which are not.

C library / floating-point library / run-time library

The following libraries are included in the LC87 toolset. Both Eclipse and the control program cc87
automatically select the appropriate libraries depending on the specified options.

DescriptionLibraries

C libraries
Mandatory letter:
s | d = RAM model sdata or data (control program option --ram-model)
Optional letter:
w = wide character support (control program option --wchar)
s = single precision floating-point (control program option --no-double)

lc87c{s|d}[w][s].lib

Floating-point libraries (contains floating-point functions needed by the C
compiler)
Optional letter:
t = trapping (control program option --fp-trap)

lc87fp[t].lib

Run-time library (contains other run-time functions needed by the C
compiler)

lc87rt.lib

Sources for the libraries are present in the directories lib\src, lib\src.* in the form of an executable.
If you run the executable it will extract the sources in the corresponding directory.

Floating-point library with trapping

If you use the trapping floating-point library (lc87fpt.lib), exceptional floating-point cases are intercepted
and can be handled separately by an application defined trap handler. Using this library decreases the
execution speed of your application. The header file except.h contains the LC87 specific software
floating-point trap handling interface definition. See Section 9.1.5, except.h for the interface functions and
a list of floating-point exceptions, such as overflow and underflow.

C library with wide character support

A number of wide character functions are available in a separate version of the C library. To use wide
character functionality use control program option --wchar.
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9.1. Library Functions

The tables in the sections below list all library functions, grouped per header file in which they are declared.
Some functions are not completely implemented because their implementation depends on the context
where your application will run.These functions are for example all I/O related functions. Where possible,
these functions are implemented using file system simulation (FSS). This system can be used by the
debugger to simulate an I/O environment which enables you to debug your application.

9.1.1. assert.h

Prints a diagnostic message if NDEBUG is not defined. (Implemented as macro)assert(expr)

9.1.2. ctype.h and wctype.h

The header file ctype.h declares the following functions which take a character c as an integer type
argument. The header file wctype.h declares parallel wide-character functions which take a character
c of the wchar_t type as argument.

Descriptionwctype.hctype.h

Returns a non-zero value when c is an alphabetic character or a
number ([A-Z][a-z][0-9]).

iswalnumisalnum

Returns a non-zero value when c is an alphabetic character
([A-Z][a-z]).

iswalphaisalpha

Returns a non-zero value when c is a blank character (tab, space...)iswblankisblank

Returns a non-zero value when c is a control character.iswcntrliscntrl

Returns a non-zero value when c is a numeric character ([0-9]).iswdititisdigit

Returns a non-zero value when c is printable, but not a space.iswgraphisgraph

Returns a non-zero value when c is a lowercase character ([a-z]).iswlowerislower

Returns a non-zero value when c is printable, including spaces.iswprintisprint

Returns a non-zero value when c is a punctuation character (such
as '.', ',', '!').

iswpunctispunct

Returns a non-zero value when c is a space type character (space,
tab, vertical tab, formfeed, linefeed, carriage return).

iswspaceisspace

Returns a non-zero value when c is an uppercase character ([A-Z]).iswupperisupper

Returns a non-zero value when c is a hexadecimal digit
([0-9][A-F][a-f]).

iswxdigitisxdigit

Returns c converted to a lowercase character if it is an uppercase
character, otherwise c is returned.

towlowertolower

Returns c converted to an uppercase character if it is a lowercase
character, otherwise c is returned.

towuppertoupper

Converts c to a lowercase character, does not check if c really is
an uppercase character. Implemented as macro. This macro
function is not defined in ISO C99.

-_tolower
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Descriptionwctype.hctype.h

Converts c to an uppercase character, does not check if c really
is a lowercase character. Implemented as macro. This macro
function is not defined in ISO C99.

-_toupper

Returns a non-zero value when c is in the range of 0 and 127.This
function is not defined in ISO C99.

isascii

Converts c to an ASCII value (strip highest bit). This function is
not defined in ISO C99.

toascii

9.1.3. dbg.h

The header file dbg.h contains the debugger call interface for file system simulation. It contains low level
functions. This header file is not defined in ISO C99.

Low level function to trap debug events_dbg_trap

Low level function for command line argument passing_argcv(const char
*buf,size_t size)

9.1.4. errno.h

External variable that holds implementation defined error codes.int errno

The following error codes are defined as macros in errno.h:

EPERM           1       Operation not permitted
ENOENT          2       No such file or directory
EINTR           3       Interrupted system call
EIO             4       I/O error
EBADF           5       Bad file number
EAGAIN          6       No more processes
ENOMEM          7       Not enough core
EACCES          8       Permission denied
EFAULT          9       Bad address
EEXIST          10      File exists
ENOTDIR         11      Not a directory
EISDIR          12      Is a directory
EINVAL          13      Invalid argument
ENFILE          14      File table overflow
EMFILE          15      Too many open files
ETXTBSY         16      Text file busy
ENOSPC          17      No space left on device
ESPIPE          18      Illegal seek
EROFS           19      Read-only file system
EPIPE           20      Broken pipe
ELOOP           21      Too many levels of symbolic links
ENAMETOOLONG    22      File name too long
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Floating-point errors

EDOM            23      Argument too large
ERANGE          24      Result too large

Errors returned by printf/scanf

ERR_FORMAT      25      Illegal format string for printf/scanf
ERR_NOFLOAT     26      Floating-point not supported
ERR_NOLONG      27      Long not supported
ERR_NOPOINT     28      Pointers not supported

Encoding errors set by functions like fgetwc, getwc, mbrtowc, etc ...

EILSEQ          29      Invalid or incomplete multibyte or wide character

Errors returned by RTOS

ECANCELED       30      Operation canceled
ENODEV          31      No such device

9.1.5. except.h

The header file except.h contains the LC87 specific software floating-point exception handling interface
definition. This header file is not defined in ISO C99.

Installs a floating-point trap handler._fp_install_trap_handler(
void (*) (
_fp_exception_info_t * )
exception )

Returns the exception mask._fp_get_exception_mask(
void )

Sets the exception mask. A value of 0xFF traps all floating-point
exceptions.

_fp_set_exception_mask( int
)

Returns the exception status._fp_get_exception_status(
void )

Sets the exception status._fp_set_exception_status(
int )name)

For each supported exception, a macro is defined. The following exceptions are defined:

EFINVOP         0x01    Invalid operation, for instance 0.0/0.0, 0.0*INF or on a NaN
EFDIVZ          0x02    Division by zero, for instance 12.5/0.0 (not 0.0/0.0)
EFOVFL          0x04    Overflow, when the result of an operation is too large
EFUNFL          0x08    Underflow, when the result of an operation is too small
EFINEXCT        0x10    Inexact
EFALL           0x1f    Combination of all of the above enlisted exceptions

INF means infinite which is the largest absolute floating-point number.
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NAN means Not A Number, this is a special notation for an undefined floating-point number.

9.1.6. fcntl.h

The header file fcntl.h contains the function open(), which calls the low level function _open(), and
definitions of flags used by the low level function _open(). This header file is not defined in ISO C99.

Opens a file a file for reading or writing. Calls _open.
(FSS implementation)

open

9.1.7. fenv.h

Contains mechanisms to control the floating-point environment. The functions in this header file are not
implemented.

Stores the current floating-point environment. (Not implemented)fegetenv

Saves the current floating-point environment and installs an environment
that ignores all floating-point exceptions. (Not implemented)

feholdexept

Restores a previously saved (fegetenv or feholdexcept) floating-point
environment. (Not implemented)

fesetenv

Saves the currently raised floating-point exceptions, restores a previously
saved floating-point environment and finally raises the saved exceptions.
(Not implemented)

feupdateenv

Clears the current exception status flags corresponding to the flags specified
in the argument. (Not implemented)

feclearexcept

Stores the current setting of the floating-point status flags. (Not implemented)fegetexceptflag

Raises the exceptions represented in the argument. As a result, other
exceptions may be raised as well.
(Not implemented)

feraiseexcept

Sets the current floating-point status flags.
(Not implemented)

fesetexceptflag

Returns the bitwise-OR of the exception macros corresponding to the
exception flags which are currently set and are specified in the argument.
(Not implemented)

fetestexcept

For each supported exception, a macro is defined. The following exceptions are defined:

FE_DIVBYZERO      FE_INEXACT       FE_INVALID
FE_OVERFLOW       FE_UNDERFLOW     FE_ALL_EXCEPT

Returns the current rounding direction, represented as one of the values of
the rounding direction macros.
(Not implemented)

fegetround

Sets the current rounding directions. (Not implemented)fesetround

Currently no rounding mode macros are implemented.
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9.1.8. float.h

The header file float.h defines the characteristics of the real floating-point types float, double and
long double.

float.h used to contain prototypes for the functions copysign(f), isinf(f), isfinite(f),
isnan(f) and scalb(f).These functions have accordingly to the ISO C99 standard been moved
to the header file math.h. See also Section 9.1.15, math.h and tgmath.h.

The following functions are only available for ISO C90:

Copies the sign of the second argument s to the value of the first
argument f and returns the result.

copysignf(float f,float s)

Copies the sign of the second argument s to the value of the first
argument d and returns the result.

copysign(double d,double s)

Test the variable f on being an infinite (IEEE-754) value.isinff(float f)

Test the variable d on being an infinite (IEEE-754) value.isinf(double d);

Test the variable f on being a finite (IEEE-754) value.isfinitef(float f)

Test the variable d on being a finite (IEEE-754) value.isfinite(double d)

Test the variable f on being NaN (Not a Number, IEEE-754) .isnanf(float f)

Test the variable d on being NaN (Not a Number, IEEE-754) .isnan(double d)

Returns f * 2^p for integral values without computing 2^N.scalbf(float f,int p)

Returns d * 2^p for integral values without computing 2^N. (See
also scalbn in Section 9.1.15, math.h and tgmath.h)

scalb(double d,int p)

9.1.9. inttypes.h and stdint.h

The header files stdint.h and inttypes.h provide additional declarations for integer types and have
various characteristics. The stdint.h header file contains basic definitions of integer types of certain
sizes, and corresponding sets of macros. This header file clearly refers to the corresponding sections in
the ISO C99 standard.
The inttypes.h header file includes stdint.h and adds portable formatting and conversion functions.
Below the conversion functions from inttypes.h are listed.

Returns the absolute value of jimaxabs(intmax_t j)

Computes numer/denomand numer % denom.The result is stored
in the quot and rem components of the imaxdiv_t structure type.

imaxdiv(intmax_t numer,
intmax_t denom)

Convert string to maximum sized integer. (Compare strtoll)strtoimax(const char *
restrict nptr, char **
restrict endptr, int base)

Convert string to maximum sized unsigned integer. (Compare
strtoull)

strtoumax(const char *
restrict nptr, char **
restrict endptr, int base)
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Convert wide string to maximum sized integer. (Compare wcstoll)wcstoimax(const wchar_t *
restrict nptr, wchar_t **
restrict endptr, int base)

Convert wide string to maximum sized unsigned integer. (Compare
wcstoull)

wcstoumax(const wchar_t *
restrict nptr, wchar_t **
restrict endptr, int base)

9.1.10. io.h

The header file io.h contains prototypes for low level I/O functions.This header file is not defined in ISO
C99.

Used by the functions close and fclose. (FSS implementation)_close(fd)

Used by all file positioning functions: fgetpos, fseek, fsetpos,
ftell, rewind. (FSS implementation)

_lseek(fd,offset,whence)

Used by the functions fopen and freopen. (FSS implementation)_open(fd,flags)

Reads a sequence of characters from a file. (FSS implementation)_read(fd,*buff,cnt)

Used by the function remove. (FSS implementation)_unlink(*name)

Writes a sequence of characters to a file. (FSS implementation)_write(fd,*buffer,cnt)

9.1.11. iso646.h

The header file iso646.h adds tokens that can be used instead of regular operator tokens.

#define and     &&
#define and_eq  &=
#define bitand  &
#define bitor   |
#define compl   ~
#define not     !
#define not_eq  !=
#define or      ||
#define or_eq   |=
#define xor     ^
#define xor_eq  ^= 

9.1.12. limits.h

Contains the sizes of integral types, defined as macros.

9.1.13. locale.h

To keep C code reasonable portable across different languages and cultures, a number of facilities are
provided in the header file locale.h.

char *setlocale( int category, const char *locale )
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The function above changes locale-specific features of the run-time library as specified by the category
to change and the name of the locale.

The following categories are defined and can be used as input for this function:

LC_ALL      0      LC_NUMERIC   3
LC_COLLATE  1      LC_TIME      4
LC_CTYPE    2      LC_MONETARY  5

struct lconv *localeconv( void )

Returns a pointer to type struct lconv with values appropriate for the formatting of numeric
quantities according to the rules of the current locale. The struct lconv in this header file is
conforming the ISO standard.

9.1.14. malloc.h

The header file malloc.h contains prototypes for memory allocation functions. This include file is not
defined in ISO C99, it is included for backwards compatibility with ISO C90. For ISO C99, the memory
allocation functions are part of stdlib.h. See Section 9.1.23, stdlib.h and wchar.h.

Allocates space for an object with size size.
The allocated space is not initialized. Returns a pointer to the
allocated space.

malloc(size)

Allocates space for n objects with size size.
The allocated space is initialized with zeros. Returns a pointer to
the allocated space.

calloc(nobj,size)

Deallocates the memory space pointed to by ptr which should be
a pointer earlier returned by the malloc or calloc function.

free(*ptr)

Deallocates the old object pointed to by ptr and returns a pointer
to a new object with size size, while preserving its contents.
If the new size is smaller than the old size, some contents at the
end of the old region will be discarded. If the new size is larger than
the old size, all of the old contents are preserved and any bytes in
the new object beyond the size of the old object will have
indeterminate values.

realloc(*ptr,size)

9.1.15. math.h and tgmath.h

The header file math.h contains the prototypes for many mathematical functions. Before ISO C99, all
functions were computed using the double type (the float was automatically converted to double, prior to
calculation). In this ISO C99 version, parallel sets of functions are defined for double, float and long
double. They are respectively named function, functionf, functionl. All long type functions, though
declared in math.h, are implemented as the double type variant which nearly always meets the
requirement in embedded applications.
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The header file tgmath.h contains parallel type generic math macros whose expansion depends on the
used type. tgmath.h includes math.h and the effect of expansion is that the correct math.h functions
are called. The type generic macro, if available, is listed in the second column of the tables below.

Trigonometric and hyperbolic functions

Descriptiontgmath.hmath.h

Returns the sine of x.sinsinlsinfsin

Returns the cosine of x.coscoslcosfcos

Returns the tangent of x.tantanltanftan

Returns the arc sine sin-1(x) of x.asinasinlasinfasin

Returns the arc cosine cos-1(x) of x.acosacoslacosfacos

Returns the arc tangent tan-1(x) of x.atanatanlatanfatan

Returns the result of: tan-1(y/x).atan2atan2latan2fatan2

Returns the hyperbolic sine of x.sinhsinhlsinhfsinh

Returns the hyperbolic cosine of x.coshcoshlcoshfcosh

Returns the hyperbolic tangent of x.tanhtanhltanhftanh

Returns the arc hyperbolic sine of x.asinhasinhlasinhfasinh

Returns the non-negative arc hyperbolic cosine of x.acoshacoshlacoshfacosh

Returns the arc hyperbolic tangent of x.atanhatanhlatanhfatanh

Exponential and logarithmic functions

All of these functions are new in ISO C99, except for exp, log and log10.

Descriptiontgmath.hmath.h

Returns the result of the exponential function ex.expexplexpfexp

Returns the result of the exponential function 2x. (Not
implemented)

exp2exp2lexp2fexp2

Returns the result of the exponential function ex-1. (Not
implemented)

expm1expm1lexpm1fexpm1

Returns the natural logarithm ln(x), x>0.loglogllogflog

Returns the base-10 logarithm of x, x>0.log10log10llog10flog10

Returns the base-e logarithm of (1+x). x <> -1. (Not
implemented)

log1plog1pllog1pflog1p

Returns the base-2 logarithm of x.x>0. (Not implemented)log2log2llog2flog2

Returns the signed exponent of x as an integer.x>0. (Not
implemented)

ilogbilogblilogbfilogb

Returns the exponent of x as a signed integer in value in
floating-point notation. x > 0. (Not implemented)

logblogbllogbflogb
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frexp, ldexp, modf, scalbn, scalbln

Descriptiontgmath.hmath.h

Splits a float x into fraction f and exponent n, so that:
f = 0.0 or 0.5 ≤ | f | ≤ 1.0 and f*2n = x. Returns f, stores n.

frexpfrexplfrexpffrexp

Inverse of frexp. Returns the result of x*2n.
(x and n are both arguments).

ldexpldexplldexpfldexp

Splits a float x into fraction f and integer n, so that:
| f | < 1.0 and f+n=x. Returns f, stores n.

-modflmodffmodf

Computes the result of x*FLT_RADIXn. efficiently, not
normally by computing FLT_RADIXn explicitly.

scalbnscalbnlscalbnfscalbn

Same as scalbn but with argument n as long int.scalblnscalblnlscalblnfscalbln

Rounding functions

Descriptiontgmath.hmath.h

Returns the smallest integer not less than x, as a double.ceilceillceilfceil

Returns the largest integer not greater than x, as a double.floorfloorlfloorffloor

Returns the rounded integer value as an int according
to the current rounding direction. See fenv.h. (Not
implemented)

rintrintlrintfrint

Returns the rounded integer value as a long int
according to the current rounding direction. See fenv.h.
(Not implemented)

lrintlrintllrintflrint

Returns the rounded integer value as a long long int
according to the current rounding direction. See fenv.h.
(Not implemented)

llrintlrintllrintfllrint

Returns the rounded integer value as a floating-point
according to the current rounding direction. See fenv.h.
(Not implemented)

nearbyintnearbyintlnearbyintfnearbyint

Returns the nearest integer value of x as int.
(Not implemented)

roundroundlroundfround

Returns the nearest integer value of x as long int.
(Not implemented)

lroundlroundllroundflround

Returns the nearest integer value of x as long long int.
(Not implemented)

llroundllroundllroundfllround

Returns the truncated integer value x. (Not implemented)trunctruncltruncftrunc

Remainder after division

Descriptiontgmath.hmath.h

Returns the remainder r of x-ny. n is chosen as
trunc(x/y). r has the same sign as x.

fmodfmodlfmodffmod
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Descriptiontgmath.hmath.h

Returns the remainder r of x-ny. n is chosen as
trunc(x/y). r may not have the same sign as x. (Not
implemented)

remainderremainderlremainderfremainder

Same as remainder. In addition, the argument *quo is
given a specific value (see ISO). (Not implemented)

remquoremquolremquofremquo

Power and absolute-value functions

Descriptiontgmath.hmath.h

Returns the real cube root of x (=x1/3). (Not implemented)cbrtcbrtlcbrtfcbrt

Returns the absolute value of x (|x|). (abs, labs, llabs,
div, ldiv, lldiv are defined in stdlib.h)

fabsfabslfabsffabs

Floating-point multiply add. Returns x*y+z. (Not
implemented)

fmafmalfmaffma

Returns the square root of x2+y2.hypothypotlhypotfhypot

Returns x raised to the power y (xy).powerpowlpowfpow

Returns the non-negative square root of x. x 0.sqrtsqrtlsqrtfsqrt

Manipulation functions: copysign, nan, nextafter, nexttoward

Descriptiontgmath.hmath.h

Returns the value of x with the sign of y.copysigncopysignllcopysignfcopysign

Returns a quiet NaN, if available, with content indicated
through tagp.
(Not implemented)

-nanlnanfnan

Returns the next representable value in the specified
format after x in the direction of y. Returns y is x=y.
(Not implemented)

nextafternextafterlnextafterfnextafter

Same as nextafter, except that the second argument
in all three variants is of type long double. Returns y if
x=y.
(Not implemented)

nexttowardnexttowardlnexttowardfnexttoward

Positive difference, maximum, minimum

Descriptiontgmath.hmath.h

Returns the positive difference between: |x-y|.
(Not implemented)

fdimfdimlfdimffdim

Returns the maximum value of their arguments.
(Not implemented)

fmaxfmaxlfmaxffmax

Returns the minimum value of their arguments.
(Not implemented)

fminfminlfminffmin
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Error and gamma (Not implemented)

Descriptiontgmath.hmath.h

Computes the error function of x.
(Not implemented)

erferflerfferf

Computes the complementary error function of x.
(Not implemented)

ercerfclerfcferfc

Computes the *loge|Γ(x)|
(Not implemented)

lgammalgammallgammaflgamma

Computes Γ(x)
(Not implemented)

tgammatgammaltgammaftgamma

Comparison macros

The next are implemented as macros. For any ordered pair of numeric values exactly one of the
relationships - less, greater, and equal - is true.These macros are type generic and therefore do not have
a parallel function in tgmath.h. All arguments must be expressions of real-floating type.

Descriptiontgmath.hmath.h

Returns the value of (x) > (y)-isgreater

Returns the value of (x) >= (y)-isgreaterequal

Returns the value of (x) < (y)-isless

Returns the value of (x) <= (y)-islessequal

Returns the value of (x) < (y) || (x) > (y)-islessgreater

Returns 1 if its arguments are unordered, 0 otherwise.-isunordered

Classification macros

The next are implemented as macros.These macros are type generic and therefore do not have a parallel
function in tgmath.h. All arguments must be expressions of real-floating type.

Descriptiontgmath.hmath.h

Returns the class of its argument:
FP_INFINITE, FP_NAN, FP_NORMAL, FP_SUBNORMAL or
FP_ZERO

-fpclassify

Returns a nonzero value if and only if its argument has a finite
value

-isfinite

Returns a nonzero value if and only if its argument has an infinite
value

-isinf

Returns a nonzero value if and only if its argument has NaN value.-isnan

Returns a nonzero value if an only if its argument has a normal
value.

-isnormal
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Descriptiontgmath.hmath.h

Returns a nonzero value if and only if its argument value is
negative.

-signbit

9.1.16. setjmp.h

The setjmp and longjmp in this header file implement a primitive form of non-local jumps, which may
be used to handle exceptional situations. This facility is traditionally considered more portable than
signal.h

Records its caller's environment in env and returns 0.int setjmp(jmp_buf
env)

Restores the environment previously saved with a call to setjmp().void longjmp(jmp_buf
env, int status)

9.1.17. signal.h

Signals are possible asynchronous events that may require special processing. Each signal is named by
a number. The following signals are defined:

Receipt of an interactive attention signal1SIGINT

Detection of an invalid function message2SIGILL

An erroneous arithmetic operation (for example, zero divide, overflow)3SIGFPE

An invalid access to storage4SIGSEGV

A termination request sent to the program5SIGTERM

Abnormal termination, such as is initiated by the abort function6SIGABRT

The next function sends the signal sig to the program:

int raise(int sig)

The next function determines how subsequent signals will be handled:

signalfunction *signal (int, signalfunction *);

The first argument specifies the signal, the second argument points to the signal-handler function or has
one of the following values:

Default behavior is usedSIG_DFL

The signal is ignoredSIG_IGN

The function returns the previous value of signalfunction for the specific signal, or SIG_ERR if an
error occurs.
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9.1.18. stdarg.h

The facilities in this header file gives you a portable way to access variable arguments lists, such as
needed for as fprintf and vfprintf. va_copy is new in ISO C99. This header file contains the
following macros:

Returns the value of the next argument in the variable argument list.
Its return type has the type of the given argument type. A next call to
this macro will return the value of the next argument.

va_arg(va_list ap,type)

This macro duplicates the current state of src in dest, creating a
second pointer into the argument list. After this call, va_arg() may be
used on src and dest independently.

va_copy(va_list dest,
va_list src)

This macro must be called after the arguments have been processed.
It should be called before the function using the macro 'va_start' is
terminated.

va_end(va_list ap)

This macro initializes ap. After this call, each call to va_arg() will return
the value of the next argument. In our implementation, va_list cannot
contain any bit type variables. Also the given argument lastarg must
be the last non-bit type argument in the list.

va_start(va_list ap,
lastarg)

9.1.19. stdbool.h

This header file contains the following macro definitions. These names for boolean type and values are
consistent with C++.You are allowed to #undefine or redefine the macros below.

#define bool                            _Bool
#define true                            1
#define false                           0
#define __bool_true_false_are_defined   1

9.1.20. stddef.h

This header file defines the types for common use:

Signed integer type of the result of subtracting two pointers.ptrdiff_t

Unsigned integral type of the result of the sizeof operator.size_t

Integer type to represent character codes in large character sets.wchar_t

Besides these types, the following macros are defined:

Expands to the null pointer constant for C or 0 (zero) for C++.NULL

Expands to an integer constant expression with type size_t that is the offset
in bytes of _member within structure type _type.

offsetof(_type,
_member)

9.1.21. stdint.h

See Section 9.1.9, inttypes.h and stdint.h
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9.1.22. stdio.h and wchar.h

Types

The header file stdio.h contains functions for performing input and output. A number of functions also
have a parallel wide character function or macro, defined in wchar.h. The header file wchar.h also
includes stdio.h.

In the C language, many I/O facilities are based on the concept of streams. The stdio.h header file
defines the data type FILE which holds the information about a stream. A FILE object is created with
the function fopen. The pointer to this object is used as an argument in many of the in this header file.
The FILE object can contain the following information:

• the current position within the stream

• pointers to any associated buffers

• indications of for read/write errors

• end of file indication

The header file also defines type fpos_t as an unsigned long.

Macros

Descriptionstdio.h

Expands to the null pointer constant for C or 0 (zero) for C++.NULL

Size of the buffer used by the setbuf/setvbuf function: 512BUFSIZ

End of file indicator. Expands to -1.EOF

End of file indicator. Expands to UINT_MAX (defined in limits.h)
NOTE: WEOF need not to be a negative number as long as its value does not
correspond to a member of the wide character set. (Defined in wchar.h).

WEOF

Number of files that can be opened simultaneously: 10FOPEN_MAX

Maximum length of a filename: 100FILENAME_MAX

Expand to an integer expression, suitable for use as argument to the setvbuf function._IOFBF
_IOLBF
_IONBF

Size of the string used to hold temporary file names: 8 (tmpxxxxx)L_tmpnam

Maximum number of unique temporary filenames that can be generated: 0x8000TMP_MAX

Expand to an integer expression, suitable for use as the third argument to the fseek
function.

SEEK_CUR
SEEK_END
SEEK_SET

Expressions of type "pointer to FILE" that point to the FILE objects associated with
standard error, input and output streams.

stderr
stdin
stdout
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File access

Descriptionstdio.h

Opens a file for a given mode. Available modes are:fopen(name,mode)

"r"   read; open text file for reading
"w"   write; create text file for writing;

if the file already exists, its contents is discarded
"a"   append; open existing text file or

create new text file for writing at end of file
"r+"  open text file for update; reading and writing
"w+"  create text file for update; previous

contents if any is discarded
"a+"  append; open or create text file for update,

writes at end of file

(FSS implementation)

Flushes the data stream and closes the specified file that was previously
opened with fopen. (FSS implementation)

fclose(name)

If stream is an output stream, any buffered but unwritten date is written.
Else, the effect is undefined. (FSS implementation)

fflush(name)

Similar to fopen, but rather than generating a new value of type FILE *,
the existing value is associated with a new stream. (FSS implementation)

freopen(name,mode,
stream)

If buffer is NULL, buffering is turned off for the stream. Otherwise, setbuf
is equivalent to:(void) setvbuf(stream,buffer,_IOFBF,BUFSIZ).

setbuf(stream,buffer)

Controls buffering for the stream; this function must be called before reading
or writing. Mode can have the following values:
_IOFBF causes full buffering
_IOLBF causes line buffering of text files
_IONBF causes no buffering.
If buffer is not NULL, it will be used as a buffer; otherwise a buffer will be
allocated. size determines the buffer size.

setvbuf(stream,buffer,mode,
size)

Formatted input/output

The format string of printf related functions can contain plain text mixed with conversion specifiers.
Each conversion specifier should be preceded by a '%' character. The conversion specifier should be
built in order:

• Flags (in any order):

specifies left adjustment of the converted argument.-

a number is always preceded with a sign character.
+ has higher precedence than space.

+

a negative number is preceded with a sign, positive numbers with a space.space

specifies padding to the field width with zeros (only for numbers).0
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specifies an alternate output form. For o, the first digit will be zero. For x or X, "0x" and "0X"
will be prefixed to the number. For e, E, f, g, G, the output always contains a decimal point,
trailing zeros are not removed.

#

• A number specifying a minimum field width. The converted argument is printed in a field with at least
the length specified here. If the converted argument has fewer characters than specified, it will be
padded at the left side (or at the right when the flag '-' was specified) with spaces. Padding to numeric
fields will be done with zeros when the flag '0' is also specified (only when padding left). Instead of a
numeric value, also '*' may be specified, the value is then taken from the next argument, which is
assumed to be of type int.

• A period. This separates the minimum field width from the precision.

• A number specifying the maximum length of a string to be printed. Or the number of digits printed after
the decimal point (only for floating-point conversions). Or the minimum number of digits to be printed
for an integer conversion. Instead of a numeric value, also '*' may be specified, the value is then taken
from the next argument, which is assumed to be of type int.

• A length modifier 'h', 'hh', 'l', 'll', 'L', 'j', 'z' or 't'. 'h' indicates that the argument is to be treated as a short
or unsigned short. 'hh' indicates that the argument is to be treated as a char or unsigned char.
'l' should be used if the argument is a long integer, 'll' for a long long. 'L' indicates that the argument
is a long double. 'j' indicates a pointer to intmax_t or uintmax_t, 'z' indicates a pointer to size_t
and 't' indicates a pointer to ptrdiff_t.

Flags, length specifier, period, precision and length modifier are optional, the conversion character is not.
The conversion character must be one of the following, if a character following '%' is not in the list, the
behavior is undefined:

Printed asCharacter

int, signed decimald, i

int, unsigned octalo

int, unsigned hexadecimal in lowercase or uppercase respectivelyx, X

int, unsigned decimalu

int, single character (converted to unsigned char)c

char *, the characters from the string are printed until a NULL character is found. When the
given precision is met before, printing will also stop

s

doublef, F

doublee, E

doubleg, G

doublea, A

int *, the number of characters written so far is written into the argument. This should be a
pointer to an integer in default memory. No value is printed.

n

pointerp

No argument is converted, a '%' is printed.%
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printf conversion characters

All arguments to the scanf related functions should be pointers to variables (in default memory) of the
type which is specified in the format string.

The format string can contain :

• Blanks or tabs, which are skipped.

• Normal characters (not '%'), which should be matched exactly in the input stream.

• Conversion specifications, starting with a '%' character.

Conversion specifications should be built as follows (in order) :

• A '*', meaning that no assignment is done for this field.

• A number specifying the maximum field width.

• The conversion characters d, i, n, o, u and x may be preceded by 'h' if the argument is a pointer to
short rather than int, or by 'hh' if the argument is a pointer to char, or by 'l' (letter ell) if the argument
is a pointer to long or by 'll' for a pointer to long long, 'j' for a pointer to intmax_t or uintmax_t,
'z' for a pointer to size_t or 't' for a pointer to ptrdiff_t. The conversion characters e, f, and g
may be preceded by 'l' if the argument is a pointer to double rather than float, and by 'L' for a pointer
to a long double.

• A conversion specifier. '*', maximum field width and length modifier are optional, the conversion character
is not. The conversion character must be one of the following, if a character following '%' is not in the
list, the behavior is undefined.

Length specifier and length modifier are optional, the conversion character is not.The conversion character
must be one of the following, if a character following '%' is not in the list, the behavior is undefined.

Scanned asCharacter

int, signed decimal.d

int, the integer may be given octal (i.e. a leading 0 is entered) or hexadecimal (leading "0x"
or "0X"), or just decimal.

i

int, unsigned octal.o

int, unsigned decimal.u

int, unsigned hexadecimal in lowercase or uppercase.x

single character (converted to unsigned char).c

char *, a string of non white space characters. The argument should point to an array of
characters, large enough to hold the string and a terminating NULL character.

s

floatf, F

floate, E

floatg, G

floata, A
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Scanned asCharacter

int *, the number of characters written so far is written into the argument. No scanning is done.n

pointer; hexadecimal value which must be entered without 0x- prefix.p

Matches a string of input characters from the set between the brackets. A NULL character is
added to terminate the string. Specifying [ ]...] includes the ']' character in the set of scanning
characters.

[...]

Matches a string of input characters not in the set between the brackets. A NULL character
is added to terminate the string. Specifying [^]...] includes the ']' character in the set.

[^...]

Literal '%', no assignment is done.%

scanf conversion characters

Descriptionwchar.hstdio.h

Performs a formatted read from the given stream.
Returns the number of items converted
successfully. (FSS implementation)

fwscanf(stream,
format, ...)

fscanf(stream,
format, ...)

Performs a formatted read from stdin. Returns
the number of items converted successfully. (FSS
implementation)

wscanf(format, ...)scanf(format,...)

Performs a formatted read from the string s.
Returns the number of items converted
successfully.

swscanf(*s, format,
...)

sscanf(*s, format,
...)

Same as fscanf/fwscanf, but extra arguments
are given as variable argument list arg. (See
Section 9.1.18, stdarg.h)

vfwscanf(stream,
format, arg)

vfscanf(stream,
format, arg)

Same as sscanf/swscanf, but extra arguments
are given as variable argument list arg. (See
Section 9.1.18, stdarg.h)

vwscanf(format, arg)vscanf(format, arg)

Same as scanf/wscanf, but extra arguments
are given as variable argument list arg. (See
Section 9.1.18, stdarg.h)

vswscanf(*s, format,
arg)

vsscanf(*s, format,
arg)

Performs a formatted write to the given stream.
Returns EOF/WEOF on error. (FSS
implementation)

fwprintf(stream,
format, ...)

fprintf(stream,
format, ...)

Performs a formatted write to the stream stdout.
Returns EOF/WEOF on error. (FSS
implementation)

wprintf(format, ...)printf(format, ...)

Performs a formatted write to string s. Returns
EOF/WEOF on error.

-sprintf(*s, format,
...)

Same as sprintf, but n specifies the maximum
number of characters (including the terminating
null character) to be written.

swprintf(*s, n,
format, ...)

snprintf(*s, n,
format, ...)
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Descriptionwchar.hstdio.h

Same as fprintf/fwprintf, but extra
arguments are given as variable argument list
arg. (See Section 9.1.18, stdarg.h) (FSS
implementation)

vfwprintf(stream,
format, arg)

vfprintf(stream,
format, arg)

Same as printf/wprintf, but extra arguments
are given as variable argument list arg. (See
Section 9.1.18, stdarg.h) (FSS implementation)

vwprintf(format,
arg)

vprintf(format, arg)

Same as sprintf/swprintf, but extra
arguments are given as variable argument list
arg. (See Section 9.1.18, stdarg.h)

vswprintf(*s,
format, arg)

vsprintf(*s, format,
arg)

The C library functions printf(), fprintf(), vfprintf(), vsprintf(), ... call one single function,
_doprint(), that deals with the format string and arguments. The same applies to all scanf type
functions, which call the function _doscan(), and also for the wprintf and wscanf type functions
which call _dowprint() and _dowscan() respectively. The C library contains three versions of these
routines: int, long and long long versions. If you use floating-point the formatter function for
floating-point _doflt() or _dowflt() is called. Depending on the formatting arguments you use, the
correct routine is used from the library. Of course the larger the version of the routine the larger your
produced code will be.

Note that when you call any of the printf/scanf routines indirectly, the arguments are not known and always
the long long version with floating-point support is used from the library.

Example:

#include <stdio.h>

long L;

void main(void)
{
    printf( "This is a long: %ld\n", L );
}

The linker extracts the long version without floating-point support from the library.

See also the description of #pragma weak in Section 1.7, Pragmas to Control the Compiler.

Character input/output

Descriptionwchar.hstdio.h

Reads one character from stream. Returns the
read character, or EOF/WEOF on error. (FSS
implementation)

fgetwc(stream)fgetc(stream)
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Descriptionwchar.hstdio.h

Same as fgetc/fgetwc except that is
implemented as a macro.
(FSS implementation)
NOTE: Currently #defined as
getchar()/getwchar() because FILE I/O is
not supported. Returns the read character, or
EOF/WEOF on error.

getwc(stream)getc(stream)

Reads one character from the stdin stream.
Returns the character read or EOF/WEOF on
error. Implemented as macro.
(FSS implementation)

getwchar(stdin)getchar(stdin)

Reads at most the next n-1 characters from the
stream into array s until a newline is found.
Returns s or NULL or EOF/WEOF on error. (FSS
implementation)

fgetws(*s, n,
stream)

fgets(*s, n, stream)

Reads at most the next n-1 characters from the
stdin stream into array s. A newline is ignored.
Returns s or NULL or EOF/WEOF on error. (FSS
implementation)

-gets(*s, n, stdin)

Pushes character c back onto the input stream.
Returns EOF/WEOF on error.

ungetwc(c, stream)ungetc(c, stream)

Put character c onto the given stream. Returns
EOF/WEOF on error. (FSS implementation)

fputwc(c, stream)fputc(c, stream)

Same as fpuc/fputwc except that is
implemented as a macro. (FSS implementation)

putwc(c, stream)putc(c, stream)

Put character c onto the stdout stream. Returns
EOF/WEOF on error.
Implemented as macro. (FSS implementation)

putwchar(c, stdout)putchar(c, stdout)

Writes string s to the given stream. Returns
EOF/WEOF on error. (FSS implementation)

fputws(*s, stream)fputs(*s, stream)

Writes string s to the stdout stream. Returns
EOF/WEOF on error. (FSS implementation)

-puts(*s)

Direct input/output

Descriptionstdio.h

Reads nobj members of size bytes from the given stream into
the array pointed to by ptr. Returns the number of elements
successfully read. (FSS implementation)

fread(ptr,size,nobj,stream)

Writes nobj members of size bytes from to the array pointed to
by ptr to the given stream. Returns the number of elements
successfully written. (FSS implementation)

fwrite(ptr,size,nobj,stream)
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Random access

Descriptionstdio.h

Sets the position indicator for stream. (FSS implementation)fseek(stream, offset,
origin)

When repositioning a binary file, the new position origin is given by the following macros:

SEEK_SET 0 offset characters from the beginning of the file
SEEK_CUR 1 offset characters from the current position in the file
SEEK_END 2 offset characters from the end of the file

Returns the current file position for stream, or -1L on error.
(FSS implementation)

ftell(stream)

Sets the file position indicator for the stream to the beginning of the file. This
function is equivalent to:
(void) fseek(stream,0L,SEEK_SET);
clearerr(stream);
(FSS implementation)

rewind(stream)

Stores the current value of the file position indicator for stream in the object
pointed to by pos. (FSS implementation)

fgetpos(stream,pos)

Positions stream at the position recorded by fgetpos in *pos. (FSS
implementation)

fsetpos(stream,pos)

Operations on files

Descriptionstdio.h

Removes the named file, so that a subsequent attempt to open it fails. Returns a
non-zero value if not successful.

remove(file)

Changes the name of the file from old name to new name. Returns a non-zero
value if not successful.

rename(old,new)

Creates a temporary file of the mode "wb+" that will be automatically removed when
closed or when the program terminates normally. Returns a file pointer.

tmpfile()

Creates new file names that do not conflict with other file names currently in use.
The new file name is stored in a buffer which must have room for L_tmpnam
characters. Returns a pointer to the temporary name. The file names are created
in the current directory and all start with "tmp". At most TMP_MAX unique file names
can be generated.

tmpnam(buffer)

Error handling

Descriptionstdio.h

Clears the end of file and error indicators for stream.clearerr(stream)

Returns a non-zero value if the error indicator for stream is set.ferror(stream)

Returns a non-zero value if the end of file indicator for stream is set.feof(stream)
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Descriptionstdio.h

Prints s and the error message belonging to the integer errno. (See
Section 9.1.4, errno.h )

perror(*s)

9.1.23. stdlib.h and wchar.h

The header file stdlib.h contains general utility functions which fall into the following categories (Some
have parallel wide-character, declared in wchar.h)

• Numeric conversions

• Random number generation

• Memory management

• Environment communication

• Searching and sorting

• Integer arithmetic

• Multibyte/wide character and string conversions.

Macros

Predefined exit codes that can be used in the exit function.EXIT_SUCCES
0
EXIT_FAILURE
1

Highest number that can be returned by the rand/srand function.RAND_MAX
32767

Maximum number of bytes in a multibyte character for the extended character set
specified by the current locale (category LC_CTYPE, see Section 9.1.13, locale.h).

MB_CUR_MAX 1

Numeric conversions

The following functions convert the initial portion of a string *s to a double, int, long int and long
long int value respectively.

double      atof(*s)
int         atoi(*s)
long        atol(*s)
long long   atoll(*s)

The following functions convert the initial portion of the string *s to a float, double and long double value
respectively. *endp will point to the first character not used by the conversion.
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wchar.hstdlib.h

float       wcstof(*s,**endp)
double      wcstod(*s,**endp)
long double wcstold(*s,**endp)

float       strtof(*s,**endp)
double      strtod(*s,**endp)
long double strtold(*s,**endp)

The following functions convert the initial portion of the string *s to a long, long long, unsigned
long and unsigned long long respectively. Base specifies the radix. *endp will point to the first
character not used by the conversion.

wchar.hstdlib.h

long wcstol (*s,**endp,base)
long long wcstoll
            (*s,**endp,base)
unsigned long wcstoul
            (*s,**endp,base)
unsigned long long wcstoull
            (*s,**endp,base)

long strtol (*s,**endp,base)
long long strtoll
            (*s,**endp,base)
unsigned long strtoul
            (*s,**endp,base)
unsigned long long strtoull
            (*s,**endp,base)

Random number generation

Returns a pseudo random integer in the range 0 to RAND_MAX.rand

Same as rand but uses seed for a new sequence of pseudo random numbers.srand(seed)

Memory management

Allocates space for an object with size size.
The allocated space is not initialized. Returns a pointer to the allocated space.

malloc(size)

Allocates space for n objects with size size.
The allocated space is initialized with zeros. Returns a pointer to the allocated
space.

calloc(nobj,size)

Deallocates the memory space pointed to by ptr which should be a pointer
earlier returned by the malloc or calloc function.

free(*ptr)

Deallocates the old object pointed to by ptr and returns a pointer to a new
object with size size, while preserving its contents.
If the new size is smaller than the old size, some contents at the end of the
old region will be discarded. If the new size is larger than the old size, all of
the old contents are preserved and any bytes in the new object beyond the
size of the old object will have indeterminate values.

realloc(*ptr,size)

Environment communication

Causes abnormal program termination. If the signal SIGABRT is caught, the
signal handler may take over control. (See Section 9.1.17, signal.h).

abort()
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func points to a function that is called (without arguments) when the program
normally terminates.

atexit(*func)

Causes normal program termination. Acts as if main() returns with status as
the return value. Status can also be specified with the predefined macros
EXIT_SUCCES or EXIT_FAILURE.

exit(status)

Same as exit, but not registered by the atexit function or signal handlers
registered by the signal function are called.

_Exit(status)

Searches an environment list for a string s. Returns a pointer to the contents
of s.
NOTE: this function is not implemented because there is no OS.

getenv(*s)

Passes the string s to the environment for execution.
NOTE: this function is not implemented because there is no OS.

system(*s)

Searching and sorting

This function searches in an array of n members, for the object pointed to by
key. The initial base of the array is given by base. The size of each member
is specified by size. The given array must be sorted in ascending order,
according to the results of the function pointed to by cmp. Returns a pointer
to the matching member in the array, or NULL when not found.

bsearch(*key,
*base, n, size,
*cmp)

This function sorts an array of n members using the quick sort algorithm. The
initial base of the array is given by base. The size of each member is specified
by size. The array is sorted in ascending order, according to the results of the
function pointed to by cmp.

qsort(*base, n,
size, *cmp)

Integer arithmetic

Compute the absolute value of an int, long int, and long long int j
respectively.

int abs(j)
long labs(j)
long long llabs(j)

Compute x/y and x%y in a single operation. X and y have respectively type
int, long int and long long int. The result is stored in the members
quot and rem of struct div_t, ldiv_t and lldiv_t which have the
same types.

div_t div(x,y)
ldiv_t ldiv(x,y)
lldiv_t lldiv(x,y)

Multibyte/wide character and string conversions

Determines the number of bytes in the multi-byte character pointed to by s. At
most n characters will be examined. (See also mbrlen in Section 9.1.27,
wchar.h).

mblen(*s,n)

Converts the multi-byte character in s to a wide-character code and stores it
in pwc. At most n characters will be examined.

mbtowc(*pwc,*s,n)

Converts the wide-character wc into a multi-byte representation and stores it
in the string pointed to by s. At most MB_CUR_MAX characters are stored.

wctomb(*s,wc)
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Converts a sequence of multi-byte characters in the string pointed to by s into
a sequence of wide characters and stores at most n wide characters into the
array pointed to by pwcs. (See also mbsrtowcs in Section 9.1.27, wchar.h).

mbstowcs(*pwcs,*s,n)

Converts a sequence of wide characters in the array pointed to by pwcs into
multi-byte characters and stores at most n multi-byte characters into the string
pointed to by s. (See also wcsrtowmb in Section 9.1.27, wchar.h).

wcstombs(*s,*pwcs,n)

9.1.24. string.h and wchar.h

This header file provides numerous functions for manipulating strings. By convention, strings in C are
arrays of characters with a terminating null character. Most functions therefore take arguments of type
*char. However, many functions have also parallel wide-character functions which take arguments of
type *wchar_t. These functions are declared in wchar.h.

Copying and concatenation functions

Descriptionwchar.hstring.h

Copies n characters from *s2 into *s1 and returns *s1. If
*s1 and *s2 overlap the result is undefined.

wmemcpy(*s1,*s2,n)memcpy(*s1,*s2,n)

Same as memcpy, but overlapping strings are handled
correctly. Returns *s1.

wmemmove(*s1,*s2,n)memmove(*s1,*s2,n)

Copies *s2 into *s1 and returns *s1. If *s1 and *s2 overlap
the result is undefined.

wcscpy(*s1,*s2)strcpy(*s1,*s2)

Copies not more than n characters from *s2 into *s1 and
returns *s1. If *s1 and *s2 overlap the result is undefined.

wcsncpy(*s1,*s2,n)strncpy(*s1,*s2,n)

Appends a copy of *s2 to *s1 and returns *s1. If *s1 and
*s2 overlap the result is undefined.

wcscat(*s1,*s2)strcat(*s1,*s2)

Appends not more than n characters from *s2 to *s1 and
returns *s1. If *s1 and *s2 overlap the result is undefined.

wcsncat(*s1,*s2,n)strncat(*s1,*s2,n)

Comparison functions

Descriptionwchar.hstring.h

Compares the first n characters of *s1 to the first n
characters of *s2. Returns < 0 if *s1 < *s2, 0 if *s1 = = *s2,
or > 0 if *s1 > *s2.

wmemcmp(*s1,*s2,n)memcmp(*s1,*s2,n)

Compares string *s1 to *s2. Returns < 0 if *s1 < *s2, 0 if *s1
= = *s2, or > 0 if *s1 > *s2.

wcscmp(*s1,*s2)strcmp(*s1,*s2)

Compares the first n characters of *s1 to the first n
characters of *s2. Returns < 0 if *s1 < *s2, 0 if *s1 = = *s2,
or > 0 if *s1 > *s2.

wcsncmp(*s1,*s2,n)strncmp(*s1,*s2,n)

Performs a local-specific comparison between string *s1
and string *s2 according to the LC_COLLATE category of
the current locale. Returns < 0 if *s1 < *s2, 0 if *s1 = = *s2,
or > 0 if *s1 > *s2. (See Section 9.1.13, locale.h)

wcscoll(*s1,*s2)strcoll(*s1,*s2)

490

TASKING VX-toolset for LC87 User Guide



Descriptionwchar.hstring.h

Transforms (a local) string *s2 so that a comparison
between transformed strings with strcmp gives the same
result as a comparison between non-transformed strings
with strcoll. Returns the transformed string *s1.

wcsxfrm(*s1,*s2,n)strxfrm(*s1,*s2,n)

Search functions

Descriptionwchar.hstring.h

Checks the first n characters of *s on the occurrence of
character c. Returns a pointer to the found character.

wmemchr(*s,c,n)memchr(*s,c,n)

Returns a pointer to the first occurrence of character c in
*s or the null pointer if not found.

wcschr(*s,c)strchr(*s,c)

Returns a pointer to the last occurrence of character c in *s
or the null pointer if not found.

wcsrchr(*s,c)strrchr(*s,c)

Searches *s for a sequence of characters specified in *set.
Returns the length of the first sequence found.

wcsspn(*s,*set)strspn(*s,*set)

Searches *s for a sequence of characters not specified in
*set. Returns the length of the first sequence found.

wcscspn(*s,*set)strcspn(*s,*set)

Same as strspn/wcsspn but returns a pointer to the first
character in *s that also is specified in *set.

wcspbrk(*s,*set)strpbrk(*s,*set)

Searches for a substring *sub in *s. Returns a pointer to the
first occurrence of *sub in *s.

wcsstr(*s,*sub)strstr(*s,*sub)

A sequence of calls to this function breaks the string *s into
a sequence of tokens delimited by a character specified in
*dlm. The token found in *s is terminated with a null
character. Returns a pointer to the first position in *s of the
token.

wcstok(*s,*dlm)strtok(*s,*dlm)

Miscellaneous functions

Descriptionwchar.hstring.h

Fills the first n bytes of *s with character c and returns *s.wmemset(*s,c,n)memset(*s,c,n)

Typically, the values for errno come from int errno. This
function returns a pointer to the associated error message.
(See also Section 9.1.4, errno.h)

-strerror(errno)

Returns the length of string *s.wcslen(*s)strlen(*s)

9.1.25. time.h and wchar.h

The header file time.h provides facilities to retrieve and use the (calendar) date and time, and the
process time. Time can be represented as an integer value, or can be broken-down in components. Two
arithmetic data types are defined which are capable of holding the integer representation of times:
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clock_t unsigned long long
time_t unsigned long

The type struct tm below is defined according to ISO C99 with one exception: this implementation
does not support leap seconds. The struct tm type is defines as follows:

struct tm
{
  int   tm_sec;       /* seconds after the minute - [0, 59]   */
  int   tm_min;       /* minutes after the hour - [0, 59]     */
  int   tm_hour;      /* hours since midnight - [0, 23]       */
  int   tm_mday;      /* day of the month - [1, 31]           */
  int   tm_mon;       /* months since January - [0, 11]       */
  int   tm_year;      /* year since 1900                      */
  int   tm_wday;      /* days since Sunday - [0, 6]           */
  int   tm_yday;      /* days since January 1 - [0, 365]      */
  int   tm_isdst;     /* Daylight Saving Time flag            */
};

Time manipulation

Returns the application's best approximation to the processor time used by the
program since it was started. This low-level routine is not implemented because it
strongly depends on the hardware. To determine the time in seconds, the result of
clock should be divided by the value defined by CLOCKS_PER_SEC.

clock

Returns the difference t1-t0 in seconds.difftime(t1,t0)

Converts the broken-down time in the structure pointed to by tp, to a value of type
time_t. The return value has the same encoding as the return value of the time
function.

mktime(tm *tp)

Returns the current calendar time. This value is also assigned to *timer.time(*timer)

Time conversion

Converts the broken-down time in the structure pointed to by tp into a string in the
form Mon Jan 22 16:15:14 2007\n\0. Returns a pointer to this string.

asctime(tm *tp)

Converts the calender time pointed to by timer to local time in the form of a string.
This is equivalent to: asctime(localtime(timer))

ctime(*timer)

Converts the calender time pointed to by timer to the broken-down time, expressed
as UTC. Returns a pointer to the broken-down time.

gmtime(*timer)

Converts the calendar time pointed to by timer to the broken-down time, expressed
as local time. Returns a pointer to the broken-down time.

localtime(*timer)

Formatted time

The next function has a parallel function defined in wchar.h:
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wchar.htime.h

wcsftime(*s,smax,*fmt,tm *tp)strftime(*s,smax,*fmt,tm *tp)

Formats date and time information from struct tm *tp into *s according to the specified format *fmt.
No more than smax characters are placed into *s. The formatting of strftime is locale-specific using
the LC_TIME category (see Section 9.1.13, locale.h).

You can use the next conversion specifiers:

abbreviated weekday name%a

full weekday name%A

abbreviated month name%b

full month name%B

locale-specific date and time representation (same as %a %b %e %T %Y)%c

last two digits of the year%C

day of the month (01-31)%d

same as %m/%d/%y%D

day of the month (1-31), with single digits preceded by a space%e

ISO 8601 date format: %Y-%m-%d%F

last two digits of the week based year (00-99)%g

week based year (0000–9999)%G

same as %b%h

hour, 24-hour clock (00-23)%H

hour, 12-hour clock (01-12)%I

day of the year (001-366)%j

month (01-12)%m

minute (00-59)%M

replaced by newline character%n

locale's equivalent of AM or PM%p

locale's 12-hour clock time; same as %I:%M:%S %p%r

same as %H:%M%R

second (00-59)%S

replaced by horizontal tab character%t

ISO 8601 time format: %H:%M:%S%T

ISO 8601 weekday number (1-7), Monday as first day of the week%u

week number of the year (00-53), week 1 has the first Sunday%U

ISO 8601 week number (01-53) in the week-based year%V

weekday (0-6, Sunday is 0)%w

week number of the year (00-53), week 1 has the first Monday%W
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local date representation%x

local time representation%X

year without century (00-99)%y

year with century%Y

ISO 8601 offset of time zone from UTC, or nothing%z

time zone name, if any%Z

%%%

9.1.26. unistd.h

The file unistd.h contains standard UNIX I/O functions. These functions are all implemented using file
system simulation. Except for lstat and fstat which are not implemented. This header file is not
defined in ISO C99.

Use file system simulation to check the permissions of a file on the host. mode
specifies the type of access and is a bit pattern constructed by a logical OR of
the following values:

  R_OK   Checks read permission.
  W_OK   Checks write permission.
  X_OK   Checks execute (search) permission.
  F_OK   Checks to see if the file exists.

(FSS implementation)

access(*name,mode)

Use file system simulation to change the current directory on the host to the
directory indicated by path. (FSS implementation)

chdir(*path)

File close function. The given file descriptor should be properly closed. This
function calls _close(). (FSS implementation)

close(fd)

Use file system simulation to retrieve the current directory on the host. Returns
the directory name. (FSS implementation)

getcwd(*buf,size)

Moves read-write file offset. Calls _lseek(). (FSS implementation)lseek(fd,offset,whence)

Reads a sequence of characters from a file.This function calls _read(). (FSS
implementation)

read(fd,*buff,cnt)

Use file system simulation to stat() a file on the host platform. (FSS
implementation)

stat(*name,*buff)

This function is identical to stat(), except in the case of a symbolic link, where
the link itself is 'stat'-ed, not the file that it refers to. (Not implemented)

lstat(*name,*buff)

This function is identical to stat(), except that it uses a file descriptor instead
of a name. (Not implemented)

fstat(fd,*buff)

Removes the named file, so that a subsequent attempt to open it fails. (FSS
implementation)

unlink(*name)

Write a sequence of characters to a file. Calls _write(). (FSS implementation)write(fd,*buff,cnt)
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9.1.27. wchar.h

Many functions in wchar.h represent the wide-character variant of other functions so these are discussed
together. (See Section 9.1.22, stdio.h and wchar.h, Section 9.1.23, stdlib.h and wchar.h, Section 9.1.24,
string.h and wchar.h and Section 9.1.25, time.h and wchar.h).

The remaining functions are described below. They perform conversions between multi-byte characters
and wide characters. In these functions, ps points to struct mbstate_t which holds the conversion state
information necessary to convert between sequences of multibyte characters and wide characters:

typedef struct
{
     wchar_t         wc_value;  /* wide character value solved
                                   so far */
     unsigned short  n_bytes;   /* number of bytes of solved
                                   multibyte */
     unsigned short  encoding;  /* encoding rule for wide
                                   character <=> multibyte
                                   conversion */
} mbstate_t;

When multibyte characters larger than 1 byte are used, this struct will be used to store the conversion
information when not all the bytes of a particular multibyte character have been read from the source. In
this implementation, multi-byte characters are 1 byte long (MB_CUR_MAX and MB_LEN_MAX are defined
as 1) and this will never occur.

Determines whether the object pointed to by ps, is an initial conversion
state. Returns a non-zero value if so.

mbsinit(*ps)

Restartable version of mbstowcs. See Section 9.1.23, stdlib.h and
wchar.h.The initial conversion state is specified by ps.The input sequence
of multibyte characters is specified indirectly by src.

mbsrtowcs(*pwcs,**src,n,*ps)

Restartable version of wcstombs. See Section 9.1.23, stdlib.h and
wchar.h. The initial conversion state is specified by ps. The input wide
string is specified indirectly by src.

wcsrtombs(*s,**src,n,*ps)

Converts a multibyte character *s to a wide character *pwc according to
conversion state ps. See also mbtowc in Section 9.1.23, stdlib.h and
wchar.h.

mbrtowc(*pwc,*s,n,*ps)

Converts a wide character wc to a multi-byte character according to
conversion state ps and stores the multi-byte character in *s.

wcrtomb(*s,wc,*ps)

Returns the wide character corresponding to character c. Returns WEOF
on error.

btowc(c)

Returns the multi-byte character corresponding to the wide character c.
The returned multi-byte character is represented as one byte. Returns
EOF on error.

wctob(c)

Inspects up to n bytes from the string *s to see if those characters
represent valid multibyte characters, relative to the conversion state held
in *ps.

mbrlen(*s,n,*ps)
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9.1.28. wctype.h

Most functions in wctype.h represent the wide-character variant of functions declared in ctype.h and
are discussed in Section 9.1.2, ctype.h and wctype.h. In addition, this header file provides extensible,
locale specific functions and wide character classification.

Constructs a value of type wctype_t that describes a class of wide characters
identified by the string *property. If property identifies a valid class of wide characters
according to the LC_TYPE category (see Section 9.1.13, locale.h) of the current
locale, a non-zero value is returned that can be used as an argument in the
iswctype function.

wctype(*property)

Tests whether the wide character wc is a member of the class represented by
wctype_t desc. Returns a non-zero value if tested true.

iswctype(wc,desc)

Equivalent to locale specific testFunction

iswctype(wc,wctype("alnum"))iswalnum(wc)

iswctype(wc,wctype("alpha"))iswalpha(wc)

iswctype(wc,wctype("cntrl"))iswcntrl(wc)

iswctype(wc,wctype("digit"))iswdigit(wc)

iswctype(wc,wctype("graph"))iswgraph(wc)

iswctype(wc,wctype("lower"))iswlower(wc)

iswctype(wc,wctype("print"))iswprint(wc)

iswctype(wc,wctype("punct"))iswpunct(wc)

iswctype(wc,wctype("space"))iswspace(wc)

iswctype(wc,wctype("upper"))iswupper(wc)

iswctype(wc,wctype("xdigit"))iswxditig(wc)

Constructs a value of type wctype_t that describes a mapping between wide
characters identified by the string *property. If property identifies a valid mapping
of wide characters according to the LC_TYPE category (see Section 9.1.13, locale.h)
of the current locale, a non-zero value is returned that can be used as an argument
in the towctrans function.

wctrans(*property)

Transforms wide character wc into another wide-character, described by desc.towctrans(wc,desc)

Equivalent to locale specific transformationFunction

towctrans(wc,wctrans("tolower")towlower(wc)

towctrans(wc,wctrans("toupper")towupper(wc)

9.2. C Library Reentrancy

Some of the functions in the C library are reentrant, others are not. The table below shows the functions
in the C library, and whether they are reentrant or not. A dash means that the function is reentrant. Note
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that some of the functions are not reentrant because they set the global variable 'errno' (or call other
functions that eventually set 'errno'). If your program does not check this variable and errno is the only
reason for the function not being reentrant, these functions can be assumed reentrant as well.

The explanation of the cause why a function is not reentrant sometimes refers to a footnote because the
explanation is too lengthy for the table.

Not reentrant becauseFunction

Uses global File System Simulation buffer, _dbg_request_close

Uses I/O functions which modify iob[ ]. See (1)._doflt

Uses indirect access to static iob[ ] array. See (1)._doprint

Uses indirect access to iob[ ] and calls ungetc (access to local static
ungetc[ ] buffer). See (1).

_doscan

See exit._Exit

Uses iob[ ], which is not reentrant. See (1)._filbuf

Uses iob[ ]. See (1)._flsbuf

Uses iob[ ]. See (1)._getflt

Defines static iob[ ]. See (1)._iob

Uses global File System Simulation buffer, _dbg_request_lseek

Uses global File System Simulation buffer, _dbg_request_open

Uses global File System Simulation buffer, _dbg_request_read

Uses global File System Simulation buffer, _dbg_request_unlink

Uses global File System Simulation buffer, _dbg_request_write

Calls exitabort

-abs labs llabs

Uses global File System Simulation buffer, _dbg_requestaccess

Sets errno.acos acosf acosl

Sets errno via calls to other functions.acosh acoshf acoshl

asctime defines static array for broken-down time string.asctime

Sets errno.asin asinf asinl

Sets errno via calls to other functions.asinh asinhf asinhl

-atan atanf atanl

-atan2 atan2f atan2l

Sets errno via calls to other functions.atanh atanhf atanhl

atexit defines static array with function pointers to execute at exit of
program.

atexit

-atof

-atoi

-atol
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Not reentrant becauseFunction

-bsearch

-btowc

Sets errno via calls to other functions.cabs cabsf cabsl

Sets errno via calls to other functions.cacos cacosf cacosl

Sets errno via calls to other functions.cacosh cacosh cfacoshl

calloc uses static buffer management structures. See malloc (5).calloc

-carg cargf cargl

Sets errno via calls to other functions.casin casinf casinl

Sets errno via calls to other functions.casinh casinh cfasinhl

Sets errno via calls to other functions.catan catanf catanl

Sets errno via calls to other functions.catanh catanhf catanhl

(Not implemented)cbrt cbrtf cbrtl

Sets errno via calls to other functions.ccos ccosf ccosl

Sets errno via calls to other functions.ccosh ccoshf ccoshl

-ceil ceilf ceill

Sets errno via calls to other functions.cexp cexpf cexpl

Uses global File System Simulation buffer, _dbg_requestchdir

-cimag cimagf cimagl

Calls fclose. See (1)cleanup

Modifies iob[ ]. See (1)clearerr

Uses global File System Simulation buffer, _dbg_requestclock

Sets errno via calls to other functions.clog clogf clogl

Calls _closeclose

-conj conjf conjl

-copysign copysignf
copysignl

-cos cosf cosl

cosh calls exp(), which sets errno. If errno is discarded, cosh is
reentrant.

cosh coshf coshl

Sets errno via calls to other functions.cpow cpowf cpowl

-cproj cprojf cprojl

-creal crealf creall

Sets errno via calls to other functions.csin csinf csinl

Sets errno via calls to other functions.csinh csinhf csinhl

Sets errno via calls to other functions.csqrt csqrtf csqrtl

Sets errno via calls to other functions.ctan ctanf ctanl
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Not reentrant becauseFunction

Sets errno via calls to other functions.ctanh ctanhf ctanhl

Calls asctimectime

-difftime

-div ldiv lldiv

(Not implemented)erf erfl erff

(Not implemented)erfc erfcf erfcl

Calls fclose indirectly which uses iob[ ] calls functions in _atexit
array. See (1). To make exit reentrant kernel support is required.

exit

Sets errno.exp expf expl

(Not implemented)exp2 exp2f exp2l

(Not implemented)expm1 expm1f expm1l

-fabs fabsf fabsl

Uses values in iob[ ]. See (1).fclose

(Not implemented)fdim fdimf fdiml

(Not implemented)feclearexcept

(Not implemented)fegetenv

(Not implemented)fegetexceptflag

(Not implemented)fegetround

(Not implemented)feholdexept

Uses values in iob[ ]. See (1).feof

(Not implemented)feraiseexcept

Uses values in iob[ ]. See (1).ferror

(Not implemented)fesetenv

(Not implemented)fesetexceptflag

(Not implemented)fesetround

(Not implemented)fetestexcept

(Not implemented)feupdateenv

Modifies iob[ ]. See (1).fflush

Uses pointer to iob[ ]. See (1).fgetc fgetwc

Sets the variable errno and uses pointer to iob[ ]. See (1) / (2).fgetpos

Uses iob[ ]. See (1).fgets fgetws

-floor floorf floorl

(Not implemented)fma fmaf fmal

(Not implemented)fmax fmaxf fmaxl

(Not implemented)fmin fminf fminl

499

Libraries



Not reentrant becauseFunction

-fmod fmodf fmodl

Uses iob[ ] and calls malloc when file open for buffered IO. See (1)fopen

-fpclassify

Uses iob[ ]. See (1).fprintf fwprintf

Uses iob[ ]. See (1).fputc fputwc

Uses iob[ ]. See (1).fputs fputws

Calls fgetc. See (1).fread

free uses static buffer management structures. See malloc (5).free

Modifies iob[ ]. See (1).freopen

-frexp frexpf frexpl

Uses iob[ ]. See (1)fscanf fwscanf

Uses iob[ ] and calls _lseek. Accesses ungetc[ ] array. See (1).fseek

Uses iob[ ] and sets errno. See (1) / (2).fsetpos

(Not implemented)fstat

Uses iob[ ] and sets errno. Calls _lseek. See (1) / (2).ftell

Uses iob[ ]. See (1).fwrite

Uses iob[ ]. See (1).getc getwc

Uses iob[ ]. See (1).getchar getwchar

Uses global File System Simulation buffer, _dbg_requestgetcwd

Skeleton only.getenv

Uses iob[ ]. See (1).gets getws

gmtime defines static structuregmtime

Sets errno via calls to other functions.hypot hypotf hypotl

(Not implemented)ilogb ilogbf ilogbl

-imaxabs

-imaxdiv

-isalnum iswalnum

-isalpha iswalpha

-isascii iswascii

-iscntrl iswcntrl

-isdigit iswdigit

-isfinite

-isgraph iswgraph

-isgreater

-isgreaterequal
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Not reentrant becauseFunction

-isinf

-isless

-islessequal

-islessgreater

-islower iswlower

-isnan

-isnormal

-isprint iswprint

-ispunct iswpunct

-isspace iswspace

-isunordered

-isupper iswupper

-iswalnum

-iswalpha

-iswcntrl

-iswctype

-iswdigit

-iswgraph

-iswlower

-iswprint

-iswpunct

-iswspace

-iswupper

-iswxditig

-isxdigit iswxdigit

Sets errno. See (2).ldexp ldexpf ldexpl

(Not implemented)lgamma lgammaf lgammal

(Not implemented)llrint lrintf lrintl

(Not implemented)llround llroundf llroundl

N.A.; skeleton functionlocaleconv

-localtime

Sets errno. See (2).log logf logl

Sets errno via calls to other functions.log10 log10f log10l

(Not implemented)log1p log1pf log1pl

(Not implemented)log2 log2f log2l
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Not reentrant becauseFunction

(Not implemented)logb logbf logbl

-longjmp

(Not implemented)lrint lrintf lrintl

(Not implemented)lround lroundf lroundl

Calls _lseeklseek

(Not implemented)lstat

Needs kernel support. See (5).malloc

N.A., skeleton functionmblen

Sets errno.mbrlen

Sets errno.mbrtowc

-mbsinit

Sets errno.mbsrtowcs

N.A., skeleton functionmbstowcs

N.A., skeleton functionmbtowc

-memchr wmemchr

-memcmp wmemcmp

-memcpy wmemcpy

-memmove wmemmove

-memset wmemset

-mktime

-modf modff modfl

(Not implemented)nan nanf nanl

(Not implemented)nearbyint nearbyintf
nearbyintl

(Not implemented)nextafter nextafterf
nextafterl

(Not implemented)nexttoward nexttowardf
nexttowardl

-offsetof

Calls _openopen

Uses errno. See (2)perror

Sets errno. See (2)pow powf powl

Uses iob[ ]. See (1)printf wprintf

Uses iob[ ]. See (1)putc putwc

Uses iob[ ]. See (1)putchar putwchar

Uses iob[ ]. See (1)puts
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Not reentrant becauseFunction

-qsort

Updates the signal handler tableraise

Uses static variable to remember latest random number. Must
diverge from ISO C standard to define reentrant rand. See (4).

rand

Calls _readread

See malloc (5).realloc

(Not implemented)remainder remainderf
remainderl

Uses global File System Simulation buffer, _dbg_requestremove

(Not implemented)remquo remquof remquol

Uses global File System Simulation buffer, _dbg_requestrename

Eventually calls _lseekrewind

(Not implemented)rint rintf rintl

(Not implemented)round roundf roundl

-scalbln scalblnf scalblnl

-scalbn scalbnf scalbnl

Uses iob[ ], calls _doscan. See (1).scanf wscanf

Sets iob[ ]. See (1).setbuf

-setjmp

N.A.; skeleton functionsetlocale

Sets iob and calls malloc. See (1) / (5).setvbuf

Updates the signal handler tablesignal

-signbit

-sin sinf sinl

Sets errno via calls to other functions.sinh sinhf sinhl

Sets errno. See (2).snprintf swprintf

Sets errno. See (2).sprintf

Sets errno. See (2).sqrt sqrtf sqrtl

See randsrand

Sets errno via calls to other functions.sscanf swscanf

Uses global File System Simulation buffer, _dbg_requeststat

-strcat wcscat

-strchr wcschr

-strcmp wcscmp

-strcoll wcscoll

-strcpy wcscpy
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Not reentrant becauseFunction

-strcspn wcscspn

-strerror

-strftime wcsftime

-strlen wcslen

-strncat wcsncat

-strncmp wcsncmp

-strncpy wcsncpy

-strpbrk wcspbrk

-strrchr wcsrchr

-strspn wcsspn

-strstr wcsstr

-strtod wcstod

-strtof wcstof

Sets errno via calls to other functions.strtoimax

strtok saves last position in string in local static variable.This function
is not reentrant by design. See (4).

strtok wcstok

Sets errno. See (2).strtol wcstol

-strtold wcstold

Sets errno. See (2).strtoul wcstoul

Sets errno. See (2).strtoull wcstoull

Sets errno via calls to other functions.strtoumax

-strxfrm wcsxfrm

N.A; skeleton functionsystem

Sets errno. See (2).tan tanf tanl

Sets errno via call to other functions.tanh tanhf tanhl

(Not implemented)tgamma tgammaf tgammal

Uses static variable which defines initial start timetime

Uses iob[ ]. See (1).tmpfile

Uses local buffer to build filename.
Function can be adapted to use user buffer.This makes the function
non ISO C. See (4).

tmpnam

-toascii

-tolower

-toupper

-towctrans

-towlower
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Not reentrant becauseFunction

-towupper

(Not implemented)trunc truncf truncl

Uses static buffer to hold unget characters for each file. Can be
moved into iob structure. See (1).

ungetc ungetwc

Uses global File System Simulation buffer, _dbg_requestunlink

Uses iob[ ]. See (1).vfprintf vfwprintf

Calls _doscanvfscanf vfwscanf

Uses iob[ ]. See (1).vprintf vwprintf

Calls _doscanvscanf vwscanf

Sets errno.vsprintf vswprintf

Sets errno.vsscanf vswscanf

Sets errno.wcrtomb

Sets errno.wcsrtombs

Sets errno via calls to other functions.wcstoimax

N.A.; skeleton functionwcstombs

Sets errno via calls to other functions.wcstoumax

-wctob

N.A.; skeleton functionwctomb

-wctrans

-wctype

Calls _writewrite

Table: C library reentrancy

Several functions in the C library are not reentrant due to the following reasons:

• The iob[] structure is static. This influences all I/O functions.

• The ungetc[] array is static. This array holds the characters (one for each stream) when ungetc()
is called.

• The variable errno is globally defined. Numerous functions read or modify errno

• _doprint and _doscan use static variables for e.g. character counting in strings.

• Some string functions use locally defined (static) buffers. This is prescribed by ANSI.

• malloc uses a static heap space.

The following description discusses these items in more detail. The numbers at the beginning of each
paragraph relate to the number references in the table above.

(1) iob structures
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The I/O part of the C library is not reentrant by design. This is mainly caused by the static declaration of
the iob[] array. The functions which use elements of this array access these elements via pointers (
FILE * ).

Building a multi-process system that is created in one link-run is hard to do. The C language scoping
rules for external variables make it difficult to create a private copy of the iob[] array. Currently, the
iob[] array has external scope. Thus it is visible in every module involved in one link phase. If these
modules comprise several tasks (processes) in a system each of which should have its private copy of
iob[], it is apparent that the iob[] declaration should be changed. This requires adaptation of the
library to the multi-tasking environment.The library modules must use a process identification as an index
for determining which iob[] array to use. Thus the library is suitable for interfacing to that kernel only.

Another approach for the iob[] declaration problem is to declare the array static in one of the modules
which create a task.Thus there can be more than one iob[] array is the system without having conflicts
at link time.This brings several restrictions: Only the module that holds the declaration of the static iob[]
can use the standard file handles stdin, stdout and stderr (which are the first three entries in iob[]).
Thus all I/O for these three file handles should be located in one module.

(2) errno declaration

Several functions in the C library set the global variable errno. After completion of the function the user
program may consult this variable to see if some error occurred. Since most of the functions that set
errno already have a return type (this is the reason for using errno) it is not possible to check successful
completion via the return type.

The library routines can set errno to the values defined in errno.h. See the file errno.h for more
information.

errno can be set to ERR_FORMAT by the print and scan functions in the C library if you specify illegal
format strings.

errno will never be set to ERR_NOLONG or ERR_NOPOINT since the C library supports long and
pointer conversion routines for input and output.

errno can be set to ERANGE by the following functions: exp(), strtol(), strtoul() and tan().
These functions may produce results that are out of the valid range for the return type. If so, the result of
the function will be the largest representable value for that type and errno is set to ERANGE.

errno is set to EDOM by the following functions: acos(), asin(), log(), pow() and sqrt(). If the
arguments for these functions are out of their valid range ( e.g. sqrt( -1 ) ), errno is set to EDOM.

errno can be set to ERR_POS by the file positioning functions ftell(), fsetpos() and fgetpos().

(3) ungetc

Currently the ungetc buffer is static. For each file entry in the iob[] structure array, there is one character
available in the buffer to unget a character.

(4) local buffers
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tmpnam() creates a temporary filename and returns a pointer to a local static buffer. This is according
to the ANSI definition. Changing this function such that it creates the name in a user specified buffer
requires another calling interface. Thus the function would be no longer portable.

strtok() scans through a string and remembers that the string and the position in the string for
subsequent calls.This function is not reentrant by design. Making it reentrant requires support of a kernel
to store the information on a per process basis.

rand() generates a sequence of random numbers. The function uses the value returned by a previous
call to generate the next value in the sequence. This function can be made reentrant by specifying the
previous random value as one of the arguments. However, then it is no longer a standard function.

(5) malloc

Malloc uses a heap space which is assigned at locate time. Thus this implementation is not reentrant.
Making a reentrant malloc requires some sort of system call to obtain free memory space on a per process
basis. This is not easy to solve within the current context of the library. This requires adaptation to a
kernel.

This paragraph on reentrancy applies to multi-process environments only. If reentrancy is required
for calling library functions from an exception handler, another approach is required. For such a
situation it is of no use to allocate e.g. multiple iob[] structures. In such a situation several pieces
of code in the library have to be declared 'atomic': this means that interrupts have to be disabled
while executing an atomic piece of code.
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Chapter 10. List File Formats
This chapter describes the format of the assembler list file and the linker map file.

10.1. Assembler List File Format

The assembler list file is an additional output file of the assembler that contains information about the
generated code. For details on how to generate a list file, see Section 4.5, Generating a List File.

The list file consists of a page header and a source listing.

Page header

The page header is repeated on every page:

TASKING VX-toolset for LC87: assembler vx.yrz Build nnn SN 00000000
Title                                                       Page 1

ADDR CODE      CYCLES  LINE SOURCE LINE

The first line contains version information. The second line can contain a title which you can specify with
the assembler directive .TITLE and always contains a page number. The third line is empty and the
fourth line contains the headings of the columns for the source listing.

With the assembler directives .LIST/.NOLIST, .PAGE, and with the assembler option --list-format you
can format the list file.

Source listing

The following is a sample part of a listing. An explanation of the different columns follows below.

ADDR CODE      CYCLES  LINE SOURCE LINE
                          1         ; Module start
                          .
                          .
0000 47rrrr    1    1    18         ldw     #.1.str
0004 970200    2    3    19         stw     r1
0008 30rrrr    2    5    20         call    _printf
                          .
                          .
0000                     38         .ds     2
  |  RESERVED
0001

This column contains the memory address.The address is a hexadecimal number
that represents the offset from the beginning of a relocatable section or the absolute
address for an absolute section. The address only appears on lines that generate
object code.

ADDR
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This is the object code generated by the assembler for this source line, displayed
in hexadecimal format.The displayed code need not be the same as the generated
code that is entered in the object module. The code can also be relocatable code.
In this case the letter 'r' is printed for the relocatable code part in the listing. For
lines that allocate space, the code field contains the text "RESERVED". For lines
that initialize a buffer, the code field lists one value followed by the word
"REPEATS".

CODE

The first number in this column is the number of instruction cycles needed to
execute the instruction(s) as generated in the CODE field. The second number is
the accumulated cycle count of this section.

CYCLES

This column contains the line number. This is a decimal number indicating each
input line, starting from 1 and incrementing with each source line.

LINE

This column contains the source text. This is a copy of the source line from the
assembly source file.

SOURCE LINE

For the .SET and .EQU directives the ADDR and CODE columns do not apply. The symbol value is listed
instead.

10.2. Linker Map File Format

The linker map file is an additional output file of the linker that shows how the linker has mapped the
sections and symbols from the various object files (.obj) to output sections. The locate part shows the
absolute position of each section. External symbols are listed per space with their absolute address, both
sorted on symbol and sorted on address. For details on how to generate a map file, see Section 5.10,
Generating a Map File.

With the linker option --map-file-format you can specify which parts of the map file you want to see.

In Eclipse the linker map file (project.mapxml) is generated in the output directory of the build configuration,
usually Debug or Release.You can open the map file by double-clicking on the file name.
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Each page displays a part of the map file.You can use the drop-down list or the Outline view to navigate
through the different tables and you can use the following buttons.

DescriptionActionIcon

Goes back one page in the history list.Back

Goes forward one page in the history list.Forward

Shows the next table from the drop-down list.Next Table

Shows the previous table from the drop-down list.Previous Table

When you right-click in the view, a popup menu appears (for example, to reset the layout of a table). The
meaning of the different parts is:

Tool and Invocation

This part of the map file contains information about the linker, its version header information, binary
location and which options are used to call it.

Used Resources

This part of the map file shows the memory usage at memory level and space level. The largest free
block of memory (Largest gap) is also shown.This part also contains an estimation of the stack usage.

Explanation of the columns:
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The names of the system memory and user memory as defined in the linker script
file (*.lsl).

Memory

The size of all executable sections.Code

The size of all non-executable sections (not including stacks, heaps, debug sections
in non-alloc space).

Data

The total size of reserved memories, reserved ranges, reserved special sections,
stacks, heaps, alignment protections, sections located in non-alloc space (debug
sections). In fact, this size is the same as the size in the Total column minus the
size of all other columns.

Reserved

The free memory area addressable by this core. This area is accessible for
unrestricted items.

Free

The total memory area addressable by this core.Total

The names of the address spaces as defined in the linker script file (*.lsl). The
names are constructed of the derivative name followed by a colon ':', the core
name, another colon ':' and the space name. For example: LC87:LC87:code.

Space

The size of sections located in this space.Native used ...

The size of all sections destined for/located in other spaces, but because of overlap
in spaces consume memory in this space.

Foreign used

The name(s) of the stack(s) as defined in the linker script file (*.lsl).Stack Name

An estimation of the stack usage. The linker calculates the required stack size by
using information (.CALLS directives) generated by the compiler. If for example
recursion is detected, the calculated stack size is inaccurate, therefore this is an
estimation only.The calculated stack size is supposed to be smaller than the actual
allocated stack size. If that is not the case, then a warning is given.

Used

Processed Files

This part of the map file shows all processed files. This also includes object files that are extracted from
a library, with the symbol that led to the extraction.

Link Result

This part of the map file shows per object file how the link phase has mapped the sections from the various
object files (.obj) to output sections.

The name of an input object file.[in] File

A section name and id from the input object file.The number between '( )' uniquely
identifies the section.

[in] Section

The size of the input section.[in] Size

The offset relative to the start of the output section.[out] Offset

The resulting output section name and id.[out] Section

The size of the output section.[out] Size
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Module Local Symbols

This part of the map file shows a table for each local scope within an object file. Each table has three
columns, 1 the symbol name, 2 the address of the symbol and 3 the space where the symbol resides in.
The table is sorted on symbol name within each space.

By default this part is not shown in the map file.You have to turn this part on manually with linker option
--map-file-format=+statics (module local symbols).

Cross References

This part of the map file lists all symbols defined in the object modules and for each symbol the object
modules that contain a reference to the symbol are shown. Also, symbols that remain undefined are
shown.

Call Graph

This part of the map file contains a schematic overview that shows how (library) functions call each other.
To obtain call graph information, the assembly file must contain .CALLS directives.

You can click the + or - sign to expand or collapse a single node. Use the  /  buttons to expand/collapse
all nodes in the call graph.

DescriptionMeaningIcon

This function is the top of the call graph. If there are interrupt handlers, there
can be several roots.

Root

This function is referenced by several No leaf functions. Right-click on the
function and select Expand all References to see all functions that
reference this function. Select Back to Caller to return to the calling function.

Callee

A normal node (function) in the call graph.Node

This function calls a function which is listed separately in the call graph.
Right-click on the function and select Go to Callee to see the callee. Hover
the mouse over the function to see a popup with all callees.

Caller

Overlay

This part is empty for the LC87.

Locate Result: Sections

This part of the map file shows the absolute position of each section in the absolute object file. It is
organized per memory chip and group and sorted on space address. In Eclipse, right-click in the table
and select Configure Columns to specify which columns you want to see. If you hover the mouse over
a section, you get a popup with information about the section. If you select a range of sections, in the
Fast View bar (at the bottom) you will see information about the selected range, such as the total size,
how many sections are selected and how many gaps are present.
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The line number and default sort order.#

The name and id of the section. The number between '( )' uniquely identifies the
section. Names within square brackets [ ] will be copied during initialization from
ROM to the corresponding section name in RAM.

Section
Section name
Section number

The size of the section in minimum addressable units (hexadecimal or decimal).Sect. size (hex)
Sect. size (dec)

Sections can be ordered in groups.These are the names of the groups as defined
in the linker script file (*.lsl) with the keyword group in the section_layout
definition. The name that is displayed is the name of the deepest nested group.

Group

The first address of the section in the address space.Start address

The last address of the section in the address space.End address

The names of the external symbols that are referenced in the section. See Locate
Result: Symbols below.

Symbols in sect.

The names of the input modules the section is defined in. See Link Result: [in]
File above.

Defined in

The names of the modules that contain a reference to the section. See Cross
References above.

Referenced in

The names of the memory chips as defined in the linker script file (*.lsl) in the
memory definitions.

Chip name

The absolute offset of the section from the start of a memory chip.Chip addr

The locate rule type and properties. See Locate Rules below.Locate
type:properties

The following buttons are available in this part of the map file.

DescriptionActionIcon

Opens the Configure Section Filter dialog. Here you can select which
sections you want to see in the map file and how.

Configure Section
Filter

All sections that are marked with ”Highlight" in the Configure Section Filter
dialog will be highlighted in the table.

Enable
Highlighting

All sections that are marked with ”Collapse" in the Configure Section Filter
dialog will appear collapsed in the table.

Enable Collapsing

All lines that are not part of the selection in the Configure Section Filter
dialog will be hidden.

Only Show
Matching Lines

Also shows the gaps in the map file. Click the button again to hide the gaps.Show Gaps

Configure Section Filter Dialog

In this dialog you can filter which sections you want to see in the map file and how. Click Add to add a
new filter. Explanation of the columns and fields:

Marks the section as a candidate for highlighting. Turn on Enable Highlighting
to see the effect.

Highlight
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The highlight color.Color

Marks the section as a candidate for collapsing. Turn on Enable Collapsing to
see the effect.

Collapse

A filter to select a section or group of sections. Wildcards are allowed. Wildcards
follow the rules of regular expressions. To get help on which wildcards are
supported, press Ctrl-space. Click an item in the list for help, double-click to add
the wildcard.

Section name

The first address of the section in the address space for this filter.Start address

The last address of the section in the address space for this filter.End address

The name of the address space.Address space

The name of the memory chip as defined in the linker script file (*.lsl) in the
memory definitions.

Chip name

If gaps are shown in the map file, here you can limit the number of gaps you want
to see.

Hide gaps smaller
than

The meaning of the check boxes is the same as the corresponding buttons available in this part of the
map file.

Locate Result: Symbols

This part of the map file lists all external symbols per address space name.

The absolute address of the symbol in the address space.Address

The name of the symbol.Name

The names of the address spaces as defined in the linker script file (*.lsl). The
names are constructed of the derivative name followed by a colon ':', the core
name, another colon ':' and the space name. For example: LC87:LC87:code.

Space

Processor and Memory

This part of the map file shows the processor and memory information of the linker script file.

By default this part is not shown in the map file.You have to turn this part on manually with linker option
--map-file-format=+lsl (processor and memory info).You can print this information to a separate file with
linker option --lsl-dump.

You can click the + or - sign to expand or collapse a part of the information.

Locate Rules

This part of the map file shows the rules the linker uses to locate sections.

The names of the address spaces as defined in the linker script file (*.lsl). The
names are constructed of the derivative name followed by a colon ':', the core
name, another colon ':' and the space name.

Address space
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The rule type:

ordered/contiguous/clustered/unrestricted

Specifies how sections are grouped. By default, a group is 'unrestricted' which
means that the linker has total freedom to place the sections of the group in the
address space.

Type

absolute

The section must be located at the address shown in the Properties column.

ranged

The section must be located anywhere in the address ranges shown in the
Properties column; end addresses are not included in the range.

page

The sections must be located in some address range with a size not larger than
shown in the Properties column; the first number is the page size, the second part
is the address range restriction within the page.

ranged page

Both the ranged and the paged restriction apply. In the Properties column the
range restriction is listed first, followed by the paged restriction between parenthesis.

ballooned

After locating all sections, the largest remaining gap in the space is used completely
for the stack and/or heap.

The contents depends on the Type column.Properties

The locate priority of the rule. A higher priority value gives a rule precedence over
a rule with a lower priority, but only if the two rules have the same type and the
same properties.The relative order of rules of different types or different properties
is not affected by this priority value.You can set the priority with the priority
group attribute in LSL

Prio

The sections to which the rule applies;

restrictions between sections are shown in this column:

    <   ordered
    |   contiguous
    +   clustered

For contiguous sections, the linker uses the section order as shown here. Clustered
sections can be located in any relative order.

Sections
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Removed Sections

This part of the map file shows the sections which are removed from the output file as a result of the
optimization option to delete unreferenced sections and or duplicate code or constant data (linker option
--optimize=cxy).

The name of the section which has been removed.Section

The name of the input object file where the section is removed from.File

The name of the library where the object file is part of.Library

The symbols that were present in the section.Symbol

The reason why the section has been removed. This can be because the section
is unreferenced or duplicated.

Reason
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Chapter 11. Object File Formats
This chapter describes the format of several object files.

11.1. ELF/DWARF Object Format

The TASKING VX-toolset for LC87 by default produces objects in the ELF/DWARF 3 format.

For a complete description of the ELF format, please refer to the Tool Interface Standard (TIS).

For a complete description of the DWARF format, please refer to the DWARF Debugging Information
Format Version 3. See http://dwarfstd.org/

11.2. Intel Hex Record Format

Intel Hex records describe the hexadecimal object file format for 8-bit, 16-bit and 32-bit microprocessors.
The hexadecimal object file is an ASCII representation of an absolute binary object file. There are six
different types of records:

• Data Record (8-, 16, or 32-bit formats)

• End of File Record (8-, 16, or 32-bit formats)

• Extended Segment Address Record (16, or 32-bit formats)

• Start Segment Address Record (16, or 32-bit formats)

• Extended Linear Address Record (32-bit format only)

• Start Linear Address Record (32-bit format only)

To generate an Intel Hex output file:

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Output Format.

4. Enable the option Generate Intel Hex format file.

5. (Optional) Specify the Size of addresses (in bytes) for Intel Hex records.

6. (Optional) Enable or disable the option Emit type 2 instead of type 4 records.

7. (Optional) Enable or disable the option Emit start address record.
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By default the linker generates records in the 32-bit format (4-byte addresses).

General Record Format

In the output file, the record format is:

checksumcontenttypeoffsetlength:

where:

is the record header.:

is the record length which specifies the number of bytes of the content field. This
value occupies one byte (two hexadecimal digits). The linker outputs records of
255 bytes (32 hexadecimal digits) or less; that is, length is never greater than 0xFF.

length

is the starting load offset specifying an absolute address in memory where the
data is to be located when loaded by a tool. This field is two bytes long. This field
is only used for Data Records. In other records this field is coded as four ASCII
zero characters ('0000').

offset

is the record type. This value occupies one byte (two hexadecimal digits). The
record types are:

Record TypeByte Type

Data00

End of file01

Extended segment address 102

Start segment address 103

Extended linear address (32-bit)04

Start linear address (32-bit)05

type

is the information contained in the record. This depends on the record type.content

is the record checksum. The linker computes the checksum by first adding the
binary representation of the previous bytes (from length to content). The linker
then computes the result of sum modulo 256 and subtracts the remainder from
256 (two's complement). Therefore, the sum of all bytes following the header is
zero.

checksum

1 Type 2 and 3 records are only supported for compatibility with LC87 flash programmers.
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Extended Linear Address Record

The Extended Linear Address Record specifies the two most significant bytes (bits 16-31) of the absolute
address of the first data byte in a subsequent Data Record:

checksumupper_address04000002:

The 32-bit absolute address of a byte in a Data Record is calculated as:

  ( address + offset + index ) modulo 4G

where:

is the base address, where the two most significant bytes are the upper_address
and the two least significant bytes are zero.

address

is the 16-bit offset from the Data Record.offset

is the index of the data byte within the Data Record (0 for the first byte).index

Example:

:020000040000FA
 | |   | |   |_ checksum
 | |   | |_ upper_address
 | |   |_ type
 | |_ offset
 |_ length

Data Record

The Data Record specifies the actual program code and data.

checksumdata00offsetlength:

The length byte specifies the number of data bytes. The linker has an option (--hex-record-size) that
controls the length of the output buffer for generating Data records. The default buffer length is 32 bytes.

The offset is the 16-bit starting load offset. Together with the address specified in the Extended Address
Record it specifies an absolute address in memory where the data is to be located when loaded by a tool.

Example:

:0F00200000232222754E00754F04AF4FAE4E22C3
 | |   | |                             |_ checksum
 | |   | |_ data
 | |   |_ type
 | |_ offset
 |_ length
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Start Linear Address Record

The Start Linear Address Record contains the 32-bit program execution start address.

checksumaddress05000004:

With linker option --hex-format=S you can prevent the linker from emitting this record.

Example:

:0400000500000000F7
 | |   | |       |_ checksum
 | |   | |_ address
 | |   |_ type
 | |_ offset
 |_ length

End of File Record

The hexadecimal file always ends with the following end-of-file record:

:00000001FF
 | |   | |_ checksum
 | |   |_ type
 | |_ offset
 |_ length

11.3. Motorola S-Record Format

To generate a Motorola S-record output file:

1. From the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Output Format.

4. Enable the option Generate S-records file.

5. (Optional) Specify the Size of addresses (in bytes) for Motorola S records.

By default, the linker produces output in Motorola S-record format with three types of S-records (4-byte
addresses): S0, S3 and S7. Depending on the size of addresses you can force other types of S-records.
They have the following layout:
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S0 - record

checksumcomment0000lengthS0

A linker generated S-record file starts with an S0 record with the following contents:

        l k 8 7
S00700006C6B3837B2

The S0 record is a comment record and does not contain relevant information for program execution.

where:

is a comment record and does not contain relevant information for program
execution.

S0

represents the number of bytes in the record, not including the record type and
length byte. This value occupies one byte (two hexadecimal digits).

length

contains the name of the linker.comment

is the record checksum. The linker computes the checksum by first adding the
binary representation of the bytes following the record type (starting with the length
byte) to just before the checksum.Then the one's complement is calculated of this
sum. The least significant byte of the result is the checksum. The sum of all bytes
following the record type is 0xFF.

checksum

S1 / S2 / S3 - record

This record is the program code and data record for 2-byte, 3-byte or 4-byte addresses respectively.

checksumcode bytesaddresslengthS1

checksumcode bytesaddresslengthS2

checksumcode bytesaddresslengthS3

where:

is the program code and data record for 2-byte addresses.S1

is the program code and data record for 3-byte addresses.S2

is the program code and data record for 4-byte addresses (this is the default).S3

represents the number of bytes in the record, not including the record type and
length byte. This value occupies one byte (two hexadecimal digits).

length

contains the code or data address.address

contains the actual program code and data.code bytes

is the record checksum. The checksum calculation is identical to S0.checksum
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Example:

S3080000000B200B00C1
  | |       |     |_ checksum
  | |       |_ code
  | |_ address
  |_ length

S7 / S8 / S9 - record

This record is the termination record for 4-byte, 3-byte or 2-byte addresses respectively.

checksumaddresslengthS7

checksumaddresslengthS8

checksumaddresslengthS9

where:

is the termination record for 4-byte addresses (this is the default). S7 is the
corresponding termination record for S3 records.

S7

is the termination record for 3-byte addresses. S8 is the corresponding termination
record for S2 records.

S8

is the termination record for 2-byte addresses. S9 is the corresponding termination
record for S1 records.

S9

represents the number of bytes in the record, not including the record type and
length byte. This value occupies one byte (two hexadecimal digits).

length

contains the program start address.address

is the record checksum. The checksum calculation is identical to S0.checksum

Example:

S70500000000FA
  | |       |_checksum
  | |_ address
  |_ length

524

TASKING VX-toolset for LC87 User Guide



Chapter 12. Linker Script Language (LSL)
To make full use of the linker, you can write a script with information about the architecture of the target
processor and locating information.The language for the script is called the Linker Script Language (LSL).
This chapter first describes the structure of an LSL file. The next section contains a summary of the LSL
syntax. In the remaining sections, the semantics of the Linker Script Language is explained.

The TASKING linker is a target independent linker/locator that can simultaneously link and locate all
programs for all cores available on a target board. The target board may be of arbitrary complexity. A
simple target board may contain one standard processor with some external memory that executes one
task. A complex target board may contain multiple standard processors and DSPs combined with
configurable IP-cores loaded in an FPGA. Each core may execute a different program, and external
memory may be shared by multiple cores.

LSL serves two purposes. First it enables you to specify the characteristics (that are of interest to the
linker) of your specific target board and of the cores installed on the board. Second it enables you to
specify how sections should be located in memory.

12.1. Structure of a Linker Script File

A script file consists of several definitions. The definitions can appear in any order.

The architecture definition (required)

In essence an architecture definition describes how the linker should convert logical addresses into
physical addresses for a given type of core. If the core supports multiple address spaces, then for each
space the linker must know how to perform this conversion. In this context a physical address is an offset
on a given internal or external bus. Additionally the architecture definition contains information about items
such as the (hardware) stack and the vector table.

This specification is normally written by Altium. Altium supplies LSL files in the include.lsl directory.
The architecture definition of the LSL file should not be changed by you unless you also modify the core's
hardware architecture. If the LSL file describes a multi-core system an architecture definition must be
available for each different type of core.

See Section 12.4, Semantics of the Architecture Definition for detailed descriptions of LSL in the architecture
definition.

The derivative definition

The derivative definition describes the configuration of the internal (on-chip) bus and memory system.
Basically it tells the linker how to convert offsets on the buses specified in the architecture definition into
offsets in internal memory. Microcontrollers and DSPs often have internal memory and I/O sub-systems
apart from one or more cores. The design of such a chip is called a derivative.

When you build an ASIC or use a derivative that is not (yet) supported by the TASKING tools, you may
have to write a derivative definition.
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When you want to use multiple cores of the same type, you must instantiate the cores in a derivative
definition, since the linker automatically instantiates only a single core for an unused architecture.

See Section 12.5, Semantics of the Derivative Definition for a detailed description of LSL in the derivative
definition.

The processor definition

The processor definition describes an instance of a derivative.Typically the processor definition instantiates
one derivative only (single-core processor). A processor that contains multiple cores having the same
(homogeneous) or different (heterogeneous) architecture can also be described by instantiating multiple
derivatives of the same or different types in separate processor definitions.

See Section 12.6, Semantics of the Board Specification for a detailed description of LSL in the processor
definition.

The memory and bus definitions (optional)

Memory and bus definitions are used within the context of a derivative definition to specify internal memory
and on-chip buses. In the context of a board specification the memory and bus definitions are used to
define external (off-chip) memory and buses. Given the above definitions the linker can convert a logical
address into an offset into an on-chip or off-chip memory device.

See Section 12.6.3, Defining External Memory and Buses, for more information on how to specify the
external physical memory layout. Internal memory for a processor should be defined in the derivative
definition for that processor.

The board specification

The processor definition and memory and bus definitions together form a board specification. LSL provides
language constructs to easily describe single-core and heterogeneous or homogeneous multi-core
systems.The board specification describes all characteristics of your target board's system buses, memory
devices, I/O sub-systems, and cores that are of interest to the linker. Based on the information provided
in the board specification the linker can for each core:

• convert a logical address to an offset within a memory device

• locate sections in physical memory

• maintain an overall view of the used and free physical memory within the whole system while locating

The section layout definition (optional)

The optional section layout definition enables you to exactly control where input sections are located.
Features are provided such as: the ability to place sections at a given load-address or run-time address,
to place sections in a given order, and to overlay code and/or data sections.

Which object files (sections) constitute the task that will run on a given core is specified on the command
line when you invoke the linker. The linker will link and locate all sections of all tasks simultaneously.
From the section layout definition the linker can deduce where a given section may be located in memory,
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form the board specification the linker can deduce which physical memory is (still) available while locating
the section.

See Section 12.8, Semantics of the Section Layout Definition, for more information on how to locate a
section at a specific place in memory.

Skeleton of a Linker Script File

architecture architecture_name
{
    // Specification core architecture
}

derivative derivative_name
{
    // Derivative definition
}

processor processor_name
{
    // Processor definition
}

memory and/or bus definitions

section_layout space_name
{
    // section placement statements
}

12.2. Syntax of the Linker Script Language

This section describes what the LSL language looks like. An LSL document is stored as a file coded in
UTF-8 with extension .lsl. Before processing an LSL file, the linker preprocesses it using a standard
C preprocessor. Following this, the linker interprets the LSL file using a scanner and parser. Finally, the
linker uses the information found in the LSL file to guide the locating process.

12.2.1. Preprocessing

When the linker loads an LSL file, the linker processes it with a C-style prepocessor. As such, it strips C
and C++ comments.You can use the standard ISO C preprocessor directives, such as #include,
#define, #if/#else/#endif, #error.

For example:

#include "arch.lsl"

Preprocess and include the file arch.lsl at this point in the LSL file.
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12.2.2. Lexical Syntax

The following lexicon is used to describe the syntax of the Linker Script Language:

A is defined as B=A ::= B

A is defined as B and C; B is followed by C=A ::= B C

A is defined as B or C=A ::= B | C

zero or one occurrence of B=<B>0|1

zero of more occurrences of B=<B>>=0

one of more occurrences of B=<B>>=1

a character sequence starting with 'a'-'z', 'A'-'Z' or '_'. Following
characters may also be digits and dots '.'

=IDENTIFIER

sequence of characters not starting with \n, \r or \t=STRING

" STRING " (double quoted string)=DQSTRING

octal number, starting with a zero (06, 045)=OCT_NUM

decimal number, not starting with a zero (14, 1024)=DEC_NUM

hexadecimal number, starting with '0x' (0x0023, 0xFF00)=HEX_NUM

OCT_NUM, DEC_NUM and HEX_NUM can be followed by a k (kilo), M (mega), or G (giga).

Characters in bold are characters that occur literally. Words in italics are higher order terms that are
defined in the same or in one of the other sections.

To write comments in LSL file, you can use the C style '/* */' or C++ style '//'.

12.2.3. Identifiers and Tags

arch_name         ::= IDENTIFIER
bus_name          ::= IDENTIFIER
core_name         ::= IDENTIFIER
derivative_name   ::= IDENTIFIER
file_name         ::= DQSTRING
group_name        ::= IDENTIFIER
heap_name         ::= section_name
map_name          ::= IDENTIFIER
mem_name          ::= IDENTIFIER
proc_name         ::= IDENTIFIER
section_name      ::= DQSTRING
space_name        ::= IDENTIFIER
stack_name        ::= section_name
symbol_name       ::= DQSTRING
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tag_attr          ::= (tag<,tag>>=0)
tag               ::= tag = DQSTRING

A tag is an arbitrary text that can be added to a statement.

12.2.4. Expressions

The expressions and operators in this section work the same as in ISO C.

number            ::= OCT_NUM
                    | DEC_NUM
                    | HEX_NUM

expr              ::= number
                    | symbol_name
                    | unary_op expr
                    | expr binary_op expr
                    | expr ? expr : expr
                    | ( expr )
                    | function_call

unary_op          ::= !    // logical NOT
                    | ~    // bitwise complement
                    | -    // negative value

binary_op         ::= ^    // exclusive OR
                    | *    // multiplication
                    | /    // division
                    | %    // modulus
                    | +    // addition
                    | -    // subtraction
                    | >>   // right shift
                    | <<   // left shift
                    | ==   // equal to
                    | !=   // not equal to
                    | >    // greater than
                    | <    // less than
                    | >=   // greater than or equal to
                    | <=   // less than or equal to
                    | &    // bitwise AND
                    | |    // bitwise OR
                    | &&   // logical AND
                    | ||   // logical OR

12.2.5. Built-in Functions

function_call     ::= absolute ( expr )
                    | addressof ( addr_id )
                    | exists ( section_name )
                    | max ( expr , expr )
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                    | min ( expr , expr )
                    | sizeof ( size_id )

addr_id           ::= sect : section_name
                    | group : group_name

size_id           ::= sect : section_name
                    | group : group_name
                    | mem : mem_name

• Every space, bus, memory, section or group you refer to, must be defined in the LSL file.

• The addressof() and sizeof() functions with the group or sect argument can only be used in
the right hand side of an assignment. The sizeof() function with the mem argument can be used
anywhere in section layouts.

You can use the following built-in functions in expressions. All functions return a numerical value. This
value is a 64-bit signed integer.

absolute()

int absolute( expr )

Converts the value of expr to a positive integer.

absolute( "labelA"-"labelB" )

addressof()

int addressof( addr_id )

Returns the address of addr_id, which is a named section or group. To get the offset of the section with
the name asect:

addressof( sect: "asect")

This function only works in assignments.

exists()

int exists( section_name )

The function returns 1 if the section section_name exists in one or more object file, 0 otherwise. If the
section is not present in input object files, but generated from LSL, the result of this function is undefined.

To check whether the section mysection exists in one of the object files that is specified to the linker:

exists( "mysection" )
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max()

int max( expr, expr )

Returns the value of the expression that has the largest value. To get the highest value of two symbols:

max( "sym1" , "sym2")

min()

int min( expr, expr )

Returns the value of the expression hat has the smallest value. To get the lowest value of two symbols:

min( "sym1" , "sym2")

sizeof()

int sizeof( size_id )

Returns the size of the object (group, section or memory) the identifier refers to. To get the size of the
section "asection":

sizeof( sect: "asection" )

The group and sect arguments only works in assignments. The mem argument can be used
anywhere in section layouts.

12.2.6. LSL Definitions in the Linker Script File

description       ::= <definition>>=1

definition        ::= architecture_definition
                    | derivative_definition
                    | board_spec
                    | section_definition
                    | section_setup

• At least one architecture_definition must be present in the LSL file.

12.2.7. Memory and Bus Definitions

mem_def           ::= memory mem_name <tag_attr>0|1 {  <mem_descr ;>>=0 }

• A mem_def defines a memory with the mem_name as a unique name.

mem_descr         ::= type = <reserved>0|1 mem_type
                    | mau = expr
                    | size = expr
                    | speed = number
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                    | priority = number
                    | exec_priority = number
                    | fill <= fill_values>0|1

                    | mapping

• A mem_def contains exactly one type statement.

• A mem_def contains exactly one mau statement (non-zero size).

• A mem_def contains exactly one size statement.

• A mem_def contains zero or one priority (or speed) statement (if absent, the default value is 1).

• A mem_def contains zero or one exec_priority statement.

• A mem_def contains zero or one fill statement.

• A mem_def contains at least one mapping

mem_type          ::= rom        // attrs = rx
                    | ram        // attrs = rw
                    | nvram      // attrs = rwx
                    | blockram

fill_values       ::= expr
                    | [ expr <, expr>>=0 ]

bus_def           ::= bus bus_name {  <bus_descr ;>>=0 }

• A bus_def statement defines a bus with the given bus_name as a unique name within a core
architecture.

bus_descr         ::= mau = expr
                    | width = expr  // bus width, nr
                    |               // of data bits 
                    | mapping       // legal destination
                                    // 'bus' only

• The mau and width statements appear exactly once in a bus_descr. The default value for width is
the mau size.

• The bus width must be an integer times the bus MAU size.

• The MAU size must be non-zero.

• A bus can only have a mapping on a destination bus (through dest = bus: ).

mapping           ::= map <map_name>0|1 ( map_descr <, map_descr>>=0 )

map_descr         ::= dest = destination
                    | dest_dbits = range
                    | dest_offset = expr
                    | size = expr
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                    | src_dbits = range
                    | src_offset = expr
                    | reserved
                    | priority = number
                    | exec_priority = number
                    | tag

• A map_descr requires at least the size and dest statements.

• A map_descr contains zero or one priority statement (if absent, the default value is 0).

• A map_descr contains zero or one exec_priority statement.

• Each map_descr can occur only once.

• You can define multiple mappings from a single source.

• Overlap between source ranges or destination ranges is not allowed.

• If the src_dbits or dest_dbits statement is not present, its value defaults to the width value if
the source/destination is a bus, and to the mau size otherwise.

• The reserved statement is allowed only in mappings defined for a memory.

destination       ::= space : space_name
                    | bus : <proc_name | 

core_name :>0|1 bus_name

• A space_name refers to a defined address space.

• A proc_name refers to a defined processor.

• A core_name refers to a defined core.

• A bus_name refers to a defined bus.

• The following mappings are allowed (source to destination)

• space => space

• space => bus

• bus => bus

• memory => bus

range             ::= expr .. expr

• With address ranges, the end address is not part of the range.
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12.2.8. Architecture Definition

architecture_definition
                  ::= architecture arch_name
                      <( parameter_list )>0|1

                      <extends arch_name
                              <( argument_list )>0|1 >0|1

{ <arch_spec>>=0 }

• An architecture_definition defines a core architecture with the given arch_name as a unique
name.

• At least one space_def and at least one bus_def have to be present in an
architecture_definition.

• An architecture_definition that uses the extends construct defines an architecture that inherits
all elements of the architecture defined by the second arch_name. The parent architecture must be
defined in the LSL file as well.

parameter_list    ::= parameter <, parameter>>=0

parameter         ::= IDENTIFIER <= expr>0|1

argument_list     ::= expr <, expr>>=0

arch_spec         ::= bus_def
                    | space_def
                    | endianness_def

space_def         ::= space space_name <tag_attr>0|1 { <space_descr;>>=0 }

• A space_def defines an address space with the given space_name as a unique name within an
architecture.

space_descr       ::= space_property ;
                    | section_definition  //no space ref
                    | vector_table_statement
                    | reserved_range

space_property    ::= id = number // as used in object
                    | mau = expr
                    | align = expr
                    | page_size = expr <[ range ] <| [ range ]>>=0>0|1

                    | page
                    | direction = direction
                    | stack_def
                    | heap_def
                    | copy_table_def
                    | start_address
                    | mapping

• A space_def contains exactly one id and one mau statement.

534

TASKING VX-toolset for LC87 User Guide



• A space_def contains at most one align statement.

• A space_def contains at most one page_size statement.

• A space_def contains at least one mapping.

stack_def         ::= stack stack_name ( stack_heap_descr
                            <, stack_heap_descr >>=0 )

• A stack_def defines a stack with the stack_name as a unique name.

heap_def          ::= heap heap_name ( stack_heap_descr
                            <, stack_heap_descr >>=0 )

• A heap_def defines a heap with the heap_name as a unique name.

stack_heap_descr  ::= min_size = expr
                    | grows = direction
                    | align = expr
                    | fixed
                    | id = expr
                    | tag

• The min_size statement must be present.

• You can specify at most one align statement and one grows statement.

• Each stack definition has its own unique id, the number specified corresponds to the index in the
.CALLS directive as generated by the compiler.

direction         ::= low_to_high
                    | high_to_low

• If you do not specify the grows statement, the stack and heap grow low-to-high.

copy_table_def    ::= copytable <( copy_table_descr
                            <, copy_table_descr >>=0 )>0|1

• A space_def contains at most one copytable statement.

• Exactly one copy table must be defined in one of the spaces.

copy_table_descr  ::= align = expr
                    | copy_unit = expr
                    | dest <space_name>0|1 = space_name
                    | page
                    | tag

• The copy_unit is defined by the size in MAUs in which the startup code moves data.

• The dest statement is only required when the startup code initializes memory used by another processor
that has no access to ROM.
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• A space_name refers to a defined address space.

start_addr        ::= start_address ( start_addr_descr
                               <, start_addr_descr>>=0 )

start_addr_descr  ::= run_addr = expr
                    | symbol = symbol_name

• A symbol_name refers to the section that contains the startup code.

vector_table_statement
                  ::= vector_table section_name

( vecttab_spec <, vecttab_spec>>=0 )
{ <vector_def>>=0 }

vecttab_spec      ::= vector_size = expr
                    | size = expr
                    | id_symbol_prefix = symbol_name
                    | run_addr = addr_absolute
                    | template = section_name
                    | template_symbol = symbol_name
                    | vector_prefix = section_name
                    | fill = vector_value
                    | no_inline
                    | copy
                    | tag

vector_def        ::= vector ( vector_spec <, vector_spec>>=0 );

vector_spec       ::= id = vector_id_spec
                    | fill = vector_value
                    | optional
                    | tag

vector_id_spec    ::= number
                    | [ range ] <, [ range ]>>=0

vector_value      ::= symbol_name
                    | [ number <, number>>=0 ]
                    | loop <[ expr ]>0|1

reserved_range    ::= reserved <tag_attr>0|1 expr .. expr ;

• The end address is not part of the range.

endianness_def    ::= endianness { <endianness_type;>>=1 }

endianness_type   ::= big
                    | little
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12.2.9. Derivative Definition

derivative_definition
                  ::= derivative derivative_name
                      <( parameter_list )>0|1

                      <extends derivative_name
                              <( argument_list )>0|1 >0|1

{ <derivative_spec>>=0 }

• A derivative_definition defines a derivative with the given derivative_name as a unique
name.

derivative_spec   ::= core_def
                    | bus_def
                    | mem_def
                    | section_definition // no processor name
                    | section_setup

core_def          ::= core core_name { <core_descr ;>>=0 }

• A core_def defines a core with the given core_name as a unique name.

• At least one core_def must be present in a derivative_definition.

core_descr        ::= architecture = arch_name
                      <( argument_list )>0|1

                    | endianness = ( endianness_type
                               <, endianness_type>>=0 )

• An arch_name refers to a defined core architecture.

• Exactly one architecture statement must be present in a core_def.

12.2.10. Processor Definition and Board Specification

board_spec        ::= proc_def
                    | bus_def
                    | mem_def

proc_def          ::= processor proc_name
{ proc_descr ; }

proc_descr        ::= derivative = derivative_name
                      <( argument_list )>0|1

• A proc_def defines a processor with the proc_name as a unique name.

• If you do not explicitly define a processor for a derivative in an LSL file, the linker defines a processor
with the same name as that derivative.

• A derivative_name refers to a defined derivative.
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• A proc_def contains exactly one derivative statement.

12.2.11. Section Setup

section_setup     ::= section_setup space_ref <tag_attr>0|1

{ <section_setup_item>>=0 }

section_setup_item
                  ::= vector_table_statement
                    | reserved_range
                    | stack_def ;
                    | heap_def ;
                    | copy_table_def ;
                    | start_address ;

12.2.12. Section Layout Definition

section_definition ::= section_layout <space_ref>0|1

                       <( space_layout_properties )>0|1

{ <section_statement>>=0 }

• A section definition inside a space definition does not have a space_ref.

• All global section definitions have a space_ref.

space_ref         ::= <proc_name>0|1 : <core_name>0|1

: space_name <| space_name>>=0

• If more than one processor is present, the proc_name must be given for a global section layout.

• If the section layout refers to a processor that has more than one core, the core_name must be given
in the space_ref.

• A proc_name refers to a defined processor.

• A core_name refers to a defined core.

• A space_name refers to a defined address space.

space_layout_properties
                  ::= space_layout_property <, space_layout_property >>=0

space_layout_property
                  ::= locate_direction
                    | tag

locate_direction  ::= direction = direction

direction         ::= low_to_high
                    | high_to_low

• A section layout contains at most one direction statement.
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• If you do not specify the direction statement, the locate direction of the section layout is
low-to-high.

section_statement
                  ::= simple_section_statement ;
                    | aggregate_section_statement

simple_section_statement
                  ::= assignment
                    | select_section_statement
                    | special_section_statement

assignment        ::= symbol_name assign_op expr

assign_op         ::= =
                    | :=

select_section_statement
                  ::= select <ref_tree>0|1 <section_name>0|1

                      <section_selections>0|1

• Either a section_name or at least one section_selection must be defined.

section_selections
                  ::= ( section_selection
                        <, section_selection>>=0 )

section_selection
                  ::= attributes = < <+|-> attribute>>0

                    | tag

• +attribute means: select all sections that have this attribute.

• -attribute means: select all sections that do not have this attribute.

special_section_statement
                  ::= heap heap_name <stack_heap_mods>0|1

                    | stack stack_name <stack_heap_mods>0|1

                    | copytable
                    | reserved section_name <reserved_specs>0|1

• Special sections cannot be selected in load-time groups.

stack_heap_mods   ::= ( stack_heap_mod <, stack_heap_mod>>=0 )

stack_heap_mod    ::= size = expr
                    | tag

reserved_specs    ::= ( reserved_spec <, reserved_spec>>=0 )

reserved_spec     ::= attributes
                    | fill_spec
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                    | size = expr
                    | alloc_allowed = absolute | ranged

• If a reserved section has attributes r, rw, x, rx or rwx, and no fill pattern is defined, the section is
filled with zeros. If no attributes are set, the section is created as a scratch section (attributes ws, no
image).

fill_spec         ::= fill = fill_values

fill_values       ::= expr
                    | [ expr <, expr>>=0 ]

aggregate_section_statement
                  ::= { <section_statement>>=0 }
                    | group_descr
                    | if_statement
                    | section_creation_statement

group_descr       ::= group <group_name>0|1 <( group_specs )>0|1

section_statement

• For every group with a name, the linker defines a label.

• No two groups for address spaces of a core can have the same group_name.

group_specs       ::= group_spec <, group_spec >>=0

group_spec        ::= group_alignment
                    | attributes
                    | copy
                    | nocopy
                    | group_load_address
                    | fill <= fill_values>0|1

                    | group_page
                    | group_run_address
                    | group_type
                    | allow_cross_references
                    | priority = number
                    | tag

• The allow-cross-references property is only allowed for overlay groups.

• Sub groups inherit all properties from a parent group.

group_alignment   ::= align = expr

attributes        ::= attributes = <attribute>>=1

attribute         ::= r    // readable sections
                    | w    // writable sections
                    | x    // executable code sections
                    | i    // initialized sections
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                    | s    // scratch sections
                    | b    // blanked (cleared) sections
                    | p    // protected sections

group_load_address
                  ::= load_addr <= load_or_run_addr>0|1

group_page        ::= page <= expr>0|1

                    | page_size = expr <[ range ] <| [ range ]>>=0>0|1

group_run_address ::= run_addr <= load_or_run_addr>0|1

group_type        ::= clustered
                    | contiguous
                    | ordered
                    | overlay

• For non-contiguous groups, you can only specify group_alignment and attributes.

• The overlay keyword also sets the contiguous property.

• The clustered property cannot be set together with contiguous or ordered on a single group.

load_or_run_addr  ::= addr_absolute
                    | addr_range <| addr_range>>=0

addr_absolute     ::= expr
                    | memory_reference [ expr ]

• An absolute address can only be set on ordered groups.

addr_range        ::= [ expr .. expr ]
                    | memory_reference
                    | memory_reference [ expr .. expr ]

• The parent of a group with an addr_range or page restriction cannot be ordered, contiguous or
clustered.

• The end address is not part of the range.

memory_reference  ::= mem : <proc_name :>0|1 mem_name </ map_name>0|1

• A proc_name refers to a defined processor.

• A mem_name refers to a defined memory.

• A map_name refers to a defined memory mapping.

if_statement      ::= if ( expr ) section_statement
                      <else section_statement>0|1
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section_creation_statement
                  ::= section section_name ( section_specs )

{ <section_statement2>>=0 }

section_specs     ::= section_spec <, section_spec >>=0

section_spec      ::= attributes
                    | fill_spec
                    | size = expr
                    | blocksize = expr
                    | overflow = section_name
                    | tag

section_statement2
                  ::= select_section_statement ;
                    | group_descr2
                    | { <section_statement2>>=0 }

group_descr2      ::= group <group_name>0|1

( group_specs2 )
section_statement2

group_specs2      ::= group_spec2 <, group_spec2 >>=0

group_spec2       ::= group_alignment
                    | attributes
                    | load_addr
                    | tag

12.3. Expression Evaluation

Only constant expressions are allowed, including sizes, but not addresses, of sections in object files.

All expressions are evaluated with 64-bit precision integer arithmetic. The result of an expression can be
absolute or relocatable. A symbol you assign is created as an absolute symbol.
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12.4. Semantics of the Architecture Definition

Keywords in the architecture definition

architecture
   extends
endianness          big  little
bus
   mau
   width
   map
space
   id
   mau
   align
   page_size
   page
   direction        low_to_high  high_to_low

stack
      min_size
      grows         low_to_high  high_to_low
      align
      fixed
      id
   heap
      min_size
      grows         low_to_high  high_to_low
      align
      fixed
      id

copytable
      align
      copy_unit
      dest
      page

vector_table
      vector_size
      size
      id_symbol_prefix
      run_addr
      template
      template_symbol
      vector_prefix
      fill
      no_inline
      copy
      vector
         id
         fill       loop
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         optional
reserved
start_address

      run_addr
      symbol

map

map
      dest          bus  space
      dest_dbits
      dest_offset
      size
      src_dbits
      src_offset
      priority
      exec_priority

12.4.1. Defining an Architecture

With the keyword architecture you define an architecture and assign a unique name to it. The name
is used to refer to it at other places in the LSL file:

architecture name
{

definitions
}

If you are defining multiple core architectures that show great resemblance, you can define the common
features in a parent core architecture and extend this with a child core architecture that contains specific
features. The child inherits all features of the parent. With the keyword extends you create a child core
architecture:

architecture name_child_arch extends name_parent_arch
{

definitions
}

A core architecture can have any number of parameters. These are identifiers which get values assigned
on instantiation or extension of the architecture.You can use them in any expression within the core
architecture. Parameters can have default values, which are used when the core architecture is instantiated
with less arguments than there are parameters defined for it. When you extend a core architecture you
can pass arguments to the parent architecture. Arguments are expressions that set the value of the
parameters of the sub-architecture.

architecture name_child_arch (parm1,parm2=1)
extends name_parent_arch (arguments)

{
definitions

}
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12.4.2. Defining Internal Buses

With the bus keyword you define a bus (the combination of data and corresponding address bus). The
bus name is used to identify a bus and does not conflict with other identifiers. Bus descriptions in an
architecture definition or derivative definition define internal buses. Some internal buses are used to
communicate with the components outside the core or processor. Such buses on a processor have
physical pins reserved for the number of bits specified with the width statements.

• The mau field specifies the MAU size (Minimum Addressable Unit) of the data bus.This field is required.

• The width field specifies the width (number of address lines) of the data bus. The default value is the
MAU size.

• The map keyword specifies how this bus maps onto another bus (if so). Mappings are described in
Section 12.4.4, Mappings.

bus bus_name
{

mau = 8;
width = 8;
map ( map_description );

}

12.4.3. Defining Address Spaces

With the space keyword you define a logical address space. The space name is used to identify the
address space and does not conflict with other identifiers.

• The id field defines how the addressing space is identified in object files. In general, each address
space has a unique ID.The linker locates sections with a certain ID in the address space with the same
ID. This field is required.

• The mau field specifies the MAU size (Minimum Addressable Unit) of the space. This field is required.

• The align value must be a power of two. The linker uses this value to compute the start addresses
when sections are concatenated. An align value of n means that objects in the address space have to
be aligned on n MAUs.

• The page_size field sets the page alignment and page size in MAUs for the address space. It must
be a power of 2. The default value is 1. If one or more page ranges are supplied the supplied value
only sets the page alignment. The ranges specify the available space in each page, as offsets to the
page start, which is aligned at the page alignment.

See also the page keyword in subsection Locating a group in Section 12.8.2, Creating and Locating
Groups of Sections.

• With the optional direction field you can specify how all sections in this space should be located.
This can be either from low_to_high addresses (this is the default) or from high_to_low addresses.

• The map keyword specifies how this address space maps onto an internal bus or onto another address
space. Mappings are described in Section 12.4.4, Mappings.
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Stacks and heaps

• The stack keyword defines a stack in the address space and assigns a name to it. The architecture
definition must contain at least one stack definition. Each stack of a core architecture must have a
unique name. See also the stack keyword in Section 12.8.3, Creating or Modifying Special Sections.

The stack is described in terms of a minimum size (min_size) and the direction in which the stack
grows (grows). This can be either from low_to_high addresses (stack grows upwards, this is the
default) or from high_to_low addresses (stack grows downwards). The min_size is required.

By default, the linker tries to maximize the size of the stacks and heaps. After locating all sections, the
largest remaining gap in the space is used completely for the stacks and heaps. If you specify the
keyword fixed, you can disable this so-called 'balloon behavior'. The size is also fixed if you used a
stack or heap in the software layout definition in a restricted way. For example when you override a
stack with another size or select a stack in an ordered group with other sections.

The id keyword matches stack information generated by the compiler with a stack name specified in
LSL. This value assigned to this keyword is strongly related to the compiler’s output, so users are not
supposed to change this configuration.

Optionally you can specify an alignment for the stack with the argument align. This alignment must
be equal or larger than the alignment that you specify for the address space itself.

• The heap keyword defines a heap in the address space and assigns a name to it. The definition of a
heap is similar to the definition of a stack. See also the heap keyword in Section 12.8.3, Creating or
Modifying Special Sections.

Stacks and heaps are only generated by the linker if the corresponding linker labels are referenced in the
object files.

See Section 12.8, Semantics of the Section Layout Definition, for information on creating and placing
stack sections.

Copy tables

• The copytable keyword defines a copy table in the address space. The content of the copy table is
created by the linker and contains the start address and size of all sections that should be initialized
by the startup code.You must define exactly one copy table in one of the address spaces (for a core).

Optionally you can specify an alignment for the copy table with the argument align. This alignment
must be equal or larger than the alignment that you specify for the address space itself. If smaller, the
alignment for the address space is used.

The copy_unit argument specifies the size in MAUs of information chunks that are copied. If you do
not specify the copy unit, the MAU size of the address space itself is used.

The dest argument specifies the destination address space that the code uses for the copy table. The
linker uses this information to generate the correct addresses in the copy table.The memory into where
the sections must be copied at run-time, must be accessible from this destination space.

Sections generated for the copy table may get a page restriction with the address space's page size,
by adding the page argument.
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Vector table

• The vector_table keyword defines a vector table with n vectors of size m (This is an internal LSL
object similar to an LSL group.) The run_addr argument specifies the location of the first vector (id=0).
This can be a simple address or an offset in memory (see the description of the run-time address in
subsection Locating a group in Section 12.8.2, Creating and Locating Groups of Sections). A vector
table defines symbols __lc_ub_foo and __lc_ue_foo pointing to start and end of the table.

vector_table "vector_table" (vector_size=m, size=n, run_addr=x, ...)

See the following example of a vector table definition:

vector_table "vector_table" (vector_size = 8, size = 10, run_addr=0x00003,
                    template=".text.vector",
                    template_symbol="__lc_vector_target",
                    vector_prefix=".vector_",
                    id_symbol_prefix="foo",
                    no_inline,
                    /* default: empty, or */
                    fill="foo", /* or */ 
                    fill=[1,2,3,4], /* or */ 
                    fill=loop)
{
    vector (id=23, fill="main", optional);
    vector (id=12, fill=[0xab, 0x21, 0x32, 0x43]);
    vector (id=[1..11], fill=[0]);
    vector (id=[18..23], fill=loop);
}

The template argument defines the name of the section that holds the code to jump to a handler
function from the vector table. This template section does not get located and is removed when the
locate phase is completed. This argument is required.

The template_symbol argument is the symbol reference in the template section that must be replaced
by the address of the handler function. This symbol name should start with the linker prefix for the
symbol to be ignored in the link phase. This argument is required.

The vector_prefix argument defines the names of vector sections: the section for a vector with id
vector_id is $(vector_prefix)$(vector_id). Vectors defined in C or assembly source files that should be
included in the vector table must have the correct symbol name. The compiler uses the prefix that is
defined in the default LSL file(s); if this attribute is changed, the vectors declared in C source files are
not included in the vector table. When a vector supplied in an object file has exactly one relocation, the
linker will assume it is a branch to a handler function, and can be removed when the handler is inlined
in the vector table. Otherwise, no inlining is done. This argument is required.

With the optional no_inline argument the vectors handlers are not inlined in the vector table.

With the optional copy argument a ROM copy of the vector table is made and the vector table is copied
to RAM at startup.

With the optional id_symbol_prefix argument you can set an internal string representing a symbol
name prefix that may be found on symbols in vector handler code. When the linker detects such a
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symbol in a handler, the symbol is assigned the vector number. If the symbol was already assigned a
vector number, a warning is issued.

The fill argument sets the default contents of vectors. If nothing is specified for a vector, this setting
is used. See below. When no default is provided, empty vectors may be used to locate large vector
handlers and other sections. Only one fill argument is allowed.

The vector field defines the content of vector with the number specified by id. If a range is specified
for id ([p..q,s..t]) all vectors in the ranges (inclusive) are defined the same way.

With fill=symbol_name, the vector must jump to this symbol. If the section in which the symbol is
defined fits in the vector table (size may be >m), locate the section at the location of the vector.
Otherwise, insert code to jump to the symbol's value. A template interrupt handler section name +
symbol name for the target code must be supplied in the LSL file.

fill=[value(s)], fills the vector with the specified MAU values.

With fill=loop the vector jumps to itself. With the optional [offset] you can specify an offset from the
vector table entry.

When the keyword optional is set on a vector specification with a symbol value and the symbol is
not found, no error is reported. A default fill value is used if the symbol was not found.With other values
the attribute has no effect.

Reserved address ranges

• The reserved keyword specifies to reserve a part of an address space even if not all of the range is
covered by memory. See also the reserved keyword in Section 12.8.3, Creating or Modifying Special
Sections.

Start address

• The start_address keyword specifies the start address for the position where the C startup code is
located.When a processor is reset, it initializes its program counter to a certain start address, sometimes
called the reset vector. In the architecture definition, you must specify this start address in the correct
address space in combination with the name of the label in the application code which must be located
here.

The run_addr argument specifies the start address (reset vector). If the core starts executing using
an entry from a vector table, and directly jumps to the start label, you should omit this argument.

The symbol argument specifies the name of the label in the application code that should be located
at the specified start address.The symbol argument is required.The linker will resolve the start symbol
and use its value after locating for the start address field in IEEE-695 files and Intel Hex files. If you
also specified the run_addr argument, the start symbol (label) must point to a section. The linker
locates this section such that the start symbol ends up on the start address.

space space_name
{

id = 1;
mau = 8;
align = 8;
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page_size = 1;
stack name (min_size = 1k, grows = low_to_high);
reserved start_address .. end_address;
start_address ( run_addr = 0x0000,

symbol = "start_label" )
map ( map_description );

}

12.4.4. Mappings

You can use a mapping when you define a space, bus or memory. With the map field you specify how
addresses from the source (space, bus or memory) are translated to addresses of a destination (space,
bus). The following mappings are possible:

• space => space

• space => bus

• bus => bus

• memory => bus

With a mapping you specify a range of source addresses you want to map (specified by a source offset
and a size), the destination to which you want to map them (a bus or another address space), and the
offset address in the destination.

• The dest argument specifies the destination. This can be a bus or another address space (only for
a space to space mapping). This argument is required.

• The src_offset argument specifies the offset of the source addresses. In combination with size, this
specifies the range of address that are mapped. By default the source offset is 0x0000.

• The size argument specifies the number of addresses that are mapped. This argument is required.

• The dest_offset argument specifies the position in the destination to which the specified range of
addresses is mapped. By default the destination offset is 0x0000.

If you are mapping a bus to another bus, the number of data lines of each bus may differ. In this case
you have to specify a range of source data lines you want to map (src_dbits = begin..end) and the
range of destination data lines you want to map them to (dest_dbits = first..last).

• The src_dbits argument specifies a range of data lines of the source bus. By default all data lines
are mapped.

• The dest_dbits argument specifies a range of data lines of the destination bus. By default, all data
lines from the source bus are mapped on the data lines of the destination bus (starting with line 0).

If you define a memory and the memory mapping must not be used by default when locating sections in
address spaces, you can specify the reserved argument. This marks all address space areas that the
mapping points to as reserved. If a section has an absolute or address range restriction, the reservation
is lifted and the section may be located at these locations. This feature is only useful when more than
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one mapping is available for a range of memory addresses, otherwise the memory keyword with the same
name would be used.

For example:

memory xrom
{
    mau = 8;
    size = 1M;
    type = rom;

map cached   (dest=bus:mycore:local_bus, dest_offset=0x80000000,
                  size=1M);

map uncached (dest=bus:mycore:local_bus, dest_offset=0xa0000000,
                  size=1M, reserved);
}

Mapping priority

If you define a memory you can set a locate priority on a mapping with the keywords priority and
exec_priority. The values of these priorities are relative which means they add to the priority of
memories. Whereas a priority set on the memory applies to all address space areas reachable through
any mapping of the memory, a priority set on a mapping only applies to address space areas reachable
through the mapping. The memory mapping with the highest priority is considered first when locating. To
set only a priority for non-executable (data) sections, add a priority keyword with the desired value
and an exec_priority set to zero. To set only a priority for executable (code) sections, simply set an
exec_priority keyword to the desired value.

The default for a mapping priority is zero, while the default for exec_priority is the same as the
specified priority. If you specify a value for priority in LSL it must be greater than zero. A value
for exec_priority must be greater or equal to zero.

For more information about priority values see the description of the memory priority keyword.

memory myram
{
    mau = 8;
    size = 112k;
    type = ram;

map (dest=bus:mycore:local_bus, dest_offset=0xd0000000,
              size=112k, priority=8, exec_priority=0);

map (dest=bus:mycore:local_bus, dest_offset=0x70000000,
              size=112k);
}

From space to space

If you map an address space to another address space (nesting), you can do this by mapping the subspace
to the containing larger space. In this example a small space of 64 kB is mapped on a large space of 16
MB.
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space small
{
   id = 2;
   mau = 4;

map (src_offset = 0, dest_offset = 0,
dest = space : large, size = 64k);

}

From space to bus

All spaces that are not mapped to another space must map to a bus in the architecture:

space large
{
   id = 1;
   mau = 4;

map (src_offset = 0, dest_offset = 0,
dest = bus:bus_name, size = 16M );

}

From bus to bus

The next example maps an external bus called e_bus to an internal bus called i_bus. This internal bus
resides on a core called mycore.The source bus has 16 data lines whereas the destination bus has only
8 data lines. Therefore, the keywords src_dbits and dest_dbits specify which source data lines are
mapped on which destination data lines.

architecture mycore
{
    bus i_bus
    {
       mau = 4;
    }

    space i_space
    {
       map (dest=bus:i_bus, size=256);
    }
}

bus e_bus
{
   mau = 16;
   width = 16;
   map (dest = bus:mycore:i_bus, src_dbits = 0..7, dest_dbits = 0..7 )
}

It is not possible to map an internal bus to an external bus.
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12.5. Semantics of the Derivative Definition

Keywords in the derivative definition

derivative
   extends
core
   architecture
bus
   mau
   width
   map
memory
   type             reserved rom  ram  nvram  blockram
   mau
   size
   speed
   priority
   exec_priority
   fill
   map
section_layout
section_setup

map
      dest          bus  space
      dest_dbits
      dest_offset
      size
      src_dbits
      src_offset
      priority
      exec_priority
      reserved

12.5.1. Defining a Derivative

With the keyword derivative you define a derivative and assign a unique name to it.The name is used
to refer to it at other places in the LSL file:

derivative name
{

definitions
}

If you are defining multiple derivatives that show great resemblance, you can define the common features
in a parent derivative and extend this with a child derivative that contains specific features. The child
inherits all features of the parent (cores and memories). With the keyword extends you create a child
derivative:
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derivative name_child_deriv extends name_parent_deriv
{

definitions
}

As with a core architecture, a derivative can have any number of parameters. These are identifiers which
get values assigned on instantiation or extension of the derivative.You can use them in any expression
within the derivative definition.

derivative name_child_deriv (parm1,parm2=1)
extends name_parent_deriv (arguments)

{
definitions

}

12.5.2. Instantiating Core Architectures

With the keyword core you instantiate a core architecture in a derivative.

• With the keyword architecture you tell the linker that the given core has a certain architecture. The
architecture name refers to an existing architecture definition in the same LSL file.

For example, if you have two cores (called mycore_1 and mycore_2) that have the same architecture
(called mycorearch), you must instantiate both cores as follows:

core mycore_1
{

architecture = mycorearch;
}

core mycore_2
{

architecture = mycorearch;
}

If the architecture definition has parameters you must specify the arguments that correspond with the
parameters. For example mycorearch1 expects two parameters which are used in the architecture
definition:

core mycore
{

architecture = mycorearch1 (1,2);
}

12.5.3. Defining Internal Memory and Buses

With the keyword memory you define physical memory that is present on the target board. The memory
name is used to identify the memory and does not conflict with other identifiers. It is common to define
internal memory (on-chip) in the derivative definition. External memory (off-chip memory) is usually defined
in the board specification (See Section 12.6.3, Defining External Memory and Buses).
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• The type field specifies a memory type:

• rom: read-only memory - it can only be written at load-time

• ram: random access volatile writable memory - writing at run-time is possible while writing at load-time
has no use since the data is not retained after a power-down

• nvram: non volatile ram - writing is possible both at load-time and run-time

• blockram: writing is possible both at load-time and run-time. Changes are applied in RAM, so after
a full device reset the data in a blockram reverts to the original state.

The optional reserved qualifier before the memory type, tells the linker not to locate any section in
the memory by default.You can locate sections in such memories using an absolute address or range
restriction (see subsection Locating a group in Section 12.8.2, Creating and Locating Groups of Sections).

• The mau field specifies the MAU size (Minimum Addressable Unit) of the memory.This field is required.

• The size field specifies the size in MAU of the memory. This field is required.

• The priority field specifies a locate priority for a memory. The speed field has the same meaning
but is considered deprecated. By default, a memory has its priority set to 1. The memories with the
highest priority are considered first when trying to locate a rule. Subsequently, the next highest priority
memories are added if the rule was not located successfully, and so on until the lowest priority that is
available is reached or the rule is located. The lowest priority value is zero. Sections with an ordered
and/or contiguous restriction are not affected by the locate priority. If such sections also have a page
restriction, the locate priority is still used to select a page.

• If an exec_priority is specified for a memory, the regular priority (either specified or its default
value) does not apply to locate rules with only executable sections. Instead, the supplied value applies
for such rules. Additionally, the exec_priority value is used for any executable unrestricted sections,
even if they appear in an unrestricted rule together with non-executable sections.

• The map field specifies how this memory maps onto an (internal) bus. The mapping can have a name.
Mappings are described in Section 12.4.4, Mappings.

• The optional fill field contains a bit pattern that the linker writes to all memory addresses that remain
unoccupied during the locate process. The result of the expression, or list of expressions, is used as
values to write to memory, each in MAU.

memory mem_name
{

type = rom;
mau = 8;
fill = 0xaa;
size = 64k;
priority = 2;
map map_name ( map_description );

}

With the bus keyword you define a bus in a derivative definition. Buses are described in Section 12.4.2,
Defining Internal Buses.
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12.6. Semantics of the Board Specification

Keywords in the board specification

processor
derivative

bus
   mau
   width
   map
memory
   type             reserved  rom  ram  nvram  blockram
   mau
   size
   speed
   priority
   exec_priority
   fill
   map

map
      dest          bus  space
      dest_dbits
      dest_offset
      size
      src_dbits
      src_offset
      priority
      exec_priority
      reserved

12.6.1. Defining a Processor

If you have a target board with multiple processors that have the same derivative, you need to instantiate
each individual processor in a processor definition. This information tells the linker which processor has
which derivative and enables the linker to distinguish between the present processors.

If you use processors that all have a unique derivative, you may omit the processor definitions.
In this case the linker assumes that for each derivative definition in the LSL file there is one
processor. The linker uses the derivative name also for the processor.

With the keyword processor you define a processor.You can freely choose the processor name. The
name is used to refer to it at other places in the LSL file:

processor proc_name
{

processor definition
}
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12.6.2. Instantiating Derivatives

With the keyword derivative you tell the linker that the given processor has a certain derivative. The
derivative name refers to an existing derivative definition in the same LSL file.

For example, if you have two processors on your target board (called myproc_1 and myproc_2) that
have the same derivative (called myderiv), you must instantiate both processors as follows:

processor myproc_1
{

derivative = myderiv;
}

processor myproc_2
{

derivative = myderiv;
}

If the derivative definition has parameters you must specify the arguments that correspond with the
parameters. For example myderiv1 expects two parameters which are used in the derivative definition:

processor myproc
{

derivative = myderiv1 (2,4);
}

12.6.3. Defining External Memory and Buses

It is common to define external memory (off-chip) and external buses at the global scope (outside any
enclosing definition). Internal memory (on-chip memory) is usually defined in the scope of a derivative
definition.

With the keyword memory you define physical memory that is present on the target board. The memory
name is used to identify the memory and does not conflict with other identifiers. If you define memory
parts in the LSL file, only the memory defined in these parts is used for placing sections.

If no external memory is defined in the LSL file and if the linker option to allocate memory on demand is
set then the linker will assume that all virtual addresses are mapped on physical memory.You can override
this behavior by specifying one or more memory definitions.

memory mem_name
{

type = rom;
mau = 8;
fill = 0xaa;
size = 64k;
priority = 2;
map map_name ( map_description );

}

For a description of the keywords, see Section 12.5.3, Defining Internal Memory and Buses.
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With the keyword bus you define a bus (the combination of data and corresponding address bus). The
bus name is used to identify a bus and does not conflict with other identifiers. Bus descriptions at the
global scope (outside any definition) define external buses.These are buses that are present on the target
board.

bus bus_name
{

mau = 8;
width = 8;
map ( map_description );

}

For a description of the keywords, see Section 12.4.2, Defining Internal Buses.

You can connect off-chip memory to any derivative: you need to map the off-chip memory to a bus and
map that bus on the internal bus of the derivative you want to connect it to.

12.7. Semantics of the Section Setup Definition

Keywords in the section setup definition

section_setup
stack

      min_size
      grows         low_to_high  high_to_low
      align
      fixed
      id
   heap
      min_size
      grows         low_to_high  high_to_low
      align
      fixed
      id

copytable
      align
      copy_unit
      dest
      page

vector_table
      vector_size
      size
      id_symbol_prefix
      run_addr
      template
      template_symbol
      vector_prefix
      fill
      no_inline
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      copy
      vector
         id
         fill       loop
         optional

reserved
start_address

      run_addr
      symbol

12.7.1. Setting up a Section

With the keyword section_setup you can define stacks, heaps, copy tables, vector tables, start address
and/or reserved address ranges outside their address space definition.

section_setup ::my_space
{

vector table statements
reserved address range
stack definition
heap definition
copy table definition
start adress

}

See the subsections Stacks and heaps, Copy tables, Start address, Vector table and Reserved address
ranges in Section 12.4.3, Defining Address Spaces for details on the keywords stack, heap, copytable,
vector_table and reserved.

12.8. Semantics of the Section Layout Definition

Keywords in the section layout definition

section_layout
   direction     low_to_high  high_to_low
group

align
   attributes    + -  r w x b i s p
   copy
   nocopy

fill
ordered

   contiguous
clustered
overlay

   allow_cross_references
load_addr

      mem
run_addr
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      mem
page

   page_size
priority

select
stack
   size
heap
   size
reserved
   size
   attributes    r w x
   fill
   alloc_allowed absolute ranged
copytable
section
   size
   blocksize
   attributes    r w x
   fill
   overflow

if
else

12.8.1. Defining a Section Layout

With the keyword section_layout you define a section layout for exactly one address space. In the
section layout you can specify how input sections are placed in the address space, relative to each other,
and what the absolute run and load addresses of each section will be.

You can define one or more section definitions. Each section definition arranges the sections in one
address space.You can precede the address space name with a processor name and/or core name,
separated by colons.You can omit the processor name and/or the core name if only one processor is
defined and/or only one core is present in the processor. A reference to a space in the only core of the
only processor in the system would look like "::my_space". A reference to a space of the only core on
a specific processor in the system could be "my_chip::my_space". The next example shows a section
definition for sections in the my_space address space of the processor called my_chip:

section_layout my_chip::my_space ( locate_direction )
{

section statements
}

Locate direction

With the optional keyword direction you specify whether the linker starts locating sections from
low_to_high (default) or from high_to_low. In the second case the linker starts locating sections at
the highest addresses in the address space but preserves the order of sections when necessary (one
processor and core in this example).
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section_layout ::my_space ( direction = high_to_low )
{

section statements
}

If you do not explicitly tell the linker how to locate a section, the linker decides on the basis of the
section attributes in the object file and the information in the architecture definition and memory
parts where to locate the section.

12.8.2. Creating and Locating Groups of Sections

Sections are located per group. A group can contain one or more (sets of) input sections as well as other
groups. Per group you can assign a mutual order to the sets of sections and locate them into a specific
memory part.

group ( group_specifications )
{

section_statements
}

With the section_statements you generally select sets of sections to form the group.This is described
in subsection Selecting sections for a group.

Instead of selecting sections, you can also modify special sections like stack and heap or create a reserved
section. This is described in Section 12.8.3, Creating or Modifying Special Sections.

With the group_specifications you actually locate the sections in the group. This is described in
subsection Locating a group.

Selecting sections for a group

With the keyword select you can select one or more sections for the group.You can select a section
by name or by attributes. If you select a section by name, you can use a wildcard pattern:

matches with all section names*

matches with a single character in the section name?

takes the next character literally\

matches with a single 'a', 'b' or 'c' character[abc]

matches with any single character in the range 'a' to 'z'[a-z]

group ( ... )
{

select "mysection";
select "*";

}

The first select statement selects the section with the name "mysection". The second select
statement selects all sections that were not selected yet.
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A section is selected by the first select statement that matches, in the union of all section layouts for the
address space. Global section layouts are processed in the order in which they appear in the LSL file.
Internal core architecture section layouts always take precedence over global section layouts.

• The attributes field selects all sections that carry (or do not carry) the given attribute.With +attribute
you select sections that have the specified attribute set. With -attribute you select sections that do not
have the specified attribute set.You can specify one or more of the following attributes:

• r readable sections

• w writable sections

• x executable sections

• i initialized sections

• b sections that should be cleared at program startup

• s scratch sections (not cleared and not initialized)

• p protected sections

To select all read-only sections:

group ( ... )
{

select (attributes = +r-w);
}

Keep in mind that all section selections are restricted to the address space of the section layout in which
this group definition occurs.

• With the ref_tree field you can select a group of related sections. The relation between sections is
often expressed by means of references. By selecting just the 'root' of tree, the complete tree is selected.
This is for example useful to locate a group of related sections in special memory (e.g. fast memory).
The (referenced) sections must meet the following conditions in order to be selected:

1. The sections are within the section layout's address space

2. The sections match the specified attributes

3. The sections have no absolute restriction (as is the case for all wildcard selections)

For example, to select the code sections referenced from foo1:

group refgrp (ordered, contiguous, run_addr=mem:ext_c)
{

select ref_tree "foo1" (attributes=+x);
}

If section foo1 references foo2 and foo2 references foo3, then all these sections are selected by
the selection shown above.
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Locating a group

group group_name ( group_specifications )
{

section_statements
}

With the group_specifications you actually define how the linker must locate the group.You can
roughly define three things: 1) assign properties to the sections in a group like alignment and read/write
attributes, 2) define the mutual order in the address space for sections in the group and 3) restrict the
possible addresses for the sections in a group.

The linker creates labels that allow you to refer to the begin and end address of a group from within the
application software. Labels __lc_gb_group_name and __lc_ge_group_name mark the begin and
end of the group respectively, where the begin is the lowest address used within this group and the end
is the highest address used. Notice that a group not necessarily occupies all memory between begin and
end address. The given label refers to where the section is located at run-time (versus load-time).

1. Assign properties to the sections in a group like alignment and read/write attributes.

These properties are assigned to all sections in the group (and subgroups) and override the attributes
of the input sections.

• The align field tells the linker to align all sections in the group according to the align value. The
alignment of a section is first determined by its own initial alignment and the defined alignment for
the address space. Alignments are never decreased, if multiple alignments apply to a section, the
largest one is used.

• The attributes field tells the linker to assign one or more attributes to all sections in the group.
This overrules the default attributes. By default the linker uses the attributes of the input sections.
You can set the r, w, or rw attributes and you can switch between the b and s attributes.

• The copy field tells the linker to locate a read-only section in RAM and generate a ROM copy and
a copy action in the copy table.This property makes the sections in the group writable which causes
the linker to generate ROM copies for the sections.

• The effect of the nocopy field is the opposite of the copy field. It prevents the linker from generating
ROM copies of the selected sections.

2. Define the mutual order of the sections in the group.

By default, a group is unrestricted which means that the linker has total freedom to place the sections
of the group in the address space.

• The ordered keyword tells the linker to locate the sections in the same order in the address space
as they appear in the group (but not necessarily adjacent).

Suppose you have an ordered group that contains the sections 'A', 'B' and 'C'. By default the linker
places the sections in the address space like 'A' - 'B' - 'C', where section 'A' gets the lowest possible
address. With direction=high_to_low in the section_layout space properties, the linker
places the sections in the address space like 'C' - 'B' - 'A', where section 'A' gets the highest possible
address.

562

TASKING VX-toolset for LC87 User Guide



• The contiguous keyword tells the linker to locate the sections in the group in a single address
range.Within a contiguous group the input sections are located in arbitrary order, however the group
occupies one contiguous range of memory. Due to alignment of sections there can be 'alignment
gaps' between the sections.

When you define a group that is both ordered and contiguous, this is called a sequential group.
In a sequential group the linker places sections in the same order in the address space as they
appear in the group and it occupies a contiguous range of memory.

• The clustered keyword tells the linker to locate the sections in the group in a number of contiguous
blocks. It tries to keep the number of these blocks to a minimum. If enough memory is available, the
group will be located as if it was specified as contiguous. Otherwise, it gets split into two or more
blocks.

If a contiguous or clustered group contains alignment gaps, the linker can locate sections that are
not part of the group in these gaps. To prevent this, you can use the fill keyword. If the group is
located in RAM, the gaps are treated as reserved (scratch) space. If the group is located in ROM,
the alignment gaps are filled with zeros by default.You can however change the fill pattern by
specifying a bit pattern.The result of the expression, or list of expressions, is used as values to write
to memory, each in MAU.

• The overlay keyword tells the linker to overlay the sections in the group. The linker places all
sections in the address space using a contiguous range of addresses. (Thus an overlay group is
automatically also a contiguous group.) To overlay the sections, all sections in the overlay group
share the same run-time address.

For each input section within the overlay the linker automatically defines two symbols. The symbol
__lc_cb_section_name is defined as the load-time start address of the section. The symbol
__lc_ce_section_name is defined as the load-time end address of the section. C (or assembly)
code may be used to copy the overlaid sections.

If sections in the overlay group contain references between groups, the linker reports an error. The
keyword allow_cross_references tells the linker to accept cross-references. Normally, it does
not make sense to have references between sections that are overlaid.

group ovl (overlay)
{
    group a
    {
        select "my_ovl_p1";
        select "my_ovl_p2";
    }
    group b
    {
        select "my_ovl_q1";
    }
}
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It may be possible that one of the sections in the overlay group already has been defined in
another group where it received a load-time address. In this case the linker does not overrule
this load-time address and excludes the section from the overlay group.

3. Restrict the possible addresses for the sections in a group.

The load-time address specifies where the group's elements are loaded in memory at download time.
The run-time address specifies where sections are located at run-time, that is when the program is
executing. If you do not explicitly restrict the address in the LSL file, the linker assigns addresses to
the sections based on the restrictions relative to other sections in the LSL file and section alignments.
The program is responsible for copying overlay sections at appropriate moment from its load-time
location to its run-time location (this is typically done by the startup code).

• The run_addr keyword defines the run-time address. If the run-time location of a group is set
explicitly, the given order between groups specify whether the run-time address propagates to the
parent group or not.The location of the sections in a group can be restricted either to a single absolute
address, or to a number of address ranges (not including the end address). With an expression you
can specify that the group should be located at the absolute address specified by the expression:

group (run_addr = 0xa00f0000)

If the group is ordered, the first section in the group is located at the specified absolute address.

You can use the '[offset]' variant to locate the group at the given absolute offset in memory:

group (run_addr = mem:A[0x1000])

If the group is ordered, the first section in the group is located at the specified absolute offset in
memory.

A range can be an absolute space address range, written as [ expr .. expr ], a complete memory
device, written as mem:mem_name, or a memory address range, mem:mem_name[expr .. expr
]

group (run_addr = mem:my_dram)

You can use the '|' to specify an address range of more than one physical memory device:

group (run_addr = mem:A | mem:B)

When used in top-level section layouts, a memory name refers to a board-level memory.You can
select on-chip memory with mem:proc_name:mem_name. If the memory has multiple parallel
mappings towards the current address space, you can select a specific named mapping in the
memory by appending /map_name to the memory specifier. The linker then maps memory offsets
only through that mapping, so the address(es) where the sections in the group are located are
determined by that memory mapping.

group (run_addr = mem:CPU1:A/cached)
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• The load_addr keyword changes the meaning of the section selection in the group: the linker
selects the load-time ROM copy of the named section(s) instead of the regular sections. Just like
run_addr you can specify an absolute address or an address range.

group (contiguous, load_addr)
{
  select "mydata";  // select ROM copy of mydata:
                    // "[mydata]"
}

The load-time and run-time addresses of a group cannot be set at the same time. If the load-time
property is set for a group, the group (only) restricts the positioning at load-time of the group's
sections. It is not possible to set the address of a group that has a not-unrestricted parent group.

The properties of the load-time and run-time start address are:

• At run-time, before using an element in an overlay group, the application copies the sections from
their load location to their run-time location, but only if these two addresses are different. For
non-overlay sections this happens at program start-up.

• The start addresses cannot be set to absolute values for unrestricted groups.

• For non-overlay groups that do not have an overlay parent, the load-time start address equals the
run-time start address.

• For any group, if the run-time start address is not set, the linker selects an appropriate address.

• If an ordered group or sequential group has an absolute address and contains sections that have
separate page restrictions (not defined in LSL), all those sections are located in a single page. In
other cases, for example when an unrestricted group has an address range assigned to it, the
paged sections may be located in different pages.

For overlays, the linker reserves memory at the run-time start address as large as the largest element
in the overlay group.

• The page keyword tells the linker to place the group in one page. Instead of specifying a run-time
address, you can specify a page and optional a page number. Page numbers start from zero. If you
omit the page number, the linker chooses a page.

The page keyword refers to pages in the address space as defined in the architecture definition.

• With the page_size keyword you can override the page alignment and size set on the address
space. When you set the page size to zero, the linker removes simple (auto generated) page
restrictions from the selected sections. See also the page_size keyword in Section 12.4.3, Defining
Address Spaces.

• With the priority keyword you can change the order in which sections are located. This is useful
when some sections are considered important for good performance of the application and a small
amount of fast memory is available. The value is a number for which the default is 1, so higher
priorities start at 2. Sections with a higher priority are located before sections with a lower priority,
unless their relative locate priority is already determined by other restrictions like run_addr and
page.
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group (priority=2)
{
  select "importantcode1";
  select "importantcode2";
}

12.8.3. Creating or Modifying Special Sections

Instead of selecting sections, you can also create a reserved section or an output section or modify special
sections like a stack or a heap. Because you cannot define these sections in the input files, you must use
the linker to create them.

Stack

• The keyword stack tells the linker to reserve memory for the stack. The name for the stack section
refers to the stack as defined in the architecture definition. If no name was specified in the architecture
definition, the default name is stack.

With the keyword size you can specify the size for the stack. If the size is not specified, the linker uses
the size given by the min_size argument as defined for the stack in the architecture definition. Normally
the linker automatically tries to maximize the size, unless you specified the keyword fixed.

group ( ... )
{

stack "mystack" ( size = 2k );
}

The linker creates two labels to mark the begin and end of the stack, __lc_ub_stack_name for the
begin of the stack and __lc_ue_stack_name for the end of the stack. The linker allocates space for
the stack when there is a reference to either of the labels.

See also the stack keyword in Section 12.4.3, Defining Address Spaces.

Heap

• The keyword heap tells the linker to reserve a dynamic memory range for the malloc() function.
Each heap section has a name. With the keyword size you can change the size for the heap. If the
size is not specified, the linker uses the size given by the min_size argument as defined for the heap
in the architecture definition. Normally the linker automatically tries to maximize the size, unless you
specified the keyword fixed.

group ( ... )
{

heap "myheap" ( size = 2k );
}

The linker creates two labels to mark the begin and end of the heap, __lc_ub_heap_name for the
begin of the heap and __lc_ue_heap_name for the end of the heap. The linker allocates space for
the heap when a reference to either of the section labels exists in one of the input object files.
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Reserved section

• The keyword reserved tells the linker to create an area or section of a given size. The linker will not
locate any other sections in the memory occupied by a reserved section, with some exceptions. Each
reserved section has a name. With the keyword size you can specify a size for a given reserved area
or section.

group ( ... )
{

reserved "myreserved" ( size = 2k );
}

The optional fill field contains a bit pattern that the linker writes to all memory addresses that remain
unoccupied during the locate process. The result of the expression, or list of expressions, is used as
values to write to memory, each in MAU. The first MAU of the fill pattern is always the first MAU in the
section.

By default, no sections can overlap with a reserved section.With alloc_allowed=absolute sections
that are located at an absolute address due to an absolute group restriction can overlap a reserved
section.The same applies for reserved sections with alloc_allowed=ranged set. Sections restricted
to a fixed address range can also overlap a reserved section.

With the attributes field you can set the access type of the reserved section. The linker locates the
reserved section in its space with the restrictions that follow from the used attributes, r, w or x or a valid
combination of them. The allowed attributes are shown in the following table. A value between < and
> in the table means this value is set automatically by the linker.

Resulting section propertiesProperties set in LSL

contentmemoryaccessfilledattributes

executable<rom>yesx

data<rom>ryesr

scratch<rom>rnor

executable<rom>ryesrx

data<ram>rwyesrw

scratch<ram>rwnorw

executable<ram>rwyesrwx

group ( ... )
{

reserved "myreserved" ( size = 2k, 
attributes = rw, fill = 0xaa );

}

If you do not specify any attributes, the linker will reserve the given number of maus, no matter what
type of memory lies beneath. If you do not specify a fill pattern, no section is generated.

The linker creates two labels to mark the begin and end of the section, __lc_ub_name for the begin
of the section and __lc_ue_name for the end of the reserved section.
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Output sections

• The keyword section tells the linker to accumulate sections obtained from object files ("input sections")
into an output section of a fixed size in the locate phase.You can select the input sections with select
statements.You can use groups inside output sections, but you can only set the align, attributes,
copy and load_addr properties and the load_addr property cannot have an address specified.

The fill field contains a bit pattern that the linker writes to all unused space in the output section.
When all input sections have an image (code/data) you must specify a fill pattern. If you do not specify
a fill pattern, all input sections must be scratch sections. The fill pattern is aligned at the start of the
output section.

As with a reserved section you can use the attributes field to set the access type of the output
section.

group ( ... )
{

section "myoutput" ( size = 4k, attributes = rw,
fill = 0xaa )

   {
select "myinput1";
select "myinput2";

   }
}

The available room for input sections is determined by the size, blocksize and overflow fields.
With the keyword size you specify the fixed size of the output section. Input sections are placed from
output section start towards higher addresses (offsets). When the end of the output section is reached
and one or more input sections are not yet placed, an error is emitted. If however, the overflow field
is set to another output section, remaining sections are located as if they were selected for the overflow
output section.

group ( ... )
{
section "tsk1_data" (size=4k, attributes=rw, fill=0,

                       overflow = "overflow_data")
  {
          select ".data.tsk1.*"
  }
section "tsk2_data" (size=4k, attributes=rw, fill=0,

overflow = "overflow_data")
  {
          select ".data.tsk2.*"
  }
section "overflow_data" (size=4k, attributes=rx,

                           fill=0)
  {
  }
}
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With the keyword blocksize , the size of the output section will adapt to the size of its content. For
example:

group flash_area (run_addr = 0x10000)
{

section "flash_code" (blocksize=4k, attributes=rx,
                         fill=0)
   {
     select "*.flash";
   }
}

If the content of the section is 1 mau, the size will be 4 kB, if the content is 11 kB, the section will be
12 kB, etc. If you use size in combination with blocksize, the size value is used as default (minimal)
size for this section. If it is omitted, the default size will be of blocksize. It is not allowed to omit both
size and blocksize from the section definition.

The linker creates two labels to mark the begin and end of the section, __lc_ub_name for the begin
of the section and __lc_ue_name for the end of the output section.

When the copy property is set on an enclosing group, a ROM copy is created for the output section
and the output section itself is made writable causing it to be located in RAM by default. For this to
work, the output section and its input sections must be read-only and the output section must have a
fill property.

Copy table

• The keyword copytable tells the linker to select a section that is used as copy table. The content of
the copy table is created by the linker. It contains the start address and length of all sections that should
be initialized by the startup code.

The linker creates two labels to mark the begin and end of the section, __lc_ub_table for the begin
of the section and __lc_ue_table for the end of the copy table. The linker generates a copy table
when a reference to either of the section labels exists in one of the input object files.

12.8.4. Creating Symbols

You can tell the linker to create symbols before locating by putting assignments in the section layout
definition. Symbol names are represented by double-quoted strings. Any string is allowed, but object files
may not support all characters for symbol names.You can use two different assignment operators. With
the simple assignment operator '=', the symbol is created unconditionally. With the ':=' operator, the
symbol is only created if it already exists as an undefined reference in an object file.

The expression that represents the value to assign to the symbol may contain references to other symbols.
If such a referred symbol is a special section symbol, creation of the symbol in the left hand side of the
assignment will cause creation of the special section.

section_layout 
{
   "__lc_bs" := "__lc_ub_stack";
    // when the symbol __lc_bs occurs as an undefined reference 
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    // in an object file, the linker allocates space for the stack
}

12.8.5. Conditional Group Statements

Within a group, you can conditionally select sections or create special sections.

• With the if keyword you can specify a condition. The succeeding section statement is executed if the
condition evaluates to TRUE (1).

• The optional else keyword is followed by a section statement which is executed in case the if-condition
evaluates to FALSE (0).

group ( ... )
{

if ( exists( "mysection" ) )
      select "mysection";

else
      reserved "myreserved" ( size=2k );
}
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Chapter 13. Debug Target Configuration Files
DTC files (Debug Target Configuration files) define all possible configurations for a debug target. A debug
target can be target hardware such as an evaluation board or a simulator. The DTC files are used by
Eclipse to configure the project and the debugger. The information is used by the Target Board
Configuration wizard and the debug configuration. DTC files are located in the etc directory of the installed
product and use .dtc as filename suffix.

Based on the DTC files, the Target Board Configuration wizard adjust the project's LSL file and creates
a debug launch configuration.

13.1. Custom Board Support

When you need support for a custom board and the board requires a different configuration than those
that are in the product, it is necessary to create a dedicated DTC file.

To add a custom board

1. From the etc directory of the product, make a copy of a .dtc file and put it in your project directory
(in the current workspace).

In Eclipse, the DTC file should now be visible as part of your project.

2. Edit the file and give it a name that reflects the custom board.

The Import Board Configuration wizard in Eclipse adds DTC files that are present in your current project
to the list of available target boards.

Syntax of a DTC file

DTC files are XML files and use the XML Schema file dtc.xsd, also present in the etc directory of the
installed product.

Inspect the DTC XML schema file dtc.xsd for a description of the allowed elements and the available
attributes. Use a delivered .dtc file as a starting point for creating a custom board specification.

Basically a DTC file consists of the definition of the debug target (debugTarget element) which embodies
one or more configurations (configuration element) and one or more communication methods
(communicationMethod element).

DTC macros in LSL

To protect wizards/dialogs from changing the LSL file, you can protect the LSL file by adding the macro
__DTC_IGNORE. This can be useful for projects that need the same LSL file, but still need to run on
different target boards.

#define __DTC_IGNORE
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13.2. Description of DTC Elements and Attributes

The following table contains a description of the DTC elements and attributes. For each element a list of
allowed elements is listed and the available attributes are described.

Allowed ElementsDescriptionElement / Attribute

flashChips, lsl,
communicationMethod,
def, processor,
resource, initialize

The debug target.debugTarget

The name of the configuration.name

The manufacturer of the debug target.manufacturer

-Defines a processor that can be present on
the debug target. Multiple processor definitions
are allowed. The user should select the actual
processor on the debug target.

processor

A descriptive name of the processor derivative.name

Defines the CPU name, as for example
supplied with the option --cpu of the control
program.

cpu

ref, resource, initialize,
configuration, lsl,
processor

Defines a communication method. A
communication method is the channel that is
used to communicate with the target.

communicationMethod

A descriptive name of the communication
method.

name

The debug instrument DLL/Shared library file
to be used for this communication method. Do
not supply a path or a filename suffix.

debugInstrument

This is the method used for communication.
Allowed values: rs232, tcpip, can, none

gdiMethod

lsl, resource, initialize,
ref, configuration,
flashMonitor

Defines a set of elements as a macro. The
macro can be expanded using the ref
element.

def

The macro name.id

-Defines a resource definition that can be used
by Eclipse, the debugger or by the debug
instrument.

resource

The identifier name used by the debugger or
debug instrument to retrieve the value.

id

The value assigned to the resource.value

-Reference to a macro defined with a def
element. The elements contained in the def
element with the same name will be expanded
at the location of the ref. Multiple refs to the
same def are allowed.

ref
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Allowed ElementsDescriptionElement / Attribute

The name of the referenced macro.id

ref, initialize, resource,
lsl, flashMonitor,
processor

Defines a configuration.configuration

The descriptive name of the configuration.name

-This element defines an initialization
expression. Each initialize element contains a
resourceId attribute. If the DI requests this
resource the debugger will compose a string
from all initialize elements with the same
resourceId. This DI can use this string to
initialize registers by passing it to the debugger
as an expression to be evaluated.

initialize

The name of the resource to be used.resourceId

The name of the register to be initialized.name

When the cstart attribute is false, this is the
value to be used, otherwise, it is the default
value when using this configuration. It will be
used by the startup code editor to set the
default register values.

value

A boolean value. If true the debugger should
ask the C startup code editor for the value,
otherwise the contents of the value attribute is
used. The default value is true.

cstart

-This element specifies the flash programming
monitor to be used for this configuration.

flashMonitor

Filename of the monitor, usually an Intel Hex
or S-Record file.

monitor

The address of the workspace of the flash
programming monitor.

workspaceAddress

Specifies the buffer size for buffering a flash
sector.

flashSectorBufferSize

debugTargetThis element defines a flash chip. It must be
used by the flash properties page to add it on
request to the list of flash chips.

chip

The vendor of this flash chip.vendor

The name of the chip.chip

The width of the chip in bits.width

The number of chips present on the board.chips

The base address of the chip.baseAddress

The size of the chip in bytes.chipSize
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Allowed ElementsDescriptionElement / Attribute

chipSpecify a list of flash chips that can be
available on this debug target.

flashChips

-Defines LSL pieces belonging to the
configuration part. The LSL text must be
defined between the start and end tag of this
element. All LSL texts of the active selection
will be placed in the project's LSL file.

lsl
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Chapter 14. CERT C Secure Coding Standard
The CERT C Secure Coding Standard provides rules and recommendations for secure coding in the C
programming language. The goal of these rules and recommendations is to eliminate insecure coding
practices and undefined behaviors that can lead to exploitable vulnerabilities.The application of the secure
coding standard will lead to higher-quality systems that are robust and more resistant to attack.

This chapter contains an overview of the CERT C Secure Coding Standard recommendations and rules
that are supported by the TASKING VX-toolset.

For details see the CERT C Secure Coding Standard web site. For general information about CERT
secure coding, see www.cert.org/secure-coding.

Identifiers

Each rule and recommendation is given a unique identifier. These identifiers consist of three parts:

• a three-letter mnemonic representing the section of the standard

• a two-digit numeric value in the range of 00-99

• the letter "C" indicates that this is a C language guideline

The three-letter mnemonic is used to group similar coding practices and to indicate to which category a
coding practice belongs.

The numeric value is used to give each coding practice a unique identifier. Numeric values in the range
of 00-29 are reserved for recommendations, while values in the range of 30-99 are reserved for rules.

C compiler invocation

With the C compiler option --cert you can enable one or more checks for the CERT C Secure Coding
Standard recommendations/rules. With --diag=cert you can see a list of the available checks, or you can
use a three-letter mnemonic to list only the checks in a particular category. For example, --diag=pre lists
all supported checks in the preprocessor category.

14.1. Preprocessor (PRE)

Use parentheses within macros around parameter names

Parenthesize all parameter names in macro definitions to avoid precedence problems.

PRE01-C
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Macro replacement lists should be parenthesized

Macro replacement lists should be parenthesized to protect any lower-precedence operators
from the surrounding expression. The example below is syntactically correct, although the
!= operator was omitted. Enclosing the constant -1 in parenthesis will prevent the incorrect
interpretation and force a compiler error:

#define EOF -1  // should be (-1)
int getchar(void);
void f(void)
{
  if (getchar() EOF) // != operator omitted
  {
    /* ... */
  }
}

PRE02-C

Wrap multi-statement macros in a do-while loop

When multiple statements are used in a macro, enclose them in a do-while statement, so
the macro can appear safely inside if clauses or other places that expect a single statement
or a statement block. Braces alone will not work in all situations, as the macro expansion is
typically followed by a semicolon.

PRE10-C

Do not conclude a single statement macro definition with a semicolon

Macro definitions consisting of a single statement should not conclude with a semicolon. If
required, the semicolon should be included following the macro expansion. Inadvertently
inserting a semicolon can change the control flow of the program.

PRE11-C

14.2. Declarations and Initialization (DCL)

Declare objects with appropriate storage durations

The lifetime of an automatic object ends when the function returns, which means that a
pointer to the object becomes invalid.

DCL30-C

Declare identifiers before using them

The ISO C90 standard allows implicit typing of variables and functions. Because implicit
declarations lead to less stringent type checking, they can often introduce unexpected and
erroneous behavior or even security vulnerabilities. The ISO C99 standard requires type
identifiers and forbids implicit function declarations. For backwards compatibility reasons,
the VX-toolset C compiler assumes an implicit declaration and continues translation after
issuing a warning message (W505 or W535).

DCL31-C
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Guarantee that mutually visible identifiers are unique

The compiler encountered two or more identifiers that are identical in the first 31 characters.
The ISO C99 standard allows a compiler to ignore characters past the first 31 in an identifier.
Two distinct identifiers that are identical in the first 31 characters may lead to problems when
the code is ported to a different compiler.

DCL32-C

Do not invoke a function using a type that does not match the function definition

This warning is generated when a function pointer is set to refer to a function of an
incompatible type. Calling this function through the function pointer will result in undefined
behavior. Example:

void my_function(int a);
int main(void)
{
  int (*new_function)(int a) = my_function;
  return (*new_function)(10); /* the behavior is undefined */
}

DCL35-C

14.3. Expressions (EXP)

Do not take the size of a pointer to determine the size of the pointed-to type

The size of the object(s) allocated by malloc(), calloc() or realloc() should be a multiple of
the size of the base type of the result pointer. Therefore, the sizeof expression should be
applied to this base type, and not to the pointer type.

EXP01-C

Do not ignore values returned by functions

The compiler gives this warning when the result of a function call is ignored at some place,
although it is not ignored for other calls to this function. This warning will not be issued when
the function result is ignored for all calls, or when the result is explicitly ignored with a (void)
cast.

EXP12-C

Do not depend on order of evaluation between sequence points

Between two sequence points, an object should only be modified once. Otherwise the behavior
is undefined.

EXP30-C

Do not access a volatile object through a non-volatile reference

If an attempt is made to refer to an object defined with a volatile-qualified type through use
of an lvalue with non-volatile-qualified type, the behavior is undefined.

EXP32-C

Do not reference uninitialized memory

Uninitialized automatic variables default to whichever value is currently stored on the stack
or in the register allocated for the variable. Consequently, uninitialized memory can cause a
program to behave in an unpredictable or unplanned manner and may provide an avenue
for attack.

EXP33-C
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Ensure a null pointer is not dereferenced

Attempting to dereference a null pointer results in undefined behavior, typically abnormal
program termination.

EXP34-C

Call functions with the arguments intended by the API

When a function is properly declared with function prototype information, an incorrect call
will be flagged by the compiler. When there is no prototype information available at the call,
the compiler cannot check the number of arguments and the types of the arguments. This
message is issued to warn about this situation.

EXP37-C

Do not call offsetof() on bit-field members or invalid types

The behavior of the offsetof() macro is undefined when the member designator parameter
designates a bit-field.

EXP38-C

14.4. Integers (INT)

Ensure that unsigned integer operations do not wrap

A constant with an unsigned integer type is truncated, resulting in a wrap-around.

INT30-C

Do not shift a negative number of bits or more bits than exist in the operand

The shift count of the shift operation may be negative or greater than or equal to the size of
the left operand. According to the C standard, the behavior of such a shift operation is
undefined. Make sure the shift count is in range by adding appropriate range checks.

INT34-C

Evaluate integer expressions in a larger size before comparing or assigning to that size

If an integer expression is compared to, or assigned to a larger integer size, that integer
expression should be evaluated in that larger size by explicitly casting one of the operands.

INT35-C

14.5. Floating Point (FLP)

Do not use floating point variables as loop counters

To avoid problems with limited precision and rounding, floating point variables should not be
used as loop counters.

FLP30-C

Take granularity into account when comparing floating point values

Floating point arithmetic in C is inexact, so floating point values should not be tested for exact
equality or inequality.

FLP35-C

Beware of precision loss when converting integral types to floating point

Conversion from integral types to floating point types without sufficient precision can lead to
loss of precision.

FLP36-C
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14.6. Arrays (ARR)

Do not apply the sizeof operator to a pointer when taking the size of an array

A function parameter declared as an array, is converted to a pointer by the compiler.Therefore,
the sizeof operator applied to this parameter yields the size of a pointer, and not the size of
an array.

ARR01-C

Ensure that array types in expressions are compatible

Using two or more incompatible arrays in an expression results in undefined behavior.

ARR34-C

Do not allow loops to iterate beyond the end of an array

Reading or writing of data outside the bounds of an array may lead to incorrect program
behavior or execution of arbitrary code.

ARR35-C

14.7. Characters and Strings (STR)

Do not attempt to modify string literals

Writing to a string literal has undefined behavior, as identical strings may be shared and/or
allocated in read-only memory.

STR30-C

Size wide character strings correctly

Wide character strings may be improperly sized when they are mistaken for narrow strings
or for multi-byte character strings.

STR33-C

Cast characters to unsigned types before converting to larger integer sizes

A signed character is sign-extended to a larger signed integer value. Use an explicit cast, or
cast the value to an unsigned type first, to avoid unexpected sign-extension.

STR34-C

Do not specify the bound of a character array initialized with a string literal

The compiler issues this warning when the character buffer initialized by a string literal does
not provide enough room for the terminating null character.

STR36-C

14.8. Memory Management (MEM)

Allocate and free memory in the same module, at the same level of abstraction

The compiler issues this warning when the result of the call to malloc(), calloc() or realloc()
is discarded, and therefore not free()d, resulting in a memory leak.

MEM00-C

Use realloc() only to resize dynamically allocated arrays

Only use realloc() to resize an array. Do not use it to transform an object to an object of a
different type.

MEM08-C
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Do not access freed memory

When memory is freed, its contents may remain intact and accessible because it is at the
memory manager's discretion when to reallocate or recycle the freed chunk. The data at the
freed location may appear valid. However, this can change unexpectedly, leading to
unintended program behavior. As a result, it is necessary to guarantee that memory is not
written to or read from once it is freed.

MEM30-C

Free dynamically allocated memory exactly once

Freeing memory multiple times has similar consequences to accessing memory after it is
freed. The underlying data structures that manage the heap can become corrupted. To
eliminate double-free vulnerabilities, it is necessary to guarantee that dynamic memory is
freed exactly once.

MEM31-C

Detect and handle memory allocation errors

The result of realloc() is assigned to the original pointer, without checking for failure. As a
result, the original block of memory is lost when realloc() fails.

MEM32-C

Use the correct syntax for flexible array members

Use the ISO C99 syntax for flexible array members instead of an array member of size 1.

MEM33-C

Only free memory allocated dynamically

Freeing memory that is not allocated dynamically can lead to corruption of the heap data
structures.

MEM34-C

Allocate sufficient memory for an object

The compiler issues this warning when the size of the object(s) allocated by malloc(), calloc()
or realloc() is smaller than the size of an object pointed to by the result pointer. This may be
caused by a sizeof expression with the wrong type or with a pointer type instead of the object
type.

MEM35-C

14.9. Environment (ENV)

All atexit handlers must return normally

The compiler issues this warning when an atexit() handler is calling a function that does not
return. No atexit() registered handler should terminate in any way other than by returning.

ENV32-C

14.10. Signals (SIG)

Call only asynchronous-safe functions within signal handlersSIG30-C

Do not call longjmp() from inside a signal handler

Invoking the longjmp() function from within a signal handler can lead to undefined behavior
if it results in the invocation of any non-asynchronous-safe functions, likely compromising
the integrity of the program.

SIG32-C
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14.11. Miscellaneous (MSC)

Ensure your random number generator is properly seeded

Ensure that the random number generator is properly seeded by calling srand().

MSC32-C
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Chapter 15. MISRA-C Rules
This chapter contains an overview of the supported and unsupported MISRA C rules.

15.1. MISRA-C:1998

This section lists all supported and unsupported MISRA-C:1998 rules.

See also Section 3.7.2, C Code Checking: MISRA-C.

A number of MISRA-C rules leave room for interpretation. Other rules can only be checked in a limited
way. In such cases the implementation decisions and possible restrictions for these rules are listed.

x means that the rule is not supported by the TASKING C compiler. (R) is a required rule, (A) is an advisory
rule.

The code shall conform to standard C, without language extensions.(R)1.

Other languages should only be used with an interface standard.(A)2.x

Inline assembly is only allowed in dedicated C functions.(A)3.

Provision should be made for appropriate run-time checking.(A)4.x

Only use characters and escape sequences defined by ISO C.(R)5.

Character values shall be restricted to a subset of ISO 106460-1.(R)6.x

Trigraphs shall not be used.(R)7.

Multibyte characters and wide string literals shall not be used.(R)8.

Comments shall not be nested.(R)9.

Sections of code should not be "commented out".

In general, it is not possible to decide whether a piece of comment is C code that is
commented out, or just some pseudo code. Instead, the following heuristics are used
to detect possible C code inside a comment:

• a line ends with ';', or

• a line starts with '}', possibly preceded by white space

(A)10.

Identifiers shall not rely on significance of more than 31 characters.(R)11.

The same identifier shall not be used in multiple name spaces.(A)12.

Specific-length typedefs should be used instead of the basic types.(A)13.

Use unsigned char or signed char instead of plain char.(R)14.

Floating-point implementations should comply with a standard.(A)15.x

The bit representation of floating-point numbers shall not be used.
A violation is reported when a pointer to a floating-point type is converted to a pointer
to an integer type.

(R)16.
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typedef names shall not be reused.(R)17.

Numeric constants should be suffixed to indicate type.
A violation is reported when the value of the constant is outside the range indicated
by the suffixes, if any.

(A)18.

Octal constants (other than zero) shall not be used.(R)19.

All object and function identifiers shall be declared before use.(R)20.

Identifiers shall not hide identifiers in an outer scope.(R)21.

Declarations should be at function scope where possible.(A)22.

All declarations at file scope should be static where possible.(A)23.x

Identifiers shall not have both internal and external linkage.(R)24.

Identifiers with external linkage shall have exactly one definition.(R)25.x

Multiple declarations for objects or functions shall be compatible.(R)26.

External objects should not be declared in more than one file.(A)27.x

The register storage class specifier should not be used.(A)28.

The use of a tag shall agree with its declaration.(R)29.

All automatics shall be initialized before being used .
This rule is checked using worst-case assumptions. This means that violations are
reported not only for variables that are guaranteed to be uninitialized, but also for
variables that are uninitialized on some execution paths.

(R)30.

Braces shall be used in the initialization of arrays and structures.(R)31.

Only the first, or all enumeration constants may be initialized.(R)32.

The right hand operand of && or || shall not contain side effects.(R)33.

The operands of a logical && or || shall be primary expressions.(R)34.

Assignment operators shall not be used in Boolean expressions.(R)35.

Logical operators should not be confused with bitwise operators.(A)36.

Bitwise operations shall not be performed on signed integers.(R)37.

A shift count shall be between 0 and the operand width minus 1.
This violation will only be checked when the shift count evaluates to a constant value
at compile time.

(R)38.

The unary minus shall not be applied to an unsigned expression.(R)39.

sizeof should not be used on expressions with side effects.(A)40.

The implementation of integer division should be documented.(A)41.x

The comma operator shall only be used in a for condition.(R)42.

Don't use implicit conversions which may result in information loss.(R)43.

Redundant explicit casts should not be used.(A)44.

Type casting from any type to or from pointers shall not be used.(R)45.
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The value of an expression shall be evaluation order independent.
This rule is checked using worst-case assumptions. This means that a violation will
be reported when a possible alias may cause the result of an expression to be
evaluation order dependent.

(R)46.

No dependence should be placed on operator precedence rules.(A)47.

Mixed arithmetic should use explicit casting.(A)48.

Tests of a (non-Boolean) value against 0 should be made explicit.(A)49.

F.P. variables shall not be tested for exact equality or inequality.(R)50.

Constant unsigned integer expressions should not wrap-around.(A)51.

There shall be no unreachable code.(R)52.

All non-null statements shall have a side-effect.(R)53.

A null statement shall only occur on a line by itself.(R)54.

Labels should not be used.(A)55.

The goto statement shall not be used.(R)56.

The continue statement shall not be used.(R)57.

The break statement shall not be used (except in a switch).(R)58.

An if or loop body shall always be enclosed in braces.(R)59.

All if, else if constructs should contain a final else.(A)60.

Every non-empty case clause shall be terminated with a break.(R)61.

All switch statements should contain a final default case.(R)62.

A switch expression should not represent a Boolean case.(A)63.

Every switch shall have at least one case.(R)64.

Floating-point variables shall not be used as loop counters.(R)65.

A for should only contain expressions concerning loop control.
A violation is reported when the loop initialization or loop update expression modifies
an object that is not referenced in the loop test.

(A)66.

Iterator variables should not be modified in a for loop.(A)67.

Functions shall always be declared at file scope.(R)68.

Functions with variable number of arguments shall not be used.(R)69.

Functions shall not call themselves, either directly or indirectly.
A violation will be reported for direct or indirect recursive function calls in the source
file being checked. Recursion via functions in other source files, or recursion via
function pointers is not detected.

(R)70.

Function prototypes shall be visible at the definition and call.(R)71.

The function prototype of the declaration shall match the definition.(R)72.

Identifiers shall be given for all prototype parameters or for none.(R)73.

Parameter identifiers shall be identical for declaration/definition.(R)74.

Every function shall have an explicit return type.(R)75.
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Functions with no parameters shall have a void parameter list.(R)76.

An actual parameter type shall be compatible with the prototype.(R)77.

The number of actual parameters shall match the prototype.(R)78.

The values returned by void functions shall not be used.(R)79.

Void expressions shall not be passed as function parameters.(R)80.

const should be used for reference parameters not modified.(A)81.

A function should have a single point of exit.(A)82.

Every exit point shall have a return of the declared return type.(R)83.

For void functions, return shall not have an expression.(R)84.

Function calls with no parameters should have empty parentheses.(A)85.

If a function returns error information, it should be tested.
A violation is reported when the return value of a function is ignored.

(A)86.

#include shall only be preceded by other directives or comments.(R)87.

Non-standard characters shall not occur in #include directives.(R)88.

#include shall be followed by either <filename> or "filename".(R)89.

Plain macros shall only be used for constants/qualifiers/specifiers.(R)90.

Macros shall not be #define'd and #undef'd within a block.(R)91.

#undef should not be used.(A)92.

A function should be used in preference to a function-like macro.(A)93.

A function-like macro shall not be used without all arguments.(R)94.

Macro arguments shall not contain pre-preprocessing directives.
A violation is reported when the first token of an actual macro argument is '#'.

(R)95.

Macro definitions/parameters should be enclosed in parentheses.(R)96.

Don't use undefined identifiers in pre-processing directives.(A)97.

A macro definition shall contain at most one # or ## operator.(R)98.

All uses of the #pragma directive shall be documented.
This rule is really a documentation issue.The compiler will flag all #pragma directives
as violations.

(R)99.

defined shall only be used in one of the two standard forms.(R)100.

Pointer arithmetic should not be used.(A)101.

No more than 2 levels of pointer indirection should be used.
A violation is reported when a pointer with three or more levels of indirection is
declared.

(A)102.

No relational operators between pointers to different objects.
In general, checking whether two pointers point to the same object is impossible.The
compiler will only report a violation for a relational operation with incompatible pointer
types.

(R)103.

Non-constant pointers to functions shall not be used.(R)104.

Functions assigned to the same pointer shall be of identical type.(R)105.
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Automatic address may not be assigned to a longer lived object.(R)106.

The null pointer shall not be de-referenced.
A violation is reported for every pointer dereference that is not guarded by a NULL
pointer test.

(R)107.

All struct/union members shall be fully specified.(R)108.

Overlapping variable storage shall not be used.
A violation is reported for every union declaration.

(R)109.

Unions shall not be used to access the sub-parts of larger types.
A violation is reported for a union containing a struct member.

(R)110.

Bit-fields shall have type unsigned int or signed int.(R)111.

Bit-fields of type signed int shall be at least 2 bits long.(R)112.

All struct/union members shall be named.(R)113.

Reserved and standard library names shall not be redefined.(R)114.

Standard library function names shall not be reused.(R)115.

Production libraries shall comply with the MISRA C restrictions.(R)116.x

The validity of library function parameters shall be checked.(R)117.x

Dynamic heap memory allocation shall not be used.(R)118.

The error indicator errno shall not be used.(R)119.

The macro offsetof shall not be used.(R)120.

<locale.h> and the setlocale function shall not be used.(R)121.

The setjmp and longjmp functions shall not be used.(R)122.

The signal handling facilities of <signal.h> shall not be used.(R)123.

The <stdio.h> library shall not be used in production code.(R)124.

The functions atof/atoi/atol shall not be used.(R)125.

The functions abort/exit/getenv/system shall not be used.(R)126.

The time handling functions of library <time.h> shall not be used.(R)127.

15.2. MISRA-C:2004

This section lists all supported and unsupported MISRA-C:2004 rules.

See also Section 3.7.2, C Code Checking: MISRA-C.

A number of MISRA-C rules leave room for interpretation. Other rules can only be checked in a limited
way. In such cases the implementation decisions and possible restrictions for these rules are listed.

x means that the rule is not supported by the TASKING C compiler. (R) is a required rule, (A) is an advisory
rule.
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Environment

All code shall conform to ISO 9899:1990 "Programming languages - C", amended
and corrected by ISO/IEC 9899/COR1:1995, ISO/IEC 9899/AMD1:1995, and ISO/IEC
9899/COR2:1996.

(R)1.1

No reliance shall be placed on undefined or unspecified behavior.(R)1.2

Multiple compilers and/or languages shall only be used if there is a common defined
interface standard for object code to which the languages/compilers/assemblers
conform.

(R)1.3x

The compiler/linker shall be checked to ensure that 31 character significance and
case sensitivity are supported for external identifiers.

(R)1.4x

Floating-point implementations should comply with a defined floating-point standard.(A)1.5x

Language extensions

Assembly language shall be encapsulated and isolated.(R)2.1

Source code shall only use /* ... */ style comments.(R)2.2

The character sequence /* shall not be used within a comment.(R)2.3

Sections of code should not be "commented out". In general, it is not possible to
decide whether a piece of comment is C code that is commented out, or just some
pseudo code. Instead, the following heuristics are used to detect possible C code
inside a comment: - a line ends with ';', or - a line starts with '}', possibly preceded by
white space

(A)2.4

Documentation

All usage of implementation-defined behavior shall be documented.(R)3.1x

The character set and the corresponding encoding shall be documented.(R)3.2x

The implementation of integer division in the chosen compiler should be determined,
documented and taken into account.

(A)3.3x

All uses of the #pragma directive shall be documented and explained. This rule is
really a documentation issue. The compiler will flag all #pragma directives as
violations.

(R)3.4

The implementation-defined behavior and packing of bit-fields shall be documented
if being relied upon.

(R)3.5

All libraries used in production code shall be written to comply with the provisions of
this document, and shall have been subject to appropriate validation.

(R)3.6x

Character sets

Only those escape sequences that are defined in the ISO C standard shall be used.(R)4.1

Trigraphs shall not be used.(R)4.2
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Identifiers

Identifiers (internal and external) shall not rely on the significance of more than 31
characters.

(R)5.1

Identifiers in an inner scope shall not use the same name as an identifier in an outer
scope, and therefore hide that identifier.

(R)5.2

A typedef name shall be a unique identifier.(R)5.3

A tag name shall be a unique identifier.(R)5.4

No object or function identifier with static storage duration should be reused.(A)5.5

No identifier in one name space should have the same spelling as an identifier in
another name space, with the exception of structure and union member names.

(A)5.6

No identifier name should be reused.(A)5.7

Types

The plain char type shall be used only for storage and use of character values.(R)6.1

signed and unsigned char type shall be used only for the storage and use of
numeric values.

(R)6.2

typedefs that indicate size and signedness should be used in place of the basic
types.

(A)6.3

Bit-fields shall only be defined to be of type unsigned int or signed int.(R)6.4

Bit-fields of type signed int shall be at least 2 bits long.(R)6.5

Constants

Octal constants (other than zero) and octal escape sequences shall not be used.(R)7.1

Declarations and definitions

Functions shall have prototype declarations and the prototype shall be visible at both
the function definition and call.

(R)8.1

Whenever an object or function is declared or defined, its type shall be explicitly
stated.

(R)8.2

For each function parameter the type given in the declaration and definition shall be
identical, and the return types shall also be identical.

(R)8.3

If objects or functions are declared more than once their types shall be compatible.(R)8.4

There shall be no definitions of objects or functions in a header file.(R)8.5

Functions shall be declared at file scope.(R)8.6

Objects shall be defined at block scope if they are only accessed from within a single
function.

(R)8.7

An external object or function shall be declared in one and only one file.(R)8.8

589

MISRA-C Rules



An identifier with external linkage shall have exactly one external definition.(R)8.9

All declarations and definitions of objects or functions at file scope shall have internal
linkage unless external linkage is required.

(R)8.10x

The static storage class specifier shall be used in definitions and declarations of
objects and functions that have internal linkage.

(R)8.11

When an array is declared with external linkage, its size shall be stated explicitly or
defined implicitly by initialization.

(R)8.12

Initialization

All automatic variables shall have been assigned a value before being used.This rule
is checked using worst-case assumptions. This means that violations are reported
not only for variables that are guaranteed to be uninitialized, but also for variables
that are uninitialized on some execution paths.

(R)9.1

Braces shall be used to indicate and match the structure in the non-zero initialization
of arrays and structures.

(R)9.2

In an enumerator list, the "=" construct shall not be used to explicitly initialize members
other than the first, unless all items are explicitly initialized.

(R)9.3

Arithmetic type conversions

The value of an expression of integer type shall not be implicitly converted to a different
underlying type if:
a) it is not a conversion to a wider integer type of the same signedness, or
b) the expression is complex, or
c) the expression is not constant and is a function argument, or
d) the expression is not constant and is a return expression.

(R)10.1

The value of an expression of floating type shall not be implicitly converted to a
different type if:
a) it is not a conversion to a wider floating type, or
b) the expression is complex, or
c) the expression is a function argument, or
d) the expression is a return expression.

(R)10.2

The value of a complex expression of integer type may only be cast to a type of the
same signedness that is no wider than the underlying type of the expression.

(R)10.3

The value of a complex expression of floating type may only be cast to a type that is
no wider than the underlying type of the expression.

(R)10.4

If the bitwise operators ~ and << are applied to an operand of underlying type
unsigned char or unsigned short, the result shall be immediately cast to the
underlying type of the operand.

(R)10.5

A "U" suffix shall be applied to all constants of unsigned type.(R)10.6
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Pointer type conversions

Conversions shall not be performed between a pointer to a function and any type
other than an integral type.

(R)11.1

Conversions shall not be performed between a pointer to object and any type other
than an integral type, another pointer to object type or a pointer to void.

(R)11.2

A cast should not be performed between a pointer type and an integral type.(A)11.3

A cast should not be performed between a pointer to object type and a different pointer
to object type.

(A)11.4

A cast shall not be performed that removes any const or volatile qualification
from the type addressed by a pointer.

(R)11.5

Expressions

Limited dependence should be placed on C's operator precedence rules in
expressions.

(A)12.1

The value of an expression shall be the same under any order of evaluation that the
standard permits. This rule is checked using worst-case assumptions. This means
that a violation will be reported when a possible alias may cause the result of an
expression to be evaluation order dependent.

(R)12.2

The sizeof operator shall not be used on expressions that contain side effects.(R)12.3

The right-hand operand of a logical && or || operator shall not contain side effects.(R)12.4

The operands of a logical && or || shall be primary-expressions.(R)12.5

The operands of logical operators (&&, || and !) should be effectively Boolean.
Expressions that are effectively Boolean should not be used as operands to operators
other than (&&, || and !).

(A)12.6

Bitwise operators shall not be applied to operands whose underlying type is signed.(R)12.7

The right-hand operand of a shift operator shall lie between zero and one less than
the width in bits of the underlying type of the left-hand operand.This violation will only
be checked when the shift count evaluates to a constant value at compile time.

(R)12.8

The unary minus operator shall not be applied to an expression whose underlying
type is unsigned.

(R)12.9

The comma operator shall not be used.(R)12.10

Evaluation of constant unsigned integer expressions should not lead to wrap-around.(A)12.11

The underlying bit representations of floating-point values shall not be used. A violation
is reported when a pointer to a floating-point type is converted to a pointer to an
integer type.

(R)12.12

The increment (++) and decrement (--) operators should not be mixed with other
operators in an expression.

(A)12.13

Control statement expressions

Assignment operators shall not be used in expressions that yield a Boolean value.(R)13.1
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Tests of a value against zero should be made explicit, unless the operand is effectively
Boolean.

(A)13.2

Floating-point expressions shall not be tested for equality or inequality.(R)13.3

The controlling expression of a for statement shall not contain any objects of floating
type.

(R)13.4

The three expressions of a for statement shall be concerned only with loop control.
A violation is reported when the loop initialization or loop update expression modifies
an object that is not referenced in the loop test.

(R)13.5

Numeric variables being used within a for loop for iteration counting shall not be
modified in the body of the loop.

(R)13.6

Boolean operations whose results are invariant shall not be permitted.(R)13.7

Control flow

There shall be no unreachable code.(R)14.1

All non-null statements shall either:
a) have at least one side effect however executed, or
b) cause control flow to change.

(R)14.2

Before preprocessing, a null statement shall only occur on a line by itself; it may be
followed by a comment provided that the first character following the null statement
is a white-space character.

(R)14.3

The goto statement shall not be used.(R)14.4

The continue statement shall not be used.(R)14.5

For any iteration statement there shall be at most one break statement used for loop
termination.

(R)14.6

A function shall have a single point of exit at the end of the function.(R)14.7

The statement forming the body of a switch, while, do ... while or for
statement be a compound statement.

(R)14.8

An if (expression) construct shall be followed by a compound statement. The
else keyword shall be followed by either a compound statement, or another if
statement.

(R)14.9

All if ... else if constructs shall be terminated with an else clause.(R)14.10

Switch statements

A switch label shall only be used when the most closely-enclosing compound statement
is the body of a switch statement.

(R)15.1

An unconditional break statement shall terminate every non-empty switch clause.(R)15.2

The final clause of a switch statement shall be the default clause.(R)15.3

A switch expression shall not represent a value that is effectively Boolean.(R)15.4

Every switch statement shall have at least one case clause.(R)15.5
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Functions

Functions shall not be defined with variable numbers of arguments.(R)16.1

Functions shall not call themselves, either directly or indirectly. A violation will be
reported for direct or indirect recursive function calls in the source file being checked.
Recursion via functions in other source files, or recursion via function pointers is not
detected.

(R)16.2

Identifiers shall be given for all of the parameters in a function prototype declaration.(R)16.3

The identifiers used in the declaration and definition of a function shall be identical.(R)16.4

Functions with no parameters shall be declared with parameter type void.(R)16.5

The number of arguments passed to a function shall match the number of parameters.(R)16.6

A pointer parameter in a function prototype should be declared as pointer to const
if the pointer is not used to modify the addressed object.

(A)16.7

All exit paths from a function with non-void return type shall have an explicit return
statement with an expression.

(R)16.8

A function identifier shall only be used with either a preceding &, or with a
parenthesized parameter list, which may be empty.

(R)16.9

If a function returns error information, then that error information shall be tested. A
violation is reported when the return value of a function is ignored.

(R)16.10

Pointers and arrays

Pointer arithmetic shall only be applied to pointers that address an array or array
element.

(R)17.1x

Pointer subtraction shall only be applied to pointers that address elements of the
same array.

(R)17.2x

>, >=, <, <= shall not be applied to pointer types except where they point to the same
array. In general, checking whether two pointers point to the same object is impossible.
The compiler will only report a violation for a relational operation with incompatible
pointer types.

(R)17.3

Array indexing shall be the only allowed form of pointer arithmetic.(R)17.4

The declaration of objects should contain no more than 2 levels of pointer indirection.
A violation is reported when a pointer with three or more levels of indirection is
declared.

(A)17.5

The address of an object with automatic storage shall not be assigned to another
object that may persist after the first object has ceased to exist.

(R)17.6

Structures and unions

All structure or union types shall be complete at the end of a translation unit.(R)18.1

An object shall not be assigned to an overlapping object.(R)18.2

An area of memory shall not be reused for unrelated purposes.(R)18.3x
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Unions shall not be used.(R)18.4

Preprocessing directives

#include statements in a file should only be preceded by other preprocessor
directives or comments.

(A)19.1

Non-standard characters should not occur in header file names in #include
directives.

(A)19.2

The #include directive shall be followed by either a <filename> or "filename"
sequence.

(R)19.3x

C macros shall only expand to a braced initializer, a constant, a parenthesized
expression, a type qualifier, a storage class specifier, or a do-while-zero construct.

(R)19.4

Macros shall not be #define'd or #undef'd within a block.(R)19.5

#undef shall not be used.(R)19.6

A function should be used in preference to a function-like macro.(A)19.7

A function-like macro shall not be invoked without all of its arguments.(R)19.8

Arguments to a function-like macro shall not contain tokens that look like preprocessing
directives. A violation is reported when the first token of an actual macro argument
is '#'.

(R)19.9

In the definition of a function-like macro each instance of a parameter shall be enclosed
in parentheses unless it is used as the operand of # or ##.

(R)19.10

All macro identifiers in preprocessor directives shall be defined before use, except in
#ifdef and #ifndef preprocessor directives and the defined() operator.

(R)19.11

There shall be at most one occurrence of the # or ## preprocessor operators in a
single macro definition.

(R)19.12

The # and ## preprocessor operators should not be used.(A)19.13

The defined preprocessor operator shall only be used in one of the two standard
forms.

(R)19.14

Precautions shall be taken in order to prevent the contents of a header file being
included twice.

(R)19.15

Preprocessing directives shall be syntactically meaningful even when excluded by
the preprocessor.

(R)19.16

All #else, #elif and #endif preprocessor directives shall reside in the same file
as the #if or #ifdef directive to which they are related.

(R)19.17

Standard libraries

Reserved identifiers, macros and functions in the standard library, shall not be defined,
redefined or undefined.

(R)20.1

The names of standard library macros, objects and functions shall not be reused.(R)20.2

The validity of values passed to library functions shall be checked.(R)20.3x
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Dynamic heap memory allocation shall not be used.(R)20.4

The error indicator errno shall not be used.(R)20.5

The macro offsetof, in library <stddef.h>, shall not be used.(R)20.6

The setjmp macro and the longjmp function shall not be used.(R)20.7

The signal handling facilities of <signal.h> shall not be used.(R)20.8

The input/output library <stdio.h> shall not be used in production code.(R)20.9

The library functions atof, atoi and atol from library <stdlib.h> shall not be
used.

(R)20.10

The library functions abort, exit, getenv and system from library <stdlib.h>
shall not be used.

(R)20.11

The time handling functions of library <time.h> shall not be used.(R)20.12

Run-time failures

Minimization of run-time failures shall be ensured by the use of at least one of:
a) static analysis tools/techniques;
b) dynamic analysis tools/techniques;
c) explicit coding of checks to handle run-time faults.

(R)21.1x
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Chapter 16. Migrating from the Classic Tool
Chain to the VX-toolset
The technology used for the tools in the TASKING VX-toolset for LC87 is completely different than the
technology used for the tools in the classic toolset. The VX-toolset is based on the latest TASKING
technology which makes it possible to achieve the significant optimization improvements and additional
features such as ISO C99 compliance, CERT, MISRA-C 2004 and profiling. Several features have been
made more consistent than in the classic toolset.

A drawback of these changes is that both toolsets are not fully compatible, and that existing projects will
have to be migrated.The effort needed for such migration depends on the project structure. For example,
if a project relies on compiler internals such as a calling convention, work is required to change this code.

This chapter describes how to migrate from the classic LC87K toolset to the TASKING VX-toolset for
LC87. Also the differences between the C compiler and assembler in the classic LC87K toolset and the
TASKING VX-toolset for LC87 are described.

16.1. C Compiler Migration

This section describes the migration of the C compiler options, pragmas, calling convention, memory
models, language extensions and preprocessor symbols.

16.1.1. C Compiler Options

The following table shows the options of the classic LC87K C compiler and the possible equivalents in
the new TASKING VX-toolset for LC87 C compiler.

RemarksVX-toolset C CompilerClassic C Compiler

-?-?

Flags are different-A[flag...]-A[flag...]

Character arithmetic cannot be disabled-Ac

-Ad

Shift JIS Kanji support in strings-Ak-Aj

New keywords do not need to be disabled because
of double underscore

-Ak

Identifiers are unique up to 100 characters-Al

-Ap-Ap

Wide character support is present in wchar.h and
wctype.h

-Aq

-As

-At

-Au
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RemarksVX-toolset C CompilerClassic C Compiler

-Ag-Av

-Ax-Ax

There are currently no silicon bug workarounds
implemented. Note that if silicon bug workarounds
will be implemented in the future the name of the
option will become: --silicon-bug=number

-B[p]

Use -H or use #include in .c file to include SFR
files

-Hsfr/sfrfile.sfr-Ccpu

-D macro[=def]-D macro[=def]

Flags are different-E[flag...]-E[flag...]

-F-F

-H-H

-I-I

For more information see Section 16.1.3, Memory
Models

--rom-model=model
--ram-model=model

-M{sml}

Flags are different-Oflag...-O flag...

Section renaming is not supported yet.-R

--rom-const
--string-literal-memory=space

-S{o|c}

-U-U

-V-V

-bnumber

Inverted behavior: originally -e removed the output
file, while -k keeps it

-k-e

--error-file-err

-f file-f file

Flags are different-g[acd]-g[fln]

-n-n

-o file-o file

-s-s

-st

Use the assembler option -t-t

-u-u

--no-vector-v

-w[number]-w[number]

Use a selection of warnings with -w-wstrict
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RemarksVX-toolset C CompilerClassic C Compiler

Pragmas that have a command line equivalent have
a long option (--)

-z pragma

16.1.2. Pragmas

The following list shows all pragmas available in the classic C compiler and a description about if and
how they are supported in the VX-toolset C compiler.

VX-toolset compilerClassic Compiler
Pragma

Not available. This pragma is dedicated for the classic compiler technology.
Note that there is a pragma alias, which has a different meaning and has
arguments. The compiler will complain if arguments are not present, which
allows detection of these pragmas in existing code.

alias / noalias

Use the __asm() method.asm
asm_noflush
endasm

Not available.listinc / nolistinc

Flags have been changed.optimize / endoptimize

Use #pragma section. See Section 1.11, Section Namingrenamesect / defaultsec

Is the same: #pragma source/nosourcesource / nosource

Use __attribute__((interrupt())) after an interrupt function to specify
that the C compiler must not generate code to bind the function to a specific
interrupt vector.

vector / novector

16.1.3. Memory Models

In the VX-toolset compiler there are two memory model options (--ram-model and --rom-model) and
two options (--rom-const and --string-literal-memory) which have some interworking with the memory
model options. All of these options only affect the storage type of variables and constants, not functions.
Function storage types can only be influenced explicitely by using the ROM storage type qualifiers which
apply to program memory. The default storage type for functions is __rom which implies that they can
be located anywhere in program memory. The memory model options define the default storage type of
variables and constants located in internal data memory (RAM) or in internal program memory (ROM)
respectively. It is important to note that constants without an explicit storage type qualifier are located in
RAM by default and are not affected by the option --rom-model. These constants are only affected by
the option --rom-model if the option --rom-const is used as well. With option --rom-const all constants
without an explicit storage type qualifier are located in ROM. This behavior can be overruled for string
literals by means of the --string-literal-memory option.The default storage type for variables and constants
located in RAM is __data (full 64kB of internal data memory). The default storage type for constants
located in ROM is __zero0 (lowest 64kB of program memory).

See the description of the memory models in Section 1.3.2, Memory Models and Default Memory Type
for Data for more information.
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16.1.4. Calling Convention

The calling convention of the C compiler has changed. See Section 1.10.1, Calling Convention for a full
description of the new calling convention.

16.1.5. Language Implementation Migration

The language extensions in the VX-toolset for LC87 C compiler are slightly different from those in the
classic C compiler. The most significant difference is the use of a double underscore.

16.1.5.1. Qualifiers and Storage Types

The following list shows all C qualifier keywords available in the classic C compiler and a description
about if and how they are supported in the VX-toolset for LC87 C compiler. All old storage types except
for _reg have an equivalent new storage type. The _reg storage type is not supported because the
VX-toolset for LC87 C compiler does not implement a static stack.

VX-toolset C CompilerClassic C Compiler

Not supported._reg

__bdata_bram

__sdata_near

__mdata_mbram

__data_far

__xdata_xram

__hxdata
__xrom, __hxrom *

_hxram

__rom
__bank0, __bank1, __zero0, __zero1 *

_rom

__bit_bit

#define with hard-coded address value, see Section 16.1.5.2, SFR Definitions._sfrbit
_sfrbyte
_sfrword

Not supported._asmfunc

__interrupt_interrupt

inline_inline

__at_at

__atbit. Only supported for backwards compatibility. Use data structures with
single bit bit-fields instead.

_atbit

* The additional ROM storage types allow for more precise locating of code and constants in program
memory, or for locating constants in memory wired to the external data bus. For constants located in a
specific program memory bank or in a specific lower half of a program memory bank the compiler can
generate more efficient access code. This is because different instruction sequences are required when
accessing constants at a 16-bit address, a 17-bit address or an 18-bit address.
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16.1.5.2. SFR Definitions

SFRs are usually defined in SFR files, like lc87.sfr. The classic compiler uses _sfrbit, _sfrbyte
and _sfrword keywords for defining the SFRs.These keywords are no longer supported.The VX-toolset
for LC87 C compiler just uses #define’s of absolute addresses. For bits in SFRs the SFR file defines
structures for each SFR and defines the bit to a field in this structure.

As long as you use the SFRs defined in the SFR files included in the product, you do not have to change
anything. If you created a new SFR file or just defined SFRs in your code, you have to replace these SFR
definitions with #define’s as used in the new SFR files.

Example

Classic definition:

_sfrword _SP _at(0xFE0A);

VX-toolset definition:

typedef union __SFRWORD_U
{
    struct
    {
        unsigned char b0  : 1;
        unsigned char b1  : 1;
        unsigned char b2  : 1;
        unsigned char b3  : 1;
        unsigned char b4  : 1;
        unsigned char b5  : 1;
        unsigned char b6  : 1;
        unsigned char b7  : 1;
        unsigned char b8  : 1;
        unsigned char b9  : 1;
        unsigned char b10 : 1;
        unsigned char b11 : 1;
        unsigned char b12 : 1;
        unsigned char b13 : 1;
        unsigned char b14 : 1;
        unsigned char b15 : 1;
    } B;
    signed   int    I;
    unsigned int    U;
} __SFRWORD_type;

#define __SP    (*(__data volatile __SFRWORD_type *)0xFE0A)
#define _SP     __SP.U

16.1.5.3. Intrinsic Functions

All intrinsic names in the VX-toolset start with a double underscore (__). The list below shows all classic
intrinsic functions that are supported in the new VX-toolset.
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VX-toolset C CompilerClassic C Compiler

__testclear_testclear

__rol_rol

__ror_ror

__getbit, see note below_getbit

__putbit, see note below_putbit

__nop_nop

__mul16_mul16

__mul24_mul24

__div16_div16

__div24_div24

__getbit() / __putbit( )

Because these intrinsics are now implemented as macros, the compiler will not check the arguments
anymore for being a bit or bit-addressable. Instead, the compiler will just generate code for the current
type.

__mul24()

The __mul24() intrinsic now returns an __mul24_t type result, which is defined as an unsigned
long long when the --iso option is set to 99 (default). This makes it possible to use the full 40-bit result
range of the mul24 instruction. However, this may produce different results in some cases. For example:

unsigned long f( unsigned long a, unsigned int b )
{
    return __mul24( a, b ) >> 2;
}

Here a 64-bit shift right is used causing bit 32 and 33 of the 40-bit result to be included in the 32-bit return
value. To obtain the behavior of the classic compiler, use a type cast:

unsigned long f( unsigned long a, unsigned int b )
{
    return (unsigned long)__mul24( a, b ) >> 2;
}

When possible the compiler will use the type demotion optimization so that the smallest possible type is
used automatically. It will only do so when it can be guaranteed that the result will not change.

16.1.6. Preprocessor Symbols

The following table lists the differences in the compiler defined preprocessor symbols.

VX-toolset C CompilerClassic C Compiler

__LC87__, does not expand to version number, but to 1_C87
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VX-toolset C CompilerClassic C Compiler

Not supported._CPU

__ROM_BANK0__, __ROM_BANK1__, __ROM_ROM_, __ROM_ZERO0__,
__ROM_ZERO1__. One of these symbols expands to one depending on the
option --rom-model, the other symbols are unrecognized as macro.
__ROM_ZERO0__ is the default.

_MODEL

16.1.7. C Compiler Implementation Differences

This section describes the miscellaneous implementation differences between the classic C compiler and
the VX-toolset for LC87 C compiler.

The __bit type and initialization

Initialization of __bit type variables does not differ from the initialization of other variables. This means
that such variables are cleared or set individually, depending on the initialization value (or its omission)
in the source code. Corresponding entries for this are automatically added to the copy table and effectuated
at run-time before the call to main.You can prevent automatic clearance of unitialized __bit type
variables by means of the option --no-clear or #pragma noclear. Doing so will reduce the size of the
copy table, which is located in program memory.

String literals

String literals are treated like constants and are located by default in the memory space determined by
the compiler options--ram-model, --rom-model and --rom-const. (Note that this does not apply to
character array initializers.) The classic compiler always locates string literals in program ROM. In the
VX-toolset compiler you can control the location of string literals by means of the option
--string-literal-memory or #pragma string_literal_memory.

Bit-field allocation

There is a difference in the allocation of bit-fields between the classic C compiler and the VX-toolset C
compiler. Consider the following example.

struct u
{
    signed int bf0 : 7;
    signed int bf1 : 2;
} u;

The classic compiler allocates bf1 at byte offset 1, leaving a gap of one bit between bf0 and bf1. The
VX-toolset compiler allocates bf1 directly after bf0.

Shift operator

The behavior of the shift operator in the VX-toolset C compiler differs from the classic C compiler. For
example:
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uint16_t Shift(uint16_t a)
{
    return a >> 16;
}

With the classic C compiler this results in 0, with the VX-toolset C compiler this results in a.

Interrupt functions

The classic compiler uses a vector address as the argument of _interrupt(), the VX-toolset uses the
entry into the interrupt vector table (vector number 0..10) as the argument of __interrupt(). The
relationship between the two is as follows:

number = (address + 5) / 8

For example, vector address 0x33 (51) is interrupt number 7.

Forward references to enums are not allowed

This will yield an error message “reference to incomplete enum type”. For example:

enum test foo( void );

enum test { A=1,B=2,C=3 };

enum test foo( void )
{
 return B;
}

This was allowed by the classic C compiler. Make sure the enum is defined before the reference.

Different sizeof() behavior for bit structures

In the classic C compiler the sizeof() operator would return the size in bits for bit structures. This has
changed, and sizeof() always returns the size in bytes. In the VX-toolset use the __bitsizeof()
operator to obtain the size in bits.

Defining bit aliases with __atbit() (backwards compatibility only)

For backwards compatibility, you can still use the __atbit() keyword to define a bit symbol as an alias
for a single bit in a bit-addressable object. However, we recommend that you use data structures with
single bit bit-fields instead as described in Section 1.3.6, Accessing Bits.

For example, change the following old code for the classic C compiler:

typedef unsigned char BYTE;

_bram  BYTE     my_flags;
_bit   my_flag3 _atbit(my_flags,3);

into:
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typedef union __BYTE
{
    struct __BYTE_S
    {
        unsigned char b0 : 1;
        unsigned char b1 : 1;
        unsigned char b2 : 1;
        unsigned char b3 : 1;
        unsigned char b4 : 1;
        unsigned char b5 : 1;
        unsigned char b6 : 1;
        unsigned char b7 : 1;
    } B;
    unsigned char U;
} BYTE;

__bdata  BYTE      _my_flags;
#define  my_flags  _my_flags.U;
#define  my_flag3  _my_flags.B.b3;

The syntax of __atbit() is:

__atbit(base,offset)

or:

__attribute__((atbit(base,offset)))

where, base is a bit-addressable object and offset is the bit position in the base object.

For example:

       __mdata volatile unsigned long long base;
static __mdata volatile __bit b63 __atbit(base,63);

The following restrictions apply:

• The base object must be located in one of the bit-addressable memory spaces.

• The offset cannot be outside the base object

• The declared bit alias object must be in the same memory space as the base object.

• The base object can have any type, except for __bit.

• The __atbit keyword can only be applied to __bit type symbols.

• Both the bit alias and the object must be defined volatile explicitly. The compiler issues a warning
if the objects are not volatile and makes the objects volatile. The reason for this is, that writing
to the base object affects the bit aliases, and the other way around. The keyword volatile informs
the compiler about these side effects.
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• The bit alias must be declared static. When this is not the case, the compiler issues a warning and
makes the bit alias static. The reason for this is that in the generated assembly code the name of
the bit alias does not appear. The assembly code uses the name of the base and the offset. Therefore,
the coupling between modules must be done through the base object.

• It is not possible to use the address-of ('&') operator on bit aliases.

The static bit aliases make it easy to keep the bit offset synchronized between different modules,
because they can be included in a header file. For example:

File: x.h
=========

extern __bdata volatile unsigned int base;
static __bdata volatile __bit b15 __atbit(base,15);
static __bdata volatile __bit b8  __atbit(base, 8);
static __bdata volatile __bit b0  __atbit(base, 0);

File: a.c
=========

#include "x.h"

extern void f( void );

__bdata volatile unsigned int base;

int main( void )
{
    b15 = 1;
    b8  = 0;
    b0  = 1;
    f();
    return 0;
}

File: b.c
=========

#include "x.h"

void f( void )
{
    b15 ^= b8;
    b8  |= b0;
    b0  &= b15;
    return;
}

Drawbacks of __atbit()
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The __atbit() requires all involved objects to be volatile. If your application does not require these
objects to be volatile, you may see in many cases that the generated code is less optimal than when the
objects were not volatile. The reason for that is that the compiler must generate each read and write
access for volatile objects as written down in the C code. Fortunately the standard C language provides
methods to achieve the same result as with __atbit(). The compiler is smart enough to generate
efficient bit operations where possible.

Different stdio implementation

When an application relies on the stdio implementation it will possibly not work or even not build anymore.
For example:

_IOSTRG flag is no longer in stdio.h

_iobuf is different

You should rewrite the parts that rely on the stdio implementation.

16.2. Assembler Migration

This section describes how to migrate from the classic LC87K assembler to the VX-toolset for LC87
assembler.

16.2.1. Assembly Language

In the VX-toolset for LC87 assembly language, identifier names (labels and symbols) must start with a
lowercase or uppercase letter. Characters other than the first can be lowercase or uppercase letters,
decimal digits, a dot (.) and/or underscore characters (_). Identifier names are case sensitive. Identifier
names starting with an underscore (_) character or a dot (.) character are reserved for internal use by the
compiler, the libraries and the assembler. The dollar ($) character designates the location counter within
a section. The classic assembler uses the asterisk (*) to designate the location counter.

The classic assembler supports predefined expressions for register addresses. The symbolic names of
these expressions are ar0 .. ar63. This allows for the following expression to be used as a register
operand: ar3+1. With the VX-toolset for LC87 assembler these symbolic addresses are not available
and the expression ar3+1 must be written as r3h. If you like to keep using the old format, you can include
the following line in your assembly file: ar3 .equ 0x06.You can define expressions for all register
addresses ar0 .. ar63 in one common include file.

16.2.2. Assembler Functions

Because the VX-toolset for LC87 assembler uses ELF/DWARF instead of IEEE, which has a different
way of conveying relocation information, relocatable expressions are calculated by the linker. Because
there is no relocation stack, the assembler cannot evaluate relocatable expressions. The VX-toolset
assembler generates the appropriate relocation for the linker.To determine, for example, the bank number
of a relocatable expression, use assembler function @BANK() instead of compound expressions.

Use one of the following assembler functions:
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@BANK(expression)((expression >> 17) & 0x1)

@BPAG(expression)((expression >> 16) & 0x1)

@HI(expression)((expression >> 8) & 0xff)

@LO(expression)((expression) & 0xff)

@NEG(expression,size)((-expression) & ((1 << size) -1))

@PAGE(expression)((expression >> 16) & 0xff)

@POFF(expression)((expression) & 0xffff)

For example, replace the old syntax

chgp3 (Label >> 17) & 1

with the new syntax

chgp3 @BANK(Label)

16.2.3. Assembler Directives

With the VX-toolset for LC87 assembler all directive names start with a dot (.) character. The major
differences are in the .EXTERN and the .SECTION directives. See Section 2.10, Assembler Directives
for a description of all directives.

VX-toolset AssemblerClassic LC87K Assembler

.ALIGNALIGN

DeprecatedASCII, ASCIZ

.CALLSCALLS

DeprecatedCOMMENT

.DB, .DW, .DL, .DBITDB, DW

.DEFINEDEFINE

.SECTION, .ENDSEC

.RESUME
DEFSECT, SECT

.DS, .DSBIT, .DSB, .DSW, .DSL

.BS, .BSB, .BSW, .BSL
DS

.FOR, .ENDFOR

.REPEAT, .ENDREP
DUP, DUPA, DUPC, DUPF

.ENDEND

.EQUEQU

.BREAKEXITM

.EXTERNEXTERN

.MESSAGEFAIL, WARN, MSG
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.GLOBALGLOBAL

.IF, .ELIF, .ELSE, .ENDIFIF, ELIF, ELSE, ENDIF

.INCLUDEINCLUDE

Section symbols are local by default.LOCAL

.MACRO, .ENDMMACRO, ENDM

.SOURCENAME

Not supportedORG

DeprecatedPMACRO

DeprecatedRADIX

.SETSET

.SIZE, .TYPESYMB

.UNDEFUNDEF

Deprecated directives are available in the compiler for backwards compatibility only, they are not described
in the manual.

Section directives

With the classic assembler you would define and declare a section as follows:

    DEFSECT "section", type [, attr]... [AT address]
    SECT    "section"
      ...   ; assembly lines

For example:

    DEFSECT "mydata", DATA, NOCLEAR
    SECT    "mydata"
      ...   ; assembly lines

With the VX-toolset assembler you define a section as follows:

    .SECTION .section-prefix[.suffix][, attr]... [, at(address)]
      ...   ; assembly lines
    .ENDSEC

For example:

    .SECTION .bss.mydata, noclear
      ...   ; assembly lines
    .ENDSEC

The following table contains an overview of the old syntax and how you can change it to the syntax of
the VX-toolset assembler.
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.section .bss.mydataDEFSECT "mydata", DATA, CLEAR

.section .bss.mydataDEFSECT "mydata", DATA, CLEAR, FAR

.section .sbss.mydataDEFSECT "mydata", DATA, CLEAR, NEAR

.section .bbss.mydataDEFSECT "mydata", DATA, CLEAR, BRAM

.section .mbss.mydataDEFSECT "mydata", DATA, CLEAR, MBRAM

.section .bitbss.mydataDEFSECT "mydata", DATA, CLEAR, BIT

.section .bss.mydata, noclearDEFSECT "mydata", DATA[, NOCLEAR]

.section .bss.mydata, noclearDEFSECT "mydata", DATA[, NOCLEAR], FAR

.section .sbss.mydata, noclearDEFSECT "mydata", DATA[, NOCLEAR], NEAR

.section .bbss.mydata, noclearDEFSECT "mydata", DATA[, NOCLEAR], BRAM

.section .mbss.mydata, noclearDEFSECT "mydata", DATA[, NOCLEAR], MBRAM

.section .bitbss.mydata, noclearDEFSECT "mydata", DATA[, NOCLEAR], BIT

.section .data.mydataDEFSECT "mydata", DATA, INIT

.section .data.mydataDEFSECT "mydata", DATA, INIT, FAR

.section .sdata.mydataDEFSECT "mydata", DATA, INIT, NEAR

.section .bdata.mydataDEFSECT "mydata", DATA, INIT, BRAM

.section .mdata.mydataDEFSECT "mydata", DATA, INIT, MBRAM

.section .bitdata.mydataDEFSECT "mydata", DATA, INIT, BIT

.section .hxbss.mydataDEFSECT "mydata", XDATA, CLEAR

.section .xbss.mydataDEFSECT "mydata", XDATA, CLEAR, FIT
10000H

.section .hxbss.mydata, noclearDEFSECT "mydata", XDATA[, NOCLEAR]

.section .xbss.mydata, noclearDEFSECT "mydata", XDATA[, NOCLEAR], FIT
10000H

.section .hxdata.mydataDEFSECT "mydata", XDATA, INIT

.section .xdata.mydataDEFSECT "mydata", XDATA, INIT, FIT 10000H

.section .rodata.mydataDEFSECT "mydata", DATA, ROMDATA

.section .rodata0.mydataDEFSECT "mydata", DATA, ROMDATA, BANK 0

.section .rodata1.mydataDEFSECT "mydata", DATA, ROMDATA, BANK 1

.section .rodata.mydataDEFSECT "mydata", CODE, ROMDATA

.section .rodata0.mydataDEFSECT "mydata", CODE, ROMDATA, BANK 0

.section .rodata1.mydataDEFSECT "mydata", CODE, ROMDATA, BANK 1

.section .text.mycodeDEFSECT "mycode", CODE

.section .text0.mycodeDEFSECT "mycode", CODE, BANK 0

.section .text1.mycodeDEFSECT "mycode", CODE, BANK 1
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With the .SECTION you always start a new section. With the .RESUME directive you can reactivate a
previously defined section. See the .SECTION directive for a list of available section attributes. If you
omit the attribute, the previously defined section with the same name is reactivated (ignoring the
attribute(s)). If you specify an attribute you reactivate the section with that same attribute. So, like you
can use SECT in the old assembler to continue a section, you can use .RESUME in the new assembler.

For example:

    SECT    "mydata"                 ; classic assembler

    .RESUME .bss.mmydata, noclear    ; VX-toolset assembler

16.2.4. Assembler Controls

The new assembler does not support controls on the command line. Instead command line options must
be used. In the source code only a subset of the controls are supported in the form of directives.

VX-toolset AssemblerClassic LC87K Assembler

--case-insensitive (-c) -> Default is now case sensitive!$CASE ON / OFF

--debug-info (-g)$DEBUG ON / OFF

--symbol-scope$IDENT LOCAL / GLOBAL

.LIST, .NOLIST$LIST ON / OFF

--list-format (-L)$LIST "flags"

Not supported.$MODEL [S|M|L]

--output (-o)$OBJECT file / OFF

--optimize (-O)$OPTIMIZE [ON | OFF] "flags"

.PAGE or --page-width, --page-length$PAGE width[,length, top, bottom, left]

Not supported.$PRCTL exp|"string"

Deprecated$STITLE "title"

.TITLE$TITLE "title"

--no-warnings$WARNING OFF [ num ]

16.3. Object Files

The object files of the classic tool chain and the VX-toolset for LC87 have different object formats. The
classic tool chain uses the IEEE-695 format and the VX-toolset for 8051 uses the ELF/DWARF 3 format.
The new toolset cannot read object files of the classic tool chain.
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16.4. OPT Files and CGR Files

OPT files (.opt) and CGR files (.crd) are generated in Intel Hex format by the su.exe and cgr2.exe
tools respectively. They must be imported into the Eclipse project for inclusion in the executable image
by the linker.

To add OPT files and/or CGR files to your project

1. In Eclipse, from the Project menu, select Properties for

The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Data Objects.

4. Browse for an OPT file or a CGR file.
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